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About This Guide

The OpenText Vibe 4 Administration Guide provides administration information for OpenText Vibe 4.

¢ Part |, “VibeSite Setup,” on page 15

+ Part ll, “Site Maintenance,” on page 205

+ Part lll, “Interoperability,” on page 319

+ Part |V, “Site Security,” on page 335

+ PartV, “Appendixes,” on page 367
Audience

This guide is intended for OpenText Vibe administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please use the User Comments feature at the bottom of each page of the
online documentation.

Documentation Updates

For the most recent version of the OpenText Vibe 4 Administration Guide and other documentation,
visit the Vibe 4 Documentation website (http://www.novell.com/documentation/vibe4).

Additional Documentation

You can find more information in the OpenText Vibe documentation, which is accessible from the
Vibe 4 Documentation website (http://www.novell.com/documentation/vibe4).

To access the OpenText Vibe 4 User Guide from within Vibe, click the Settings icon, then click Help.
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Logging In as the Vibe Site Administrator

After logging in to the OpenText Vibe site, you should reset the Vibe administrator’s password. Also,
you might want to create additional Vibe administrators.

¢ “Logging In” on page 17

+ “Changing the Vibe Administrator User ID or Password” on page 17

+ “Creating Additional Vibe Administrators” on page 18

Logging In

After installing and configuring Vibe, you need to log in to the Vibe site to perform additional
administrative tasks.

1 In your web browser, specify one of the following URLs, depending on whether you are using a
secure SSL connection:

http://vi be_host nanme
https://vibe_hostnane

Replace vi be_host nane with the hostname or fully qualified domain name of the Vibe server
that you have set up in DNS. If you configured the HTTP ports correctly during installation, you
do not need to include the port number in the Vibe URL.

2 If this is the first time you have logged in to the Vibe site, log in using admi n as the login name
and admi n as the password.

The Change Password dialog box is automatically displayed when you first log in to the Vibe site.

If this is not your first time logging in, log in using adm n as the login name and your password.

Changing the Vibe Administrator User ID or Password

When you first install OpenText Vibe, the Vibe administrator user name is adm n and the password
is adm n. When you first log in to the Vibe site as the administrator, you should change the
administrator password from the default password to a secure password of your own choosing.

¢ “Changing the Administrator Password” on page 17

+ “Changing the Administrator User ID and Other Profile Information” on page 18

Changing the Administrator Password

You can change your password to a new password at any time:

1 In your web browser, specify one of the following URLs, depending on whether you are using a
secure SSL connection:
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http://vibe_host name: 8080
htt ps://vi be_host nane: 8443

Replace vi be_host nane with the hostname or fully qualified domain name of the Vibe server
that you have set up in DNS. If you configured the HTTP ports correctly during installation, you
do not need to include the port number in the Vibe URL.

2 (Conditional) If this is your first time accessing the site, log in using admi n as the login name
and admi n as the password.

The Change Password dialog box is automatically displayed when you first log in to the Vibe site.

3 (Conditional) If this is not your first time accessing the site, log in using the administrator user
name and password, then change your password as described in “Changing Your Password” in
the OpenText Vibe 4.0.8 User Guide.

Changing the Administrator User ID and Other Profile
Information

You might want to change the administrator User ID in addition to other information on the
administrator’s user profile.

+ User ID: As a security precaution, it might make sense to change the administrator’s user ID
from the default admi n. The administrator user ID is used only when logging in to the Vibe
system.

Changing the administrator user ID requires that you restart each Vibe appliance in the Vibe
system in order for the change to take effect.

+ First Name and Last Name: Providing a first and last name for the administrator changes the
name that appears in the upper-right corner of each Vibe page, as well as the name that
appears in the administration console under Administrators.

To change the Vibe administrator user ID, as well as other profile information, follow the steps in
“Modifying Your Profile” in the OpenText Vibe 4.0.8 User Guide.

Creating Additional Vibe Administrators

Only the original (built-in) Vibe administrator can add or remove site administrator rights for users
and groups.

Additional Vibe administrators have rights to administer the following:

+ Users
+ Groups

+ Mobile Devices

+ “Assigning Administrative Rights to a User or Group” on page 19

¢ “Creating an Administration Group” on page 19
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Assigning Administrative Rights to a User or Group

1 Login to Vibe as the Vibe administrator.
1la Launch a web browser.
1b Specify one of the following URLs, depending on whether you are using a secure SSL
connection:

http://vi be_host name: 8080
htt ps://vi be_host nane: 8443

Replace vi be _host nanme with the host name or fully qualified domain name of the Vibe
server that you have set up in DNS. If you configured the HTTP ports correctly during
installation, you do not need to include the port number in the Vibe URL.

Depending on how you have configured your Vibe system, you might not be required to
enter the port number in the URL. If you are using NetlQ Access Manager, the Vibe login
screen is not used.

2 Click the admin link in the upper-right corner of the page, then click the Administration Console
icon '+,
3 In the Management section, click Administrators.

4 Click Add, then begin typing the name of the user or group for whom you want to grant
administrator rights.

5 Click the user or group name when it appears in the drop-down list.
To remove administrator rights from a user or group:

1 Select the users or groups for whom you want to remove administrator rights.

2 Click Remove.

Creating an Administration Group

You can create an administration group and assign rights only to that group:

1 Login to Vibe as the Vibe administrator.
1a Launch a web browser.
1b Specify one of the following URLs, depending on whether you are using a secure SSL
connection:

http://vi be_host nanme: 8080
https://vi be_host nane: 8443

Replace vi be_host nane with the host name or fully qualified domain name of the Vibe
server that you have set up in DNS. If you configured the HTTP ports correctly during
installation, you do not need to include the port number in the Vibe URL.

Depending on how you have configured your Vibe system, you might not be required to
enter the port number in the URL. If you are using NetlQ Access Manager, the Vibe login
screen is not used.

2 Create an administration group, described in “Creating Groups of Users” on page 99.
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3 Assign administrator rights to that group, as described in “Assigning Administrative Rights to a
User or Group” on page 19.

4 When you want to grant administrative rights to a user, add that user to the administrator group
that you created. (For information about how to add users to a group, see “Modifying Groups”
on page 233.)
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Planning and Controlling User Access to
Workspaces and Folders

As the administrator for the OpenText Vibe site, you are responsible for setting up and controlling
user access across the entire site. Even though workspace and folder owners are responsible for
controlling user access in their individual workspaces and folders, you as the Vibe administrator have
the ability to create new roles, modify existing roles, and change default access control settings for
all types of workspaces and for all types of functions across the Vibe site.

+ “Understanding Access Control” on page 21

¢ “Controlling User Access in Workspaces” on page 26

+ “Controlling User Access throughout the Vibe Site” on page 30
+ “Managing Roles to Refine Access Control” on page 31

IM

+ “Restricting Access Rights of Users Outside the Firewall” on page 38
+ “Enabling Users to Send Messages to All Users” on page 41
+ “Enabling Users to Send Messages to All Users” on page 42

+ “Enabling Users to Access Entries via the Workspace Tree When They Do Not Have Access to the
Parent Folder or Workspace” on page 43

+ “Enabling Folder Administrators to Apply Definition Settings to Sub-Folders and Entries” on
page 44

Understanding Access Control

Access control is how you specify which users have the right to perform which tasks in which places.
Because your OpenText Vibe site is a hierarchy of workspaces and folders and because access control
settings can be inherited (or not), access control settings affect a variety of Vibe features

OpenText Vibe uses role-based access control. By default, there are seven roles, and each role
contains specific rights. If you want a particular user to have certain rights, you can assign that user
to the appropriate role.

For example, a user who has been assigned to the Participant role in a workspace or folder can add
comments or replies, create entries, delete his or her own entries, modify his or her own entries, and
read entries in that folder or workspace.

The following sections help you better understand how access control works in Vibe.

+ “Inheritance” on page 22

*

“Navigation” on page 22

*

“Default Access Control Behavior in Workspaces” on page 23

*

“Default User Rights” on page 23
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+ “Default Roles” on page 23

+ “Default Users and Groups” on page 25

Inheritance

Workspaces can inherit the access control settings of their parent workspaces. You should
understand the following facts about access control inheritance:

+ If you create a new workspace under an existing workspace that is inheriting its access control
settings from its parent, the new workspace continues the inheritance chain. If you change any
access control settings above the new workspace at a later time, the access control settings for
the new workspace also change. Global workspaces inherit access control settings from the
parent workspace by default.

+ If you create a new workspace under an existing workspace that is not inheriting its access
control settings, the new workspace retains the non-inherited settings of the parent workspace.

+ If you move a workspace that is inheriting its access control settings from its original parent
workspace, it inherits the access control settings of the new parent workspace into which it is
moved. If the new parent workspace has different settings than the original parent workspace,
the access control settings for the moved workspace change accordingly.

+ Team membership is inherited separately from access control settings. If access control settings
are being inherited, this does not necessarily mean that team membership is also being
inherited. To edit team membership or to change the team membership inheritance settings for

a team workspace, click the Configure icon @ next to the workspace title, then click Edit Team.

Navigation

As a best practice, you should not grant users access to sub-workspaces and sub-folders while
restricting access for the same users to the higher-level (parent) folders. Ignoring this best practice
can be problematic for the following reasons:

+ Users cannot navigate to the sub-workspace or sub-folder using the Workspace tree navigation,
even though they have appropriate rights to the sub-workspace or sub-folder.

If you understand this limitation and still have a need to restrict access to a parent workspace or
folder while granting access to a sub-workspace or sub-folder, users can still access the hidden
sub-workspace or sub-folder by using the Search feature or by accessing the location through
WebDAV.

+ Users can see the name of a higher-level workspace, even though they do not have appropriate
rights.

Users who use the Search feature or WebDAV to locate the sub-workspace or sub-folder that
they have been granted access to are able to see the name of the parent workspace, which they
would otherwise not be able to see. However, they can see only the workspace name, not the
contents of the workspace.
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Default Access Control Behavior in Workspaces

By default, most places inherit the access control settings of their parent. When you establish
settings for a primary space, all sub-places automatically apply the same settings, saving
administration time. However, unlike other types of workspaces, Team workspaces do not retain the
access control settings of the parent workspace by default. This is because the desired access control
settings for Team workspaces can vary greatly depending on the objectives of the team.

Also, team membership is inherited separately from access control settings. If access control settings
are being inherited, this does not necessarily mean that team membership is also being inherited. To
edit team membership or to change the team membership inheritance settings for a team
workspace, click Workspace > Edit Team.

Default User Rights

By default, all Vibe users have rights to perform the following actions:
+ Participate in any team workspaces in which they are a member (create folders and entries,
make comments, and so forth)

+ Create team workspaces (by default, only members of a team can view and participate in team
workspaces)

+ Visit all personal workspaces (read entries and comment on them)

+ Participate in all global workspaces and folders

Default Roles

Vibe includes default roles that you can assign to users and groups. The following sections describe
the function of each default role, but does not describe all of the rights associated with each role.
For a complete list of rights, click the name of the role in the table on the Configure Access Control

page. (Click the Configure icon © next to the workspace or folder title, then click Access Control.)

For information on how the administrator can assign users to various roles for the Vibe site, see
“Controlling User Access throughout the Vibe Site” on page 30. For a detailed description of each
right that can be associated with a given role, see “Understanding the Various Rights for Roles” on
page 37.

Vibe enables site administrators to create their own custom roles, as described in “Defining a New
Role” on page 32.

+ “Understanding Default Roles for Workspaces and Folders” on page 24
+ “Understanding Default Roles for Entries” on page 24

¢ “Understanding Default Administrative Roles” on page 25
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Understanding Default Roles for Workspaces and Folders

Role

Description

Allow Sharing With
Internal Users

Allow Sharing With
External Users

Allow Forwarding of
Sharing Rights

Allow Sharing With The
Public

Allow Sharing File Links
Visitor

Participant

Guest Participant

Team Member

Workspace and Folder
Administrator

Workspace Creator

Can share workspaces and folders with internal users.

Can share workspaces and folders with external users.

When sharing, can allow users to re-share workspaces and folders.

Can share workspaces and folders with the Public.

Can share File Links.
Has read-only and comment-only access.

Can create entries and modify those entries, can download folder content as a
CSVfile, plus perform tasks associated with the Visitor role.

Can read entries, create entries, and add comments.

Has all the rights of a Participant. In addition, can generate reports and manage
global tags.

Can create, modify, or delete workspaces or folders; moderate participation
(modify or delete the entries of others); design entries and workflows; set entry-
level access controls on entries of others; and perform tasks associated with the
Participant and Team Member role.

Can create sub-workspaces. In Team Workspace Root workspaces, this role lets
users create their own team workspaces.

Understanding Default Roles for Entries

Role

Description

Owner Create Entry ACLs

Read

Read and Reply
Write

Delete

Change Access Controls

The owner of the entry can create entry-level access controls.

Can read the entry.

Can read the entry and add comments or replies to the entry.

Can read the entry, add comments or replies, and modify the entry.

Can read the entry, add comments or replies, modify, and delete the entry.

Can read the entry, add comments or replies, modify, and delete the entry. Can
also modify the access control settings of the entry.
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Understanding Default Administrative Roles

Role Description
Allow Adding Guest Can make Vibe workspaces and folders available to Guest users in Vibe.
Access

By default, Guest users can access only the Guest user personal workspace, as
well as any workspace or folder that the Vibe administrator has granted them
rights to access.

For more information, see “Enabling Individual Users to Grant Guest Access
throughout the Vibe Site” on page 109.

Can Only See Members Of Removes a user’s ability to view other Vibe users who are not members of a
Groups | Am In group that he or she belongs to.

Override “Can Only See  Overrides the Can Only See Members Of Groups | Am In role. This can simplify
Members Of Groups | Am the administration of the Can Only See Members Of Groups | Am In role.

Inll
For example, you might assign the Can Only See Members Of Groups | Am In role

to a group, but at the same time you want to allow certain members of the group
to retain their ability to see users that belong to groups outside of their own. In
this circumstance, you can assign the Override “Can Only See Members Of
Groups | Am In” role to the members who you want to retain their ability to see
users outside of their own groups.

Token Requester Can make web service calls on behalf of another Vibe user.

This functionality can enable administrators to perform proxy functions for
individual Vibe users without logging in as the Vibe user. This means that the web
services application does not cache individual users’ credentials in order to
perform operations.

This role should not be assigned to a Vibe user, but rather to a system-level
(agent) account that you want to be responsible for executing web service
operations on behalf of one or more regular Vibe users.

For more information about the web services operations that support the Token
Requester role, see “admin_getApplicationScopedToken” and
“admin_destroyApplicationScopedToken” in the OpenText Vibe 4.0.8 Developer
Guide.

Zone Administration Has all rights associated with access control.

Default Users and Groups

You can assign default or custom access control roles to users and groups for the Vibe site if you are
the Vibe administrator, or in your workspaces if you are a workspace owner. In addition to the users
and groups that the Vibe administrator creates, Vibe includes four default users and groups to which
you can assign roles.

Default User and Group Description

Owner of a Workspace or  The person who created the workspace, or the person assigned to be the owner
Folder of the workspace.
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Default User and Group Description

Team Members The individuals who are designated as team members in a given place.

For information about how to add team members, see “Adding Additional Team
Members to Your Workspace” in the OpenText Vibe 4.0.8 User Guide.

All Users Every person registered within the Vibe site.

Site Administrator The person who has rights to perform any task in any workspace or folder.
Available only to Vibe administrators.

Controlling User Access in Workspaces

The access control settings on each OpenText Vibe workspace determine who can see the
workspace and how different types of users can participate in each workspace.

+ “Controlling User Access to Personal Workspaces” on page 26
+ “Controlling User Access to Team Workspaces” on page 28

+ “Controlling User Access to Global Workspaces” on page 29

Controlling User Access to Personal Workspaces

+ “Default Access Controls” on page 26

+ “Restricting Access to Personal Workspaces throughout the Vibe Site” on page 26

Default Access Controls

By default, personal workspaces are created with the following access:

User or Group Access Role Role Description

Workspace Owner Administrator Can create, modify, or delete workspaces or folders; moderate
(user) participation (modify or delete the entries of others); design entries and
workflows; and can perform Participant tasks.

All Users group Visitor Has read-only and comment-only access.

Restricting Access to Personal Workspaces throughout the Vibe Site

You might want to set up your Vibe site so users’ personal workspaces remain hidden and
confidential.

IMPORTANT: If you configure your Vibe site to hide users’ personal workspaces as described in this
section, the following side effects occur:

+ Users cannot follow one another

+ Users are not displayed in the Personal Workspaces workspace
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+ Users are not displayed under Personal Workspaces in the Workspace tree

+ User workspaces and user profiles cannot be found when performing a search (this means that
users cannot search for and find other Vibe users.)

When you configure your Vibe site as described in this section, you should make these configuration
changes before any users are added to your Vibe system. If users are added to your Vibe system
before you make these configuration changes, you must manually adjust the access control settings
for each user workspace, as described in “Controlling Access” in the OpenText Vibe 4.0.8 Advanced
User Guide.

1 Click your linked name in the upper right corner of the page, then click the Administration
Console icon %',

2 Under Management, click Workspace and Folder Templates.

Workspace and Folder Templates
New v |[ Reset | Import || Export

Standard Templates

= Discussion - A Discussion folder is useful for creating a forum where users are likely to both create and reply to entries.

= Blog - Ablog folder is a forum where entire entries are displayed in reverse chronological order, based on when they were created.
Blogs typically provide information on a particular topic from an individual or small group of authors. Optionally, the blog folder can be
configured so that a larger group can make comments on the entries posted by the original author.

= Calendar - A calendar folder is a place to post group events or display other types of entries by date

= Guestbook - A guestbook folder is a simple place that individuals
Workspace. Visitors may also leave comments about the entries cre
reverse chronological order. A picture of the individual signing the g
for expanding users’ social networks.

= Files - Afile folder is a place to putfiles. Comments or entire discussions can
be automatically locks plac ew

au

"sign,” indicating that they have visited a user's Personal
ed in that personal workspace. Comments are displayed in
estbook is displayed with the comment. The guestbook is useful

be posted aboutindividual files. Additionally, the files can
on le. Afile folder can emulate a WebDAY server.

3 Click User Workspace.
4 Click Manage This Target > Access Control.
The Configure Access Control page is displayed.
5 In the access control table, in the All Users row, deselect the check box in the Visitor column.
6 Click Save Changes.
7 Verify access before you start adding users to your Vibe system:
+ Create a test user in the Vibe system, navigate to this user’s personal workspace, then click
Workspace > Access Controls. Ensure that no check boxes are selected in the All users row.
+ Navigate to the Personal Workspaces workspace by clicking the Workspace tree icon & in

the Action toolbar, then clicking Personal Workspaces. Click the Configure icon 'E} next to
the workspace title, then click Access Controls. Ensure that in the All users row the check
box is selected in the Visitor column. If this check box is not selected, users cannot search
for other users in the Vibe system.

For information on how to add users to your Vibe system, see “Adding New Users to Your Vibe Site”
on page 99.

Vibe users can adjust the access control for their personal workspaces, as described in “Controlling
Access” in the OpenText Vibe 4.0.8 Advanced User Guide.
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Controlling User Access to Team Workspaces

By default, new team workspaces created under the main Team Workspaces directory are visible
only to members of the team workspace. Following are the default access control settings for a team
workspace:

User or Group Access Role  Role Description

Workspace Owner Administrator Can create, modify, or delete workspaces or folders; moderate
(team creator) participation (modify or delete the entries of others); design entries and
workflows; and can perform Participant tasks.

Team Members Team Has all the rights of a Participant. In addition, can generate reports and
Member manage community tags.

After you create a new team workspace, you can configure different access control settings for it.

1 Navigate to the new team workspace, then click Workspace > Access Control.

2 Select No in the Inheritance box.

This folder does not inherit its access control settings from its parent.

Inherit role membership from the parent folder or workspace?
Yes @ np

3 Click Apply to activate the Access Control table:

v designates the access control sefting of the parent workspace

Add User Names from Clipboard

Add a Role

Participant Team Member Workspace and Folder Administrator Workspace Creator

Owner of Workspace or Folder m v B
Team Members v ] ]

Add a Group ¥ Group Title Group Name Participant Team Member Workspace and Folder Administrator Workspace Creator
All Users allusers v | ] [ v O

Add a User = User Title User Id Participant Team Member Workspace and Folder Administrator Workspace Creator
—No Users—

Add an Application Group = Application Group Title  Application Group Name  Participant Team Member Workspace and Folder Administrator Workspace Creator

—no application groups—

Add an Application Application Title Application Name Participant Team Member Workspace and Folder Administrator Workspace Creator

—no applications—

4 Adjust the access control settings for the new team workspace as needed, as described in
“Controlling Access to Workspaces and Folders” in “Controlling Access” in the OpenText Vibe
4.0.8 Advanced User Guide.

5 Click Save Changes > Close.
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Controlling User Access to Global Workspaces

By default, the Global Workspace directory immediately under the Home Workspace inherits the
access control settings of the Home Workspace:

User or Group

Access Role

Role Description

Workspace Owner
(admin)

Team Members

All Users group

All Applications
group

Administrator

Team
Member

Participant
Visitor

Visitor

Can create, modify, or delete workspaces or folders; moderate
participation (modify or delete the entries of others); design entries and
workflows; and can perform Participant tasks.

Has all the rights of a Participant. In addition, can generate reports and
manage community tags.

Can create and modify entries, plus perform the Visitor tasks.
Has read-only and comment-only access.

Has read-only and comment-only access. For information about
application groups, see “Managing Remote Applications” in the
OpenText Vibe 4.0.8 Advanced User Guide.

When you create a new global workspace under the main Global Workspaces directory, the new
global workspace by default inherits the access control settings of the main Global Workspaces
directory, as listed above. After you create a new global workspace, you can configure different
access control settings for it.

1 Navigate to the new global workspace, then click Workspace > Access Control.

2 Select No in the Inheritance box.

This folder does not inherit its access control settings from its parent.

Inherit role membership from the parent folder or workspace?

yes

9 no

3 Click Apply to activate the Access Control table:

v designates the access control setting of the parent workspace

Add User Names from Clipboard

Add aRole =
Visitor  Participant Team Member Workspace and Folder Administrator

Owner of Workspace or Folder v @
Team Members v ¥

Add a Group T Group Title Group Name Visitor  Participant Team Member Workspace and Folder Administrator
All Users allusers v FH v

Add a User = User Title User Id Visitor  Participant Team Member Workspace and Folder Administrator
—nNo users—

Add an A Group = ion Group Title jon Group Name  Visitor  Participant Team Member Workspace and Folder Administrator
Al Applications allApplications v &

Add an Application =

Application Title

Application Name Visitor Participant Team Member Workspace and Felder Administrator

—no applications—
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4 Adjust the access control settings for the new global workspace as needed, as described in
“Controlling Access” in the OpenText Vibe 4.0.8 Advanced User Guide.

5 Click Save Changes > Close.

Controlling User Access throughout the Vibe Site

By assigning users to access control roles for the OpenText Vibe site, you can give users additional
rights, or restrict current rights.
+ “Controlling User Access to Administrative Functions” on page 30

+ “Controlling User Access to Workspaces, Folders, and Entries” on page 31

Controlling User Access to Administrative Functions

You can create additional Vibe administrators as described in “Creating Additional Vibe
Administrators” on page 18.

This section describes how you can make more granular access settings.

Administrative roles grant users rights to perform administrative functions throughout your Vibe
site. As the Vibe administrator, you can assign users and groups to administrative roles. For a list of
default administrative roles, see “Understanding Default Administrative Roles” on page 25.

To assign a user to a particular role for every place on the Vibe site:

1 Login to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon '+,
The Administration page is displayed.

3 Under System, click Access Control.

Configure Access Control

Configure Access Control @ [ Close ]

Administrative Functions

Add User Names from Clipboard

Add a Role »
Enable Enable Override
Allow . . SE::::f Sharing Sharing SE;"::': Enable Enable Create c’;g‘"’ “Can Only
Group Group  Adding % with the All  with the All % Forwarding  Sharing Net See Token Zone
Add a Group » Net Creating ith with Members °
Title Name Guest ot CreRNd e External Internal "M ofSharing  withthe  Folder  JIST°%'"  Members  Requester Administration
Access Users Users Rights Public  Servers PS  of Groups |
Users Users I Am In
Group Group Am In"
All
Internal : allusers Ui L4 L4 T4 v T4
Users
Enable Enable Override
Allow . . SE::::f Sharing Sharing SE;"::': Enable Enable Create c’;g‘"’ “Can Only
User Adding ' withthe All  with the All % Forwarding  Sharing Net See Token Zone
Add a User = User Id Creating with ith Members
Title Guest it Rl External Inernal %00 ofsharing  withthe  Folder  OMO®'S  Members  Reguester Administration
Access Users Users Rights Fublic  Servers PS  of Groups |
Users Users I Am In
Group Group Am In"

—N0 Users—

Assigning roles ta an application or application group at the zone level actually spacifies the maximum set of rights that the application is allowed to use. This allows the site administrator ta prevent an
application from ever having maore rights than are needed to perform its task. If no roles are assigned, then the application has no rights

admin (admin) has been designated as the default site administrator with privileges to perform any task on any workspace or folder.
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A basic Vibe site consists of a single zone. OpenText Vibe lets you set up multiple zones in a
single Vibe site. For more information about creating multiple zones, see Chapter 18, “Setting
Up Zones (Virtual Vibe Sites),” on page 197.

4 Add the user to whom you want to grant the site-wide role to the Access Control table.

For information on how to add users to the Access Control table, see “Adding Users to the
Access Control Table” in the OpenText Vibe 4.0.8 Advanced User Guide.

5 Add the role that you want to grant to the Access Control table.

For information on how to add roles to the Access Control table, see “Adding Roles to the
Access Control Table” in the OpenText Vibe 4.0.8 Advanced User Guide.

6 Click Save Changes, then click Close.

Controlling User Access to Workspaces, Folders, and Entries

Workspace and folder roles define which rights users have in specific workspaces and folders
throughout the Vibe site. Entry roles define which rights users have in specific entries.

Workspace and folder owners (or anyone with administrative rights) can assign workspace and
folder roles to specific users and groups by configuring access controls for their workspaces and
folders. For more information about how to do this, see “Managing Access Control for Users and
Groups” in “Controlling Access” in the OpenText Vibe 4.0.8 Advanced User Guide.

As the Vibe administrator, you can modify each default role for workspaces, folders, or entries to suit
your organization’s needs. These roles are then made available so that workspace and folder
administrators can assign them to users and groups in their workspaces and folders. For information
about how to modify existing roles or about how to create new roles, see “Managing Roles to Refine
Access Control” on page 31.

Managing Roles to Refine Access Control

OpenText Vibe uses role-based access control. Each default role contains specific rights. If you want a
particular user to have certain rights, you can assign that user to the appropriate role. For a list of all
the default access roles that are included in Vibe, see “Default Roles” in the OpenText Vibe 4.0.8
Advanced User Guide.

If you find that the existing roles do not meet the needs of your organization, you can modify them
or create new ones. This can be particularly useful if you want to delegate the administration of sub-
workspaces and sub-folders, and if you do not want to grant all of the privileges that come with the
Workspace and Folder Administration role.

Vibe also lets you delete roles that are no longer useful to your organization.

+ “Defining a New Role” on page 32

+ “Modifying Existing Roles” on page 34

+ “Deleting Existing Roles” on page 35

+ “Understanding the Various Rights for Roles” on page 37
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Defining a New Role

1 Login to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon '+,
The Administration page is displayed.

3 Under System, click Role Definitions.

Role Definitions

Configure Roles

[» Adda New Role

Currently Defined Roles

Workspace and Folder Roles

[> Allow Forwarding of Sharing Rights
[> Allow Sharing File Links

[> Allow Sharing With External Users
Allow Sharing With Internal Users
Allow Sharing With The Public
Guest Participant

Participant

Team Member

View Binder Title

Visitor

Workspace and Folder Administrator

v v v v W W% v v =

Workspace Creator

Entry Roles

[> Change Access Controls
[ Delete

[* Read and Reply

[ Read

[> Write

4 Click Add a New Role.
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Role Definitions

Rol Defiions

Configure Roles

= Add a New Role

Role Name
Role Scope Workspaces and Folders v

Role Conditions —none—

Add Comments or Replies

Add Folders

Add Workspaces

Allow Forwarding of Sharing Rights
Allow Sharing File Links

Allow Sharing with External Users
Allow Sharing with Internal Users
Allow Sharing with the Public
Change Access Control

Create Entries

Create Entry-Level Access Controls
Delete Entries

Delete Owned Entries

Design Entries

Design Workflows

Download Folder As CSV File
Generate Reporis

Manage Global Tags

Maodify Entries

Maodify Entry Fields

Modify Owned Entries

Maodify, Move, or Delete Folders and Workspaces
Owner Create Entry-Level Access Controls
Read Entries

Read Owned Entries

Rename Entries

Rename Owned Entries

N Fmiae Pl o Tkl -

In the Role Name field, specify a name for the new role, then select all of the rights that you
want members of this role to be able to perform.

In the Role Scope drop-down list, select whether you want this new role to be available for
workspaces or folders, or for entries.

(Optional) In the Role Conditions field, select the role condition that you want to associate with
this role.

Role conditions enable you to restrict what information users can access when they are outside
your corporate firewall. For more information, see “Restricting Access Rights of Users Outside
the Firewall” on page 38.

Select the rights that you want to be associated with this role.
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For information about each right that you can select, see “Understanding the Various Rights for
Roles” on page 37.

9 Click Add, then click Close.

The role is added to the list of existing roles. If you added this role to control access to entries,
the role is automatically made available on the access control page. If you added this role to
control access to workspaces and folders, Vibe users can now add this role to the Access Control
table, as described in “Adding Roles to the Access Control Table” in the OpenText Vibe 4.0.8

Advanced User Guide.

Modifying Existing Roles
1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration

Console icon * .
The Administration page is displayed.

3 Under System, click Configure Role Definitions.
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Role Definitions

Configure Roles

[» Adda New Role

Currently Defined Roles

Workspace and Folder Roles

[> Allow Forwarding of Sharing Rights
[> Allow Sharing File Links

[> Allow Sharing With External Users
[> Allow Sharing With Internal Users
[> Allow Sharing With The Public

[> Guest Participant

[> Participant

[» Team Member

[> View Binder Title

[> wisitor

[* Workspace and Folder Administrator
[* Workspace Creator

Entry Roles

[> Change Access Controls
[ Delete

[* Read and Reply

[ Read

[> Write

4 In the Currently Defined Roles section, click the role that you want to modify.

5 Select the rights that you want members of this role to be able to perform, and deselect the
rights that you don’t want them to be able to perform.

For information about each right that you can select, see “Understanding the Various Rights for
Roles” on page 37.

6 Click Apply, then click Close.

Deleting Existing Roles

1 Login to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon * .

The Administration page is displayed.
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3 Under System, click Configure Role Definitions.

Role Definitions

Rol Definions

Configure Roles

[» Adda New Role

Currently Defined Roles

Workspace and Folder Roles

[> Allow Forwarding of Sharing Rights
[> Allow Sharing File Links

[> Allow Sharing With External Users
[> Allow Sharing With Internal Users
[> Allow Sharing With The Public

[* Guest Participant

[> Participant

[» Team Member

[ View Binder Title

[> Visitor

[> Workspace and Folder Administrator

[* Workspace Creator

Entry Roles

[> Change Access Controls
[ Delete

[* Read and Reply

[* Read

[> Write

4 In the Currently Defined Roles section, click the role that you want to delete.

5 Click Delete, then click Close.

Understanding the Various Rights for Roles

Roles are made up of various rights. Default roles have a set of default rights that are associated with
them. When you modify a default role, you remove existing rights and add other rights. When you
create a custom role, you create a new name for a role and then associate rights with the new role.

Some rights apply only to workspaces and folders, and some apply only to entries. If you associate a
right with a role, and then assign users to that role in a workspace, then by default that role applies
to all folders and entries in the workspace. For example, if you associate the Delete Entries right with
a role in a workspace and assign that role to all users, then all users can delete any entry in the
workspace.
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Following is the list of rights you can choose from when modifying or creating a role. You cannot

create new rights in Vibe.

Right

Function

Add Comments or Replies
Add Folders
Add Workspaces

Allow Forwarding of Sharing
Rights

Allow Sharing File Links

Allow Sharing with External
Users

Allow Sharing with Internal
Users

Allow Sharing with the Public

Change Access Control
Create Entries

Create Entry-Level Access
Controls

Delete Entries
Delete Owned Entries

Design Entries

Design Workflows

Generate Reports

Manage Global Tags

Modify Entries

Modify Entry Fields

Modify Owned Entries

Can add comments or replies to entries.
Can add folders to workspaces and folders.
Can add workspaces to existing workspaces.

Can grant users the ability to re-share items when sharing.

Can share File Links.

Can share items with users who are external to the Vibe system.

Can share items with users who are internal to the Vibe system.

Can share items to the Public. Iltems are publicly available if Guest access has
been enabled.

Can modify the access control settings of workspaces, folders, or entries.
Can create entries.

Can change access control settings for all entries that are contained in a
workspace or folder.

Can delete entries.
Users can delete only the entries they own in a workspace or folder.

Users can design their own custom entries by using the Form and View
Designers tool, as described in “Designing Custom Folder Entry Forms” in the
OpenText Vibe 4.0.8 Advanced User Guide.

Users can design their own custom workflows by using the Form and View
Designers tool, as described in “Creating and Managing Workflows” in the
OpenText Vibe 4.0.8 Advanced User Guide.

Users can generate reports. For more information about generating reports in
Vibe, see “Generating Activity Reports for a Workspace”, “Generating an
Activity Report on a Folder”, and “Generating Reports about a Folder Entry” in
the OpenText Vibe 4.0.8 User Guide.

Users can manage community tags, as described in “Using Tags” in the
OpenText Vibe 4.0.8 User Guide.

Can modify entries.

Users can modify only a specific field in an entry. This is useful if you have an
entry that is associated with a workflow, and you want only certain users to
modify certain fields in the entry.

Users can modify only the entries they own in a workspace or folder.
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Right Function

Modify, Move, or Delete Users can modify, move, or delete a folder or workspace.
Folders and Workspaces

Owner Create Entry-Level Users can change the access control settings only for the entries they own in a
Access Controls workspace or folder.

Read Entries Can read entries.

Read Owned Entries Users can read only the entries they own in a workspace or folder.

Rename Owned Entries Users can rename only the entries they own in a workspace or folder.

View Binder Title Enables users who have access to an entry, but do not have access to the

parent workspace or folder, to navigate to the entry by using the Workspace
tree, as described in “Navigating the Workspace Tree” in the OpenText Vibe
4.0.8 User Guide.

This right is disabled by default, and is not available to assign to any role. For
information on how to enable this right and make it available, see “Enabling
Users to Access Entries via the Workspace Tree When They Do Not Have
Access to the Parent Folder or Workspace” on page 43.

Restricting Access Rights of Users Outside the Firewall

Vibe lets you restrict what information users can access when they are outside your corporate
firewall.

If your Vibe site contains sensitive data, and users access the site from non-secure locations, you
might want to consider restricting users to certain workspaces and folders when they are not
accessing Vibe from inside the corporate firewall.

For example, a user accessing the Vibe system from a public kiosk increases the risk of sensitive data
being inappropriately exposed.

To restrict access for users who are outside the corporate firewall, you must create a condition that
contains one or more IP addresses (or range of IP addresses), associate this condition with an
existing role, then assign the role to users and groups in the workspaces, folders, or entries where
you want to allow access.

+ “Creating a New Role Condition” on page 39

+ “Associating the Role Condition with a New or Existing Role” on page 40

+ “Assigning the Role Condition to Users and Groups” on page 41

+ “Example” on page 41

Creating a New Role Condition

1 Login to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon %',

The Administration page is displayed.
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3 Under System, click Role Definitions.
4 Click the Define Role Conditions tab.
5 Click Add a New IP Address Condition.

Define Role Conditions

Define Role Conditions

Add a New IP Address Condition
Title

Description

IP Addresses

Add Another [P Address

Currently Defined Role Conditions

Title Description IP Addresses

6 Provide the following information for the new condition:
Title: Specify a title for the condition.
Description: Specify a description for the role condition.
IP Address: Specify the IP address that you want to associate with this condition.
You can mask your IP address by using asterisks. For example, 155.5.*.*

Allow: Select this option to allow access from the specified IP address. There must be at least
one IP Address field with Allow selected.

Deny: Select this option to deny access from the specified IP address. Select this option only if
you have multiple IP Address fields, and one of these fields has Allow selected.

If you are masking an IP address, such as 155.5.*.*, you can exclude an IP address within the
range that you are masking. For example, in the first IP Addresses field you specify 155. 5. *. *,
then select Allow. You then add a second IP Address field by clicking Add Another IP Address,
then specifying an IP address that is within the range of your masked IP address. In your second
IP Address field, you specify 155. 5. 4. *, then select Deny. This denies access to users who are
using an IP address within the range 155.5.4.*, but allows access to users using any other IP
address within the range 155.5.*.*.

7 (Optional) Click Add Another IP Address to associate multiple IP addresses with this condition.
You can also add multiple IP addresses if you want to deny access to a specific IP address that is
included within a range of IP addresses that you are allowing.

Planning and Controlling User Access to Workspaces and Folders 39



8 Click Add.

9 Continue with “Associating the Role Condition with a New or Existing Role” on page 40.

Associating the Role Condition with a New or Existing Role

You must associate the role condition that you created in “Creating a New Role Condition” on
page 39 with a new or existing role.
1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon * .
The Administration page is displayed.
3 Under System, click Role Definitions.
4 On the Role Definitions tab, click Add a New Role.
or
Click an existing role in the Currently Defined Roles section.

For more information about managing roles, see “Managing Roles to Refine Access Control” on
page 31.

5 Inthe Role Conditions drop-down list, select the role condition that you want to associate to the
role.

6 Click Apply.

7 Continue with “Assigning the Role Condition to Users and Groups” on page 41.

Assigning the Role Condition to Users and Groups

After you have completed “Creating a New Role Condition” on page 39 and “Associating the Role
Condition with a New or Existing Role” on page 40, you need to assign the role that contains the new
role condition to users and groups. You accomplish this in one of two ways, depending on whether
you associated the role condition to a new role or an existing role (as described in “Associating the
Role Condition with a New or Existing Role” on page 40):

+ “Assigning the New Role to Users and Groups” on page 41

+ “Assigning an Existing Role to Users and Groups” on page 41

Assigning the New Role to Users and Groups

To assign the role that contains the new role condition to users and groups:

1 Add the role to the Access Control table for the workspaces, folders, or entries where you want
to grant users access rights, as described in “Controlling Access to Workspaces and Folders” in
the OpenText Vibe 4.0.8 Advanced User Guide.

2 Assign the roles to the users and groups who you want to be granted access rights, as described
in “Controlling Access to Workspaces and Folders” in the OpenText Vibe 4.0.8 Advanced User
Guide.
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Assigning an Existing Role to Users and Groups

If you associated the role condition with an existing role, the role is automatically applied to users
and groups in workspaces, folder, and entries where this role is already assigned.

Example

The following example shows how to restrict access to users outside the firewall by using role
conditions:
1. Set up a proxy server (such as NetlQ Access Manager) that is external to the firewall.

2. Define a role condition that includes only a range of IP addresses that are internal to the
firewall.

3. Associate this role condition to all or some existing Vibe roles.

If you associate this role condition to all roles except the Workspace and Folder Administrator
role, only users who are workspace and folder administrators are able to access workspaces and
folders from outside the firewall. Users who are not workspace and folder administrators do not
have access.

Enabling Users to Send Messages to All Users

By default, OpenText Vibe allows only the Vibe administrator to send email messages to the All Users
group. If you want to change this functionality to allow anyone to send messages to the All Users
group:

1 Change to the following directory:

Linux: /opt/ novel | / t eam ng/ apache-t ontat/
webapps/ ssf/WEB- | NF/ cl asses/ confi g

Windows: c¢:\Program Fi | es\ Novel | \ Teani ng\ apache-t ontat\
webapps\ ssf\ WEB- | NF\ cl asses\ config

2 Make a backup copy of the ssf - ext . properti es file, which is located in the same directory
asthe ssf. properti es file.

3 Openthessf. properti es filein a text editor.

4 Search for the following line:
mai | . al | owSendToAl | User s=f al se

5 Openthe ssf-ext. properti es file in a text editor.

6 Copythemmil . al |l owSendToAl | User s=f al se line from the ssf. properti es file to the
bottom of the ssf - ext. properti es file.

7 Changef al se totrue, so that the line now reads mai | . al | owSendToAl | User s=t r ue.
8 Save and close the ssf - ext . properti es file.
9 Close the ssf . properti es file without saving it.

10 Stop and restart Vibe to enable users to send messages to the All Users group in your Vibe site.
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Enabling Users to Send Messages to All Users

By default, OpenText Vibe allows only the Vibe administrator to send email messages to the All Users
group. If you want to change this functionality to allow anyone to send messages to the All Users
group:

1

Change to the following directory:
Linux: /opt/ novel | / t eam ng/ apache-t ontat /

webapps/ ssf/WEB- | NF/ cl asses/ config
Windows: c¢:\Program Fi | es\ Novel | \ Team ng\ apache-t ontat\

webapps\ ssf\ WEB- | NF\ cl asses\config

Make a backup copy of the ssf - ext . properti es file, which is located in the same directory
asthe ssf. properti es file.

3 Openthe ssf. properti es file in a text editor.

9
10

Search for the following line:
mai | . al | owSendToAl | User s=f al se

Open the ssf - ext . properti es file in a text editor.

Copy the mai | . al | owSendToAl | User s=f al se line from the ssf. properti es file to the
bottom of the ssf - ext. properti es file.

Changef al se totrue, so that the line now reads mai | . al | owSendToAl | User s=tr ue.
Save and close the ssf - ext . properti es file.
Close the ssf. properti es file without saving it.

Stop and restart Vibe to enable users to send messages to the All Users group in your Vibe site.

Enabling Users to Access Entries via the Workspace Tree
When They Do Not Have Access to the Parent Folder or
Workspace

You can enable users who have access to an entry, but do not have access to the parent workspace
or folder, to navigate to the entry by using the Workspace tree, as described in “Navigating the
Workspace Tree” in the OpenText Vibe 4.0.8 User Guide.

Users who do not have this right must either perform a search to locate the entry, or they must have
the entry shared with them as described in “Sharing Entries, Folders, and Workspaces” in the
OpenText Vibe 4.0.8 User Guide.

For information about how users can grant other Vibe users access to an entry even when users
don’t have access to the parent workspace or folder, see “Exposing a Vibe Entry to a Wider Audience
Than the Folder Access Controls Allow” in the OpenText Vibe 4.0.8 Advanced User Guide.

To enable users to access entries via the Workspace tree when users do not have access rights to the
parent folder or workspace:

1

Change to the following directory:
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Linux: / opt/ novel | / t eam ng/ apache-t ontat /
webapps/ ssf/WEB- | NF/ cl asses/ confi g

Windows: c¢:\ Program Fi | es\ Novel | \ Teani ng\ apache-tontat\
webapps\ ssf\ WEB- | NF\ cl asses\ config

2 Make a backup copy of the ssf - ext . properti es file, which is located in the same directory
as the ssf. properti es file.

3 Openthessf.properti es file in a text editor.

4 Search for the following line:
accessControl . vi ewBi nderTi tl e. enabl ed=f al se

5 Openthe ssf-ext. properti es file in a text editor.

6 CopytheaccessControl.vi ewBi nderTitl e.enabl ed=f al se line from the
ssf. properti es file to the bottom of the ssf - ext. properti es file.

7 Changefal setotrue.

8 Save and close the ssf - ext. properti es file.

9 Close the ssf . properti es file without saving it.
10 Stop and restart Vibe.

Enabling Folder Administrators to Apply Definition
Settings to Sub-Folders and Entries

You can enable folder owners to apply entry definition types to folders or entries that have already
been created. This enables users to apply all definition settings of a parent folder to all subfolders.
Also, this enables users to change the definition settings to make all folder entries the same. For
example, a user might begin a discussion entry in a Discussion folder, then move the entry to the
Tasks folder after it is decided that something needs to be done in order to resolve the discussion.
After the discussion entry is added to the Tasks folder, the entry can be converted to a task entry. For
more information, see “Changing the View Definitions for Existing Folders and Folder Entries” in the
OpenText Vibe 4.0.8 Advanced User Guide.

1 Change to the following directory:
Linux: / opt/ novel | / t eam ng/ apache-tontat/
webapps/ ssf/WEB- | NF/ cl asses/ confi g
Windows: c¢:\ Program Fi | es\ Novel | \ Teani ng\ apache-tontat\

webapps\ ssf\ WEB- | NF\ cl asses\ config

2 Make a backup copy of the ssf - ext . properti es file, which is located in the same directory
as the ssf. properti es file.

3 Openthe ssf. properti es file in a text editor.

4 Search for the following line:

ssf. al | owFol der Defi ni ti onFi xups=fal se
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5 Openthe ssf-ext. properti es file in a text editor.

6 Copy the appropriate line from the ssf. properti es file to the bottom of the ssf -
ext. properti es file.

7 Changef al se totrue, so that the line now reads
ssf. al | owFol der Def i ni ti onFi xups=true.

8 Save and close the ssf - ext. properti es file.
9 Close the ssf . properti es file without saving it.
10 Stop and restart Vibe.

44 Planning and Controlling User Access to Workspaces and Folders



3 Setting Up Initial Workspaces

Proper organization of workspaces is critical to building an effective OpenText Vibe site.

+ “Understanding Workspaces” on page 45

+ “Setting Up Users’ Personal Workspaces” on page 46
+ “Managing Team Workspaces” on page 58

+ “Creating Global Workspaces” on page 61

+ “Using Workspace and Folder Templates” on page 62

+ “Importing Workspaces” on page 68

See also Chapter 22, “Managing Workspaces,” on page 235.

Understanding Workspaces

Your OpenText Vibe site consists of seven types of workspaces:

+ Personal workspaces: When you add users to your Vibe site, as described in “Adding Users to
Your Vibe Site” in “Single-server (Basic) Installation” in the OpenText Vibe 4.0.8 Installation
Guide, a personal workspace is established for each user. Users can customize their personal
workspaces, as described in “Setting Up Your Personal Workspace” in “Getting Started” in the

OpenText Vibe 4.0.8 User Guide.

+ Team workspaces: Vibe users, along with you as the Vibe administrator, can create team

workspaces for groups of people who work together regularly, as described in “Setting Up Your

Personal Workspace” in “Getting Started” in the OpenText Vibe 4.0.8 User Guide. You, as the
Vibe administrator, need to decide how you want to organize team workspaces before you let

users start creating them.

+ Team Workspace Root workspaces: Team Workspace Root workspaces are the optimal type of

workspace if you want to create a library of team workspaces as sub-workspaces.

For more information on Team Workspace Root workspaces, see “Creating and Managing a
Team Workspace Root Workspace” in the OpenText Vibe 4.0.8 Advanced User Guide.

+ Project Management Workspaces: Project Management workspaces include special

accessories that help leaders track the progress of task completion for potentially large projects.

Project Management workspaces focus on project completion.

For more information on Project Management workspaces, see “Creating and Managing a
Project Management Workspace” in the OpenText Vibe 4.0.8 Advanced User Guide.

+ Discussions workspaces: The Discussions workspace can be the home page for a set of

discussion forums. You can also use the Discussions workspace to house other types of folders.

Discussions workspaces can be particularly useful for site administrators who are responsible

for creating the overall structure of the Vibe site.

For more information on how you can use Discussions workspaces, see “Creating and Managing

a Discussions Workspace” in the OpenText Vibe 4.0.8 Advanced User Guide.
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+ Basic workspaces: Like other types of Vibe workspaces, basic workspaces in Vibe can be used
to organize information inside of existing workspaces, creating different levels of hierarchy
within a workspace.

For more information on basic workspaces, see “Creating and Managing a Basic Workspace” in
the OpenText Vibe 4.0.8 Advanced User Guide.

+ Global workspaces: Global workspaces contain information that is of interest to all Vibe users.
You, as the Vibe administrator, decide what type of information needs to be globally available
on your Vibe site.

For more information on Global workspaces, see “Creating Global Workspaces” on page 61.

Setting Up Users’ Personal Workspaces

+ “Understanding Personal Workspaces” on page 46

¢ “Customizing the Default Personal Workspace View” on page 47

+ “Enabling Users to Create Landing Pages on Personal Workspaces” on page 49
¢ “Customizing the Default User Profile View” on page 50

+ “Adding LDAP Elements to the User Profile View” on page 55

¢ “Customizing the Default Profile Quick View” on page 56

See also “Controlling User Access to Personal Workspaces” on page 26.

Understanding Personal Workspaces

When you create your OpenText Vibe site, a workspace named Personal Workspaces is automatically
created.

o

7 Home Warkspace
Global Warkspaces
[ Personal Workspaces
[» Team Workspaces

Initially, clicking the Workspace tree icon B and expanding Personal Workspaces lists only two
personal workspaces, even after you have created Vibe users, as described in “Adding Users to Your
Vibe Site” in “Single-server (Basic) Installation” in the OpenText Vibe 4.0.8 Installation Guide.

o

=7 Horne Warkspace
Global Warkspaces
= Personal Waorkspaces
[> admin (admin)
[» Guest (guest)
[ Team “Workspaces

Users’ workspaces appear in the Workspace tree after the users log in for the first time. To see a list
of all users in the Vibe system regardless of whether they have logged in, click Personal Workspaces.
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You can manually add Vibe users from this user list, as described in “Listing Vibe Users” on page 223.

You can also create new Vibe users by using the method described in “Creating a User” in “Single-
server (Basic) Installation” in the OpenText Vibe 4.0.8 Installation Guide.

As the Vibe administrator, you can access any user’s personal workspace by clicking it in the user list.
You cannot access a user’s personal workspace until the user has logged in to the Vibe site one time.
After the user has logged in, the user’s personal workspace is ready for the user to personalize.

For information on how users can customize and populate their personal workspaces, see “Setting
Up Your Personal Workspace” in the OpenText Vibe 4.0.8 User Guide.

Customizing the Default Personal Workspace View

As a Vibe administrator, you have the ability to customize the default view for all personal
workspaces in your Vibe site.

¢ “Customizing the Default View for Existing and Future Personal Workspaces” on page 47

¢ “Customizing the Default View for Future Personal Workspaces” on page 48

Customizing the Default View for Existing and Future Personal
Workspaces

1 Click your linked name in the upper right corner of the page, then click the Administration
Console icon %',
The Administration page is displayed.

2 Under System, click Form/View Designers.

Form and View Designers

Public Form and View definitions
MNew Copy... Reset Import Export

Bl @ Form/figw Designers
[ @ Entry Definitions
External User Workspac e View
Folder Views

Profile Listings

User Workspac & \WView

Workflow Processes

al
] @
] @
H- @
H- @ Profile \View
Ho- @
] @
] @

i OO NN s OO e OO o OO o IO

Workspace view

Vibe Resource Library

3 Expand User Workspace View, then click User Workspace.

Setting Up Initial Workspaces 47


https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_inst/vibe4_inst.pdf#bj9cpxq
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_inst/vibe4_inst.pdf#installbasic
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_inst/vibe4_inst.pdf#installbasic
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_inst/vibe4_inst.pdf#bookinfo
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_user/vibe4_user.pdf#bj293fa
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_user/vibe4_user.pdf#bj293fa
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_user/vibe4_user.pdf#bookinfo

Form and View Designers
Designer >> User Workspace (_userWerkspace) E=3

userWorkspace.

4 Add the form and view elements that you want your existing and future personal workspaces to
contain by default.

For information on the kinds of elements that you can add and how to add them, see “Adding
Elements to the Workspace Add/Modify Form” in the OpenText Vibe 4.0.8 Advanced User
Guide.

Customizing the Default View for Future Personal Workspaces

The procedure in this section affects only future personal workspaces (workspaces that have not yet
been created). For information on how to change the default view for existing workspaces as well as
future workspaces, see “Customizing the Default View for Existing and Future Personal Workspaces”
on page 47.
1 Login as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon * .
The Administration page is displayed.

3 Under Management, click Workspace and Folder Templates.
Workspace and Folder Templates

New « Reset Import Export

Standard Templates

Discussion - A Discussion folder is useful for creating a forum where users are likely to both create and reply to entries.

Blog - A blog folder is a forum where entire entries are displayed in reverse chronological order, based on when they were created.
Blogs typically provide information on a particular topic from an individual ar small group of authors. Optionally, the blog folder can be
configured so that a larger group can make comments on the entries posted by the original author.

Calendar - A calendar folder is a place to post group events or display other types of entries by date.

Guestbook - A guestbook folder is a simple place thatindividuals can "sign,” indicating that they have visited a user's Personal
‘Workspace. Visitors may also leave comments about the entries created in that personal workspace. Comments are displayed in
reverse chronological order. A picture ofthe individual signing the guestbook is displayed with the comment. The guestbook is useful
for expanding users' social netwaorks.

4 Click User workspace.
5 Modify the settings.

For information on the types of modifications that you can make to the User Workspace
template, see “Modifying Workspace and Folder Templates” on page 263.
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Enabling Users to Create Landing Pages on Personal Workspaces

By default, Vibe users cannot create a landing page on their personal workspaces. However, as a
Vibe administrator, you can enable landing page creation on personal workspaces.
1 Login as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon ' *'.
The Administration page is displayed.
3 Under System, click Form/View Designers.
The Form and View Designers page is displayed.
4 Click New > User Workspace View.
5 Specify the following information:
Caption: Specify a name for the new user workspace landing page view.

This is the name that appears in the Vibe interface that users see when they use this view. (For
example, User Landi ng Page.)

Name: Specify the internal name for the new user workspace landing page view.

The name that you enter in this field is not visible to users who use this view. (For example,
user | andi ng_page.)

Family: Ensure User Workspace is selected in the drop-down list.
6 Click OK.
The Designer page is displayed.

Form and View Designers

Designer >> User Landing Page (user_landing_page) [ Close ]

e "d

Modify the Properties of This Definition
Copy This Definition

Delete This Definition

Export This Definition

Retire This Definition

ED c=D

7 Click Workspace Add/Modify Form.
8 Click Add in the Workspace Add/Modify Form window.
9 Click Layout Options > Landing Page Layout.
10 Specify the appropriate information, then click OK.
11 Click User Workspace View.
12 Click Add in the User Workspace View window.
13 Click Standard Entry Elements > Landing Page Layout.
14 Specify the appropriate information, then click OK.

Vibe users can now enable this landing page on their personal workspaces, as described in
“Creating a Landing Page On Your Personal Workspace” in the OpenText Vibe 4.0.8 Advanced
User Guide.
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For information on how to add other elements and layout options to this user workspace landing
page view, see “Creating Custom Folder Views” in the OpenText Vibe 4.0.8 Advanced User Guide.

Customizing the Default User Profile View

The default user profile view is the view that appears in a user’s profile in the personal workspace.
When you customize the default user profile view, you modify the information that is displayed in all
user profiles.

The default user profile view was expanded in Vibe 3 to rival other professional knowledgebases
such as LinkedIn. Users can include more information to share with their colleagues, such as
education, qualifications, and competencies.

Profila

Julio Chavez workspees Follow

jchavez
Marketing Manager ABCOUT ME

Utat e

84606

All Intemal Uisers

aniREETOG
8015557091

M EELEGT

jchavez@yourc ompanyname.c om

Q- mot |

Marketing

Choasea File | Mo file chosen

If you are updating your Vibe site from a version prior to Vibe 3 to Vibe 3 or later and you modified
the user profile definition in your previous Vibe version, you do not see the new user profile when
you upgrade to Vibe 3 or later. In order to see the new user profile, you need to reset your profile
user definition. For information about how to reset your definitions, see “Resetting Your Definitions”
in “Upgrade” in the OpenText Vibe 4.0.8 Installation Guide.
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You can customize the default user profile view to include custom fields. If you want to customize
the user profile view, then you must also customize the user profile form. The view is what users see
when they view a user profile; the form is what users fill out when they edit their user profiles. You
must design both the form and view of the user profile in order for the elements to be displayed in
the user profile view.

+ “Designing the User Profile Form” on page 51

+ “Designing the User Profile View” on page 53

Designing the User Profile Form

The user profile form is what a users see when they edit their user profile in Vibe. For example:

User

User Id
jchavez

Password

Current Password

New Password

Confirm New Password

frren

First Name Middle Name Last Name
Julio Chavez
Picture

Choose File | Mo file chosen Edit File Mota...

Current Picture

“i julio-chavez.png
(Select the Files to be Deleted. Deleted Files Cannot be Restored.)

Time zone
(GMT -7:00) Mountain Standard Time (Denver) v

Locale
English (United States) [English (United States)] A

Personal Information

About Me
Edit View nsert Format Table
Font Family Font Sizes Faragraph B 7/ Y A A &

I

This text editor supports the following types of markup:
[[entry title]] creates a link to another entry in this folder
==Section name== and ===Subseciion name=== add seclions and subsections to your text.

Job Title
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To modify the information that is displayed in the user profile form that users fill out when they edit
a user profile:

1 Login as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration icon
1

The Administration page is displayed.

3 Under System, click Form/View Designers.
Form and View Designers

Public Form and View definitions

New - Copy... Reset Import Export

- @ Form/\View Designers
[l @ Entry Definitions
@ External User Workspace View
[l @ Folder Views
.. @ Profile Listings
a
a

Profile \igw

User Workspace \iew
Norkflow Processes

Workspace view

Vibe Resource Library

4 Expand Profile View, then click User.
5 Expand Profile Form Definition, then click Form.
6 Click Modify.

Farm and View Designers

Designer >> User (_user) =

Profile Standard Farm .
VP etile Foem with Nosing Inciided -

7 In the Form Name field, provide a name for the form.
8 In the Type field, select Profile Form with Nothing Included.

This lets you add elements anywhere inside the view. If you do not select this option, you can
add elements only after the last element in the default view.

9 Click OK.
10 Expand Profile Form Definition, then click Form.

11 Depending on how you want to modify the profile form, continue with one of the following
sections:

+ “Adding Elements to the Form” on page 53
+ “Modifying Elements within the Form” on page 53
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Adding Elements to the Form

1 Expand Profile Form Definition, then click Form.
2 In the Form dialog box, click Add to add an element or layout option to the view.

You can add any of the elements and layout options that are described in “Workspace Form
Elements” and “Understanding Layout Options” in the OpenText Vibe 4.0.8 Advanced User
Guide.

3 Continue with “Designing the User Profile View” on page 53 to create the user profile view that
users will see when they view a user profile.

Modifying Elements within the Form

1 Expand Profile Form Definition, then expand Form.
2 Click the element that you want to modify.

Depending on the element that you click, you can copy, delete, modify, or move the element.
You can also add sub-elements.

3 Inthe dialog box on the right side of the page, click the action that you want to perform, then
follow the on-screen instructions.

4 Continue with “Designing the User Profile View” on page 53 to create the user profile view that
users will see when they view a user profile.

Designing the User Profile View

After you have designed the user profile form, as described in“Designing the User Profile Form” on
page 51, you can modify the user profile view. The user profile view is what a user sees when the
user views a user profile in Vibe. For example:

Prafie

Julio Chavez workspacs Follow

jchavez

Marketing Manager

Choase File | No file chosen
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To modify the information that is displayed in the user profile view that users see when they view a
user profile:
1 Login as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon '+,
The Administration page is displayed.

3 Under System, click Form/View Designers.
Form and View Designers

Public Form and View definitions
New Copy... Resst Import Export

- @ Formi\iew Designers

- @ Entry Definitions

External User Workspace \View

Folder “iews

Profile Listings

User Workspace View

]

L]
a
a

- @ Profile View
a
@ ‘Workflow Processes
a

[

Workspate view

Wibe Resource Library

4 Expand Profile View, then click User.

The User Designer page is displayed.

Form and View Designers

Designer >> User [_user) [ Close ]

5 Expand Profile Standard View to view a list of all the elements and layout options that currently
exist in the view.

6 Depending on how you want to modify the profile view, continue with one of the following
sections:

+ “Adding Elements to the View” on page 55
+ “Modifying Elements within the View” on page 55
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Adding Elements to the View

1 Click Profile Standard View.

2 In the Profile Standard View dialog box, click Add to add an element or layout option to the
view.

You can add any of the elements and layout options that are described in “Workspace View
Elements” and “Understanding Layout Options” in the OpenText Vibe 4.0.8 Advanced User
Guide.

Modifying Elements within the View

1 Click the element that you want to modify.
You can copy, delete, modify, or move the element. You can also add sub-elements.

2 In the dialog box on the right side of the page, click the action that you want to perform, then
follow the on-screen instructions.

Adding LDAP Elements to the User Profile View

If there is information in your LDAP source that does not have a corresponding element in Vibe, and
you want that information to be displayed in the Vibe user profile view, you can create an element in
the profile view as described in “Customizing the Default User Profile View” on page 50. After you
have created the element, you can synchronize it with the corresponding information from LDAP, as
described in “Synchronizing Additional LDAP Attributes” on page 218.
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Customizing the Default Profile Quick View

The Profile Quick View is displayed when you click a user’s Presence icon & in Vibe.

b ]
User Properties

Julio Chavez

| am a dedicated marketing professional.

Profile...

Marketing Manager
jchavez@yourcompanyname.com
8015557091

Greenwich Mean Time

English (United States)

jchavez

Mar 19, 2015 12:03:56 AM GMT
4

Locally Provisioned

Quotas... Quota 100 MB (system default)

Sharing... Sharing rights: Internal+External+Public+File Link/Re-Share

Presence is displayed in the following locations in Vibe:

+ In afolder entry next to a user’s name
+ Ina user’s profile

+ In the home page of a user’s personal workspace
To modify the information that is displayed in the Profile Quick View:
1 Login as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon '+,

The Administration page is displayed.

3 Under System, click Form/View Designers.
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Form and View Designers

Public Form and View definitions

| Mew~ || Copy.. || Reset || Import || Export |

- @ Form/\iew Designers
; Entry Definitions
External User Workspace \View

Folder \iews

Profile Listings

Profile \iew

User Workspace View
‘Workflow Processes
Werkspace view

Wibe Resource Library

4 Expand Profile View, then click User.

The User Designer page is displayed.

Form and View Designers

Designer >> User (_user)

E||:| User (_user)

[] Profile Form Definition

[[] Profile \iew Definition

|:| Business Card (Deprecated)
[[] mini Business Card

[[] Profile Standard \iew

[[] Profile Quick View

User (_user)

Maodify the Properties of This Definition
Copy This Definition

Delete This Definition

Export This Definition

Retire This Definition

5 Expand Profile Quick View, expand Conditional by License, then click Quick View Elements.

6 Inthe Quick View Elements window, click Modify.
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Form and View Designers

Designer >> User (_user) [ Close ]

D Profile Form Definition . . N
\ » Profile Quick View Elements
D Profile “iew Definition

D Business Card (Deprecated) User Id ~
[[] Mini Business Card User Title
D Profile Standard \iew Crganization

FPhone
E‘D Profile Quick Wiew ‘Waork phone
E1-[7] Conditional by License Mobile phone
U _ Profile Elements to be Shown ' F?h
D Profile Quick View Elements (select multiple) Dm.e one
D Conditional by License Egisil:e Email

Text Messaging Email
Instant Message 1D
Skype Name

Twitter Name -

7 Press and hold the Ctrl key to select and deselect elements that you want to include in the
Profile Quick View or exclude from the Profile Quick View.

If the element you want to add is not available in the list, click Quick View Elements, then in the
Quick View Elements window, click Add. Select the element from the list, then click OK.

8 Click OK.

Managing Team Workspaces

+ “Understanding Team Workspaces” on page 58

+ “Creating a Team Workspace Root Workspace” on page 59
¢ “Creating a Team Workspace” on page 59

+ “Managing Share Rights for Team Workspaces” on page 59
+ “Deleting Top-Level Team Workspaces” on page 59

+ “Viewing Team Membership of Top-Level Team Workspaces” on page 60

See also Chapter 22, “Managing Workspaces,” on page 235.

Understanding Team Workspaces

When you create your OpenText Vibe site, a workspace named Team Workspaces is automatically
created.

o

= Home Workspace
Global Workspaces
[* Personal Workspaces
[ Team Waorkspaces
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As the Vibe administrator, you are responsible to determine how team workspaces should be
organized. Without guidance, Vibe users will inevitably create chaos under the Team Workspaces
directory.

You might want to organize team workspaces to parallel your business organization. If appropriate,
you might have a level for geographical areas. You would typically want a level for departmental
areas, and perhaps even for projects within departments. In addition, you must decide which Vibe
users need what kind of access to which teams. Creating groups, as described in “Creating Groups of
Users” on page 99, facilitates creating teams because you do not need to individually add users to
teams.

In the Team Workspaces directory that is automatically created when you install Vibe, you can create
other Team Workspace Root workspaces. A Team Workspace Root workspace is designed to contain
multiple team workspaces, so use this type of workspace if you want to create additional team
workspaces as sub-workspaces to this workspace.

Creating a Team Workspace Root Workspace

After you have planned the hierarchical organization of the team workspaces for your Vibe site, you
can start to implement it by creating Team Workspace Root workspaces, as described in “Creating
and Managing a Team Workspace Root Workspace” in the OpenText Vibe 4.0.8 Advanced User Guide.

Creating a Team Workspace

In the Team Workspaces directory, or in the Team Workspace Root workspaces that you have
created:

1 Create each team workspace, as described in “Creating a Team Workspace” in “Getting Started”
in the OpenText Vibe 4.0.8 User Guide.

2 Set the access controls on the team workspace, as described in “Controlling User Access to
Team Workspaces” on page 28.

Managing Share Rights for Team Workspaces

For information about how to manage share rights for team workspaces, see “Enabling Sharing for
Top-Level Team Workspaces” on page 137.

Deleting Top-Level Team Workspaces

You can easily delete top-level team workspaces:

1 Login to the Vibe site as the Vibe administrator.
1a Launch a web browser.

1b Specify one of the following URLs, depending on whether you are using a secure SSL
connection:

http:// Vi be_host nanme: 8080
https:// Vi be_host nane: 8443
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Replace Vi be_host nane with the hostname or fully qualified domain name of the Vibe
server that you have set up in DNS. If you configured the HTTP ports correctly during
installation, you do not need to include the port number in the Vibe URL.

Depending on how you have configured your Vibe system, you might not be required to
enter the port number in the URL. If you are using NetlQ Access Manager, the Vibe login
screen is not used.

2 Click the Browse icon % in the Action toolbar, then expand Home Workspace in the Workspace
tree.

o

Horme Workspace
Global Workspaces
Personal Workspaces
Team Warkspaces

The Home Workspace directory is the highest-level folder in the workspace tree, and might be
named something specific to your organization.

3 Click Team Workspaces.
The Teams page is displayed.

4 Select the top-level teams that you want to delete by selecting the checkbox next to the team
name.

Click Delete.

a un

(Conditional) To move the workspace to the trash, select Move to trash, then click OK.

Selecting this option removes the workspace from its current location without permanently
deleting it from the Vibe system. You can undelete the workspace as described in “Recovering a
Workspace from the Trash” in the OpenText Vibe 4.0.8 User Guide.

~

(Conditional) To permanently delete the workspace, select Delete.

IMPORTANT: Deleted items cannot be recovered.

8 Click OK.

Viewing Team Membership of Top-Level Team Workspaces

You can easily view the team membership of top-level team workspaces:

1 Log in to the Vibe site as the Vibe administrator.
1a Launch a web browser.

1b Specify one of the following URLs, depending on whether you are using a secure SSL
connection:

http:// Vi be_host nane: 8080
https:// Vi be_host nane: 8443
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Replace Vi be_host nane with the hostname or fully qualified domain name of the Vibe
server that you have set up in DNS. If you configured the HTTP ports correctly during
installation, you do not need to include the port number in the Vibe URL.

Depending on how you have configured your Vibe system, you might not be required to
enter the port number in the URL. If you are using NetlQ Access Manager, the Vibe login
screen is not used.

2 Click the Browse icon % in the Action toolbar, then expand Home Workspace in the Workspace
tree.

o

Horme Workspace
Global Workspaces
Personal Workspaces
Team Warkspaces

The Home Workspace directory is the highest-level folder in the workspace tree, and might be
named something specific to your organization.

3 Click Team Workspaces.
The Teams page is displayed.

Team members are listed in the Team Members column.

Creating Global Workspaces

A Global workspace is intended to present very high-level information that would be of interest to all
OpenText Vibe users. It might include a Frequently Asked Questions (FAQ) workspace to help new
Vibe users find their way around in the organization of team workspaces that you have set up. It
might provide a place to post company-wide news. All Global workspaces must be created under
Home Workspace > Global Workspaces on the Vibe site.

You might want to use geography to organize your company’s global information, and then use
departmental categories (Engineering, Human Resources, Marketing) to further organize the
information. Or, depending on your organization, you might want to reverse the order (function
followed by geography), or use some other organizational scheme.

We strongly recommend that you limit the creation of Global workspaces. First, organic team
creation is the more effective use model for this product. Second, we have worked with a significant
number of customers who duplicated complex organizational charts in the structure of Global
workspaces, and users found them to be confusing and unusable. Instead, populate the global area
with a minimal amount of information, and let users guide you in developing a useful structure and
content in this area.

Setting Up Initial Workspaces 61



62

Using Workspace and Folder Templates

Templates in OpenText Vibe are a powerful way to create consistent custom folders and workspaces.
If you are not satisfied with the way default workspaces and folders behave, you can either modify
the current templates, or create new templates.

+ “Understanding Templates” on page 62

+ “Understanding Default Workspace and Folder Templates” on page 63

¢ “Creating Workspace and Folder Templates” on page 65

Understanding Templates

Workspace and Folder templates are a powerful and efficient way to manage your Vibe site. They
enable you to customize the default features, default layout, and default access control settings of
the workspaces and folders throughout your Vibe site.

For example, the Team Workspaces template is used when any team workspace is created. By
default, the access control settings for the Team Workspaces template specify that only team
members are able to view the team workspace. However, if you want to run a more relaxed Vibe site
and allow all Vibe users to view any team workspace, you can simply modify the access control
settings for the Team Workspaces template.

For information about the specific access control roles that you can assign to various users in Vibe,
see “Understanding Access Control” in the OpenText Vibe 4.0.8 Advanced User Guide.

+ “Creating Templates or Modifying Existing Templates” on page 62

+ “Templates vs. Form and View Designers” on page 62

Creating Templates or Modifying Existing Templates

You can modify existing templates, like the Team Workspaces template, or you can create your own
custom templates. When you create a new template, all Vibe users have access to that template
when they create new workspaces or folders. When you modify existing templates, users who create
new workspaces and folders see only the modified template.

For more information on the default templates that are included in Vibe, see “Understanding Default
Workspace and Folder Templates” on page 63.

Templates vs. Form and View Designers

Vibe provides two methods of customizing the default features and default layout of workspaces
and folders in your Vibe site.

+ Templates: If users have not yet started using your Vibe site, use templates to create and
modify custom folder and workspace views. Typically, templates are easier to work with than
the Form and View Designers tool; however, changes that you make to templates affect only
those workspaces and folders that are created after the template was modified.
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+ Form and View Designers Tool: If users have already started using your Vibe site, you might
want to use the Form and View Designers tool to create and modify folder and workspace
views. When you modify folder and workspace views by using the Form and View Designers
tool, all modifications are displayed in existing workspaces and folders.

For information on using the Form and View Designers tool to create new workspace and folder
views, see “Creating Custom Workspace Views” and “Creating Custom Folder Views” in the
OpenText Vibe 4.0.8 Advanced User Guide.

Understanding Default Workspace and Folder Templates

By default, Vibe provides basic default templates for various types of workspaces and folders. If the
default workspace and folder templates are not sufficient for your needs, you can either modify
these templates, as described in “Modifying Workspace and Folder Templates” on page 263, or
create new templates, as described in “Creating Workspace and Folder Templates” on page 65.

The following sections outline the default workspace and folder templates that are provided in Vibe:

+ “Default Workspace Templates” on page 63

+ “Default Folder Templates” on page 64

Default Workspace Templates

+ Discussions Workspace
+ Project Management Workspace

+ Team Workspace

*

Workspace (Basic)
+ Landing Page
+ User Workspace

Following are some examples of default workspace templates:
+ “Team Workspace” on page 63

+ “User Workspace” on page 64

Team Workspace

& @ T MyWorkspace WhatsNew My Favorites My Teams Recent Places View Q Gt
-r:«:-.-'s Workspace 1 Team Workspaces View What's New @'

BY) Marketing @
Accessory Panel v
000D~

2. Marketing
Team Members
Julio Chavez B jchavez@vyourcompanyname.com

admin

Permalinks
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User Workspace

@ @ Ba My Workspace What's New My Favorites~ My Teams~ RecentPlaces~ View =

Anita Olivos  profile

et i L e T s coms R

Tasks

Task Mame Pricrity

Guestbook

Anita Olivos (aolivos) i Guestbook

Blog

Anita Olivos (aolivos) /f Blog

Photo Album

Anita Olivos (aolivos) # Photo Album

Due Date

Default Folder Templates

+ Discussion

+ Blog

+ Calendar

+ Guestbook
+ Files

+ Milestones
+ Micro-Blog
+ Mirrored Files
+ Photo Album
+ Surveys

+ Tasks

* Wiki

Status

Permalinks

Assigned to

Following are some examples of default folder templates:

+ “Discussion Folder” on page 65

+ “Calendar Folder” on page 65
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Accessory Panel = <

0000~

Location

0008~

Sign the guestbook

0008~
Mo results

000Q ~



Discussion Folder

® @ T MyWorkspace WhatsNew My Favorites ~ My Teams~ RecentPlaces = View = Q, Search G
Home Workspace Team Workspac e Paperless Initiative Article Market Target: . y
o orksp: m Workspaces perless Initiative Arti arl rgets View What's New E],
L.ga Discussion @
¥ New - Add Files... - @) Fitter List ° @
¥ < No. Title (] State Author Date Rating

Mo items in this folder.

Calendar Folder

@ @ e My Workspace What's New My Favorites My Teams » RecentPlaces = View = Q, Search Gt

Home Workspace Team Workspaces Paperless Initiative Article Market Targets View Whats New m

E Calendar @
New + Add Files... v || Show~ @ Fiter List o0

worksay~ | @@ March, 2015 EBEE ©

1 2 3 4 5 6 7

8 9 10 1 12 13 14

15 16 17 13 19 20 21

22 23 24 25 26 27 28

29 30 k]| 1 2 3 4

iCal, Permalinks, Email Addresses, RSS Links, and WebDAY URL

Creating Workspace and Folder Templates

OpenText Vibe lets you create templates based on existing workspaces and folders; or, you can
create new templates. You can also modify existing templates.

+ “Creating Templates Based on Existing Workspaces and Folders” on page 65
+ “Creating New Templates” on page 67

+ “Modifying Existing Templates” on page 68

Creating Templates Based on Existing Workspaces and Folders

You can create templates based on existing workspaces and folders only if the workspaces and
folders do not contain local definitions. For example, if a workspace contains a custom form that is
being used for the Discussion folder, you cannot create a template based on this workspace.

To find out if a workspace or folder contains local definitions, navigate to the workspace or folder,
then click Workspace > Form/View Designers (or Folder > Form/View Designers if you are in a folder).
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To create a template based on an existing workspace or folder:

1 Click your linked name in the upper right corner of the page, then click the Administration
Console icon * .
The Administration page is displayed.

2 Under Management, click Workspace and Folder Templates.

Workspace and Folder Templates
New v |[ Reset | Import |[ Export

Standard Templates

= Discussion - A Discussion folder is useful for creating a forum where users are likely to both create and reply to entries.

= Blog - Ablog folder is a forum where entire entries are displayed in reverse chronological order, based on when they were created
Blogs typically provide information on a particular topic fram an individual or small group of authors. Optionally, the blog folder can be
configured so thata larger group can make comments on the entries posted by the original author.

= Calendar - A calendar folder is a place o post group events or display other types of entries by date

= Guestbook - A guesthook folder is a simple place that individuals can “sign,” indicating that they have visited a user's Personal
Workspace. Visitors may also leave comments about the entries ereated in that personal workspace. Comments are displayed in
reverse chronological order. A picture of the individual signing the guestbook is displayed with the comment. The guestbook is useful
for expanding users' social networks.

3 Click New > Create a New Template from an Existing Workspace or Folder.
Add Templates

Choose a Folder
Eﬁi Home Workspace
® Global Workspaces

:ﬁ Perscnal Workspaces

) Team Workspaces

4 Use the Workspace tree to navigate to and select the folder or workspace whose template you
want to modify.

5 Click Add.

Workspace and Folder Templates
‘Workspace Template:Guest (guest)
Manage This Template - Manage This Target «

H-Guest (guest)

Guest (guest)

Accessories

Accessory Panel » <7

Guestbook o ° @ 0 —

Blog 000D~
Photo Album o ° @ 0 ~
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6 Modify the template as desired.

For information on how to modify a template after you have created it, see “Modifying
Workspace and Folder Templates” on page 263.

Creating New Templates

Vibe lets you design completely new custom workspace or folder templates.

1 Click your linked name in the upper right corner of the page, then click the Administration
Console icon *.
The Administration page is displayed.

2 Under Management, click Workspace and Folder Templates.

Workspace and Folder Templates
Mew v |[ Reset | Import |[ Export

Standard Templates

= Discussion - A Discussion folder is useful for creating a forum where users are likely to both create and reply to entries.

= Blog - Ablog folder is a farum where entire entries are displayed in reverse chronological arder, based on when they were created
Blogs typically provide information on a particular topic from an individual or small group of authors. Optionally, the blog folder can be
configurad so thata larger group can make comments on the entries posted by the original author.

= Calendar - A calendar folder is a place to post group events or display other types of entries by date.

» Guestbook - A guestbook folder is a simple place that individuals can “sign,” indicating that they have visited a user's Personal
Woarkspace. Visitors may also leave comments about the entries created in that personal workspace. Comments are displayed in
reverse chronological order. A picture of the individual signing the guestbook is displayad with the comment. The guestbook is useful
for expanding users' social netwaorks.

3 Click New > Folder or Workspace, depending on which type of template you want to create.

Add Templates
| Add ]

Add Templates

Name:
Template Title:

Description:
Edit -~ View~ Insert~ Format~ Table
Font Family Font Sizes Paragraph B /7 Y A A &

= = = = = s
= = = = = =

Copy Content into New Folders from this Folder:
Select a Content Source Folder

[ Add ] Cancel
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4 Fill in the following fields:
Name: Internal name of the template
For example, cust om t enpl at e.
Template Title: Visible name of the template.
For example, Cust om Tenpl at e.
Description: Description of the template.

5 Click Add > OK.
The template is created.

6 Set up the template as desired.

For information on how to set up a template after you have created it, see “Modifying
Workspace and Folder Templates” on page 263.

Modifying Existing Templates
Vibe lets you modify default templates or custom templates that you have created.

For information on how to modify existing templates, see “Modifying Workspace and Folder
Templates” on page 263.

Importing Workspaces

OpenText Vibe data can be transferred from one Vibe site to another by exporting it and then
importing it. If you have data to import into your Vibe site, see “Exporting/Importing Workspaces,
Folders, and Entries” on page 235.
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4 Setting Up Site-Wide Customizations

+ “Creating High-Level Landing Pages” on page 69

+ “Creating a Site-Wide Brand” on page 69

+ “Setting a Default Home Page” on page 71

+ “Re-Branding the Login Dialog Box” on page 75

+ “Enabling User ID Auto-Completion for the Login Dialog Box” on page 75

¢ “Customizing Vibe Styles” on page 76

¢ “Customizing Icons on Your Vibe Site” on page 77

+ “Configuring How Items Are Displayed in the What’s New Page” on page 79

+ “Sorting Names throughout the Vibe Site by Last Name” on page 82

+ “Managing How Group Names Are Displayed during Name Completion” on page 84
+ “Changing the Number of Recent Places That Are Displayed” on page 84

+ “Configuring File Associations for Edit in Place Applications” on page 85

+ “Understanding and Configuring Search Functionality” on page 87

+ “Understanding and Configuring Document Conversions with OpenText KeyView” on page 94

+ “Customizing the Simple URL Prefix” on page 96

Creating High-Level Landing Pages

Landing pages are a good way to put a custom face on your OpenText Vibe site while at the same
time providing easier access to your site’s most important information.

You might want to create landing pages at high-level workspaces, such as the Home Workspace
workspace, which is the default name of the top-level workspace.

For information on how to create a landing page, see “Creating and Managing Landing Pages” in the
OpenText Vibe 4.0.8 Advanced User Guide

Creating a Site-Wide Brand

You can brand your OpenText Vibe site to match your corporate brand. When you add a site-wide
brand to your Vibe site, the brand is displayed on every Vibe page for authenticated users.

If you have configured Guest access to the OpenText Vibe site, the site branding is not displayed for
the Guest user. For more information about enabling Guest access to the Vibe site, see “Setting Up
Guest Access for the Vibe Site” on page 107.
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By default, users can create their own brands for their individual workspaces, team workspaces, and
folders. When you create a site-wide brand, you can disable this functionality. For more information,
see Branding Rules in Step 4.
1 Signin to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon '+,
The Administration page is displayed.
3 In the System section, click Site Branding.
The Site Branding dialog box is displayed.
4 Specify the following information to create your desired brand:
Use Branding Image: Select this option if you want to use the drop-down list to select an

existing image, or click the Browse icon £ to browse to an image on your computer’s file
system.

Use Advanced Branding: Select this option, then click Edit Advanced if you want to create a
brand that includes advanced features in your brand, such as a YouTube video.

Background Image: Use the drop-down list to select an existing image, or click the Browse icon
E2 to browse to an image on your computer’s file system.

The background image is displayed behind your regular branding.

Stretch Image: Stretches the image to occupy the entire branding area.

If you stretch your background image, the image overrides any background color that you have
set.

Background Color: Adds a background color that occupies the entire branding area. To change
the background color, click the color name to the right of this field, select the new color, then
click OK.

If you added a background image and stretched the image, the background color is not
displayed.

Text Color: Changes the text color of the workspace name in the upper right corner of the
branding area. To change the text color, click the color name to the right of this field, select the
new color, then click OK.

Branding Rules: Select from the following:

+ Display site branding only: Displays only the site-wide branding on all Vibe pages. Vibe
users cannot create their own brands for workspaces and folders.
+ Display both site and workspace branding: Enables Vibe users to create their own brands

for workspaces and folders. Both the site-wide brand and the workspace or folder brand
are displayed.

+ Workspace branding overrides site branding: Enables Vibe users to create their own
brands for workspaces and folders. Workspace and folder brands override the site-wide
brand.

Sign In Dialog Image: This option lets you change the image that is displayed on the sign-in
dialog. For more information, see “Re-Branding the Login Dialog Box” on page 75.

Clear branding: Click this option to clear all your current branding selections.
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5 Click OK.
The Vibe site now displays the brand that you created.

For more information about creating brands in Vibe, see “Branding a Folder or Workspace” in the
OpenText Vibe 4.0.8 Advanced User Guide.

Setting a Default Home Page

By default, all users who log in to the OpenText Vibe site are first taken to the What’s New page.
However, you can change this default behavior to have all users taken to a different home page of
your choosing. This might be a corporate landing page that provides links to important places on the
Vibe site.

You can also configure Vibe so that users are taken to their personal workspaces when they first log
in to the Vibe site. For information on how to configure Vibe in this way, see “Restricting the What's
New Page from Being Displayed When Users First Log In” on page 81.

+ “Setting a Default Home Page for All Licensed Vibe Users” on page 71

+ “Setting a Default Home Page for Guest Users” on page 72

+ “Removing the Default Home Page” on page 74

Setting a Default Home Page for All Licensed Vibe Users

1 Log in to the Vibe site as the Vibe administrator.

2 Create a landing page on the workspace that you want to set as the new default home page for
all registered users.

For example, you might navigate to the Global Workspaces directory and create a landing page
on this workspace.

For information on how to create a landing page, see “Creating and Managing Landing Pages” in
the OpenText Vibe 4.0.8 Advanced User Guide.

3 Set the access control for the workspace to allow all users to be visitors to the workspace, if it is
not set already:
3a Click the Configure icon '@' next to the workspace title, then click Access Control.
3b In the Inherit role membership section, select no, then click Apply.
3c In the All Users row, ensure that the box is selected in the Visitor column.
3d Click Save Changes > Close.
4 Click your linked name in the upper right corner of the page, then click the Administration
Console icon * .

5 Under System, click Default Landing Pages.
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72

Default Landing Pages

Default Home Page

Select the Folder or Workspace to be the Default Home Page for this Zone

The current home page is: Victory Regional Medical Center
Delete

Default Guest Home Page

Select the Folder or Workspace to be the Default Home Page for Guest Users

The current guest home page is: Victory Regional Medical Center
Delete

Ok ] Ciose ]

6 In the Select the Folder or Workspace to be the Default Home Page for this Zone field, begin
typing the name of the folder or workspace that you want to set as the default home page for
all licensed users, then click it when it appears in the drop-down list.

7 Click OK.

If you want users to be automatically taken to this page before they log in, and if you want people
who do not have a user account to have access to the page, see “Making the Guest User Default
Home Page the Same as the Home Page for Licensed Users” on page 72.

Setting a Default Home Page for Guest Users

When you allow people who do not have a user account to access the Vibe site as a guest user, as
described in “Allowing Guest Access to Your Vibe Site” on page 106, then by default they are taken to
the Guest User workspace when they access Vibe. If you want guest users to be taken to a
workspace other than the Guest User workspace, you can set a default home page for guest users
that is different from the Guest User workspace. The default home page can be the same default
home page that you have set up for your licensed Vibe users, or it can be a different page.

+ “Making the Guest User Default Home Page the Same as the Home Page for Licensed Users” on
page 72
+ “Setting Up a Default Home Page Specifically for Guest Users” on page 73

Making the Guest User Default Home Page the Same as the Home Page
for Licensed Users

If you have already set up a default home page for your licensed Vibe users, as described in “Setting
a Default Home Page for All Licensed Vibe Users” on page 71, you can configure Vibe to allow guest
users who access the Vibe site to be taken to the same home page. If you configure Vibe in this way,
everyone who accesses the Vibe site is taken directly to the default home page without logging in.

1 Follow the steps in “Setting a Default Home Page for All Licensed Vibe Users” on page 71.

2 Navigate to the workspace that you want to set as the default home page for guest users, which
is the workspace that you already set as the default home page for licensed Vibe users in
“Setting a Default Home Page for All Licensed Vibe Users” on page 71.
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3 Click the Configure icon @ next to the workspace title, then click Access Control.
The Configure Access Control page is displayed.

4 Click Add User, start typing Guest inthe Add a User field, then click Guest when it appears in the
drop-down list.

This adds Guest as a new row in the Access Control table.

v* designates the access control setting of the parent workspace

Add User Names from Clipboard
Add a Role ¥

Visitor  Participant Team Member Workspace and Folder Administrator

Owner of Workspace or Folder v
Team Members o

Add a Group ¥ Group Title Group Name Visitor  Parficipant Team Member Workspace and Folder Administrator
AllUsers ! allusers ! v ] B ]

Add aUser = User Title User Id Visitor Participant Team Member Workspace and Folder Administrator
Guest quest = ] B ]

Add an Application Group = Application Group Title  Application Group Name  Visitor  Participant Team Member Workspace and Folder Administrator

—no application groups—

Add an Application ¥ Application Title Application Hame Visitor  Participant Team Member Workspace and Folder Administrator

—no applications—

5 In the Guest row, ensure that the box is selected in the Visitor column.

6 Click Save Changes > Close.

Setting Up a Default Home Page Specifically for Guest Users

You might want guest users who access the Vibe site to be taken to a workspace that is designated
specifically for guest users.
1 Login to the Vibe site as the Vibe administrator.

2 Create a landing page on the workspace that you want to set as the new default home page for
guest users.

For information on how to create a landing page, see “Creating and Managing Landing Pages” in
the OpenText Vibe 4.0.8 Advanced User Guide.

3 Set the access control for the workspace to allow guest users to be visitors to the workspace.

3a Click the Configure icon @ next to the workspace title, then click Access Control.
3b In the Inherit role membership section, select no, then click Apply.

3c Click Add User, start typing Quest in the Add a User field, then click Guest when it appears
in the drop-down list.

This adds Guest as a new row in the Access Control table.
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v designates the access control sefting of the parent workspace

Add User Names from Clipboard

Add a Role =

Visitor pant Team Member and Folder

Owner of Warkspace or Folder v
Team Wembers sl
Add a Group ¥ Group Title Group Hame. Visitor  Participant Team Member Workspace and Folder Administrator
All Users 1 allusers ! v O ] sl
Add a User ¥ User Title User Id Visitor  Participant Team Member Workspace and Folder Administrator
Guest guest = ] ] sl
Add an Application Group = p Title: pName  Visitor pant Team Member and Folder
—no application groups—
Add an Application = Application Title Application Name Visitor pant Team Member and Folder

—no applications—

3d In the Guest row, ensure that the box is selected in the Visitor column.
3e Click Save Changes > Close.
4 Click your linked name in the upper right corner of the page, then click the Administration
Console icon *.

5 Under System, click Default Landing Pages.
Default Landing Pages
Default Home Page

Select the Folder or Workspace to be the Default Home Page for this Zone

The current home page is: Victory Regional Medical Center
Delete

Default Guest Home Page

Select the Folder or Workspace to be the Default Home Page for Guest Users

The current guest home page is: Victory Regional Medical Center
Delete

[0k ] Cose ]

6 In the Select the Folder or Workspace to be the Default Home Page for Guest Users field, begin
typing the name of the folder or workspace that you want to set as the default home page for
guest users, then click it when it appears in the drop-down list.

7 Click OK.

Removing the Default Home Page

If you remove the default home page, users are taken to their individual workspaces when they first
access the Vibe site.

1 Click your linked name in the upper right corner of the page, then click the Administration
Console icon * .

2 Under System, click Default Landing Pages.
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3 Beneath The current home page is, select Delete.
Default Landing Pages

Default Home Page

Select the Folder or Workspace to be the Default Home Page for this Zone
The current home page is: Victory Regional Medical Center

#| Delete

Default Guest Home Page

Select the Folder or Workspace to be the Default Home Page for Guest Users

The current guest home page is: Victory Regional Medical Center
Delete

4 Click OK.

Re-Branding the Login Dialog Box

You can change the image that is used in the login dialog box that users see before they log in to the
OpenText Vibe site.

To re-brand the login dialog box to contain a custom image:

1 Signin to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon * .
The Administration page is displayed.

3 In the System section, click Site Branding.
The Site Branding dialog box is displayed.

4 In the Sign In Dialog Image section, use the drop-down list to select an existing image, or click
the Browse icon & to browse to an image on your computer’s file system.

5 Click OK.

Enabling User ID Auto-Completion for the Login Dialog Box

You can enable auto-completion for the User ID field in the login dialog box for your OpenText Vibe
site. When you enable auto-completion, each user in your Vibe site can start typing his or her user ID
and then select it from a drop-down list when it appears.

To enable auto-completion for your Vibe site:

1 Change to the following directory:
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Linux: / opt/ novel | / t eam ng/ apache-t ontat /
webapps/ ssf/WEB- | NF/ cl asses/ confi g

Windows: c¢:\ Program Fi | es\ Novel | \ Teani ng\ apache-tontat\
webapps\ ssf\ WEB- | NF\ cl asses\ config

2 Openthe ssf-ext. properti es file in a text editor.
3 Scroll to the bottom of the ssf - ext . properti es file, then add the following line:

enabl e. | ogi n. aut oconpl et e=t rue

4 Save and close the ssf - ext. properti es file.
5 Stop and restart Vibe.

Customizing Vibe Styles

You can customize colors, background images, and fonts throughout the Vibe interface. You might
want to do this if you want to change the default Vibe styles to better match your corporate theme.

You must have knowledge of CSS styling to successfully customize styles in your Vibe site. When
customizing styles, you need to either add a style, change an existing style, or delete a style.

For information about how to customize icons throughout the Vibe site, see “TID 7007607:
Modifying the Default Vibe Icons” in the Novell Support Knowledgebase (http://www.novell.com/
support).

IMPORTANT: As you customize styles on the Vibe server, back up the changes you are making and

record where you are making them. This is because when you upgrade your Vibe system to a new

version, any style changes that you have made could be overwritten. You might need your backups
and detailed notes in order to re-create your customized Vibe styles after an upgrade.

Most style customizations in Vibe are accomplished through the modification of CSS style sheets.
Some style settings in the Vibe interface are contained within JSP files.

The type of files that you need to modify in order to affect Vibe styles depends on the area of the
Vibe interface that you want to customize, as shown in the following table.

Table 4-1 CSS Style Locations

Area of Vibe Interface Type of File to Modify Location on the Vibe Server

Masthead CSS style sheet apache-t ontat/ webapps/ ssf/static/version/
j s/ gwt/gwtt eam ng/ GM Team ng. css

Navigation Panel CSS style sheet apache-t ontat / webapps/ ssf/static/version/
j s/ gwt/gwtteam ng/ Gm Teami ng. css

Action Toolbar CSS Style Sheet apache-t ontat / webapps/ ssf/static/version/
j s/ gwt/gwtteam ng/ Gm Teamn ng. css

Setting Up Site-Wide Customizations


http://www.novell.com/support

Area of Vibe Interface Type of File to Modify Location on the Vibe Server

User Profile Page CSS Style Sheet apache-t ontat / webapps/ ssf/static/ version/
js/gwt/gwtteam ng/ Gm Profile.css

Content Area JSP file apache-t ontat / webapps/ ssf/WEB- I NF/ j sp/
common

To customize styles for your Vibe system:
1 Find the CSS selector name for the area of the interface for which you want to customize the
style setting.

For example, suppose you want to modify the color or font of the Action toolbar for your Vibe
site. You use Firebug on Firefox to find the selector name for the Action toolbar, which is
mai nMenuCont rol .

2 Onthe Vibe server, navigate to the directory where the style that you want to modify is located.
See Table 4-1 for the file location on the Vibe server.

For example, Table 4-1 shows that the mai nMenuCont r ol selector for the Action toolbar is
located in the apache-t ontat / webapps/ ssf/static/version/js/gw/gwteam ng
directory, in the Gam Teani ng. css file.

3 Open the appropriate file in an editor, then search for the selector name.

For example, to customize the color of the Action toolbar, open the Gam Team ng. css file, then
search for mai nMenuContr ol .

If the appropriate file is a JSP file, you first need to locate the appropriate JSP file.
4 Make your desired style modifications in one of the following ways:

+ Inthe CSS style sheet, modify the value of the CSS definition that you want to customize,
add a new CSS definition, or delete an existing CSS definition.

+ Modify any images that are referenced in the CSS style sheet by navigating to the directory
where the images reside and making changes there.

If you modify an image that is not referenced in the CSS style sheet, your modifications are
not reflected in the Vibe interface.

5 Save your changes on the Vibe server, then clear the browser cache and refresh the browser to
see the changes.

Following are examples of color and font changes to the Action toolbar:

The Action toolbar has been changed to red, and the font has been changed.

Customizing Icons on Your Vibe Site

+ “Replacing Existing Icons” on page 78

+ “Adding New Icons” on page 78

Setting Up Site-Wide Customizations 77



Replacing Existing Icons

You can customize your OpenText Vibe site by replacing standard icons with icons of your own
choosing.

1 Change to the following directory:

Linux: / opt/ novel | / t eam ng/ apache-t ontat /
webapps/ ssf/WEB- | NF/ cl asses/ config

Windows: c¢:\Program Fi |l es\ Novel | \ Teani ng\ apache-t ontat\
webapps\ ssf\ WEB- | NF\ cl asses\ config

2 Openthessf. properti es filein a text editor.
3 Search fori cons in order to move to the section that defines the Vibe icons.

Four types of icons are listed:

i cons. wor kspace=

i cons. fol der=

i cons.profilelist=
i cons.entry=

These icons are stored in the following directory:
Linux: / opt/ novel | / t eam ng/ apache-t ontat/

webapps/ ssf/i mages/i cons
Windows: c¢:\ Program Fi | es\ Novel | \ Teani ng\ apache-tontat\

webapps\ ssf\i mages\i cons

4 Replace standard image files with your own image files with the same filenames.

This replaces the standard Vibe icons with your own customized icons. The next time you access
the Vibe site, your customized icons display instead of the standard Vibe icons.

Adding New Icons

You can add icons to your Vibe site for use in areas of the Vibe site that you are customizing on a
significant scale.

1 Change to the following directory:
Linux: / opt/novel | / t eam ng/ apache-t oncat/
webapps/ ssf/WEB- | NF/ cl asses/ confi g

Windows: c¢:\ Program Fi | es\ Novel | \ Teani ng\ apache-tontat\
webapps\ ssf\ WEB- | NF\ cl asses\ config

2 Openthessf. properti es file in a text editor.
3 Search fori cons in order to move to the section that defines the Vibe icons.

Four types of Vibe icons are listed:
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i cons. wor kspace=

i cons. fol der=

i cons. profileList=
icons.entry=

These Vibe icons are stored in the following directory:

Linux: / opt/ novel | / t eam ng/ apache-t ontat /
webapps/ ssf/i mages/i cons

Windows: c¢:\Program Fi |l es\ Novel | \ Teani ng\ apache-t ontat\
webapps\ ssf\i mages\i cons

4 Make a backup copy of the ssf - ext. properti es file, located in the same directory with the
ssf. properti es file.

5 Openthe ssf-ext. properti es filein a text editor.

6 Copy thel cons section from the ssf. properti es file to the bottom of the ssf -
ext. properti es file.

7 List additional image files for each icon type as needed.

8 Add the new image files to the appropriate subdirectory under the i cons directory where the
existing Vibe icons are stored.

9 Save and close the ssf - ext. properti es file.
10 Close the ssf. properti es file without saving it.

11 Stop and restart Vibe to make the new icons available on your Vibe site.

Configuring How Items Are Displayed in the What’s New
Page
OpenText Vibe users can view what’s new in Vibe by using the What’s New page. Users can quickly

see what’s new in their teams, favorite places, and more.

As the Vibe administrator, you can control various aspects of the What’s New page by modifying
Vibe configuration settings.

+ “Understanding the Configuration Settings You Can Customize for the What’s New Page” on
page 80

+ “Changing the Configuration Settings for the What’s New Page” on page 81
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Understanding the Configuration Settings You Can Customize for
the What’s New Page

The tables in the following sections describe configuration settings for the What’s New page that the
Vibe administrator can customize, the system default for the setting, and the line in the ssf -
ext . properti es file that controls the setting:

+ “Customizing the Number of Comments That Can Be Displayed for Each Entry on the What’s
New Page” on page 80

¢ “Customizing the Number of Words That Are Displayed for Each Item on the What’s New Page”
on page 80

¢ “Customizing How Often the What’s New Page Is Updated” on page 80

¢ “Customizing the Number of Items That Are Returned When the What’s New Page Is Updated”
on page 81

+ “Restricting the What’s New Page from Being Displayed When Users First Log In” on page 81

Customizing the Number of Comments That Can Be Displayed for Each
Entry on the What’s New Page

Configuration Setting System Default Line in the ssf-ext.properties File

The maximum number of 2 comments activity.streamactive.coments
comments that are displayed for
any given entry.

Customizing the Number of Words That Are Displayed for Each Item on
the What’s New Page

Configuration Setting System Default Line in the ssf-ext.properties File

The maximum number of words -1 (The first activity.streamdi spl ay. words
that are displayed for each item on several lines of
the What’s New page. an item are

displayed)

Customizing How Often the What’s New Page Is Updated

Configuration Setting System Line in the ssf-ext.properties File
Default

How often the What’s New pageis 60 seconds activity.streaminterval.refresh.client
updated to display the most
recent posts.
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NOTE: Adjusting this setting to update the What’s New page more frequently than the system
default (60 seconds) can result in inadequate system performance. However, depending on how
many users access your Vibe system and your current configuration, a more frequent or less
frequent update cycle might be appropriate.

Customizing the Number of Items That Are Returned When the What'’s
New Page Is Updated

Configuration Setting System Default Line in the ssf-ext.properties File

The maximum number of new or 1000 items activity.stream maxhits
modified items that are returned

by the search (includes entries and

comments).

Restricting the What’s New Page from Being Displayed When Users First
LogIn

Configuration Setting System Default Line in the ssf-ext.properties File

Defines whether the What’s New  true (The activity.streamon.login
page is displayed when users first ~ What’s New

log in to the Vibe site. If the value  page is

of this line is t r ue, the What's displayed when

New page is displayed. If the value users first log

is f al se, users see their personal in)

workspaces when they first log in

to the Vibe site.

IMPORTANT: If you have specified a default home page for you Vibe site, as described in “Setting a
Default Home Page” on page 71, users are taken to that home page when they first log in to the Vibe
site, regardless of this setting.

Changing the Configuration Settings for the What’s New Page

To change the configuration settings of the What’s New page:

1 Change to the following directory:

Linux: / opt/ novel | / t eam ng/ apache-t ontat/

webapps/ ssf/WEB- | NF/ cl asses/ confi g
Windows: c¢:\ Program Fi | es\ Novel | \ Teani ng\ apache-tontat\

webapps\ ssf\ WEB- | NF\ cl asses\ config

2 Make a backup copy of the ssf - ext . properti es file, which is located in the same directory
as the ssf. properti es file.
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3 Openthessf. properti es file in a text editor.

4 Search for the appropriate line that represents the configuration setting that you want to
customize for the What’s New page.

See the table in “Understanding the Configuration Settings You Can Customize for the What’s
New Page” on page 80 to find the line in the ssf - ext . properti es file that controls the
setting that you want to customize.

For example, if you want to change the number of words that are displayed for each item on the
What’s New page, search for the line acti vi ty. st ream di spl ay. wor ds=- 1, then change
the value to the number of words that you want to be displayed. For example,
activity.stream displ ay. wor ds=25.

5 Openthe ssf-ext. properti es file in a text editor.

6 Copy the appropriate line from the ssf . properti es file to the bottom of the ssf -
ext. properti es file.

7 Change the default value of the line to the value that you want.
8 Save and close the ssf - ext. properti es file.
9 Stop and restart Vibe.

Sorting Names throughout the Vibe Site by Last Name

By default, where lists of users are displayed in Vibe, names are sorted by first name (for example,
Anne Marie Hall), rather than by last name (for example, Hall, Anne Marie).

A list of users in your Vibe system are displayed in the following locations:

+ Navigation Panel in the Personal Workspaces workspace.

You access the Personal Workspaces workspace by clicking the Workspace tree icon &,
expanding Home Workspace, then clicking Personal Workspaces.
+ Workspace tree in the Action toolbar.
You access the Workspace tree by clicking the Workspace tree icon & in the Action toolbar.
+ Workspace tree in other areas throughout the Vibe site.

The workspace tree appears in other locations throughout Vibe, such as in the Search Index.

The following figure shows names in the Navigation panel sorted by first name.
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To configure the Vibe site to sort names by last name:

1

Change to the following directory:
Linux: /opt/ novel | / t eam ng/ apache-t ontat /
webapps/ ssf/WEB- | NF/ cl asses/ config

Windows: c¢:\Program Fi | es\ Novel | \ Teani ng\ apache-t ontat\
webapps\ ssf\ WEB- | NF\ cl asses\config

Make a backup copy of the ssf - ext . properti es file, which is located in the same directory

asthe ssf. properti es file.

3 Openthessf. properti es filein a text editor.

Search for the following line:

wsTree.titl eFormt=0

5 Openthe ssf-ext. properti es filein a text editor.

Copy the appropriate line from the ssf . properti es file to the bottom of the ssf -
ext. properti es file.

7 Change 0 to 1, so that the line now reads wsTree. ti t| eFor mat =1.

10

Save and close the ssf - ext . properti es file.
Close the ssf. properti es file without saving it.
Stop and restart Vibe.

Setting Up Site-Wide Customizations

83



84

Managing How Group Names Are Displayed during Name
Completion

Certain fields throughout the Vibe site employ name completion (or Type-to-Find) functionality. For
example, when you share an item in Vibe and you begin typing the name of a user or group in the
Share with field, names of users or groups that match what you have typed so far appear in a drop-
down list.

In the Type-to-Find drop-down list, Vibe includes the group name or group title, as well as secondary
information about the group (either the group description or the Fully Qualified DN). This secondary
information helps distinguish between multiple groups that have the same name.

Vibe allows you to determine the way group names are displayed in this Type-to-Find drop-down
list.
1 Login to the Vibe site as the Vibe administrator.
1a Launch a web browser.

1b Specify one of the following URLs, depending on whether you are using a secure SSL
connection:

http:// Vi be_host nanme: 8080

https:// Vi be_host nane: 8443

Replace Vibe_hostname with the host name or fully qualified domain name of the Vibe
server that you have set up in DNS.

Depending on how you have configured your Vibe system, you might not be required to
enter the port number in the URL. If you are using NetlQ Access Manager, the Vibe login
screen is not used.

2 Click the admin link in the upper-right corner of the page, then click the Administration Console
icon.

3 Under System, click Name Completion Settings.
The following options are available:

Primary display text: Select Name or Title. Name represents the name of the group as it
appears in Vibe. Title represents the title as it appears in the LDAP directory.

Secondary display text: Select Description or Fully Qualified DN. Description represents the
description of the group as it appears in Vibe. Fully Qualified DN represents the Fully Qualified
Domain Name as it appears in the LDAP directory.

4 Click OK.

Changing the Number of Recent Places That Are Displayed

You can modify how many recent places are displayed in the Recent Places menu in the Action
toolbar. By default, a user’s 20 most recently visited places are displayed. (For more information, see
“Viewing and Revisiting Recent Places”in the OpenText Vibe 4.0.8 User Guide.)

To change the number of recently visited places that are displayed for each user:

1 Change to the following directory:
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Linux: / opt/ novel | / t eam ng/ apache-t ontat /
webapps/ ssf/WEB- | NF/ cl asses/ confi g

Windows: c¢:\ Program Fi | es\ Novel | \ Teani ng\ apache-tontat\
webapps\ ssf\ WEB- | NF\ cl asses\ config

2 Make a backup copy of the ssf - ext . properti es file, which is located in the same directory
as the ssf. properti es file.

3 Openthessf.properti es file in a text editor.

4 Search for the following line:
recent - pl aces- dept h=20

5 Openthe ssf-ext. properti es file in a text editor.

6 Copytherecent-pl aces- dept h=20 line from the ssf . properti es file to the bottom of
the ssf - ext . properti es file.

7 Change 20 to the number that represents how many recent entries you want to be displayed for
each user. For example, if you want only 10 recently visited entries to be displayed, the line
would now read r ecent - pl aces- dept h=10.

8 Save and close the ssf - ext. properti es file.
9 Close the ssf. properti es file without saving it.
10 Stop and restart Vibe.

Configuring File Associations for Edit in Place Applications

When using Edit in Place functionality in OpenText Vibe, you can configure Vibe to open specific
types of files with non-default applications. You can also configure Vibe to support file extensions
that are not supported by default.

For more information about Edit in Place functionality, see “Editing Files Accessed through a Web
Browser” in the OpenText Vibe 4.0.8 User Guide.

+ “Changing Global File Associations for Edit in Place Applications” on page 85
+ “Configuring Vibe to Support Additional File Types for Edit in Place Applications” on page 86

Changing Global File Associations for Edit in Place Applications

When calling applications with the Edit in Place feature, OpenText Vibe uses the file associations
defined in the ssf . properti es file, unless there is no association, in which case it defaults to the
application defined on each user’s system.

To reconfigure Vibe to use the preferred file association for all users on the Vibe site:

1 Change to the following directory:
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Linux: / opt/ novel | / t eam ng/ apache-t ontat /
webapps/ ssf/WEB- | NF/ cl asses/ confi g

Windows: c¢:\ Program Fi | es\ Novel | \ Teani ng\ apache-tontat\
webapps\ ssf\ WEB- | NF\ cl asses\ config

Make a backup copy of the ssf - ext . properti es file, which is located in the same directory
as the ssf. properti es file.

3 Openthessf.properti es file in a text editor.

(9]

O 00 N O

10

11

12
13
14

SearchforEdit in pl ace to move to the block of lines that control the Edit in Place feature.

Review the subsequent comment lines to become more familiar with how the Edit in Place
feature works.

Scroll down to locate the lines for the file associations that you want to change.

Copy the lines to the clipboard of your text editor.

Open the ssf - ext . properti es file.

Scroll to the end of the ssf - ext . properti es file, then paste the line you copied in Step 7.
Edit the file association as needed.

Use double backslashes for Mac or Linux systems when you need to include a space in the path,
as shown in the above example.

(Optional) Copy additional lines from the ssf . properti es file to the ssf - ext . properties
file as needed.

Save and close the ssf - ext. properti es file.
Close the ssf . properti es file without saving it.

Stop and restart Vibe to put the modified file associations into affect for your Vibe site.

Configuring Vibe to Support Additional File Types for Edit in
Place Applications

You can configure Vibe to support other document editors to the list of documents that Vibe can
edit using Edit in Place.

1

Change to the following directory:
Linux: / opt/novel | / t eam ng/ apache-t ontat/

webapps/ ssf/WEB- | NF/ cl asses/ confi g
Windows: c¢:\Program Fil es\ Novel | \ Team ng\ apache-t ontat\

webapps\ ssf\ WEB- | NF\ cl asses\ config

Make a backup copy of the ssf - ext . properti es file, which is located in the same directory
as the ssf. properti es file.

3 Openthessf.properti es file in a text editor.

SearchforEdit in pl ace to move to the block of lines that control the Edit in Place feature.
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5 Review the subsequent comment lines to become more familiar with how the Edit in Place
feature works.

6 Copy the following line to the clipboard of your text editor:
edit.in.place.file.applet.extensions=

7 Openthe ssf-ext. propertiesfile.
8 Scroll to the end of the ssf - ext . properti es file, then paste the line you copied in Step 6.
9 Add the file extension to the comma-delimited list of file extensions.

10 (Optional) Copy additional lines from the ssf. properti es file to the ssf - ext . properties
file as needed.

11 Save and close the ssf - ext. properti es file.
12 Close the ssf. properti es file without saving it.
13 Stop and restart Vibe.

Understanding and Configuring Search Functionality

OpenText Vibe contains various features that control how items are indexed and how searches are
executed on the Vibe site. As the Vibe administrator, you can configure the settings for these
features. The default configurations are optimal for most Vibe sites.

These features are supported only with Vibe folder entries that contain English or other Western
European languages. (For a list of supported languages, see “Supported Languages for Indexing and
Searching for the Root Form of Words” on page 93.)

+ “Removing Frequently Used Words That Have No Inherent Meaning” on page 87

+ “Searching for Various Forms of the Same Word” on page 88

+ “Searching for Words That Contain Accents” on page 88

+ “Increasing the Number of Words That Are Indexed for Each Document” on page 88

+ “Modifying Configuration Settings” on page 88

+ “Supported Languages for Indexing and Searching for the Root Form of Words” on page 93

Removing Frequently Used Words That Have No Inherent
Meaning

Vibe removes frequently used words that have no inherent meaning when items are indexed and
when users perform a search. Examples of such words are a, an, t he, i n, on, t he, and so forth.

This includes when users perform a search with quotation marks. For example, "sel | the
product s" would return all of the following: sel | their products,sell wth products,
sel|l the products, and so forth. However, it would not return sel | products.

You can customize the words that Vibe considers to have no inherent meaning. For more
information, see “lucene.indexing.stopwords.file.path” on page 90.

This functionality is enabled by default. For information on how to modify the default settings, see
“Modifying Configuration Settings” on page 88.
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Searching for Various Forms of the Same Word

When Vibe indexes a word, it indexes the root form of the word. Likewise, when users perform a
search for a word, Vibe searches for the root form of the word and returns all matches. For example,
performing a search on the word r esear ch returns all forms of the word, including r esear chi ng,
resear ched, and r esear ches. Likewise, searching for the word r esear chi ng returns results for
resear ch, r esear ches, and so forth.

This functionality is enabled by default. For information on how to modify the default settings, see
“Modifying Configuration Settings” on page 88.

Searching for Words That Contain Accents

When Vibe indexes a word, it indexes the word without accents, regardless of whether the word
originally contains accents. Likewise, when users perform a search for a word, Vibe searches for the
word without accents, regardless of whether the user uses accents during the search. This means
that when a user performs a search on the word cl i ché, Vibe returns results for the word cl i ché
and cl i che. Vibe also returns both forms of the word if the user performs a search on the word
cliche.

This functionality is enabled by default. For information on how to modify the default settings, see
“Modifying Configuration Settings” on page 88.

Increasing the Number of Words That Are Indexed for Each
Document

Vibe indexes all the words (and their variations) in documents that are uploaded to the Vibe site. In
most cases, the default settings are sufficient to index documents that contain tens of pages.

If you have very large documents (hundreds or thousands of pages per document) that are stored on
your Vibe site, you might encounter problems with parts of the document not being returned in
search results. This can be due to the fact that the document is not being indexed in its entirety,
because the document is too large. In this case, you might want to increase the number of words
that are indexed for each document. Be aware that increasing the number of words that are indexed
uses more system resources (RAM and disk space).

You can increase the number of words that are indexed for each document that is added to the Vibe
site. For information on how to do this, see “Modifying Configuration Settings” on page 88.

Modifying Configuration Settings

The location of the configuration file on the Vibe server depends on whether you have a single
Lucene Index Server that is located on the same server as Vibe, or if your Lucene Index Server is
located on a remote server or you have multiple Lucene Index Servers.

For more information about the various ways that you can set up the Lucene Index Server, see
“Changing Your Lucene Index Server Configuration” in the OpenText Vibe 4.0.8 Installation Guide.

To modify configuration settings for the Search feature:

1 Change to the following directory:
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Linux: / opt/ novel | / t eam ng/ apache-t ontat /
webapps/ ssf/WEB- | NF/ cl asses/ config

Windows: c¢:\ Program Fi | es\ Novel | \ Teani ng\ apache-tontat\
webapps\ ssf\ WEB- | NF\ cl asses\ config

2 Openthessf. properti es file in a text editor if you have a single Lucene Index Server that is
located on the same server as Vibe.

or

Open the |l ucene-server. properti es file in a text editor if your Lucene Index Server is
located on a remote server or you have multiple Lucene Index Servers.

3 Scroll down to locate the line for the search functionality that you want to change.

For information on each configuration setting that you can modify for searching on the Vibe
site, see “Configuration Settings for Search Features” on page 89.

4 Copy that line to the clipboard of your text editor.

5 Depending on which file you are modifying (as described in Step 2), make a backup copy of the
corresponding ssf - ext . properti es file orl ucene- server-ext. properti es file, which
are located in the same directory as the ssf. properti es file and the | ucene-
server. propertiesfile.

6 Open either the ssf-ext. properti es file or thel ucene- server-ext. properti es file.

7 Scroll to the end of the ssf - ext . properti es file or the | ucene- server -
ext. properti es file, then paste the line you copied.

8 Edit the setting for the appropriate search functionality as needed.

9 Save and close the ssf - ext . properti es file or thel ucene- server-ext. properties
file.

10 Close the ssf. properti es file or thel ucene- server. properti es without saving.
11 Stop and restart Vibe to put the modified search customizations into affect for your Vibe site.

12 Re-index the Vibe site, as described in “Rebuilding the Lucene Index” on page 285.

Configuration Settings for Search Features

The following tables show the configuration settings that you can modify for the various search
features. Each configuration setting has a | ucene. i ndexi ng setting and a corresponding
| ucene. sear chi ng setting. Both setting must be configured in order to produce the desired
functionality.

+ Table 4-2, “Removing Frequently Used Words,” on page 90

+ Table 4-3, “Searching for Various Forms of the Same Word,” on page 91

+ Table 4-4, “Searching for Words That Contain Accents,” on page 92

+ Table 4-5, “Increasing the Number of Words That Are Indexed for Each Document,” on page 93
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Table 4-2 Removing Frequently Used Words

Setting

Function

| ucene. i ndexi ng. st opwor ds. enabl e

| ucene. i ndexi ng. stopwords. fil e. charset

| ucene. i ndexi ng. stopwords. file.path

| ucene. sear chi ng. st opwor ds. enabl e

| ucene. sear chi ng. stopwords. fil e. charset

Enables or disables the functionality that removes
frequently used words that have no inherent
meaning when items are added to the index. For
more information, see “Removing Frequently Used
Words That Have No Inherent Meaning” on

page 87.

By default, the value is t r ue (enabled).

If you have provided your own file that contains
frequently used words that you want to be ignored
(as described in
“lucene.indexing.stopwords.file.path” on page 90),
you can change the default character encoding of
the file that contains the new words.

By default, the value is UTF- 8.

Lets you point to a file that you create that contains
your own list of words that you want Vibe to ignore
when items are added to the index. This file should
be in a directory where it does not get overwritten
or removed during an upgrade. If you are running
Vibe in a clustered environment, this should be a
directory that is accessible to and shared by all Vibe
nodes.

You must specify the full path to the file.
Each line of the file should contain only one word.
All words in the file must be in lowercase.

By default, there is no file path specified, and Vibe
defaults to a list of common words that are not
normally useful when performing a search, such as
a, in, this, and so forth.

Enables or disables the functionality that removes
frequently used words that have no inherent
meaning when users perform a search. For more
information, see “Removing Frequently Used Words
That Have No Inherent Meaning” on page 87.

By default, the value is t r ue (enabled).

If you have provided your own file that contains
frequently used words that you want to be ignored
(as described in
“lucene.indexing.stopwords.file.path” on page 90),
you can change the default character encoding of
the file that contains the new words.

By default, the value is UTF- 8.
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Setting

Function

| ucene. searchi ng. stopwords. file.path

Lets you point to a file that you create that contains
your own list of words that you want Vibe to ignore
when performing a search. This file should be in a
directory where it does not get overwritten or
removed during an upgrade. If you are running Vibe
in a clustered environment, this should be a
directory that is accessible to and shared by all Vibe
nodes.

You must specify the full path to the file.
Each line of the file should contain only one word.
All words in the file must be in lowercase.

By default, there is no file path specified, and Vibe
defaults to a list of common words that are not
normally useful when performing a search, such as
a, in, this, and so forth.

If you leave all three search features enabled
(removing frequently used words, searching for
various forms of the same word, and searching for
words that contain accents), and you want to
specify words to ignore that contain accents, you
must specify both forms of the word (with and
without the accents).

Table 4-3 Searching for Various Forms of the Same Word

Setting

Function

| ucene. i ndexi ng. st emmi ng. enabl e

| ucene. i ndexi ng. st enmi ng. st enmer . nanes

Enables or disables the functionality that indexes
various forms of the same word. For more
information, see “Searching for Various Forms of
the Same Word” on page 88.

By default, the value is t r ue (enabled).

Lets you specify the language that you want Vibe to
use when indexing the root form of words. For
more information, see “Searching for Various Forms
of the Same Word” on page 88.

By default, the language is Engl i sh.

For information about which languages are
available, see “Supported Languages for Indexing
and Searching for the Root Form of Words” on
page 93.
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Setting

Function

| ucene. sear chi ng. st emmmi ng. enabl e

| ucene. sear chi ng. st enm ng. st ermer . nanes

Enables or disables the functionality that lets users
search for various forms of the same word. For
more information, see “Searching for Various Forms
of the Same Word” on page 88.

By default, the value ist r ue (enabled).

Lets you specify the language that you want Vibe to
use when searching for the root form of words. For
more information, see “Searching for Various Forms
of the Same Word” on page 88.

By default, the language is Engl i sh.

For information about which languages are
available, see “Supported Languages for Indexing
and Searching for the Root Form of Words” on
page 93.

Table 4-4 Searching for Words That Contain Accents

Setting

Function

| ucene. i ndexi ng. asci i f ol di ng. enabl e

| ucene. searchi ng. asci i f ol di ng. enabl e

Enables or disables the functionality that indexes
words with accents as well as the same word
without the accents. For more information, see
“Searching for Words That Contain Accents” on
page 88.

By default, the value is t r ue (enabled).

Enables or disables the functionality that lets users
search for words with accents as well as the same
word without the accents. For more information,
see “Searching for Words That Contain Accents” on
page 88.

By default, the value is t r ue (enabled).
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Table 4-5 Increasing the Number of Words That Are Indexed for Each Document

Setting

Function

| ucene. max. fiel dl ength

doc. conver si on. si ze. t hreshol d

doc. max. text.extraction. si ze.threshol d

Designates the maximum number of terms that are
indexed for each document that is uploaded to
Vibe. Be aware that the number of terms per
document can be much higher than the number of
words in the document (because stemming and
ascii folding capabilities enable various forms of
each word in the document to be indexed). Only
terms that are indexed appear in search results. For
more information, see “Increasing the Number of
Words That Are Indexed for Each Document” on
page 88.

By default, the value is 100000.

Depending on your specific environment and need,
you might need to modify this setting in addition to
thel ucene. max. fi el dl engt h setting.

Designates the size of the document that can be
indexed in the Vibe site. For more information, see
“Increasing the Number of Words That Are Indexed
for Each Document” on page 88.

By default, the value is 31457280.

Depending on your specific environment and need,
you might need to modify this setting in addition to
thel ucene. max. fi el dl engt h setting.

Designates the maximum size of a document that
can be indexed in the Vibe site after the document
has undergone file conversion. For more
information, see “Increasing the Number of Words
That Are Indexed for Each Document” on page 88.

By default, the value is 1048576 (about 1MB).

Supported Languages for Indexing and Searching for the Root

Form of Words

By default, when Vibe indexes a word, it indexes the root form of the word. Likewise, when users
perform a search for a word, Vibe searches for the root form of the word and returns all matches.
(For more information, see “Searching for Various Forms of the Same Word” on page 88.)

The default language of the Vibe site is irrelevant in regards to indexing and searching for the root
form of words; Vibe detects the language for each individual entry when it performs the indexing

and search.

You can configure Vibe to use any of the following languages when indexing and searching for the

root form of words (the default is English):

+ Danish
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¢ Dutch
+ English
¢ Finnish
+ French
+ German

+ German2 (This is a modified version of German that handles umlaut characters differently.
Appends an e after vowels that would otherwise have an umlaut. For example, & becomes ae, é
becomes o€, and U becomes ue.)

¢ Hungarian
+ [talian
+ Norwegian

+ Porter (This is for the English language; this option simply indexes and searches in a different
way.)

+ Portuguese
¢+ Romanian
+ Russian

+ Spanish

+ Swedish

+ Turkish

Understanding and Configuring Document Conversions
with OpenText KeyView

OpenText Vibe uses the OpenText converter to perform document conversions. Documents undergo
two types of conversions:

+ Word conversion when they are first added to the Vibe site

+ HTML conversion when they are viewed as HTML from the Vibe site
If the OpenText KeyView converter is crashing with certain file types during the word conversion
process, you can exclude the problematic file types from being indexed to the Vibe site.

+ “Configuring Which File Formats Can Be Viewed as HTML” on page 94

+ “Excluding File Types from Being Indexed” on page 95

Configuring Which File Formats Can Be Viewed as HTML

Many file formats in OpenText Vibe can be viewed as HTML by default, as described in “Viewing the
File in HTML Format” in the OpenText Vibe 4.0.8 User Guide. File formats that can be viewed as
HTML by default are:. 123, . bnp, . doc, . docx, . dot m . drw, . dxf,. htm.htm,. | wp,. odp,
.ods,.odt,.ppt,.pptx,.prz,.rtf,.shw,.sxw,.tif,.txt,.vsd,.wpd,.xls,.xlsx,.sxi
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Some file formats, such as . pdf files, cannot be viewed as HTML by default. This is because the
quality of these files is lessened when viewed as HTML. However, if you choose, you can enable non-
default file formats, such as . pdf files, to be viewed as HTML.

Not all file formats can be enabled to be viewed as HTML in Vibe, but many can be. If you are unsure
whether Vibe supports a particular file format to be viewed as HTML, try it and see.

You can enable additional file formats to be viewed as HTML during the Vibe installation, as
described in “Installing and Setting Up a Basic Vibe Site” in the OpenText Vibe 4.0.8 Installation
Guide.

Excluding File Types from Being Indexed

If the OpenText KeyView converter is crashing with certain file types during indexing, you can restrict
the problematic file types from being indexed.

+ “Excluding File Types from Being Indexed to the Vibe Site” on page 95
+ “Excluding File Types from Being Displayed in HTML” on page 96

Excluding File Types from Being Indexed to the Vibe Site

IMPORTANT: Performing the following procedure causes the file types that you specify to be
excluded from searches performed in Vibe.

1 Change to the following directory:

Linux: / opt/ novel | / t eam ng/ apache-t ontat/
webapps/ ssf/WEB- | NF/ cl asses/ confi g

Windows: c:\Program Fil es\ Novel | \ Teanm ng\ apache-t ontat\
webapps\ ssf\ WEB- | NF\ cl asses\ config

2 Openthe ssf. properti es file in a text editor.

3 Search for the following line:
excl ude. from keyvi ew. i ndexi ng. ext ensi ons=
exclude.fromlibreoffice.indexing.extensions=

4 Make a backup copy of the ssf - ext . properti es file, which is located in the same directory
asthe ssf. properti es file.
5 Openthe ssf-ext. properti es file in a text editor.

6 Copy the excl ude. from keyvi ew. i ndexi ng. ext ensi ons= line from the
ssf. properti es file to the bottom of the ssf - ext. properti es file.

7 Add the file types that are causing LibreOffice to crash to be the value of this property. For
example, excl ude. f rom keyvi ew. i ndexi ng. ext ensi ons=. ppt x, . odf

8 Save and close the ssf - ext. properti es file.
9 Close the ssf. properti es file without saving it.
10 Stop and restart Vibe.
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Excluding File Types from Being Displayed in HTML

You can display files in HTML view as described in “Viewing the File in HTML Format” in “Working
with Folder Entries” in the OpenText Vibe 4.0.8 Advanced User Guide. If LibreOffice crashes during
this HTML conversion process with certain files, you can exclude the problematic file types from
being converted. These file types can then no longer be viewed in HTML. For information on how to
exclude file types from displaying in HTML, see “Configuring Which File Formats Can Be Viewed as
HTML” on page 94.

Customizing the Simple URL Prefix

When users create user-friendly URLs that point to their workspaces or folders, by default, the name
they specify is preceeded by the text string / novl / . For more information, see “Defining a User-
Friendly URL for a Workspace or Folder” in the OpenText Vibe 4.0.8 User Guide

Some Vibe 3.x administrators configured their systems to not use a prefix, but “empty prefixes” are
no longer supported in Vibe 4.x because that would preclude WebDAV support.

Other Vibe 3.x administrators customized the prefix by including a simpleurl.ctx parameter in the ssf-
ext.properties file.

Starting with Vibe 4.x, this action alone is no longer sufficient.
To configure Vibe to prepend a different text string, you must do the following:

1 Change to the following directory:
Linux: /opt/ novel | / t eam ng/ apache-t ontat /
webapps/ ssf/WEB- | NF/ cl asses/ config
Windows: c¢:\Program Fi |l es\ Novel | \ t eani ng\ apache-t ontat\

webapps\ ssf\ WEB- | NF\ cl asses\config

2 Make a copy of the ssf - ext. properti es file then open the file in a text editor.
3 Insert the following line at the bottom of the ssf - ext . properti es file.

simpl eurl. ct x=/ new prefix

where new-prefix is the text string that you want prepended.
4 Save and close the ssf - ext . properti es file.

5 Change to the following directory:

Linux: / opt/ novel | / t eam ng/ apache-t ontat / conf

Windows: c¢:\Program Fi | es\ Novel I\t eam ng\ apache-t ontat\ conf

6 Make a copy of the server. xnl file then open the file in a text editor.
7 Search for the string / vi be.

8 Insert a new line before the line containing / vi be as follows:

<Cont ext pat h="/new prefix" rel oadabl e="fal se" docBase="novl"
crossContext="true"/>
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where new-prefix is the text string you that you also specified in Step 3.
9 Save the server.xm file.

10 Stop and restart Vibe to enable the simple URL configuration change.
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5 Setting Up User Access to the Vibe Site

“Adding New Users to Your Vibe Site” on page 99

“Creating Groups of Users” on page 99

“Restricting Groups of Users from Seeing One Another” on page 105
“Allowing Guest Access to Your Vibe Site” on page 106

“Allowing Users Limited External Access to Your Vibe Site” on page 110
“Allowing Web Crawler Access to Your Vibe Site” on page 110
“Disabling User Access to the Vibe Site on the Web” on page 111
“Managing Mobile Device Access to Your Vibe Site” on page 113

Adding New Users to Your Vibe Site

You can add new users to your Vibe site in any of the following ways:

*

Synchronizing from an LDAP directory, as described in “Synchronizing Users and Groups from an
LDAP Directory” on page 207.

Manually adding local users, as described in “Creating a New Local User” on page 223.

Importing profile files for local users, as described in “Managing Local Users and Groups by
Importing Profile Files” on page 229.

Creating Groups of Users

This section describes how to create groups within Vibe. You can also synchronize groups of users
from your LDAP directory to your OpenText Vibe site, as described in “Synchronizing Users and
Groups from an LDAP Directory” on page 207.

You can use existing groups or create additional groups within Vibe to facilitate access control on
your Vibe site. For background information on access control, see “Controlling Access” in the
OpenText Vibe 4.0.8 Advanced User Guide.

In addition to creating groups to assist with access control, you might want to create groups for any
of the following reasons:

*

To facilitate team creation, as described in “Creating a Team Workspace” in “Getting Started” in
the OpenText Vibe 4.0.8 User Guide.

To facilitate managing data quotas, as described in “Managing User Data Quotas” on page 248.

To facilitate user visibility restrictions, as described in “Restricting Groups of Users from Seeing
One Another” on page 105.

To create multiple Vibe administrators, as described in “Creating Additional Vibe
Administrators” on page 18.
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Users are responsible for access control in their personal workspaces and any team workspaces that
they create. As the Vibe site administrator, you are responsible for access control in public locations
such as global workspaces. By creating groups of users who have attributes in common, you and
other Vibe users can set access controls and create teams without listing users individually. Groups
can be nested within groups, so create small groups first, then build larger groups from your smaller
groups.

You can create either static or dynamic groups.

¢ “Creating Static Groups” on page 100

¢ “Creating Dynamic Groups” on page 101

Creating Static Groups

Static groups are groups whose membership does not change based on LDAP queries.

This section describes how to create static groups directly from Vibe. You can synchronize static
groups to Vibe from your LDAP directory as described in “Synchronizing Users and Groups from an
LDAP Directory” on page 207.

To create static groups in Vibe:

1 Login to the Vibe site as the Vibe administrator.
2 Click the admin link in the upper-right corner of the page, then click the Administration Console
icon '+,

3 Under Management, click Groups, then click New.
Add Group 7]

Mame: |

Title:

Description:

* Group membership is static
P P Edit group membership

Group membership is dynamic

4 Fill in the following fields:

Name: Specify the unique name under which the group is stored in the Vibe database. You can
use alphanumeric characters (a-z, A-Z, 0-9), hyphens (-), and underscores (_).

Title: Specify the group name that displays to users on the Vibe site. This string can include any
characters that you can type.

Setting Up User Access to the Vibe Site



Description: Describe what the members of this group have in common.
5 Select Group membership is static.
This means that group membership does not change based on LDAP queries.

6 Click Edit group membership.
Static membership for group:

Users Groups

User:

Femove

Mame

4 4 [00ofD »

7 Click the Users or Groups tab, depending on whether you want to add users or groups to the
group that you are creating.

8 In the User or Group field, specify the name of the user or group that you want to add to the
group that you are creating, then click the name of the user or group when it appears in the
drop-down list.

9 Repeat Step 7 and Step 8 to add multiple users and groups to the group that you are creating,
then click OK when you have finished adding users and groups.

10 Click OK to create the group.

After you have created one or more small groups, you can use the Groups field to create larger
groups from smaller groups.

Creating Dynamic Groups

Groups based on LDAP queries are dynamic in that they can be configured to have their membership
updated when the information in the LDAP directory changes.

Creating groups based on LDAP queries is a quick way to create Vibe groups that consist of users who
match specific criteria. You can create dynamic groups as described in the following sections:

+ “Creating Dynamic Groups within LDAP” on page 102
+ “Creating Dynamic Groups within Vibe” on page 102
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Creating Dynamic Groups within LDAP

Depending on the LDAP directory that you are using, you might be able to create dynamic groups
within your LDAP directory. For example, you can create dynamic group objects in eDirectory with
iManager (for more information, see the iManager Documentation (http://www.novell.com/
documentation/imanager27/index.html)).

Dynamic groups created within LDAP are stored in your LDAP directory and can then be synchronized
to Vibe, as described in “Synchronizing Users and Groups from an LDAP Directory” on page 207

Creating Dynamic Groups within Vibe

You can create dynamic groups in Vibe by querying the LDAP directory.

+ “Prerequisites” on page 102

+ “Advantages” on page 102

+ “Considerations with Multiple LDAP Sources” on page 103
¢ “Creating the Group” on page 103

Prerequisites

+ Users must already have existing Vibe user accounts in order for them to be added to a Vibe
group as described in this section. If your LDAP query includes users who are not already Vibe
users, the users are not added to the Vibe group

+ When configuring your LDAP connection, you must specify the GUID name (LDAP attribute that
uniquely identifies the user), because the value of this attribute never changes. For eDirectory,
this value is GUI D. For Active Directory, this value is obj ect GUI D. For GoupWise, this value is
ent r yUUl D. For more information about this attribute, see “Server Information” on page 209.

The Vibe process that creates a dynamic group uses the LDAP configuration settings in Vibe to
authenticate to the LDAP directory server. The credentials that are used are the LDAP server
URL, user DN, and password. For more information on how to configure these and other LDAP
configuration settings in Vibe, see “Synchronizing Users and Groups from an LDAP Directory” on
page 207.

Advantages
Advantages to creating dynamic groups within Vibe rather than within your LDAP directory include:

+ Allows the Vibe administrator to control group membership without having direct access to the
group object in the LDAP user store.

+ Your LDAP directory might not support dynamic groups.

+ You do not want dynamic groups to sync to applications other than Vibe that are leveraging
your LDAP directory.
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Considerations with Multiple LDAP Sources
Consider the following if your Vibe site is configured with multiple LDAP sources:

+ You should not create dynamic groups in Vibe if the base dn that you define for the dynamic
group does not exist in each LDAP source. This is because the membership of the dynamic
group might not get updated correctly.

+ If your Vibe site is configured with multiple LDAP sources and the base dn that you define for
the dynamic group exists in each LDAP source, the membership of the dynamic group contains
users from each LDAP source that match the dynamic group’s filter.

Creating the Group
To create the dynamic group within Vibe:

1 Login to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon %',

3 Under Management, click Groups, then click Add.

Add Group o

Mame: |

Title:

Description:

*' Group membership is static
P P Edit group membership

Group membership iz dynamic

4 Fill in the following fields:

Name: Specify the unique name under which the group is stored in the Vibe database. You can
use alphanumeric characters (a-z, A-Z, 0-9), hyphens (-), and underscores (_).

Title: Specify the group name that displays to users on the Vibe site. This string can include any
characters that you can type.

Description: Describe what the members of this group have in common.
5 Select Group membership is dynamic.

This means that group membership is based on an LDAP query that you will define in this
procedure.

6 Click Edit group membership.
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Edit Dynamic Membership

Base DN: E
LDAP Filter:

Search subtree

Update group membership during scheduled |dap synchronization

Test Idap query

7 Specify the following options:

Base DN: Specify the base DN where you want to start your search.

If you have multiple LDAP sources, see “Considerations with Multiple LDAP Sources” on
page 103 before proceeding.

LDAP Filter: Specify the filter criteria.
For example, to search for all users located in Utah, specify (st =Ut ah) .

Search subtree: Select this option if you want to also search for matches in subtrees of the base
dn you are currently searching.

Update group membership during scheduled Idap synchronization: Select this option to
update the membership of this group during each scheduled LDAP synchronization. Group
membership is updated based on changes that might have occurred in the LDAP directory.

For information on how to set the LDAP synchronization schedule, see “Configuring the
Synchronization Schedule” on page 218.

(Optional) Click Test Idap query to test the results of your LDAP query.

This process can take several minutes, depending on the size of your LDAP directory.

9 Click OK > OK to create the group.
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Restricting Groups of Users from Seeing One Another

If your OpenText Vibe site has multiple sets of users who need to remain hidden from each other,
you can use access controls to restrict users who belong to a specific group from seeing users who
do not belong to the group. For example, you might want to do this if your Vibe site contains users
from more than one company and you want users to see only the users who belong to the same
company.

You accomplish this by setting zone-level access controls on individual users or groups of users,
limiting them to seeing only those users with whom they share a common group.

When you restrict groups of users from seeing one another in your Vibe site, you see the following
behaviors:

+ When users search for people in the Vibe site, they do not see the users they are restricted from
seeing.

+ By default, users cannot see the personal workspaces of users they are restricted from seeing.
However, individual users can modify the access control settings of their personal workspaces
to grant access to users who are restricted from seeing them. Users can do this by granting
access to other groups.

+ The Vibe site might contain folders and entries that are open to a wider audience, such asin a
global workspace. If a restricted user has access to one of these folders, and an entry is posted
by someone the user is not allowed to see, the name of the entry creator is hidden. The name is
also hidden from the restricted user wherever else it might appear, such as in the Left
Navigation pane or on the Search Results page.

For example, User B is restricted from seeing User A. when User A posts an entry in a global
workspace, User B can see the entry but cannot see User B’s name on the entry.

To restrict groups of users from seeing one another:
1 Create a group for each set of users that you want to keep separate. For example, create groups
called Company A, Company B, and Company C.
For information about how to create a group, see “Creating Groups of Users” on page 99.
2 Populate each group with the appropriate users.

For information about how to populate groups with users, see “Creating Groups of Users” on
page 99.

3 Navigate to the Administration page and add the groups to the Can Only See Members of Groups
I Am In role or use the Limit User Visibility option as explained in “Limiting User Visibility” on
page 228.

If you want to allow certain members of a group to retain their ability to see users that belong
to groups outside of their own, you can add these specific users to the Override “Can Only See
Members of Groups | Am In” role.

For more information about these roles as well as other roles, see “Controlling User Access to
Administrative Functions” on page 30.

For information about how to add users and groups to a specific role, see “Controlling User
Access to Administrative Functions” on page 30.
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IMPORTANT: Do not create a group that contains users who you want to hide from each other. For
example, if your Vibe site has users from Company A and Company B, you should not create a single
group that contains users from both Company A and Company B. Users who belong to a common
group are able to see each other, regardless of any access controls that are set on other groups. If
you must create a single group of users from multiple companies, first create a sub-group for each
company so you can keep users’ names separate from each other.

Allowing Guest Access to Your Vibe Site

When a person arrives at the OpenText Vibe site URL, the person is considered to be a Guest user on
the site, as indicated by the user name displayed in the upper right corner of the page:

Guest | Sign In

G;

This page is also the main Vibe login page. Users with Vibe user names can log in to their personal
workspaces, and from there they can access any other locations where they have been granted
access.

+ “Guest Access Limitations” on page 106

¢ “Understanding the Guest User” on page 107

+ “Setting Up Guest Access for the Vibe Site” on page 107

+ “Configuring Any Workspace to Be the Default Home Page for Guest Users” on page 109

+ “Enabling Individual Users to Grant Guest Access throughout the Vibe Site” on page 109

+ “Monitoring Guest User Access” on page 110

Guest Access Limitations

Guest access to the Vibe site is not possible in the following situations:
+ If you are using NetlQ Access Manager to provide single sign-on functionality.

For more information about NetlQ Access Manager, see “Configuring Single Sign-On with Novell
Access Manager” in “Advanced Installation and Reconfiguration” in the OpenText Vibe 4.0.8
Installation Guide.

+ If users are accessing the Vibe mobile interface. For guest users to access the Vibe site, they
must access the full user interface from a browser.

For more information about accessing the Vibe mobile interface, see the Vibe Mobile Quick
Start (https://www.novell.com/documentation/vibe4/vibe4_qs_mobile/data/
vibed_gs_mobile.html).
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Understanding the Guest User

As the administrator, you can choose whether you want people who do not have Vibe user names to
be able to access information on the Vibe site as the Guest user.

For example, a government organization such as a city might give Vibe user accounts only to key city
knowledge workers. However, it is critical that other city workers and regular citizens also access the
site to see a listing of upcoming events, read city news, report complaints, and so forth. As a Vibe
administrator, you can use the Guest User workspace as a place to present information to non-
registered Vibe users.

When people visit your Vibe site as the Guest user, they can have some or all of the following
experiences, depending on the access controls that you set for the Guest user:
+ Any user who knows the Vibe site URL can access the Guest workspace.

+ The Relevance Dashboard in the Guest workspace displays only the information that the Guest
user has been specifically granted access to see.

+ A Guest user can find out what is accessible on the Vibe site by clicking the Search Options icon
Gt selecting Places, then pressing the Spacebar.

+ If a Guest user uses the Search feature, the only information returned is information that the
Guest user has been granted access to see.

+ When a Guest user adds a folder entry, the entry form requests the user’s name and email
address. This information is displayed like a signature when the folder entry is viewed. Providing
the name and email address is optional.

+ If you grant Participant rights to the Guest user, people who access the Vibe site as the Guest
user can modify and delete entries and comments posted by other people who have accessed
the Vibe site as the Guest user.

Setting Up Guest Access for the Vibe Site

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon *.

3 Under System, click Web Application.

Configure Web Applic ation

Allow Guest access
Guest access is read only

Disable web access

4 Under System, click Configure Guest Access and Self Registration.
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5 Make sure that Allow Guest Access is selected, then click Close.

Even though this option is selected by default, the Guest workspace is initially inaccessible
because the default user access control settings do not allow access.

(=)}

add files or make comments on files.

7 Click Close again to close the Administration page.

o o

The Guest user’s personal workspace is displayed.

(Optional) Select Guest access is read only if you do not want the Guest user to be allowed to

Click the Workspace tree icon Iz , expand Home Workspaces, then click Personal Workspaces.

Begin typing Guest in the Entry field, then click it in the drop-down list.

10 Click the Configure icon E" next to the workspace title, then click Access Control.

11 Ensure that no is selected in the Inherit role membership section. If it is not, select no then click

Apply.

Configure Access Control 0

Current Workspace: Guest {quest)
Workspace Owner: admin (zdmin) [=dit]

F-Home Workspace J [-Personal Workspaces Jf [-Guest (guest)

This folder does not inherit its access control settings from its parent.

Inherit role membership from the parent folder or workspace?

Eyes @ no

12 Add the roles that you want the Guest user to be able to perform in the Guest workspace:

12a Click Add a User, start typing Quest in the Add a User field, then click Guest when it appears

in the drop-down list.

This adds Guest as a new row in the Access Control table.

" designates the access control sefting of the parent workspace

Add User Names from Clipboard

Add a Role ¥

Visitor

pai

Team Member

and Folder

Owner of Warkspace or Folder v
Team Members ]
Add a Group ¥ Group Title Group Name Visitor  Participant Team Member Workspace and Folder Administrator
All Users 1 allusers ! v O ] sl
AddaUser = User Title User Id Visitor pant Team Member and Folder
Guest guest ) B ] sl
Add an Application Group = p Title: pName  Visitor pant Team Member and Folder
—no application groups—
Add an Application ¥ Application Title Application Name. Visitor  Participant Team Member Workspace and Folder Administrator

—no applications—

12b Select one or more roles that you want the Guest user to be able to perform on the Guest

User workspace. For example:

Visitor: The Guest user can read entries and add comments or replies in folders in the

Guest user workspace.
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Participant: In addition to Visitor activities, the Guest user can also create new entries, and
modify or delete his or her own entries.

For more information about the additional access control options, see “Controlling Access”
in the OpenText Vibe 4.0.8 Advanced User Guide.

12c¢ Click Save Changes, then click Close.

Now, when people access the Vibe site who do not have user names, they are admitted as
a Guest user and see the What’s New page (only items that the Guest user has access to
see are visible).

13 (Conditional) If you want the Guest user to be able to access content throughout the Vibe site,
add the Guest user to the Configure Access Control page for those workspaces or folders.

You can also enable specific Vibe users in addition to the Vibe administrator to grant Guest
access to locations in your Vibe site, as described in “Enabling Individual Users to Grant Guest
Access throughout the Vibe Site” on page 109.

14 Notify people who might be interested in accessing your Vibe site about your Vibe site URL.

15 (Conditional) If you want information on your Vibe site to be searchable on the Internet, see
“Allowing Web Crawler Access to Your Vibe Site” on page 110.

Configuring Any Workspace to Be the Default Home Page for
Guest Users
If you're not satisfied with the What’s New page being the default home page for guest users, you

can configure the Guest User workspace or a different workspace to be the default home page,
giving you complete control over what guest users see when they first access the Vibe site.

For information on how to change the default home page for guest users, see “Setting a Default
Home Page for Guest Users” on page 72.

Enabling Individual Users to Grant Guest Access throughout the
Vibe Site

If you want users in addition to the Vibe administrator to be able to grant Guest access to locations
in your Vibe site:

1 Login to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon %',

3 Under System, click Access Control.
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A basic Vibe site consists of a single zone. OpenTextVibe lets you set up multiple zones in a
single Vibe site. For more information about zones, see Chapter 18, “Setting Up Zones (Virtual
Vibe Sites),” on page 197.

4 Click Add a User, start typing the user’s name, then select the user from the drop-down list to
add the user to the Access Control table.

5 Select the check box in the Allow Adding Guest Access column.

6 Repeat Step 4 and Step 5 for each user who you want to be able to grant Guest access to
locations on your Vibe site.

7 Click Save Changes, then click Close.

8 Notify the users who are allowed to grant Guest access.

Monitoring Guest User Access

As the Vibe site administrator, you can create a report of all locations on the Vibe site that the Guest
user can access. For instructions, see “User Access Report” on page 302.

Allowing Users Limited External Access to Your Vibe Site

Vibe lets you restrict what information users can access when they are outside your corporate
firewall. For more information, see “Restricting Access Rights of Users Qutside the Firewall” on
page 38.

Allowing Web Crawler Access to Your Vibe Site

If you allow Guest access to your Vibe site, as described in “Setting Up Guest Access for the Vibe
Site” on page 107, you can provide Internet search engines (such as Google) with the Vibe
permalinks for workspaces and folders that you want to make publicly available on the Internet. A
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Vibe permalink is the complete URL that someone outside of your Vibe site and outside of your
organization, such as a web crawler (http://en.wikipedia.org/wiki/Web_crawler), could use to access
a specific location on your Vibe site.

1 To determine the permalink of a workspace or folder, click Permalinks at the bottom of a
workspace or folder page.

Disabling User Access to the Vibe Site on the Web

If you want users to have access to the Vibe system only through the Vibe desktop application, you
can disable users’ ability to access the Vibe site via a web browser.

You can restrict access to the Vibe site on the web for all users, or for specific users and groups.
Alternatively, you can disable access to the site for all users and then enable access for specific users
and groups.

+ “Disabling Access for All Users” on page 111

+ “Disabling or Enabling Access for Individual Users” on page 112

+ “Disabling or Enabling Access for Individual Groups” on page 113

Disabling Access for All Users

Disabling access as described in this section disables access to Vibe on the web for all users in the
Vibe system, except for the Vibe administrator.
1 Login to the Vibe site as the Vibe administrator.
1a Launch a web browser.
1b Specify one of the following URLs, depending on whether you are using a secure SSL

connection:

http:// Vi be_host nanme: 8080
https:// Vi be_host nane: 8443

Replace Vi be _host name with the hostname or fully qualified domain name of the Vibe
server that you have set up in DNS. If you configured the HTTP ports correctly during
installation, you do not need to include the port number in the Vibe URL.

Depending on how you have configured your Vibe system, you might not be required to
enter the port number in the URL. If you are using NetlQ Access Manager, the Vibe login
screen is not used.

2 Click the admin link in the upper-right corner of the page, then click the Administration Console
icon .

3 Under System, click Web Application.
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Configure Web Application

Allow Guest access
Guest access is read only

Disable web access

4 Select Disable web access.

5 Click OK.

Disabling or Enabling Access for Individual Users

1 Login to the Vibe site as the Vibe administrator.

1la Launch a web browser.
1b Specify one of the following URLs, depending on whether you are using a secure SSL
connection:

http:// Vi be_host nanme: 8080
https:// Vi be_host nane: 8443

Replace Vi be_host nane with the hostname or fully qualified domain name of the Vibe
server that you have set up in DNS. If you configured the HTTP ports correctly during
installation, you do not need to include the port number in the Vibe URL.

Depending on how you have configured your Vibe system, you might not be required to
enter the port number in the URL. If you are using NetlQ Access Manager, the Vibe login
screen is not used.

Click the admin link in the upper-right corner of the page, then click the Administration Console
icon *.

Under Management, click Users.

The Manage Users page is displayed.

(Conditional) If you have not disabled access for all users (as described in “Disabling Access for
All Users” on page 111), you can disable access for an individual user by clicking the drop-down
arrow next to the user’s name and then clicking Disable Web Access for this User.

or

To disable access for multiple users, select the users whose access you want to disable, then
click More > Disable Web Access.

(Conditional) If you have disabled access for all users, you can enable access for an individual
user by clicking the drop-down arrow next to the user’s name and then clicking Enable Web
Access for this User.

or

To enable access for multiple users, select the users whose access you want to enable, then click
More > Enable Web Access.
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Disabling or Enabling Access for Individual Groups

1 Login to the Vibe site as the Vibe administrator.
1la Launch a web browser.
1b Specify one of the following URLs, depending on whether you are using a secure SSL
connection:

http:// Vi be_host name: 8080
https:// Vi be_host nane: 8443

Replace Vi be _host nanme with the hostname or fully qualified domain name of the Vibe
server that you have set up in DNS. If you configured the HTTP ports correctly during
installation, you do not need to include the port number in the Vibe URL.

Depending on how you have configured your Vibe system, you might not be required to
enter the port number in the URL. If you are using NetlQ Access Manager, the Vibe login
screen is not used.

2 Click the admin link in the upper-right corner of the page, then click the Administration Console
icon %,

3 Under Management, click Groups.
The Manage Groups page is displayed.

4 (Conditional) If you have not disabled access for all users (as described in “Disabling Access for
All Users” on page 111), you can disable access for users who belong to an individual group by
clicking the drop-down arrow next to the group name and then clicking Disable Web Access for
Users in this Group.

or

To disable access for multiple users, select the users whose access you want to disable, then
click More > Disable Web Access.

5 (Conditional) If you have disabled access for all users, you can enable access for users who
belong to an individual group by clicking the drop-down arrow next to the group name and then
clicking Enable Web Access for Users in this Group.

or

To enable access for multiple users, select the users whose access you want to enable, then click
More > Enable Web Access.

Managing Mobile Device Access to Your Vibe Site

By default, your Vibe site allows mobile device access at one of the following URLs, depending on
whether or not you are using a secure SSL connection:

http://vi be_host name/ nobi | e
https://vi be_host nane/ nobi | e

In these URLs, vi be_host nane is the hostname or fully qualified domain name of the Vibe server
that you have set up in DNS.
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For a list of supported mobile devices, see “Mobile App Requirements” in the Vibe Mobile Quick
Start (https://www.novell.com/documentation/vibe4/vibe4_qs_mobile/data/
vibed_qs_mobile.html).

For instructions on using the mobile device interface to the Vibe site, see the Vibe Mobile Quick
Start (https://www.novell.com/documentation/vibe4/vibe4_qs_mobile/data/
vibed_qgs_mobile.html).

+ “Restricting Mobile Device Access to Your Vibe Site” on page 114

+ “Changing the Default View for Tablets” on page 114

+ “Configuring Mobile Device Access with NetlQ Access Manager” on page 116

Restricting Mobile Device Access to Your Vibe Site

As the Vibe administrator, you can prevent mobile device access to your Vibe site if necessary.

1 Login to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon * .

3 Under System, click Mobile Access.

4 Deselect Enable Mobile Access.

5 Click Apply, then click Close.

Changing the Default View for Tablets

When users access the Vibe site through a browser (not through the mobile app), some tablets (such
as the iPad and Kindle Fire) display the full Ul by default (the same Ul that is displayed when you
access Vibe from your workstation). Other tablets (such as Android-based tablets) display the mobile
Ul by default.

For a better user experience, users should use the Vibe mobile app. For more information about
accessing Vibe by using the mobile app, see the Vibe Mobile Quick Start (https://www.novell.com/
documentation/vibe4/vibe4_qs_mobile/data/vibe4_qs_mobile.html).

+ “Changing the Default View for the iPad” on page 114
¢ “Changing the Default View for Android Tablets” on page 115
+ “Changing the Default View for All Other Tablets” on page 116

Changing the Default View for the iPad

To change the default view for the iPad to display the mobile Ul rather than the full Ul:

1 Change to the following directory:
Linux: / opt/ novel | / t eam ng/ apache-t ontat /
webapps/ ssf/WEB- | NF/ cl asses/ config

Windows: c¢:\Program Fil es\ Novel | \ Team ng\ apache-t ontat\
webapps\ ssf\ WEB- | NF\ cl asses\config
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2 Openthessf. properti es filein a text editor.

3 Search for the following line:
t abl et . user Agent Regexp=(?:i pad)
exclude. fromlibreoffice.indexing.extensions=

4 Make a backup copy of the ssf - ext . properti es file, which is located in the same directory
as the ssf. properti es file.

5 Openthe ssf-ext. properti es file in a text editor.

6 Copythetabl et. user Agent Regexp=(?:i pad) line fromthe ssf. properti es file to the
bottom of the ssf - ext. properti es file.

7 If you want the iPad to display the mobile Ul, delete the value of this property (( ?: i pad) ), so
that it now reads as follows:

tabl et . user Agent Regexp=
exclude.fromlibreoffice.indexing.extensions=

8 Save and close the ssf - ext. properti es file.
9 Close the ssf . properti es file without saving it.
10 Stop and restart Vibe.

Changing the Default View for Android Tablets

To change the default view for all tablets that are running the Android operating system to display
Vibe in the Full Ul rather than the mobile Ul:

1 Change to the following directory:
Linux: / opt/ novel | / t eam ng/ apache-tontat/
webapps/ ssf/WEB- | NF/ cl asses/ confi g
Windows: c¢:\Program Fi | es\ Novel | \ Teani ng\ apache-tontat\

webapps\ ssf\ WEB- | NF\ cl asses\ confi g

2 Openthe ssf. properti es file in a text editor.

3 Search for the following line:
t abl et . useDef aul t Test For Andr oi dTabl et s=f al se
exclude. fromlibreoffice.indexing.extensions=

4 Make a backup copy of the ssf - ext. properti es file, which is located in the same directory
asthe ssf. properti es file.

5 Openthe ssf-ext. properti es filein a text editor.

6 Copythet abl et . useDef aul t Test For Andr oi dTabl et s=f al se line from the
ssf. properti es file to the bottom of the ssf - ext . properti es file.

7 Change the value of this property from f al se tot r ue, so that it now reads as follows:

t abl et . useDef aul t Test For Andr oi dTabl et s=t rue
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8
9
10

exclude. fromlibreoffice.indexing.extensions=

Save and close the ssf - ext. properti es file.
Close the ssf . properti es file without saving it.
Stop and restart Vibe.

Changing the Default View for All Other Tablets

To change the default view for all tablets that are not the iPad or Android-based (Kindle, Xoom,
Playbook, etc.) to display Vibe in the mobile Ul rather than the full Ul:

1

Change to the following directory:

Linux: / opt/ novel | / t eam ng/ apache-t ontat/
webapps/ ssf/WEB- | NF/ cl asses/ config

Windows: c¢:\Program Fi |l es\ Novel | \ Teani ng\ apache-t ontat\
webapps\ ssf\ WEB- | NF\ cl asses\config

Open the ssf . properti es file in a text editor.

Search for the following line:
t abl et . user Agent Regexp=(?:i pad)
exclude. fromlibreoffice.indexing.extensions=

Make a backup copy of the ssf - ext . properti es file, which is located in the same directory
as the ssf. properti es file.
Open the ssf - ext . properti es file in a text editor.

Copy thet abl et . user Agent Regexp=(?:i pad) line from the ssf. properti es file to the
bottom of the ssf - ext . properti es file.

If you want to change the default view of a specific kind of tablet to display the full Ul rather
than the mobile Ul, add the name of the tablets to the value, as follows:

t abl et . user Agent Regexp=(?: i pad| xoomn] pl aybook| t abl et | ki ndl e| schi 800)

Save and close the ssf - ext . properti es file.

9 Close the ssf. properti es file without saving it.

10

Stop and restart Vibe.

Configuring Mobile Device Access with NetlQ Access Manager

To allow mobile device access to Vibe through NetlQ Access Manager, you need to modify your
protected resource in NetlQ Access Manager to allow a non-redirected login and to redirect the
identity server when no authentication header is provided.

Follow the steps in “Configuring an Authentication Procedure for Non-Redirected Login” in
“Protecting Web Resources Through Access Gateway” in the Net/Q Access Manager Administration
Guide.
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When specifying the method for obtaining credentials, ensure that Non-Redirected Login and
Redirect to Identity Server When No Authentication Header Is Provided are selected.
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Configuring Single Sign-On to the Vibe Site

+ “Configuring Single Sign-On with NetlQ Access Manager” on page 119
+ “Configuring Single Sign-On with KeyShield” on page 119

Configuring Single Sign-On with NetlQ Access Manager

For more information about configuring single sign-on with NetlQ Access Manager, see “Configuring
Single Sign-On with Novell Access Manager” in “Advanced Installation and Reconfiguration” in the
OpenText Vibe 4.0.8 Installation Guide.

Configuring Single Sign-On with KeyShield

Use the information and instructions in the following sections to configure Vibe to work with an
existing KeyShield installation.

+ “Prerequisites” on page 119

+ “(Conditional) Allowing the Authorization Connectors to Access the APl Key” on page 120

+ “Configuring Vibe for KeyShield SSO Support” on page 120

+ “KeyShield Attribute Alias Support” on page 123

+ “Configuring Two-Factor Authentication” on page 124

+ “Downloading and Installing the KeyShield SSO SSL Certificate” on page 125

+ “Testing the KeyShield SSO Configuration” on page 127

Prerequisites

For Vibe to work with an existing KeyShield installation, you must have the following already in
place.

+ A KeyShield SSO server that is registered with DNS and provides single sign-on services to your
network users.
+ An API Key that is displayed in a defined APl Authorization configuration.

+ One or more Authentication Connectors (defined on the KeyShield server) that are allowed to
be used with the API Key.

+ Administrative Access to the KeyShield server for obtaining the following:

+ The API Authorization Key associated with the KeyShield Connectors you are leveraging for
Vibe

¢ The SSL certificate, downloadable as a . CERfile for importing into the Vibe keystore.
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(Conditional) Allowing the Authorization Connectors to Access
the API Key

Continuing in the General tab (accessed in the previous section), if access to the KeyShield SSO APIs
is restricted to users on specific connectors, ensure that the connectors that your Vibe users will be
connecting through are listed, by doing the following:

1 If the connectors your users will use are not listed, click the bar below the already-allowed
connectors.

Connectors = All-eDir

I * |

=]

2 Select the connectors for your users, then click OK.

Select Connector(s) a

o
B Connector ID
All-AD
OES-eDir
Win-file-AD

-

Configuring Vibe for KeyShield SSO Support

1 Open a new tab or a new browser session to access Vibe on port 8443:
https:// Vi be-i p-address-or-dns-nane: 8443
For example ht t ps: 192. 168. 30. 150: 8443

Having a new session will let you easily switch between the KeyShield administration console
and the Vibe Administration console.

2 Inthe new browser session, log in to Vibe as an administrator.

3 Click the admin link in the upper-right corner of the page, then click the Administration Console

icon

4 In the left frame, click KeyShield SSO.
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Database Logs
Search Index

License

System

Share Settings
Web Application
Desktop Application
Mobile Applications
Password Policy
Email

KeyShield S50

LDAP

Name Completion Settings
Reports
Site Branding

m

1

5 In the KeyShield SSO Configuration dialog, click Enable KeyShield SSO.

KeyShield SSO Configuration

[EEnable keyshield sso

6 In the KeyShield Server URL field, type the access URL for the KeyShield server:

https://ks-server-dns-namnme_or _i p-address: ks-server-https-port/

For example,

KeyShield SSO Configuration

Enable KeyShield SS0

KeyShield Server
URL:

|https://keyshield-srv.oes-lab.local.8436/ |

7 Switch to the KeyShield browser-based console, toggle open the API Key, then select and copy

the key to your clipboard.

- webacc

$f edit @ remove

= aPI Key:

oV8dGf1C SDrmxyjQkwHqlusSArFINuwEg

apiKey G-VSdGﬂ CSDrmecyjQlowHglus5ArFINuwd I

Access Key for KeyShield SSO APIs (S50 json/xml/certificate, SAML, etc.). This Key mu

8 Switch to the Vibe Administration panel and paste the API Key into the API Authorization field.
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KeyShield SSO Configuration

Enable KeyShield S0

KeyShield Server

URL. https://keyshield-srv.oes-lab.local:3486/

‘:5;_3“”1””23“0” [GricSDmxyjakwHglusEAFINWWS |

9 The HTTP Connection Timeout controls how long the Vibe Appliance will wait for a response
from the KeyShield server before prompting users for their login credentials.

OpenText doesn’t recommend changing this value unless the connection between the Vibe
Appliance and the KeyShield SSO server doesn’t facilitate a quick response. For example the
appliance and server are connected over a WAN.

KeyShield SSO Configuration

Enable KeyShield SSO

E;{_Shmld EELE hitps://keyshield-srv.oes-lab.local:8486/

?E;_E“‘hm'zam” GFICSDrmxyjQkwHglusSATFINUWS
HTTP connection

. i 250 milliseconds
timeout:

10 In the Connector Names field, type the names of each KeyShield SSO connector that Vibe users
will connect through.

KeyShield S50 Configuration

Enable KeyShield SS0

E;{_Shmld EELE hitps://keyshield-srv.oes-lab.local:8486/

?E;_E“‘hm'zam” GFICSDrmxyjQkwHglusSATFINUWS

HTTP connection

. i 250 milliseconds
timeout:

Enter the names of every authentication connector separated by a comma.

Connector names: IOES—eDir,Win—ﬁIe—ADI

Test connection

11 Continue with the next section, “KeyShield Attribute Alias Support.”
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KeyShield Attribute Alias Support

Vibe lets administrators provision users from different LDAP sources, such as eDirectory and Active
Directory. It also allows for flexibility in specifying which LDAP attribute will be imported as the Vibe
username.

In addition to Vibe, organizations have email applications, RADIUS clients, and so on, that use
different LDAP attributes for their usernames.

KeyShield 6 includes support for Attribute Aliases. These let KeyShield match username validation
requests from each application with the LDAP attribute that the application uses for its usernames.

A Vibe Example

1. Jane Smith logs in through KeyShield’s SSO service using jsmith (her UID in LDAP) as her
Username.

2. Jane then launches Vibe.

Unfortunately, the Vibe administrator who configured the LDAP import, specified CN as the
LDAP username attribute and JaneSmith was imported as Jane’s Vibe username.

3. When Vibe tries to authenticate Jane Smith, KeyShield doesn’t find her as an authenticated user
and the attempt fails.

Jane is then prompted to log in to Vibe.

4. To fix the mismatch of LDAP attributes, Jane’s KeyShield administrator adds x- Vi be = cnasan
Attribute Alias in Keyshield.

5. Jane’s Vibe administrator adds x- Vi be as the Username Attribute Alias in Vibe.

6. The next time Jane launches Vibe after signing in through KeyShield’ SSO service, KeyShield
verifies to Vibe that JaneSmith is authenticated and no additional login is required.

Configuring Attribute Alias Support

1 In Keyshield, specify the appropriate Attribute Alias for each Authentication Connector.

For example, if your Vibe deployment uses the CN attribute as the username for an eDirectory
server that is defined as an Authentication Connector in KeyShield, then in the Attribute Alias
field in the connector configuration, you would specify

x-Vibe = cn

This means that for this Authentication Connector, when authentication verification requests
arrive with the Attribute Alias x- Vi be, KeyShield needs to request a match in the CN attributes
in the targeted eDirectory Authentication Connector.

2 By default, the Vibe 2.0 KeyShield SSO Configuration dialog, the Username Attribute Alias is set
to x- Vi be.

We strongly recommend that you not change this value. However, if you do, be sure that the
name is changed in each KeyShield Authentication Connector configuration as well.
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KeyShield SSO Configuration Q

[¥] Enable KeyShield S50

KeyShield Server URL (use http or https): https://keyshield-srv.oes-lab.local: 8486/
API authorization key: GfLCSDrmxyjQkwHglusSArFINuwS
HTTP connection timeout: 250 milliseconds
Enter the names of every authentication connector separated by a comma.
Connector names: OES-eDir, Win-file-AD

This is a system supplied default.

Username attribute alias: x-vibe

3 Continue with “Configuring Two-Factor Authentication.”

Configuring Two-Factor Authentication

KeyShield 6.1 adds the ability to require a hardware token in addition to usernames and passwords
for LDAP users seeking access through a web browser or WebDAV.

NOTE: Two-factor authentication doesn’t apply to desktop or mobile device applications.

Vibe 2.0 and later supports KeyShield’s two-factor authentication capability through two new
options in the KeyShield SSO Configuration dialog:

+ Require Hardware Token: Requires a physical token, such as an access card, for access to Vibe.
You can also specify the error messages that you want displayed when the required token is
either not presented or not recognized by KeyShield for web browser or WebDAV access.

+ Allow Username/Password based Fallback Authentication (non-SSO) for LDAP Users: Allows
authentication by entering a username and password as an alternative to the hardware token.

Use this option if you want users to be able to effectively bypass the hardware token
requirement by typing in their username and password.

1 If you want to configure two-factor authentication for your KeyShield 6.1 SSO service, select the
options and specify the text accordingly.

2 Click Test Connection.

Because the Vibe appliance doesn’t yet have the KeyShield SSO SSL certificate in its keystore,
the test fails.
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KeyShield SSO Configuration

[¥] Enable KeyShield S50

KeyShield Server URL (use http or https):
API authorization key:

HTTP connection timeout:

Connector names:

Username attribute alias:

https://keyshield-srv.oes-lab.local: 8486/
GF1CSDrmyjQlkwHglusSArFINuwWS

250 milliseconds

Enter the names of every authentication connector separated by a comma.
0QES-eDir, Win-file-AD

This is a system supplied default.

x-filr

Two Factor Authentication

[¥] Require hardware token

Missing token error message for WebDAY
interface:

Missing token error message for Web interface:

Access card required for Web interface access

Access card required for WebDAV interface access

[¥] Allow username/password based fallback authentication (non-SS80) for LDAP users

Test connection

3 Continue with “Downloading and Installing the KeyShield SSO SSL Certificate” on page 125

Downloading and Installing the KeyShield SSO SSL Certificate

1

I-ﬁ-edi:l

General/Web interface

Open a third browser session and access the Vibe appliance on port 9443:
https:// Vi be-i p-address-or-dns-nane: 9443

For example htt ps: 192. 168. 30. 150: 9443

Login as vaadmi n.

Switch to the KeyShield browser-based console and under General/Web Interface, click Edit.

Click the Download button for the HTTPS Keystore.
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¥ General KeyShield SS0O server configuration and Web interface/API configuration B

-

* Web address |192.168.30.110
* Web port | 8485
HTTP mode | enabled E'
* HTTPS port | 8486
HTTPS keystore |kevshield.pfx Browse...

HTTPS keystore password eseses L0 4

m

11 Eoon Areim

5 Save the Keyshi el d. cer file on the workstation running the browser.

6 Switch to the browser session opened in Step 1 on page 125 and click the Appliance
Configuration icon.

7 Click the Digital Certificates icon.

R

Digital Certificates

8 Click File > Import > Trusted Certificate.

File ~| Edit = Reload
Mew Certificate (Key Pair) ‘ Type
b Trusted Certificate o

ri

Key Pair

Certification Request 3 TrosTEneer
Trusted Certi

9 Click Browse, then browse to the location where you saved the Keyshi el d. cer file and click
Open.
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& File Upload (=]
@Qv| & » Administrater » Downloads v|¥7|

Organize Mew folder = - 0 @

- -
497 Favorites MName Date modified Type

PR Desktop _EJ keyshield 31172015 2:24 PM Security C
4 Downloads

:
=1 Recent Places

4 Libraries
> 3 Documents 3
> J”- Music
» =] Pictures

> B videos

> 1M Computer

>£‘§ MNetwork || L1 3

File name: - [ Al Files -

[ Open [v]|| cance |

10 Click OK to import the certificate file.

Import Trusted Certificate *
Certificate File: keyshield.cer Browse...
Aligs: keyshield

K Cancel

11 Acknowledge the message about restarting the appliance by clicking OK.

12 Click the back arrow in the browser, then select Reboot.

I’ Reboot ]I
[ Shutdown ]

13 After the system restarts, continue with the next section, Testing the KeyShield SSO
Configuration.

Testing the KeyShield SSO Configuration

1 Switch back to the Vibe administration console (port 8443).

2 Click Test Connection.
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KeyShield S50 Configuration

Enable KeyShield SS0

KeyShield Server

URL. hitps://keyshield-srv.oes-lab.local:8486/

?E;_E“‘hm'zam” GFICSDrmxyjQkwHglusSATFINUWS

HTTP connection

. i 250 milliseconds
timeout:

Enter the names of every authentication connector separated by a comma.

Connector names: OES-eDir, Win-file-AD

Test connection

The test should succeed.
3 Click OK to finalize the configuration and complete the Keyshield SSO integration.
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Setting Up Sharing

As the Vibe administrator, you need to enable sharing privileges for users on your Vibe site before
users are able to share files and folders from their personal workspace. You then need to enable
sharing for the top-level Global and Team workspaces in order for users to be able to share content
from those workspaces. You or workspace owners can then enable sharing on lower-level
workspaces on an individual basis.

There are various sharing privileges that you can grant.

+ “Understanding Sharing” on page 129

+ “Enabling Users to Share” on page 130

+ “Enabling Sharing on Workspaces” on page 135
+ “Managing Shares” on page 139

Understanding Sharing

Sharing in Vibe enables users to grant access to entries, folders, and workspaces to other users,
either internal or external to the organization.

If multiple users share the same item with a single user, the user who receives the share is granted
the highest level of access that was shared with the user. For example, User B shares a file with User
A and grants User A Read rights to the file. Then User C shares the same file with User A and grants
Read and Write rights to the file. As a result, User A has Read and Write rights to the file.

+ “Understanding External Users” on page 129

¢ “Users Can’t Grant Share Roles That They Don’t Have” on page 130

Understanding External Users

Users external to your organization can access your Vibe site at no additional cost. External users in
Vibe do not count as a licensed Vibe user, but they have their own individual user account (unlike
the Guest user) and can participate in Vibe workspaces like any other user.

An example of an external user might be a contractor who interacts with the corporation for only a
couple months a year, who needs access to the system as a defined user but does not need
consistent access to the system.

External users are added to the Vibe system when a workspace, folder, or entry is shared with them.
You as the Vibe administrator, determine whether users can share externally. For information about
how to enable this functionality, see “Enabling Users to Share” on page 130.
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Users Can’t Grant Share Roles That They Don’t Have

Users with Contributor rights on folders or workspaces can grant Viewer, Editor, and Contributor
rights to other users as Vibe system share settings allow.

On the other hand, Users with Viewer rights on folders or workspaces can grant only Viewer rights to
other users with whom they are allowed to share.

Enabling Users to Share

IMPORTANT: You must enable the sharing feature before any sharing can take place on the Vibe
system.

After you enable the sharing feature, the default behavior for whether users can share files from
their personal workspace differs depending on whether the user is new to the Vibe system after
Vibe 4, or if the user existed in the Vibe system prior to Vibe 4:

+ New users: Users who are new to the Vibe system after Vibe 4 are able to share items from
their personal workspace by default.

+ Existing users: Users who existed in the Vibe system prior to Vibe 4 do not automatically have
rights to share items from their personal workspace.

For users to be able to share files that are located outside of their personal workspace (such as their
team workspaces, etc.), sharing must be enabled on the individual workspace. For information about
how to enable sharing for the top-level Global and Team workspaces, see “Enabling Sharing on
Workspaces” on page 135.

When you enable users to share, it is best to keep the share rights fairly unrestricted (for example,
give the All Internal Users group the ability to share whatever they want). You can then restrict
sharing of files in the personal workspace on a per-user basis.

When you set up sharing for your Vibe site, complete the necessary steps in the following order:

1. Set up sharing for the entire Vibe site (as described in “Enabling Sharing for All Users” on
page 131).

2. Configure sharing for individual users (as described in “Modifying Share Rights on a User Basis”
on page 134).
After you have enabled sharing for the entire Vibe system, you can fine-tune share rights
throughout the site on the user level.
You might need to do this for the following reasons:

+ If you want only certain users to be allowed to share files from their personal workspace.
After you have enabled sharing for the entire site (as described in “Enabling Sharing for All
Users” on page 131), then you can restrict sharing privileges at the user level.
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For example, if you want only a few groups of users to be allowed to share with external
users, you first need to enable sharing to external users at the site level. After you have
enabled it at the site level, you can then remove this ability from the users who you do not
want to have this ability.

+ Ifthere are users who existed in your Vibe system prior to Vibe 4, and you want these users
to be able to share items from their personal workspace, you must modify the workspace
share rights for these users at the user level.

+ “Enabling Sharing for All Users” on page 131
+ “Modifying Share Rights on a User Basis” on page 134

Enabling Sharing for All Users

1 Log in to the Vibe site as the Vibe administrator.
1a Launch a web browser.
1b Specify one of the following URLs, depending on whether you are using a secure SSL
connection:

http:// Vi be_host nanme: 8080
https:// Vi be_host nane: 8443

Replace Vi be_host nane with the hostname or fully qualified domain name of the Vibe
server that you have set up in DNS. If you configured the HTTP ports correctly during
installation, you do not need to include the port number in the Vibe URL.

Depending on how you have configured your Vibe system, you might not be required to
enter the port number in the URL. If you are using NetlQ Access Manager, the Vibe login
screen is not used.

2 Click the admin link in the upper-right corner of the page, then click the Administration Console
icon *',

3 Under System, click Share Settings.
The Share Settings page is displayed.

Rights Whitelist / Blacklist External Users Licensing Terms

¥ Allow all users to share with internal groups that have been imported from LDAP

Select a user or group to add to the list and then grant share rights.

User or Group:
Name Rights Type

No cne has been selected.

4 Select Allow all users to share with groups that have been imported from LDAP to enable users to
share with LDAP groups.

Setting Up Sharing 131



132

If you select this option, groups that were imported from the LDAP directory are displayed in
the Share with field when users are sharing an item (as described in “Sharing Entries, Folders,
and Workspaces” in the OpenText Vibe 4.0.8 User Guide). All users in the LDAP group then have
access to the item that was shared.

To enable sharing for all internal users on the Vibe site, go to the User or Group field, begin
typing Al | I nternal Users, then selectit when it appears in the drop-down list.

or

To enable sharing on a per-user or per-group basis, go to the Select user/group field, begin
typing the name of the user or group for whom you want to grant share rights, then select the
name when it appears in the drop-down list.

The Edit Share Rights dialog box is displayed. Select from the following options:

Re-share items: When users share a file or folder, they can give the users they are sharing with
the ability to re-share the file or folder. The user receiving the share can share the file only if
that user has been given administrative rights to share the file or folder.

IMPORTANT: When selecting this option, be aware that if one user's access rights to an item
are removed, it does not remove the access rights of the user with whom the item was re-
shared.

For example, suppose User A shares an item with User B and grants re-share rights. User B then
shares the item with User C. If User A revokes User B's access rights to the item, User C
continues to have access to the shared item.

Share with Internal users: lets users share items with internal users.

Share with “All Internal Users” group: lets users perform a mass share to all internal users by
sharing with the Al | I nternal Users group.

Share with External users: lets users share items with users external to the organization.

Users external to the organization receive an email notification with a link to the shared item,
and they can then log in to the Vibe site. For more information, see “Sharing with People
Outside Your Organization” in the OpenText Vibe 4.0.8 User Guide.

Share with Public: lets users make items publicly available. This means that anyone with the
correct URL to the shared item can access the shared item without logging in to the Vibe site.

In addition to selecting this option, you also need to enable Guest access to the Vibe site if you
want to allow users to share items with the public. For information about how to enable Guest
access to the Vibe site, see “Setting Up Guest Access for the Vibe Site” on page 107.

Share using File Link: lets users share a link to a file in Vibe. Any user with the link can then
access the file. However, the file is not displayed in the Public area, so users must have direct
access to the link in order to access the file.

For more information about File Links, see “Distributing a Link to a File” in the OpenText Vibe
4.0.8 User Guide.

(Optional) Click the Whitelist / Blacklist tab to configure which email addresses and domains
users can share with when sharing externally.
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Rights Whitelist / Blacklist External Users Licensing Terms

Specify email addresses and domains that may (whitelist) or
may not (blacklist) be shared with as external shares.

Mode
® No restrictions - Lists are ignored
Whitelist - Email addresses and domains that may be shared with
Blacklist - Email addresses and domains that may not be shared with
Email addresses
Add...

Delete

Domains
Add...

Delete

Delete shares that don't meet the criteria

The following options are available when configuring a whitelist or blacklist for sharing:

No restrictions: Select this option to disregard any email addresses or domains that might
already exist in the Email addresses and Domains fields. Selecting this option means that users
can share with any email address.

Whitelist: Select this option to allow sharing only with email addresses and domains that have
been specified in the Email addresses and Domains fields.

Blacklist: Select this option to disallow sharing with any email addresses and domains that have
been specified in the Email addresses and Domains fields.

Email addresses: Click Add, specify the email address that you want to add to the whitelist or
blacklist, then click OK.

Repeat this process to add multiple email address.

Domains: Click Add, specify the domain that you want to add to the whitelist or blacklist (for
example, yahoo. com, then click OK.

Repeat this process to add multiple domains.

Delete shares that don’t meet the criteria: Select this option to delete all existing shares in the
Vibe system that do not match the criteria you set.

For example, if you selected Blacklist and then specified yahoo.com in the Domains field,
selecting this option would delete all Vibe shares made to Yahoo email addresses.

7 Click OK.

Modify individual user share rights as described in “Modifying Share Rights on a User Basis” on
page 134,
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Modifying Share Rights on a User Basis

After you have enabled sharing of files for the entire Vibe system (as described in “Enabling Sharing
for All Users” on page 131), you can modify share rights throughout the site on the user level.

You might need to do this for the following reasons:

+ If you want only certain users to be allowed to share files from their personal workspace. After
you have enabled sharing for the entire site (as described in “Enabling Sharing for All Users” on
page 131), then you can restrict sharing privileges at the user level.

For example, if you want only a few groups of users to be allowed to share with external users,
you first need to enable sharing to external users at the site level. After you have enabled it at
the site level, you can then remove this ability from the users who you do not want to have this
ability.

+ If there are users who existed in your Vibe system prior to Vibe 4, and you want these users to
be able to share items from their personal workspace, you must modify the workspace share
rights for these users at the user level.

You cannot grant individual users more rights than are currently defined for the site-wide setting.
To modify share rights for specific users:

1 Log in to the Vibe site as the Vibe administrator.
1a Launch a web browser.

1b Specify one of the following URLs, depending on whether you are using a secure SSL
connection:

http:// Vi be_host nanme: 8080
https:// Vi be_host nane: 8443

Replace Vi be_host nane with the hostname or fully qualified domain name of the Vibe
server that you have set up in DNS. If you configured the HTTP ports correctly during
installation, you do not need to include the port number in the Vibe URL.

Depending on how you have configured your Vibe system, you might not be required to
enter the port number in the URL. If you are using NetlQ Access Manager, the Vibe login
screen is not used.

2 Click the admin link in the upper-right corner of the page, then click the Administration Console
icon 't
3 Under Management, click Users.

4 Select the users whose sharing rights you want to manage, then click More > Workspace Share
Rights.
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k|
Set User Workspace Sharing Rights (1 users)

Allow Sharing with Allow Clear
Internal Users .
External Users .
Public .
Filr Link .

Allow Clear

Allow Re-Sharing of
granted rights

L]

5 Select the radio button in the Clear column next to the sharing right that you want to remove
from the user or group, then click OK.

or

If you have already removed a share right and you want to add it again, select the radio button
in the Allow column next to the sharing right that you want to add to the user or group, then
click OK.

Enabling Sharing on Workspaces

After sharing has been enabled for users on your Vibe site (as described in “Enabling Users to Share”
on page 130), you can enable sharing for the top-level Global and Team workspaces in order for
users to be able to share content from those workspaces. You or workspace owners can then enable
sharing on lower-level workspaces on an individual basis.

+ “Enabling Sharing for Top-Level Global Workspaces” on page 135
+ “Enabling Sharing for Top-Level Team Workspaces” on page 137

Enabling Sharing for Top-Level Global Workspaces

1 Log in to the Vibe site as the Vibe administrator.
1a Launch a web browser.

1b Specify one of the following URLs, depending on whether you are using a secure SSL
connection:

http:// Vi be_host nane: 8080
https:// Vi be_host nane: 8443
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Replace Vi be_host nane with the hostname or fully qualified domain name of the Vibe
server that you have set up in DNS. If you configured the HTTP ports correctly during
installation, you do not need to include the port number in the Vibe URL.

Depending on how you have configured your Vibe system, you might not be required to
enter the port number in the URL. If you are using NetlQ Access Manager, the Vibe login
screen is not used.

2 Click the Workspace Tree icon £ in the Action toolbar, expand Home Workspace, then click

Global Workspaces.

3 Select all top-level workspaces by selecting the checkbox in the column header.

When all the top-level workspaces are selected, click Workspace Share Rights.
The Set Workspace Sharing Rights dialog box is displayed.

Select Allow next to any share rights that you want to grant to all the selected workspaces, and
select Clear next to any share rights you do not want to grant. Select No Change to maintain any
share rights that might already exist on any workspaces.

The following share rights are available:
Internal Users: lets users share items with internal users.
External Users: lets users share items with users external to the organization.

Users external to the organization receive an email notification with a link to the shared item,
and they can then log in to the Vibe site. For more information, see “Sharing with People
Outside Your Organization” in the OpenText Vibe 4.0.8 User Guide.

Public: lets users make items publicly available. This means that anyone with the correct URL to
the shared item can access the shared item without logging in to the Vibe site.

In addition to selecting this option, you also need to enable Guest access to the Vibe site if you
want to allow users to share items with the public. For information about how to enable Guest
access to the Vibe site, see “Setting Up Guest Access for the Vibe Site” on page 107.

File Link: lets users share a link to a file in Vibe. Any user with the link can then access the file.
However, the file is not displayed in the Public area, so users must have direct access to the link
in order to access the file.

For more information about File Links, see “Distributing a Link to a File” in the OpenText Vibe
4.0.8 User Guide.

Allow Re-Sharing of granted rights: When users share a file or folder, they can give the users
they are sharing with the ability to re-share the file or folder. The user receiving the share can
share the file only if that user has been given administrative rights to share the file or folder.

IMPORTANT: When selecting this option, be aware that if one user's access rights to an item
are removed, it does not remove the access rights of the user with whom the item was re-
shared.

For example, suppose User A shares an item with User B and grants re-share rights. User B then
shares the item with User C. If User A revokes User B's access rights to the item, User C
continues to have access to the shared item.

5 Click OK.
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Enabling Sharing for Top-Level Team Workspaces

1 Login to the Vibe site as the Vibe administrator.
1a Launch a web browser.

1b Specify one of the following URLs, depending on whether you are using a secure SSL
connection:

http:// Vi be_host name: 8080
https:// Vi be_host nane: 8443

Replace Vi be _host nanme with the hostname or fully qualified domain name of the Vibe
server that you have set up in DNS. If you configured the HTTP ports correctly during
installation, you do not need to include the port number in the Vibe URL.

Depending on how you have configured your Vibe system, you might not be required to
enter the port number in the URL. If you are using NetlQ Access Manager, the Vibe login
screen is not used.

2 Click the Browse icon & in the Action toolbar, then expand Home Workspace in the Workspace
tree.

o

Home Workspace
Global Workspaces
Personal Workspaces
Tearn Waorkspaces

The Home Workspace directory is the highest-level folder in the workspace tree, and might be
named something specific to your organization.

3 Click Team Workspaces.
The Teams page is displayed.

4 Select the top-level teams that you want to grant share rights by selecting the checkbox next to
the team name.

5 Click Team Share Rights.
The Set Team Sharing Rights dialog box is displayed.
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Set Team Sharing Rights (2 teams)

Share rights will be set for the owner

Share rights will be set for members of the team
Allow Sharing with: Allow Clear No Change
Internal Users O
External Users O
I Public . |
File Link .

Allow Clear Mo Change

Allow Re-Sharing of

. -
granted rights

Select Allow next to any share rights that you want to grant to all the selected workspaces, and
select Clear next to any share rights you do not want to grant. Select No Change to maintain any
share rights that might already exist on any workspaces (this option is displayed only when
multiple teams are selected).

The following share rights are available:
Internal Users: lets users share items with internal users.
External Users: lets users share items with users external to the organization.

Users external to the organization receive an email notification with a link to the shared item,
and they can then log in to the Vibe site. For more information, see“Sharing with People
Outside Your Organization” in the OpenText Vibe 4.0.8 User Guide.

Public: lets users make items publicly available. This means that anyone with the correct URL to
the shared item can access the shared item without logging in to the Vibe site.

In addition to selecting this option, you also need to enable Guest access to the Vibe site if you
want to allow users to share items with the public. For information about how to enable Guest
access to the Vibe site, see “Setting Up Guest Access for the Vibe Site” on page 107.

File Link: lets users share a link to a file in Vibe. Any user with the link can then access the file.
However, the file is not displayed in the Public area, so users must have direct access to the link
in order to access the file.

For more information about File Links, see “Distributing a Link to a File” in the OpenText Vibe
4.0.8 User Guide.

Allow Re-Sharing of granted rights: When users share a file or folder, they can give the users
they are sharing with the ability to re-share the file or folder. The user receiving the share can
share the file only if that user has been given administrative rights to share the file or folder.

IMPORTANT: When selecting this option, be aware that if one user's access rights to an item
are removed, it does not remove the access rights of the user with whom the item was re-
shared.
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For example, suppose User A shares an item with User B and grants re-share rights. User B then
shares the item with User C. If User A revokes User B's access rights to the item, User C
continues to have access to the shared item.

6 Click OK.

Managing Shares

As the Vibe administrator, you are in control of all shared items in the Vibe system. You can view who
has shared items, what items have been shared, what access rights have been granted via the share,
and so forth. Furthermore, you can modify share rights for existing shares or delete existing shares.

You can manage shares through a management interface, where you can filter by user, file, folder, or
all shares. Or, you can manage shares for individual folders and files as you encounter them in the
Vibe site.

Users are not notified about changes that you make to shared items.

+ “Managing Shares for the Vibe Site” on page 139
+ “Managing Individual Shares” on page 140

Managing Shares for the Vibe Site

You can manage all active shares in the Vibe system with the Manage Shares dialog box in the
administration console. You can filter shares by individual users, files, or folders. Or, you can view all
active shares in the Vibe system.
1 Login to the Vibe site as the Vibe administrator.
1la Launch a web browser.
1b Specify one of the following URLs, depending on whether you are using a secure SSL
connection:

http:// Vi be_host name: 8080
https:// Vi be_host nane: 8443

Replace Vi be _host name with the hostname or fully qualified domain name of the Vibe
server that you have set up in DNS. If you configured the HTTP ports correctly during
installation, you do not need to include the port number in the Vibe URL.

Depending on how you have configured your Vibe system, you might not be required to
enter the port number in the URL. If you are using NetlQ Access Manager, the Vibe login
screen is not used.

2 Click the admin link in the upper-right corner of the page, then click the Administration Console
icon *',

3 Under Management, click Shares.
The Manage Shares dialog box is displayed.

4 Inthe Find share items by drop-down list, select one of the following options by which you want
to manage shares:
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User: Begin typing the name of a user in the User field, then select the user name when it
appears in the drop-down list. All active shares from that user are displayed in the table.

File: Begin typing the name of a file in the File field, then select the file name when it appears in
the drop-down list. All active shares associated with that file are displayed in the table.

Folder: Begin typing the name of a folder in the Folder field, then select the folder name when
it appears in the drop-down list. Or click the Browse icon next to the Folder field and browse to
the folder. All active shares associated with that folder are displayed in the table.

Find all shares: Displays all active shares in the Vibe system.
(Optional) Change the access control settings, expiration date, and note for a shared item.

For more information about these options, see “Sharing Entries, Folders, and Workspaces” in
the OpenText Vibe 4.0.8 User Guide.

(Optional) Remove a user or group’s access to a shared item by selecting the share that you
want to remove, then clicking Delete.

7 Click OK.

Managing Individual Shares

As the administrator, you can manage shares for individual entries, folders, or workspaces as you
encounter them in the site.

1 In a workspace or folder, click the Configure icon © next to the workspace or folder title, then

click Manage Shares.

or

In a folder or an area such as your Shared with Me area, click the drop-down arrow @ next to
the entry, then click Manage Shares

The Manage Shares dialog box is displayed.
(Optional) Change the access control settings, expiration date, and note for a shared item.

For more information about these options, see “Sharing Entries, Folders, and Workspaces” in
the OpenText Vibe 4.0.8 User Guide.

(Optional) Remove a user or group’s access to a shared item by selecting the share that you
want to remove, then clicking Delete.

4 Click OK.
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Allowing Access to the Vibe Site through
NetlQ Access Manager

To allow access to the Vibe site through NetlQ Access Manager, you need to make configuration
changes in NetlQ Access Manager to configure a protected resource for a Vibe server as described in
“Configuring a Protected Resource for a Vibe Server” on page 141.

IMPORTANT: When NetlQ Access Manager (or another single sign-on tool) is used in conjunction
with your Vibe system, external users and the Guest user cannot access your Vibe site.

For more information about external users in Vibe, see “Understanding External Users” on page 129.

Configuring a Protected Resource for a Vibe Server

The following sections explain how to configure the Access Gateway with a domain-base multi-
homing service. The instructions assume that you have a functioning Vibe server on Linux and a
functioning Access Manager system (3.1 SP1 IR1 or higher) with a reverse proxy configured for SSL
communication between the browsers and the Access Gateway.

The Vibe server needs to be configured to trust the Access Gateway to allow single sign-on with
Identity Injection and to provide simultaneous logout. You also need to create an Access Gateway
proxy service and configure it.

+ “Configuring the Vibe Server to Trust the Access Gateway” on page 141

+ “Configuring a Reverse-Proxy Single Sign-On Service for Vibe” on page 143

+ “Forwarding Cache Control Headers” on page 147

For information on other possible Access Gateway configurations, see “Teaming 2.0: Integrating with
Linux Access Gateway” (http://www.novell.com/communities/node/9580/teaming-20-integration-
linux-access-gateway).

Configuring the Vibe Server to Trust the Access Gateway

To use Vibe as a protected resource of an Access Gateway and to use Identity Injection for single
sign-on, the server needs a trusted relationship with the Access Gateway. With a trusted
relationship, the Vibe server can process the authorization header credentials. The Vibe server
accepts only a simple user name (such as userl) and password in the authorization header.

This section explains how to set up the trusted relationship and how to enable simultaneous logout,
so that when the user logs out of Vibe, the user is also logged out of the Access Gateway.

To configure the trusted relationship:

1 Login to the Vibe server.

2 Stop the Vibe server with the following command:
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/etc/init.d/team ng stop
3 Runtheinstaller-team ng.!|inux script.
4 Accept the license agreement, then select Reconfigure settings, then click Next.
5 Confirm that your Vibe server is shut down, then select Advanced installation, then click Next.
6 Continue through the installation program until you reach the Network Information page.

Ensure that you have a valid Host name specified. You will need this later in the installation.

Network Information

Specify how you want Novell Vibe to communicate on the network, N

You must specify a valid fully qualified domain name (FQDN) in order for remote clients and services to connect to your
Vibe site,

If installing in a clustered environment, it is important to enter identical set of network information for all the Vibe
nodes that are members of the duster. You must enter the DNS name that end users use to access Vibe services
rather than the DMS name of the individual Vibe node.

Host: |vibe novell,com
HTTP Port: |50
Secure HTTP port: '-H3—
Listen port: |30a0
Secure listen port: 'S-HE—
Shutdown port: 3005
APpert gooe
Session timeout |240

Keystore file

7 Continue through the installation program until you reach the Reverse Proxy Configuration
page. Specify the following configuration options:

Enable Access Gateway: Select this option to enable the reverse proxy access gateway.

Access Gateway address(es): Specify the IP address of the Access Gateway that is used for the
connection to the Vibe server.

If the Access Gateway is part of a cluster, add the IP address for each cluster member. Wildcards
such as 164.99.*.* are allowed.

When you specify IP addresses in this option, Vibe logins are allowed only from the specified
addresses. Also, if Authorization header credentials are not present or are incorrect, the user is
prompted for login using Basic Authentication.

Logout URL: Specify the URL of the published DNS name of the reverse proxy that you have
specified for the ESP, plus / AGLogout .

You can find the domain used for the ESP by editing the LAG/MAG cluster configuration, then
clicking Reverse Proxy / Authentication.

For example, if the published DNS name of the proxy service that you have specified for the ESP
is esp. your si t e. com specify the following URL:

https://esp.yoursite.com AG.ogout

Use Access Gateway for WebDAV connections: Leave this option unselected.
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Reverse Proxy Configuration

Configure the following settings if using Movell Vibe with Movell Access Manager. N

Select ‘Enable Access Gateway' when user access to the Movell Vibe server is provided through Access Gateway.

'Access Gateway address(zs)' is 5 comma separated list of IP addresses used by the Access Gateway(s) for connection
to the Movell Vibe server.

'Logout URL' is the logout URL of the Access Gateway for the purpose of simultaneous logout. Examples: http:/f<DNS
name of Access Gateway proxy service = fAGLogout or http: f/f<IP address of Movell Vibe server =: <port =fAGLogout

Select 'Use Access Gateway for WebDAY connections' if WebDAY connections will be routed through a separate proxy
service, (Mot reguired with Movell Access Manager.)

"WebDAY Access Gateway address' is the DMS name used for WebDAY connections, Example; webday.company.name

¥ Enable Access Gateway

Access Gateway address(es) |13?.-55.-55. 111

Logout URL |ht1q35 :ffesp.novell.comfAGLogout

[ Use Access Gateway for WebDAY connections

WebDAV Access Gateway address [webdav.company.com

8 Continue through the installation program to complete the reconfiguration process.
9 Start the Vibe server with the following command:
/fetc/init.d/teaming start

10 Continue with “Configuring a Reverse-Proxy Single Sign-On Service for Vibe” on page 143.

Configuring a Reverse-Proxy Single Sign-On Service for Vibe

To configure a reverse-proxy single sign-on service for Vibe, complete the following tasks:

+ “Creating a New Reverse Proxy” on page 143

+ “Configuring the Domain-Based Proxy Service” on page 144
¢ “Creating Policies” on page 144

+ “Configuring Protected Resources” on page 145

+ “Disabling a Rewriter Profile” on page 147

Creating a New Reverse Proxy

Before you can configure the domain-based proxy service, you need to create a new reverse proxy.
For information on how to create a reverse-proxy, see “Managing Reverse Proxies and
Authentication” in the Net/Q Access Manager Administration Guide.

Configuring the Domain-Based Proxy Service

1 Inthe Administration Console, click Devices > Access Gateways > Edit, then click the name of the
reverse proxy that you created in “Creating a New Reverse Proxy” on page 143.

2 Click the reverse proxy link that you have previously created. In the Reverse Proxy List, click New,
then fill in the following fields:
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Proxy Service Name: Specify a display name for the proxy service that the Administration
Console uses for its interfaces.

Published DNS Name: Specify the DNS name you want the public to use to access your site.
This DNS name must resolve to the IP address you set up as the listening address. For example,
vi be. doc. provo. Novel | . com

Web Server IP Address: Specify the IP address of the Vibe server.
Host Header: Select the Forward received host name.

Web Server Host Name: Because of your selection in the Host Header field, this option is
dimmed.

3 Click OK.

Click the newly added proxy service, then select the Web Servers tab.

5 Make sure that Enable Session Stickiness is selected.

Otherwise, users will get | nval i d RPC t oken errors when two or more Vibe servers are
online.

Select the check box Connect Using SSL to enable SSL and apply the certificate.

7 Change the Connect Port to 8080.

9
10

If the Linux Vibe server has port forwarding enabled, you do not need to change from the
default port 80.

NOTE: Change the Connect Port to 8443, If you need to change from the default port 443.

Click TCP Connect Options.
Click OK.

Continue with “Configuring Protected Resources” on page 145.

Creating Policies

There are two policies that you need to create, LDAP Identity Injection, and X-Forwarded-Proto:

*

*

“Creating the LDAP Identity Injection Policy” on page 144
“Creating the X-Forwarded-Proto HTTP Header Policy” on page 145

Creating the LDAP Identity Injection Policy

1
2
3

In the Administration Console, click Policies > Policies.
Select the policy container, then click New.

Specify | dap_aut h as the name for the policy, select Access Gateway: Identity Injection for the
type, then click OK.

(Optional) Specify a description for the injection policy. This is useful if you plan to create
multiple policies to be used by multiple resources.

5 In the Actions section, click New, then select Inject into Authentication Header.

Fill in the following fields:
User Name: Select Credential Profile > LDAP User Name.

Password: Select Credential Profile > LDAP Password.
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7 Leave the default value for the Multi-Value Separator, which is comma.
8 Click OK.
9 To save the policy, click OK, then click Apply Changes.

For more information on creating such a policy, see “Configuring an Authentication Header
Policy” in the NetlQ Access Manager Appliance 4.2 Administration Guide.

Creating the X-Forwarded-Proto HTTP Header Policy

When communicating over HTTPS from the browser to Access Manager, and over HTTP from Access
Manager to Vibe, the X-Forwarded-Proto is a best practice. Vibe 3.3 was enhanced to take advantage
of the HTTP header X-Forwarded-Proto.

1 In the Administration Console, click Policies > Policies.

2 Select the policy container, then click New.

3 Specify x- f or war ded as the name for the policy, select Access Gateway: Identity Injection for
the type, then click OK.

4 (Optional) Specify a description for the injection policy. This is useful if you plan to create
multiple policies to be used by multiple resources.

5 In the Actions section, click New, then select Inject into Custom Header.
6 Fill in the following fields:
Custom Header Name: Specify X- For war ded- Pr ot 0 as the name.
Value: Select String Constant in the drop-down, then specify ht t ps.
7 Leave the other settings at the defaults.
8 Click OK.
9 To save the policy, click OK, then click Apply Changes.

For more information on creating such a policy, see “Configuring an Identity Injection Policy” in
the NetlQ Access Manager Appliance 4.2 Administration Guide.

Configuring Protected Resources

You need to create three protected resources, one for HTML content, one for WebDAV content, and
a public:
1 Create a protected resource for HTML content:

1a In the Protected Resource List, click New, specify Basi ¢ auth with redirection for
the name, then click OK.

1b (Optional) Specify a description for the protected resource. You can use it to briefly
describe the purpose for protecting this resource.

1c Specify a value for Authentication Procedure. For example, select the Secure Name/
Password - Form contract.

1d Click the Edit icon.
1le Inthe dialog box that is displayed, fill in the following fields.

Contract: Select the Secure Name/Password - Form contract, which is same contract that
you selected for the HTML content protected resource.
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Non-Redirected Login: Select this option.

Realm: Specify a name that you want to use for the Vibe server. This name does not
correspond to a Vibe configuration option. It appears when the user is prompted for
credentials.

Redirect to Identity Server When No Authentication Header is Provided: Select this
option.
1f Click OK twice.
2 Create a public protected resource for web Services:
2a In the Protected Resource List, click New, specify publ i ¢ for the name, then click OK.

2b (Optional) Specify a description for the protected resource. You can use it to briefly
describe the purpose for protecting this resource.

2c For the Authentication Procedure, select None.
2d Click OK.
2e Inthe URL Path List, remove the / * path and add the following paths:

/ ssf/atomn *

/ssflicall*

[ ssf/lws/*

/ssflrss/* - enables non-redirected login for RSS reader
connecti ons.

I ssflslreadFil el share/*

/ssrl*

Irest/*

| ssflapplets/fileopen/* - enables Edit this file functionality
/ downl oads/* - enables dient Downl oads page

/ dave/ *

The /ssf/rss/* path enables non-redirected login for RSS reader connections. Vibe
provides authentication for all of the paths listed above.
2f Click OK.
3 Create a protected resource for WebDAV content:

3a In the Protected Resource List, click New, specify Basi ¢ auth w t hout redirection
for the name, then click OK.

3b (Optional) Specify a description for the protected resource. You can use it to briefly
describe the purpose for protecting this resource.

3c Specify a value for Authentication Procedure. For example, select the Secure Name/
Password - Basic contract.

3d Click the Edit icon.
3e In the dialog box that is displayed, fill in the following fields.

Contract: Select the Secure Name/Password - Form contract, which is same contract that
you selected for the HTML content protected resource.

Non-Redirected Login: Select this option.

Realm: Specify a name that you want to use for the Vibe server. This name does not
correspond to a Vibe configuration option. It appears when the user is prompted for
credentials.
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Redirect to Identity Server When No Authentication Header is Provided: Do not select
this option.

3f In the URL Path List, remove the / * path and add the following path:

[ dav/ *
[ davs/ *

3g Click OK twice.
Assign the X-Forward-Proto Header policy to all three protected resources that you created:

4a Click Access Gateways > Edit > [Name of Reverse Proxy] > [Name of Proxy Service] >
Protected Resources.

4b For each Vibe protected resource, click the Identity Injection link, select the x-forward
policy that you created, click Enable, then click OK.

4c Click OK.

Assign the Identity Injection policy to two of the protected resources that you created,
specifically Basic auth with redirection and Basic auth without redirection. Do not assign this
policy to the public protected resource.

5a Click Access Gateways > Edit > [Name of Reverse Proxy] > [Name of Proxy Service] >
Protected Resources.

5b For each Vibe protected resource, click the Identity Injection link, select the Idap_auth
policy that you created, click Enable, then click OK.

5c Click OK.
To save the configuration changes, click Devices > Access Gateways, then click Update.
In the Protected Resource List, ensure that the protected resources you created are enabled.
To apply your changes, click Devices > Access Gateways, then click Update.

Continue with “Disabling a Rewriter Profile” on page 147.

Disabling a Rewriter Profile

In the Proxy Service List, ensure that the HTML Rewriter is disabled.

Forwarding Cache Control Headers

The recommended configuration for Vibe is to configure Access Manager to forward cache control
headers to the browser. For information on how to forward cache control headers to the browser,
see “Controlling Browser Caching” in the Net/Q Access Manager Appliance 4.2 Administration Guide.
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Providing File Access and Editing for Vibe
Users

Vibe includes four file-access methods and applications.

Use the following information to understand the methods, distribute the related applications to
users, and configure Vibe to support the methods you provide.

+ “Vibe Desktop Application for Windows and Mac” on page 149

+ “Vibe Add-in for Microsoft Office:” on page 161

+ “Web Browser Access to Files Through Edit-in-Place” on page 161

+ “Mobile App Access to Files” on page 163

+ “Distributing File-Access Applications to Users” on page 163

Vibe Desktop Application for Windows and Mac

The Vibe desktop lets users synchronize files on the Vibe server with their computer’s local file
system. Changes made to local copies are synchronized with the server, and changes made by others
to files on the server are synchronized with local copies.

As a Vibe administrator, you must enable file synchronization for the Vibe Desktop in order for users
to take advantage of this functionality. There are also optional administrative procedures that you
might want to perform when configuring Vibe Desktop.

For more information about Vibe Desktop usage, see the Vibe Desktop for Windows Quick Start
(http://www.novell.com/documentation/vibe4/vibe4d qs_desktop/data/vibe4 _gs_desktop.html)
and the Vibe Desktop for Mac Quick Start (http://www.novell.com/documentation/vibe4/

vibe4 gs_desktopmac/data/vibe4_gs_desktopmac.html).

To enable Vibe Desktop usage, complete the instructions in the following sections:

+ “Providing Access to the Vibe Desktop Application” on page 149

+ “Vibe Desktop—Server Configuration” on page 150

+ “Vibe Desktop—Windows Configuration” on page 153

+ “Load Balancing Vibe Desktop and the Vibe Add-In for MS Office Traffic” on page 159

Providing Access to the Vibe Desktop Application

To provide users with download access to the Vibe Desktop Application software, you must:

1. Follow the instructions in “Distributing File-Access Applications to Users” on page 163.

2. Complete the applicable steps in the sections that follow.
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Vibe Desktop—Server Configuration

Vibe Desktop usage is not enabled by default.

You must enable usage (and optionally specify certain limits) as explained in the following sections:

*

*

*

*

*

“Configuring the Vibe Desktop Application for All Users” on page 150
“Configuring Vibe Desktop for Individual Users and Groups” on page 151
“Configuring the Maximum File Size Limit for Vibe Desktop” on page 152
“Configuring the Maximum File Size Limit for Uploading Files” on page 152

“Configuring the Maximum File Size Limit for Uploading and Downloading Files” on page 153

Configuring the Vibe Desktop Application for All Users

To enable this functionality for the Vibe site:

1 In Vibe, click your linked name in the upper right corner of the page, then click the

Administration Console icon "',
Under System, click Desktop Application.
In the Configure Desktop Application dialog box, specify the following information:

Access Vibe: lets users access the Vibe site through the Vibe desktop application.

NOTE: Depending on the amount of anticipated load that the Vibe desktop application will put
on your Vibe system, you might want to make the application available to users in a staged
process.

Allowing access to the Vibe site through the Vibe desktop application can be changed on a per-
user basis, as described in “Configuring Vibe Desktop for Individual Users and Groups” on
page 151.

Cache the user’s password: lets users enable the Remember password option on the Account
Information page in the Vibe Console.

This option can be changed on a per-user basis, as described in “Configuring Vibe Desktop for
Individual Users and Groups” on page 151.

Be deployed: Select this option to make the Vibe desktop application available to users. If this
option is selected, users can download the Vibe desktop application as described in
“Downloading and Installing Vibe Desktop (https://www.novell.com/documentation/vibe4/
vibed gs_desktop/data/vibe4_qgs_desktop.html#bwrkOll)” in the Vibe Desktop Quick Start for
Windows (https://www.novell.com/documentation/vibe4/vibe4 qgs_desktop/data/
vibed_qs_desktop.html) or the Vibe Desktop Quick Start for Mac (https://www.novell.com/
documentation/vibe4/vibe4_qs_desktopmac/data/vibed qs_desktopmac.html). If this option
is not selected, the link to download the Vibe desktop application is not visible to users.

NOTE: You might want to leave the Be deployed option deselected if you plan to deploy Vibe
Desktop to user workstations by using client management software such as ZENworks. The
. nei file is available to you if you are planning to deploy Vibe Desktop by using ZENworks.

For more information about how to deploy Vibe by using the . nsi file, see “Vibe Desktop—
Windows Configuration” on page 153.
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Auto-update URL: Specify the HTTP server where the applications download page is located.
This is also where Vibe Desktop can check for Vibe Desktop updates.

You can configure your Vibe server to be the HTTP server that provides auto-update
information, or you can configure a separate web server to provide the auto-update
information.

If you configure the Vibe server for this purpose, the auto-update URLis htt ps://
vi be_host nane: 8443/ downl oads.

For information about how to set up a separate web server to deploy the application, see
“Providing Application Downloads from a Non-Vibe Web Server” on page 165. Select this
option if your Vibe system is clustered or fronted by an L4 or L10 switch.

If this option is selected, the available field must be populated with the URL of the web server
that you configure for deploying the desktop application.

Synchronization every xx Minutes: Specify the interval (in minutes) for how often the Vibe
Desktop checks Vibe for changes to files. The default is every 15 minutes. This means that 15
minutes after one synchronization ends, another begins. This lets you control the amount of
load Vibe Desktop puts on the Vibe server.

Changes made in the desktop application are automatically synchronized to the server
regardless of this setting.

Maximum file size that can be synchronized: Specify the maximum file size (in MB) that can be
synchronized between the Vibe desktop application and the Vibe server.

4 Click OK.
Users need to download, install, and configure Vibe Desktop on their personal computers. For more
information, see the Vibe Desktop Quick Start for Windows (https://www.novell.com/
documentation/vibe4/vibe4 qs_desktop/data/vibe4 gs_desktop.html) or the Vibe Desktop Quick

Start for Mac (https://www.novell.com/documentation/vibe4/vibe4 qgs_desktopmac/data/
vibed gs_desktopmac.html).

Configuring Vibe Desktop for Individual Users and Groups

Individual user and group settings override global settings. This section describes how to customize
the desktop application experience for individual users and groups on your Vibe system.

To make the desktop application available to only a subset of users in your system, configure the
application for all users, as described in “Configuring the Vibe Desktop Application for All Users” on
page 150, then restrict access to the users and groups who should not have access to the
application, as described in this section.
1 In Vibe, click the admin link in the upper-right corner of the page, then click the Administration
Console icon %',
2 Under Management, click Users.
The Manage Users page is displayed.

3 Select the check boxes next to the names of the users or groups for whom you want to
configure Vibe Desktop, then click More > Desktop Application Settings.

The Configure Desktop Application page is displayed.
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4 To change the desktop application settings for the selected users to be different from the global
settings, select Use user settings to allow the desktop application to, then choose from the
following options:

Access Vibe: lets users access the Vibe site through the Vibe desktop application.

Cache the user’s password: lets users enable the Remember password option on the Account
Information page in the Vibe Console.

5 Click OK.
If you have set individual and group settings for Vibe Desktop, you can change those settings back to
the global settings for the individual users and groups.
1 In Vibe, click the admin link in the upper-right corner of the page, then click the Administration
Console icon '+,
2 Under Management, click User Accounts.
The Manage Users page is displayed.

3 Select the check boxes next to the names of the users or groups for whom you want to
configure Vibe Desktop, then click More > Desktop Application Settings.

The Configure Desktop Application page is displayed.

4 To change the desktop application settings back to the global settings for the selected users,
select Use global settings.

5 Click OK.

Configuring the Maximum File Size Limit for Vibe Desktop

By default, Vibe Desktop does not upload or download any file that exceeds 1 GB.

If a file size limit has already been set for uploading files to the Vibe site (as described in “Setting a
File Upload Size Limit for Individual Users and Groups” on page 261), whichever limit is more
restrictive is honored by Vibe Desktop.

For example, if you set a file size limit in Vibe of 500 MB and the maximum file size limit for Vibe
Desktop is set at 2 GB, users cannot upload files bigger than 500 MB to the Vibe site either by
accessing the Vibe site directly or by uploading files through Vibe Desktop.

Configuring the Maximum File Size Limit for Uploading Files

To restrict the size of files that are uploaded to the Vibe site outside of Vibe Desktop (such as by
accessing Vibe through a browser, through the Vibe Add-in, or through WebDAV), as well as through
Vibe Desktop (while keeping the default 1 GB file size limit for files that are downloaded through
Vibe Desktop), use the Vibe administration console to modify this setting, as described in “Managing
the File Upload Size Limit” on page 260.
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Configuring the Maximum File Size Limit for Uploading and Downloading
Files

You can increase or decrease the file size limit for files that are both uploaded and downloaded to
and from the Vibe site through Vibe Desktop.

Modifying the property as described in this section does not affect a user’s ability to upload
documents to Vibe outside of Vibe Desktop (such as by accessing Vibe through a browser, through
the Vibe Add-in, or through WebDAV).

1 Change to the following directory:

Linux: / opt/ novel | / t eam ng/ apache-tontat/
webapps/ ssf/WEB- | NF/ cl asses/ config

Windows: c¢:\Program Fi | es\ Novel | \ Teani ng\ apache-t oncat\
webapps\ ssf\ WEB- | NF\ cl asses\ config

2 Make a backup copy of the ssf - ext . properti es file, which is located in the same directory
as the ssf. properti es file.

3 Openthe ssf. properti es file in a text editor.

4 Search for the following line:
fsa.max.file.size=

5 Openthe ssf-ext. properti es file in a text editor.

6 Copythefsa. max. fil e.size=line fromthe ssf. properti es file to the bottom of the
ssf-ext. properti es file.

7 Change the value of this property to the file size (in bytes) that represents the maximum file size
that you want Vibe Desktop to upload to the Vibe site and download from the Vibe site. For
example, if you want Vibe Desktop to be able to upload and download only 500 MB files, the
line would read f sa. max. fil e.si ze=536870912.

8 Save and close the ssf - ext. properti es file.
9 Close the ssf. properti es file without saving it.
10 Stop and restart Vibe.

Vibe Desktop—Windows Configuration

+ “Preparing Workstations for Client-Management Software” on page 154

+ “Customizing the Installation for the Vibe Desktop Application” on page 154

+ “Controlling Windows Explorer Restart” on page 157

+ “Integrating Windows Authentication with Vibe Desktop and the Vibe Add-In” on page 158
+ “Configuring Vibe Desktop to Access Your Vibe Site (Windows)” on page 158
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Preparing Workstations for Client-Management Software

You can manage the Vibe desktop application on users’ workstations with client-management
software such as ZENworks.

When following the instructions in this section, you must use the . nsi file, which is bundled in the
M cr oFocusVi be- conbo- 4. 0. x. t gz file, and is available at the Novell Downloads site (https://
download.novell.com/).

If you use the . nsi file to distribute the Vibe desktop application to user workstations, you need to
install the following items to each user workstation, independent of the Vibe software:

+ Microsoft .NET Framework 4.5 (Applies to 64-bit Windows and Mac workstations.)
You can download Microsoft .NET Framework 4.5 from the Microsoft .NET Downloads page
(http://www.microsoft.com/net/downloads).

+ Microsoft Visual C++ 2013 Redistributable Package (Applies to all workstations)

You can download the redistributable package from the Microsoft Download Center (https://
www.microsoft.com/en-us/download/details.aspx?id=40784).

NOTE: The ability to manage the Vibe desktop application is available only with Vibe desktop 1.0.2
and later.

Customizing the Installation for the Vibe Desktop Application

You can customize the installation process of the Vibe desktop application for your organization in
the following ways:

+ Configure default values for each installation option of the Vibe desktop application. (Users can
change these default values when configuring the Vibe desktop application.)

+ Auto-configure all values for each installation option of the Vibe desktop application. (Users
specify only their user name and password when configuring the Vibe desktop application;
users cannot change the default values during initial configuration.)

+ Disallow users from modifying configuration options in the Vibe desktop application. (Users
cannot change the default values during initial configuration, and cannot modify the values via
the Vibe console after initial configuration.)

NOTE: This does not prevent users from manually modifying configuration settings in the
registry or file system.

The following sections describe how to make these customizations.

+ “Configuring Default Values” on page 155
+ “Enabling Auto-Configuration” on page 156
+ “Disallowing User Configuration” on page 156

+ “Modifying the Vibe Desktop Configuration” on page 157
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Configuring Default Values

You can configure the default values for each installation option of the Vibe desktop application.
Users can change these default values when configuring the Vibe desktop application.

You accomplish this on Windows by creating registry values, and on Mac by adding properties to the
application’s | nf 0. pl i st file.
1 Windows: Access the following location where you will create registry values:
\'\ HKLM Sof t war e\ Novel | \ Vi be

Mac: Access the | nf 0. pl i st file where you will add properties. This file is usually in the
following location:

/ Appl i cati ons/ Novel | Vi be/ Contents/Info.plist

2 Create Windows registry values and add properties to the | nf 0. pl i st file for the values for
which you want to configure defaults.

The following table displays the available options for configuring default values.

Table 9-1 Default Value Configuration Options

Windows Value Type Mac Property Name Value Type Supports Default Value
Registry Value Env
Name Variables
Default Server  REG_SZ VibeDefaultServerURL  string No https://
URL
Default REG_SZ VibeDefaultUsername string Yes %USERNAME%
Username
or
SUSER
Default Account REG_SZ VibeDefaultAccountNa string No Hostname in
Name me server URL
Default REG_SZ (“true”  VibeDefaultRemember <true/>or No false
Remember or “false”) Password <false/>
Password
Default Sync Dir REG_SZ VibeDefaultSyncDir string Yes %USERNAME%\
Vibe
or
SUSER\Vibe
Default Start On REG_SZ (“true”  VibeDefaultStartOnLog <true/> or No true
Login or “false”) in <false/>
Default Folder REG_MULTI_SZ VibeDefaultFolderList  Array of strings  No My Files
List

Shared with Me
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Enabling Auto-Configuration

After you have configured default values for the Vibe desktop application installation, you can
enable auto-configuration. When auto-configuration is enabled, users cannot change the default
values during initial configuration. (Users specify only their user name and password when
configuring the Vibe desktop application.)

You accomplish this on Windows by creating registry values, and on Mac by adding properties to the
application’s I nf 0. pl i st file.
1 Windows: Access the following location where you will create registry values:
\\ HKLM Sof t war e\ Novel I'\ Vi be

Mac: Access the | nf 0. pl i st file where you will add properties. This file is usually in the
following location:

/ Applications/ Novel | Vibel/Contents/Info.plist

2 Create Windows registry values and add properties to the | nf 0. pl i st file for the values for
which you want to configure defaults.

The following table displays the available options for auto-configuration.

Table 9-2 Auto-Configuration Options

Windows Value Type Mac Property Value Type Supports Env Default

Registry Value Name Variables Value

Name

Auto Configure  REG_SZ (“true” or VibeAutoConfigur <true/> or <false/ No false
“false”) e >

Disallowing User Configuration

You can disallow users from modifying configuration options in the Vibe desktop application. This
means that users cannot change the default values during initial configuration, and they cannot
modify the values via the Vibe console after initial configuration.

NOTE: This does not prevent users from manually modifying configuration settings in the registry or
file system.

You accomplish this on Windows by creating registry values, and on Mac by adding properties to the
application’s I nf 0. pl i st file.
1 Windows: Access the following location where you will create registry values:
\'\ HKLM Sof t war e\ Novel I\ Vi be

Mac: Access the | nf 0. pl i st file where you will add properties. This file is usually in the
following location:

/ Applications/ Novel |l Vibel/Contents/Info.plist

2 Create Windows registry values and add properties to the | nf 0. pl i st file for the values for
which you want to configure defaults.

The following table displays the available options for disallowing user configuration.
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Table 9-3 Disallow User Configuration Options

Windows Value Type Mac Property Name Value Type Supports Default
Registry Value Env Value
Name Variables

Allow User REG_SZ (“true”  VibeAllowUserConfigurati <true/> or <false/ No true
Configuration or “false”) on >

Modifying the Vibe Desktop Configuration

If you have configured the Vibe desktop application with auto-configuration (as described in
“Enabling Auto-Configuration” on page 156), you can modify the configuration settings:
1 Change the options in the registry or . pl i st file, then restart the Vibe desktop application.

When the Vibe desktop application starts, it detects that the default settings have changed and
applies the new settings.

NOTE: The one exception is that the synchronization directory cannot be changed after the Vibe
desktop application has been configured.

Controlling Windows Explorer Restart

The Vibe desktop application for Windows includes overlay icons that do not appear until Windows
Explorer is restarted. In previous versions of the Vibe desktop application, the Windows . nsi always
restarted Windows Explorer during the installation (except when using the No Ul option). Because
restarting Explorer might not always be desirable, the Vibe desktop application lets you override the
default.

The Windows installer supports four basic user interface levels for installing M5l files:
+ No Ul (“msiexec /gn”)

Windows Explorer is never restarted when using this option.
+ Basic Ul (“msiexec /gb”)
+ Reduced Ul (“msiexec /qr”)

+ Full Ul (“msiexec /gf” or simply “msiexec”, since this is the default)

For example, use the following command to install the M5l with basic Ul and without restarting
Windows Explorer:

nei exec /qb /i Novel |l Vi be-version. msi RESTARTEXPLORER=no
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Integrating Windows Authentication with Vibe Desktop and the Vibe
Add-In

If your Vibe server is configured with Integrated Windows Authentication, Vibe Desktop cannot
synchronize files on your Vibe site because of a port conflict.

To work around this issue:

1 Configure Vibe Desktop and the Vibe Add-in to point directly to Tomcat’s secure port (by
bypassing port 80 and port 443) in the Vibe Desktop and Vibe Add-in installation programs.

For more information about configuring Windows Authentication for your Vibe site, see
“Configuring Single Sign-On with Internet Information Services for Windows"” in the OpenText Vibe
4.0.8 Installation Guide.

Configuring Vibe Desktop to Access Your Vibe Site (Windows)

If you use application management software, such as ZENworks, to deploy Vibe Desktop to user
workstations, you can also prepopulate Vibe Desktop with your organization’s Vibe server URL. This
saves users from specifying the Vibe server URL when they are configuring Vibe Desktop on their
individual workstations.

To configure Vibe Desktop in this way, you must accomplish the tasks in either of the following
sections as part of the deployment process of Vibe Desktop to user workstations with your
application management software:

+ “Setting the VIBEURL Windows Installer Property” on page 158
¢ “Writing the Vibe Server URL to the Registry” on page 158

Setting the VIBEURL Windows Installer Property

You can prepopulate Vibe Desktop with the URL of your organization’s Vibe server by specifying the
VIBEURL Windows Installer property when Vibe Desktop is installed.

The exact steps for specifying the Windows Installer property differ depending on the application
management software you are using to deploy Vibe Desktop to user workstations; however, the
following command illustrates how to perform a silent installation of Vibe Desktop and prepopulate
Vibe Desktop with the URL of your organization’s Vibe server:

nei exec /i Novel | Vi beDeskt op. nsi /qui et VIBEURL=https://vibe.nyconpany.com

Writing the Vibe Server URL to the Registry

You can prepopulate Vibe Desktop with the URL of your organization’s Vibe server by writing the
Vibe server URL directly to the registry after Vibe Desktop is installed.

The exact steps for writing the Vibe server URL to the registry differ depending on the application
management software you are using to deploy Vibe Desktop to user workstations; however, in

\\ HKEY_LOCAL_MACHI NE\ Sof t war e\ Novel | \ Vi be Deskt op you must set the Def aul t
Server URL string value to your organization’s Vibe server URL.
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Load Balancing Vibe Desktop and the Vibe Add-In for MS Office
Traffic

NOTE: Load balancing instructions for Vibe Desktop and the Vibe Add-in for MS Office are included
together because of overlaps. This does no imply, however, that the two must be offered or used
together.

Vibe Desktop and Vibe Add-in for MS Office can cause a large amount of traffic on the Vibe servers.
To prevent the Vibe Desktop and the Vibe Add-in synchronization process or the Vibe site from
becoming slow, you can distribute Vibe Desktop and Vibe Add-in traffic among dedicated Vibe
servers with your load balancer or reverse proxy server.

For example, if you have a Vibe installation with five servers, you could dedicate one server to
handle Vibe Desktop traffic, one server to handle Vibe Add-in traffic, and use the remaining three
servers to serve the main Vibe web application. This configuration prevents an unusual spike in Vibe
Desktop traffic or Vibe Add-in traffic from impacting the Vibe site.

You can distribute Vibe Desktop traffic and Vibe Add-in traffic differently, depending on whether you
want traffic from all applications (not just Vibe Desktop and Vibe Add-in) that are accessing Vibe to
be handled in the same way, or whether you want Vibe Desktop traffic and Vibe Add-in traffic to be
handled independently from each other and from other applications that are accessing Vibe.

+ “Distributing Vibe Desktop Traffic Separately from Other Applications” on page 159

+ “Distributing Vibe Add-In Traffic Separately from Other Applications” on page 160

+ “Distributing Vibe Desktop and Vibe Add-In Traffic in Conjunction with Other Applications” on
page 160

+ “Load Balancer and Reverse Proxy Server Configuration” on page 160
Distributing Vibe Desktop Traffic Separately from Other Applications
You can configure your load balancer or reverse proxy server to distribute Vibe Desktop

synchronization traffic among multiple Vibe servers. Vibe Desktop traffic is independent of traffic
from other applications that are accessing Vibe.

NOTE: Your load balancer or reverse proxy server must be able to make routing decisions based on
the request headers.

1 Configure your load balancer or reverse proxy server to use the user agent request header. For
Vibe Desktop, the request header begins with Novel | Vi beDeskt op. For example: User -
Agent: Novel | Vi beDesktop/ 1.0 (Wndows NT 6.1; Python/2.7.0; en_US)
suds/ 0. 4.

For specific information on how to configure the load balancer or reverse proxy server, see
“Load Balancer and Reverse Proxy Server Configuration” on page 160.
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Distributing Vibe Add-In Traffic Separately from Other Applications

You can configure your load balancer or reverse proxy server to distribute Vibe Add-in
synchronization traffic among multiple Vibe servers. Vibe Add-in traffic is independent of traffic
from other applications that are accessing Vibe.

NOTE: Your load balancer or reverse proxy server must be able to make routing decisions based on
the request headers.

1 Configure your load balancer or reverse proxy server to use the user agent request header. For
Vibe Add-in, the request header begins with Novel | Vi beDeskt op. For example: User -
Agent: Novel | Vi beMsoAddin/ 1.0 (W ndows NT 6. 1.7601. 65536; .NET
Framewor k 4.0.30319. 239; en_US)

For specific information on how to configure the load balancer or reverse proxy server, see
“Load Balancer and Reverse Proxy Server Configuration” on page 160.

Distributing Vibe Desktop and Vibe Add-In Traffic in Conjunction with
Other Applications

You can configure your load balancer or reverse proxy server to distribute Vibe Desktop and Vibe
Add-in synchronization traffic (along with traffic coming from all other applications that use the Vibe
web service interface) among multiple Vibe servers.

Examples of other applications that use the Vibe web service interface are:

+ GroupWise client SOAP requests
+ All other SOAP requests from third-party applications

NOTE: Your load balancer or reverse proxy server must be able to make routing decisions based on
the HTTP URL path.

1 Configure your load balancer or reverse proxy server to send all Vibe Desktop HTTP requests
(designated by the following paths / ssf/ ws/ Teami ngSer vi ceV1 and/rest/*) to one pool
of Vibe servers.

All other requests are sent to another pool of Vibe servers.

For specific information on how to configure the load balancer or reverse proxy server, see
“Load Balancer and Reverse Proxy Server Configuration” on page 160.
Load Balancer and Reverse Proxy Server Configuration

For information on how to configure a load balancer for your Vibe site, see any of the following
sections, depending on the type of load balancer you want to use:

+ “Configuring Apache as a Load Balancer” in “Running Vibe on Multiple Servers” in the OpenText
Vibe 4.0.8 Installation Guide.
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+ “Configuring Linux Virtual Server as a Load Balancer” in “Running Vibe on Multiple Servers” in
the OpenText Vibe 4.0.8 Installation Guide.

+ “Configuring IIS to Load Balance in a Clustered Environment” in “Configuring Single Sign-On
with Internet Information Services for Windows” in the OpenText Vibe 4.0.8 Installation Guide.

For information on how to configure a reverse-proxy server for your Vibe site, see “Configuring
Single Sign-On with Novell Access Manager” in the OpenText Vibe 4.0.8 Installation Guide.

Vibe Add-in for Microsoft Office:

Users with the Vibe Add-in for MS Office installed and configured can browse to documents, edit
them, save them to Vibe, and much more, all directly from their Microsoft Office Ul.

For more information about the Vibe Add-in, see the Vibe Add-In Quick Start (http://
www.novell.com/documentation/vibe4/vibe4_gs_office/data/vibed_qgs_office.html).

Providing Access to the Vibe Add-in for MS Office

To provide users with download access to the Vibe Desktop Application software, you must:

1. Follow the instructions in “Distributing File-Access Applications to Users” on page 163.

2. Complete the instructions in Configuring Vibe to Allow MS Office Add-in Usage below.

Configuring Vibe to Allow MS Office Add-in Usage

To allow users to co-edit documents, you must modify the access control settings for the Team
Member role to allow team members to edit entries that were created by other team members:
1 In Vibe, click your linked name in the upper right corner of the page, then click the
Administration Console icon %',
2 Under System, click Configure Role Definitions.

3 On the Configure Role Definitions tab, in the Currently Defined Roles section, expand Team
Member.

4 Select Modify Entries, then click Apply.

This adds the Modify Entries right to the Team Member role. For more information about roles
and the rights that are associated with them, see “Managing Roles to Refine Access Control” on
page 31.

Web Browser Access to Files Through Edit-in-Place

By default, Vibe users can access files on the Vibe server directly using a web browser.

If they have sufficient rights, they can then open files for editing using whichever of the following
two options you configure Vibe to support.

+ “MS URI-Based File Editing” on page 162
+ “Vibe URI-Based File Editing” on page 162
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MS URI-Based File Editing

MS URI-based editing is available by default to all users who have:

+ Web browser access to vibe.

+ Microsoft Office 2010 or later installed on their workstation.

Users can edit files directly in Vibe (through underlying WebDAV support) using the Edit this file
drop-down option wherever it appears.

IMPORTANT: LibreOffice is not supported by MS URI.

For more information, see “Editing Files Accessed through a Web Browser” in the OpenText Vibe
4.0.8 User Guide.

Vibe URI-Based File Editing

Vibe URI-based editing (also knowns as Vibe Edit-in-Place) is not the default browser-based option.
It requires action on your part as well as by your users, but for many it is the best option because:

+ It supports both Mac and Windows.
+ It supports Microsoft Office and LibreOffice.

To provide Vibe-URI-based file editing, complete the steps in the following sections:

+ “Configuring Vibe to Support Vibe URI (Edit-in-Place Functionality)” on page 162

+ “Having Users Download and Install Vibe Edit-in-Place.” on page 163

Configuring Vibe to Support Vibe URI (Edit-in-Place Functionality)

To configure the Vibe server, you must do the following:

1 Follow the instructions in “Distributing File-Access Applications to Users” on page 163.

2 Change to the following directory:

Linux: / opt/ novel | / t eam ng/ apache-t ontat/
webapps/ ssf/WEB- | NF/ cl asses/ confi g

Windows: c¢:\Program Fil es\ Novel | \ Teanm ng\ apache-t ontat\
webapps\ ssf\ WEB- | NF\ cl asses/ confi g

Open the ssf - ext . properti es file.
Insert a new entry as follows: edi t . i n. pl ace. node=vi beuri .

Save and close the ssf - ext . properti es file.

A U A~ W

Stop and restart Vibe.

NOTE: If you want to revert to msuri functionality, simply change the edi t . i n. pl ace. node option
tomsuri and restart Vibe.
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Having Users Download and Install Vibe Edit-in-Place.

To use Vibe URI (Edit-in-Place), users must download and install the Vibe Edit-in-Place application for

their workstation type.

Mobile App Access to Files

Mobile devices don’t support file-editing capabilities, but users can view an HTML-rendering of files

on the Vibe server.

Vibe mobile apps are available through device app stores. See the OpenText Vibe Desktop for
Windows Quick Start and the OpenText Vibe Desktop for Mac Quick Start.

For more information about Vibe web access, see the Vibe Mobile Quick Start (https://
www.novell.com/documentation/vibe4/vibe4_qgs_mobile/data/vibe4 gs_mobile.html).

Distributing File-Access Applications to Users

You can provide users with access to file-access applications through the Vibe Applications

Downloads page.

Micro Focus. Vibe Application Downloads

PRODUCT TYPE

Vibe Desktop

Vibe Add-In for Office

Vibe Edit-In-Place

Vibe Mobile apps

B A *

DOWNLOADS

Windows x86

(MD5: 5d7543d85533d12e135950452307 4ce)
Windows x64

(MD5: e56abdfb5Tb952cc 3¢ 1107fbasST7469)

Mac
(MD5: be251ab11de 25300d27 dffTec 42cd4da)

Windows
(MD5: 860e166abe06cfT8c9afc6326e829a36)

Windows
(MDS5: 8a7a3bb030edad 1dc2cc 122542771195)

Mac

(MD5: 8afc632668e9a36a3bb030edad 1dc2ec)

You can download the Micro Focus Vibe
mebile app for free from the following
stores directly from your mobile device.

a Amazon Store
.@. Apple App Store
e Blackberry App World

L/ Google Play
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Synchronize Vibe files between your computer and Vibe

For mere information about installing and configuring Vibe Desktop,
see the Micro Focus Vibe Desktop for Windows Quick Start
or the Micro Focus Vibe Desktop for Mac Quick Start.

‘Work directly with Vibe files from within Microsoft Office.

For mere information about installing and configuring the Vibe Add-In,
see the Micro Focus Vibe Add-In Quick Start

Edit Vibe files directly from your browser.

For meore information about installing the Vibe Edit-In-Place launcher,
see the Micro Focus Vibe Edit-In-Place for Windows
Quick Start or the Micro Focus Vibe Edit-In-Place for Mac Quick Start.

To install the Vibe mobile app on your mobile device, launch your preferred
store app. Enter the search "micro focus vibe” to locate the app.

Follow the instructions within the store to download the Micro Focus Vibe app.
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Applications can be distributed through either your Vibe servers or through an external server as
described in the following sections:
+ “Providing Application Downloads from the Vibe Server” on page 164

+ “Providing Application Downloads from a Non-Vibe Web Server” on page 165

Providing Application Downloads from the Vibe Server

You can configure your Vibe server as an HTTP server to provide access to the Vibe applications
downloads that are described in this chapter.

This section describes how to configure Vibe as an HTTP server when Vibe is running on a single
server. If you want to configure Vibe as an HTTP server when Vibe is running in a clustered
environment, you must configure each Vibe node. If Vibe is running in a clustered environment, it is
probably more convenient to use an external web server or the reverse-proxy server as the HTTP
server.

To configure your single-server Vibe server as an HTTP server to provide application downloads, do
the following:

1 Download the M cr oFocusVi be- conbo- 4. 0. x. t gz file from the Vibe downloads page on
the Novell Downloads site (https://download.novell.com) to the / apache-t ontat / webapps/
downl oads directory. (If the downl oads directory does not already exist, you need to create
it.)

2 (Linux) With the M cr oFocusVi be- conbo- 4. 0. x. t gz file in the / apache-t ontat /
webapps/ downl oads directory, extract it:

tar -xvf M croFocusVi be-conbo-4.0.x.tgz
This creates the following structures within the downloads directory

[ opt/ novel | / t eami ng/ apache-t ontat / webapps/ downl oads

Vibe URI (Vibe Edit-in-Place) for / edi ti npl ace/ wi ndows/ Vi beEdi t | nPl aceSet up. nsi
Windows

Vibe URI (Vibe Edit-in-Place) for / edi ti npl ace/ wi ndows/ Vi beEdi t | nPl aceSet up. pkg

Windows

Vibe Add-in for MS Office / of fi ceaddi n/ Vi beAddi nSet up. exe

Vibe Desktop for Windows (32- / novel | vi bedeskt op/ wi ndows/ x86/

bit) M cr oFocusVi beDeskt op- x86- 4. 0. X. nsi

Vibe Desktop for Windows (64- / novel | vi bedeskt op/ wi ndows/ x86/

bit) M cr oFocusVi beDeskt op- x64- 4. 0. x. nsi

Vibe Desktop for Mac / novel I vi bedeskt op/ osx/ x64/ M cr oFocusVi beDeskt op-
4. 0. x. pkg

3 (Windows) With the M cr oFocusVi be- conbo- 4. 0. x. t gz file in the \ apache-
t ontat \ webapps\ downl oads directory, extract it using a file archive utility, such as 7-Zip.

This creates the following structures within the downloads directory:

c:\Program Fi | es\ Novel |\ Teani ng\ apache-t ontat \ webapps\ downl oads
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Vibe URI (Vibe Edit-in-Place) for
Windows

\'edi ti npl ace\ wi ndows\ Vi beEdi t | nPl aceSet up. nsi

Vibe URI (Vibe Edit-in-Place) for
Windows

\ edi ti npl ace\ wi ndows\ Vi beEdi t | nPl aceSet up. pkg

Vibe Add-in for MS Office

\ of f i ceaddi n\ Vi beAddi nSet up. exe

Vibe Desktop for Windows (32-
bit)

\ novel I vi bedeskt op\ wi ndows\ x86\ M cr oFocusVi beDesk
t op- x86-4. 0. X. nsi

Vibe Desktop for Windows (64-
bit)

\'novel I vi bedeskt op\ wi ndows\ x86\ M cr oFocusVi beDesk
t op- x64-4. 0. X. nmsi

Vibe Desktop for Mac

\'novel | vi bedeskt op\ osx\ x64\ M cr oFocusVi beDeskt op-
4. 0. x. pkg

4 (Linux) Change the ownership:

chown -R vi be: vi be downl oads

5 From a browser, ensure that you can access the following files:

http://vibe_hostname/downloads/editinplace/windows/version.json
http://vibe_hostname/downloads/editinplace/osx/version.json
http://vibe_hostname/downloads/officeaddin/version.json
http://vibe_hostname/downloads/vibedesktop/windows/x86/version.json
http://vibe_hostname/downloads/vibedesktop/windows/x64/version.json
http://vibe_hostname/downloads/vibedesktop/osx/x64/version.json

6 Access Vibe in a browser and click your linked name in the upper right corner of the page, then

click the Administration Console icon "+ .

7 Under System, click Desktop Application.

8 In the Auto-update URL: field, specify the HTTP server where the downloads directory is

located.

For example, ht t ps: // vi be_host nane/ downl oads.

Providing Application Downloads from a Non-Vibe Web Server

As a best practice and to minimize load on the Vibe servers in a clustered environment, we
recommend that you set up a separate web server and configure it to provide access to the Vibe file-

access application downloads.

1 Set up a web server that doesn’t require authentication as a host for the application downloads.

NOTE: If you are using secure HTTP, the web server must have a certificate signed by a trusted

certificate authority.
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2 Using the instructions in “Providing Application Downloads from the Vibe Server” on page 164
as a guide, set up the non-Vibe server to provide the same download capabilities as described

for the Vibe server.

For example, download and extract the M cr oFocusVi be- conbo- 4. 0. x. t gz file into a
directory on the web server from which they can be downloaded via the http server (as
described in Step 1 thru Step 4 on page 165. Then check to make sure that the .json files are
reachable (Step 5). And so on until you have completed all of the steps.
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Configuring Email Integration

Initial email configuration is performed when you install OpenText Vibe. Additional aspects of email
handling are configured on the Vibe site. For information about how to further configure email
settings beyond what is covered in this section, see Chapter 27, “Managing Email Configuration,” on
page 275.

+ “Enabling/Disabling Outbound Emailing of Folder Digests” on page 167
+ “Disabling/Enabling Inbound Email Postings” on page 168

Enabling/Disabling Outbound Emailing of Folder Digests

During installation, you configured OpenText Vibe to communicate with your email system, as
described in “Planning for Outbound Email” in “Single-server (Basic) Installation” in the OpenText
Vibe 4.0.8 Installation Guide. As a result, Vibe users can send email messages to other Vibe users
and to anyone whose email address they know. They can also send email notifications when they
create workspaces, add folder entries, and so on.

In addition to this basic email functionality, you can configure your Vibe site so that users can receive
folder digests of site activity that are created and sent to the users who have subscribed to the
folders.

1 Login to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the Vibe page, then click the Administration
icon 't

3 Under System, click Email.

Email @

Enabling outgoing email will allow emails, including share and subscribe notifications, to be sentto recipients through email or text messages
*| Enable Outgoing Email {including Share and Subscribe Notifications)

Default Digest Schedule (Subscribe Notification)

®' Every Day

Weekly (on selected days)
Sun Mon Tue Wed Thu Fri Sat
AtTime 00 v . 00 v MDT

®' RepeatEvery 025 v Hours

Outgoing Email Quotas (for each email)

Sum of All File Attachments Maximum Size
KE

File Attachment Maximum Size
KB

(blank = unlimited)

* Enable Incoming Email Using the Embedded Email Server and Simple URLs

e TRy
:ff"ﬂ;,a.\,— LS "

4 Select Enable Outgoing Email.
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By default, folder digests are compiled and sent daily at fifteen minutes after midnight.
5 Adjust the schedule as needed to meet the needs of the majority of your Vibe users.

Users can turn the digests on and off for individual folders, but they cannot change the email
schedule that you establish.

6 (Optional) To set a data quota on outgoing mail messages, specify the quota limit in the Sum of
All File Attachments Maximum Size and the File Attachment Maximum Size fields.

By default, there is no limit to the size of attached files. You can leave the fields blank to retain
the default of no limit.

To restrict any attachments from being sent, specify 0 in each field.

7 Click Apply to save the settings, then click Close.

For information about the options that users have for receiving email notifications, see “Subscribing
to a Folder or Entry” in “Getting Informed” in the OpenText Vibe 4.0.8 User Guide.

Disabling/Enabling Inbound Email Postings

During installation, you configured OpenText Vibe to include an internal SMTP mail host for receiving
email postings to folders, as described in “Planning to Enable Inbound Email” in “Single-server
(Basic) Installation” in theOpenText Vibe 4.0.8 Installation Guide. Your selection during installation
carries over into the configuration of your Vibe site. Therefore, you can disable incoming email if
necessary, and then enable it again on the Vibe site. Relaying is permanently disabled on the internal
SMTP mail host.

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration

Console icon % .

3 Under System, click Email.

Email @

Enabling outgoing email will allow emails, including share and subscribe notifications, to be sent to recipients through email or text messages
¥ Enable Qutgoing Email {including Share and Subscribe Notifications)

Default Digest Schedule (Subscribe Notification)

*' Every Day
Weekly (on selected days)
Sun Mon Tue Wed Thu Fri Sat
AtTime 00 v : 00 v MDT
® RepeatEvery 025 ¥ Hours
Outgoing Email Quotas (for each email)

Sum of All File Attachments Maximum Size
KB

File Attachment Maximum Size
KB

(blank = unlimited)

¥ Enable Incoming Email Using the Embedded Email Server and Simple URLs

o I come ]

4 Select or deselect Enable Incoming Email Using the Embedded Email Server and Simple URLs.

5 Click Apply > Close to save the setting.
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For information about how to configure folders to receive email postings, see “Enabling Folders to
Receive Entries through Email” in “Managing Folders” in the OpenText Vibe 4.0.8 Advanced User
Guide. Failed email postings are listed in the Tomcat log file. For background information about the

Tomcat log file, see “Tomcat Log File” on page 313.
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Configuring Weekends and Holidays

You can configure OpenText Vibe to recognize weekends and holidays. Currently, the weekend and
holiday schedule is used by default only in relation to task durations. It can also be leveraged by
users when configuring workflow transitions.

+ “Configuring Vibe to Recognize Weekends and Holidays” on page 171
+ “Using Weekend and Holiday Information in Tasks and Workflows” on page 172

Configuring Vibe to Recognize Weekends and Holidays

To configure weekends and holidays for your Vibe site:

1 Log in to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration

Console icon *.

3 Under System, click Weekends and Holidays.
Configure Weekends and Holidays Schedule

Weekend Days

Monday Tuesday Wednesday Thursday Friday | Saturday ¥ Sunday

Holidays

4 In the Weekend Days section, select the days that you want to designate as the weekend.

Days left unselected are considered regular workdays.

5 In the Holidays section, click in the field on the right, select the date that you want to make a
holiday, then click Add.

To remove a date as a holiday, select the date in the field on the left, then click Delete.

6 Click Apply > Close.
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Using Weekend and Holiday Information in Tasks and
Workflows

+ “When Calculating Task Durations” on page 172
+ “When Configuring Workflow Transitions” on page 172

When Calculating Task Durations

If you have configured weekends and holidays, task durations exclude these days when calculating
task due dates. For example, a task with a duration of 10 days translates into two full weeks
(assuming a two-day weekend for each week). For more information about task durations, see
“Working with Tasks Folders” in the OpenText Vibe 4.0.8 User Guide.

NOTE: Configuring a weekend and holiday schedule or changing an existing weekend and holiday
schedule does not immediately affect the due dates of existing tasks. Existing tasks are affected only
after the due dates are recalculated, such as when a new task (that includes a task duration) is added
to the Tasks folder where the existing tasks are located.

When Configuring Workflow Transitions

If you have configured weekends and holidays, the weekend and holiday schedule can be leveraged
by users when configuring workflows to transition after a specified number of days, as described in
“Transition After Time Elapsed” in “Creating and Managing Workflows” in the OpenText Vibe 4.0.8
Advanced User Guide.
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Configuring Real-Time Communication
Tools

From the OpenText Vibe site, Vibe users can communicate with each other in various ways.

+ “Integrating Messenger with Vibe” on page 173
+ “Integrating Skype with Vibe” on page 174

Integrating Messenger with Vibe

Vibe 3 and later lets you integrate with GroupWise Messenger 2.2 and later. This integration displays
a user’s Messenger presence information within Vibe. For information about where presence
information is displayed in Vibe, see “Sending an Instant Message from within Vibe” in the OpenText
Vibe 4.0.8 User Guide.

When you click a user’s presence icon, the Profile Quick View is displayed, which lets you send an
instant message to the user, view the user’s personal workspace, follow the user, and more.

To successfully integrate GroupWise Messenger with Vibe, you must complete the following tasks:

+ “Defining an Allowed Service User in ConsoleOne” on page 173
+ “Configuring Messenger Integrations in the Vibe Installation Program” on page 173

+ “Configuring Presence” on page 174

Defining an Allowed Service User in ConsoleOne

The Allowed Service User’s function is to log in to the Messenger system and retrieve presence
information, which is then displayed in Vibe.

For information about how to create an Allowed Service User in ConsoleOne, see “Integrating Vibe
with GroupWise Messenger” in the GroupWise Messenger 18 Administration Guide

Configuring Messenger Integrations in the Vibe Installation
Program

After you have defined an Allowed Service User in ConsoleOne, as described in “Integrating Vibe
with GroupWise Messenger” in the GroupWise Messenger 18 Administration Guide, you need to run
the Vibe installation program and configure Messenger.

For information about the presence configuration page in the Vibe installation program, see
“Configuring Presence” in the OpenText Vibe 4.0.8 Installation Guide.
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Configuring Presence

You should use LDAP to sync users with a directory service such as eDirectory in order to populate
the Presence ID field in Vibe.
1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon * .
3 Under System, click LDAP.

4 On the Users tab, map the identifier pr esencel Dto the LDAP attribute that identifies the user.
For example, pr esencel D=cn.

5 Click OK.

Integrating Skype with Vibe

OpenText Vibe enables Vibe users to use Skype to contact other Vibe users directly from the Vibe
interface.

This functionality is enabled on a system level by default. For more information on how Vibe users
can use Skype to contact other Vibe users from inside Vibe, see “Using Skype from within Vibe” in
“Connecting With Your Co-Workers” in the OpenText Vibe 4.0.8 User Guide.
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Enabling Custom JSPs to Be Used on Your
Vibe Site

OpenText Vibe supports the use of custom JavaServer Pages (JSP) files. As a Vibe administrator, you
can work with Vibe developers to write custom JSP files that enhance the appearance and
functionality of your Vibe site.

Before you can enable a JSP file to be used in your Vibe site, the file must first be created. For
information on how to create a custom JSP file, see “Creating JavaServer Pages (JSPs)” in the
OpenText Vibe 4.0.8 Developer Guide.

+ “Enabling JSP Files to Be Used on Your Vibe Site” on page 175
¢ “Using Sample Custom JSPs to Modify the Behavior of a Landing Page” on page 176

Enabling JSP Files to Be Used on Your Vibe Site

After a JSP file has been created, you need to make it available to users in your Vibe site.

1 On the Vibe server, locate the JSP file that you want to make available to users.
2 Place the JSP file in the / WEB- | NF/ j sp/ cust om j sps directory.

Users need to reference this file by name in order to use it, so make sure that the name of the
file is intuitive and easy to remember.

TIP: You might want to create separate folders for each custom JSP file inside the cust om j sps
directory. This can make managing your custom JSP files more simple. However, users who
leverage these sample JSP files from the Vibe site will need to enter the relative path to the file.
For example: new_f ol der/ cust om j sp_| andi ng_page_entry.j sp.

3 Stop and Restart the Vibe server.
or

If you are running Vibe in a non-production environment, you can configure Vibe to
automatically update a all JSP changes that you make on the Vibe server, without stopping and
restarting the Vibe server. For more information, see “Dynamically Updating JSP Files by
Running Vibe in Development Mode” on page 175.

Dynamically Updating JSP Files by Running Vibe in Development
Mode

WARNING: Running Vibe in development mode is not supported in production environments,
significantly decreases Vibe performance, and is offered only as a convenience for developers.
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If you are testing JSP files on a non-production system and you want all JSP changes that you make
on the Vibe server to be automatically available on the Vibe server without stopping and restarting
the Vibe server, you can run Vibe in development mode.

To run Vibe in development mode:

1 Opentheweb. xm file in a text editor.

The web. xm file is located in the following directory:

Platform Default Location

Linux: / opt/ novel | / t eam ng/ apache-t ontat/ conf

Windows: c¢:\ Program Fi |l es\ Novel | \ Team ng\ apache-t ontat\ conf

2 Search for the devel opnent parameter, then change the value of this parameter from f al se
totrue.

3 Save and close the web. xni file.

Using Sample Custom JSPs to Modify the Behavior of a
Landing Page

NOTE: While the information in this section is still valid, users can achieve the same results (and
more) with Vibe 3.1 and later by adding an Enhanced View element to the landing page. For more
information, see “Enhanced View:” in “Adding Content to Your Landing Page” in the OpenText Vibe
4.0.8 Advanced User Guide.

OpenText Vibe includes sample custom JSP files that enable you to modify the behavior of Vibe
landing pages. Before you implement the sample JSP files that are described in this section, you
might want to further customize them to suit your specific needs, as described in “Creating
JavaServer Pages (JSPs)” in the OpenText Vibe 4.0.8 Developer Guide.

For information on how users can add these custom JSP files to their individual landing pages after
the JSP files have been enabled for use, see “Adding Content to Your Landing Page” in “Creating and
Managing Landing Pages” in the OpenText Vibe 4.0.8 Advanced User Guide.

+ “Listing Folder Entry Titles in a Bulleted List” on page 176

+ “Displaying Entry Replies on a Landing Page” on page 177

+ “Enabling Users to Take a Survey Directly from a Landing Page” on page 177

Listing Folder Entry Titles in a Bulleted List

To activate the sample JSP file that enables Vibe users to list entries in a bulleted list for any given
folder:
1 Inthe Vibe source files, navigate to the \ VEB- | NF\ j sp\ cust om j sp\ sanpl es directory.

2 Select and copy the cust om j sp_| andi ng_page_fol der _|i st. | sp file, then paste it into
the \ VEB- | NF\ j sp\ cust om j sp directory.
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TIP: You might want to create separate folders for each custom JSP file inside the cust om j sps
directory. This can make managing your custom JSP files more simple. However, users who
leverage these sample JSP files from the Vibe site need to enter the relative path to the file. For
example: new f ol der/custom jsp_| andi ng_page_entry.jsp.

Displaying Entry Replies on a Landing Page
You can display replies for a single entry, or for all entries that are contained in a folder.

+ “Displaying Entry Replies for a Single Entry” on page 177
+ “Displaying Entry Replies for All Entries in a Folder” on page 177

Displaying Entry Replies for a Single Entry

To activate the sample JSP file that lets Vibe users display entry replies on a landing page when
referencing a folder entry:
1 Inthe Vibe source files, navigate to the \ VEB- | NF\ j sp\ cust om j sp\ sanpl es directory.

2 Select and copy the cust om j sp_| andi ng_page_entry. j sp file, then paste it into the
\ VEB- | NF\ j sp\ cust om j sp directory.

TIP: You might want to create separate folders for each custom JSP file inside the cust om j sps
directory. This can make managing your custom JSP files more simple. However, users who
leverage these sample JSP files from the Vibe site need to enter the relative path to the file. For
example: new f ol der/custom jsp_| andi ng_page_entry.j sp.

Displaying Entry Replies for All Entries in a Folder

To activate the sample JSP file that lets Vibe users display entry replies on a landing page when
referencing a folder:
1 In the Vibe source files, navigate to the \ VEB- | NF\ j sp\ cust om j sp\ sanpl es directory.

2 Select and copy the cust om j sp_| andi ng_page_f ol der. j sp file, then paste it into the
\ VEB- | NF\ j sp\ cust om j sp directory.

TIP: You might want to create separate folders for each custom JSP file inside the cust om j sps
directory. This can make managing your custom JSP files more simple. However, users who
leverage these sample JSP files from the Vibe site need to enter the relative path to the file. For
example: new f ol der/custom jsp_| andi ng_page_entry.jsp.

Enabling Users to Take a Survey Directly from a Landing Page

To activate the sample JSP file that enables Vibe users to participate in a survey directly from a
landing page:

1 Inthe Vibe source files, navigate to the \ WEB- | NF\ j sp\ cust om j sp\ sanpl es directory.

2 Select and copy the cust om j sp_| andi ng_page_survey_entry. j sp file, then paste it
into the \ VEB- | NF\ j sp\ cust om j sp directory.

Enabling Custom JSPs to Be Used on Your Vibe Site 177



178  Enabling Custom JSPs to Be Used on Your Vibe Site



Enabling Custom JAR Files to Be Used on
Your Vibe Site

OpenText Vibe supports the use of custom Java Archive (JAR) files. JAR files are one way that you can

incorporate custom functionality to Vibe workflows.

As a Vibe administrator, you can work with Vibe developers to write custom JAR files that enhance

the functionality of workflows on your Vibe site.

Before you can enable a JAR file to be used in a workflow, the file must first be created. (The Vibe
documentation does not describe how to create a JAR file.)

After the code has been written to accomplish a specific workflow action and then packaged into
JAR file, you need to make that JAR file available to Vibe users who are creating workflows.

When you customize workflows by using JAR files as described in this section, the JAR file can be
referenced from any zone within your Vibe system. If you want customizations to be available to
only one particular zone, you can instead add the customizations by adding an extension, as
described in Chapter 15, “Adding Software Extensions to Your Vibe Site,” on page 181. (For more
information about zones in Vibe, see Chapter 18, “Setting Up Zones (Virtual Vibe Sites),” on
page 197.)

To make the custom JAR file available to Vibe users:

1 Place the JAR file in the following directory. If the directory does not yet exist, create it.
Linux: /opt/ novel | / t eam ng/ apache-t ontat /
I'i b/ cust om ext
Windows: c¢:\Program Fi | es\ Novel |\ Teani ng\ apache-t oncat\

|'i b\ cust om ext

Users can now reference this JAR file by adding a Custom Action element to a workflow, as
described in “Adding On-Entry or On-Exit Events” in “Creating an Advanced Workflow” in the
OpenText Vibe 4.0.8 Advanced User Guide.

Enabling Custom JAR Files to Be Used on Your Vibe Site
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Adding Software Extensions to Your Vibe
Site

You can customize your OpenText Vibe site through the use of software extensions. Vibe
administrators or Vibe developers can create custom extensions (add-ons) that enhance the power
and usefulness of the Vibe software. For example, you might have an extension that enables Flash
video support in Vibe.

When you customize your Vibe site through the use of software extensions, as described in this
section, the customizations are available only for the zone where the software extension is
deployed. If you are creating customizations for workflows, and you want to make the
customizations available to multiple zones, you can instead add the customizations as JAR files, as
described in Chapter 14, “Enabling Custom JAR Files to Be Used on Your Vibe Site,” on page 179. (For
more information about zones in Vibe, see Chapter 18, “Setting Up Zones (Virtual Vibe Sites),” on
page 197.)

This section discusses how to add software extensions that have already been created.
+ “Creating a Software Extension” on page 181
+ “Deploying the Extension in Your Vibe Site” on page 181

+ “Viewing Your Vibe Extensions” on page 182

+ “Removing an Extension from Your Vibe Site” on page 183

If you want Vibe to communicate with a third-party application and display related information
inside of Vibe, you can set up a remote application, as described in Chapter 16, “Using Remote
Applications on Your Vibe Site,” on page 185.

Creating a Software Extension

For information on how to create a custom software extension for OpenText Vibe, see “Creating and
Packaging Extensions for Deployment” in the OpenText Vibe 4.0.8 Developer Guide.

Deploying the Extension in Your Vibe Site

1 Login to the OpenText Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon * .

3 Under Management, click Extensions.
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Extensions

Add a new extension

Mame Description Remove

4 Click Add a new extension.
5 Inthe Choose a File section, click Browse, then browse to the extension that you want to deploy.

The extension is a zi p file that can contain definition xm files, custom JSP files, Java classes,
ht M files, css files, JavaScript, and other third-party files.

6 Click Add.
The extension is now installed and is displayed in a table on the Manage Extensions page.

You might need to configure an extension after it has been installed. For information on how to
configure extensions, see the installation instructions on the web site where you obtained the
extension.

Installation instructions are specific for each extension, and should be written by the extension
creator.

Viewing Your Vibe Extensions

1 Log in to the OpenText Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon ' *'.

3 Under Management, click Extensions.
The Extensions page is displayed.

The table lists all extensions that are currently available in the Vibe site.

182  Adding Software Extensions to Your Vibe Site



Removing an Extension from Your Vibe Site

An extension cannot be removed from the OpenText Vibe site if the extension is being referenced by
a binder or entry. If an extension is being referenced somewhere in the Vibe site, you must first
manually delete the files and definitions that are referencing the extension before you can remove
the extension itself. When an extension is removed, it does not remove any actual data from the
Vibe site.

To remove an extension from your Vibe site:

1 Login to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon %',
3 Under Management, click Extensions.
The Manage Extensions page is displayed.
4 In the table, click the (x) in the Remove column for the extension that you want to delete.
5 Click OK.

The extension is removed from the Vibe site and can no longer be used.
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Using Remote Applications on Your Vibe
Site

A remote application is a program that runs on a remote server and delivers data for use on your
OpenText Vibe site (such as data from a remote database). For example, you could set up a remote
application for Twitter that displays all of your Twitter entries in Vibe.

Unlike creating an extension for Vibe, creating a remote application does not modify the Vibe
software in any way.

+ “Adding a Remote Application to Your Vibe Site” on page 185
¢ “Creating an Application Group” on page 187
+ “Managing Access Controls for Remote Applications” on page 189

+ “Implementing Remote Applications on Your Vibe Site” on page 190

If you want to make modifications to the Vibe software itself, you can add a software extension, as
described in Chapter 15, “Adding Software Extensions to Your Vibe Site,” on page 181.

Adding a Remote Application to Your Vibe Site

After you or a developer have created a remote application, you need to make it available on your
OpenText Vibe site.

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon %',

3 Under Manage, click Applications.

Applic ations

Applications

Add a New Application

Select an Application to Modify or Delete

4 Click Add a New Application.
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Applic ations

Applications

Add a New Application
Title

Nameo

Description

Trusted

Vibe Initiates Interactions

Post URL

Post Timeout in seconds (0 means No Timeout)
60

Application Initiates Interactions

Maximum Idle Time in seconds (0 means No Timeout)
3500

#| Same Address Policy

Select an Application to Modify or Delete

5 Fill in the following fields:

Title: Specify a unique title for the remote application. For example, Hel | o Wor | d.

Vibe site users who add the remote application to a form or view can select the title from the
list of available remote applications.

Name: Specify a unique name for the remote application. The name is for internal use in the
Vibe database. The first character must be an alphabetic character (a-z, A-Z). For the rest of the
name, you can use alphanumeric characters (a-z, A-Z, 0-9), hyphens (-), and underscores (_). For
example, hel | owor | d.

Description: Provide a description of what the remote application does.

Trusted: Select Trusted if the application is extremely trustworthy (for example, if you write,
maintain, and run the application on the same server that runs Vibe). If you select Trusted, Vibe
applies access control according to the viewing user’s access control settings. For complete
information about access control, see “Managing Remote Applications” in the OpenText Vibe
4.0.8 Advanced User Guide.

Post URL: Specify the URL of the remote application. Vibe posts requests for information, along
with the requesting user and a security token for use by Vibe web services, to this URL, then
waits to receive the requested HTML snippets for posting on the Vibe site. For example, ht t p: /
/| ocal host : 8080/ r enot eapp/ hel | oWr | d.

Post Timeout: Specify the number of seconds that Vibe should wait for a response from the
remote application before it assumes that the remote application is not available. The default is
60 (1 minute). If Vibe does not receive a response from the remote application, it displays the
page requested by the user without any input from the remote application.
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Maximum Idle Time: Specify the number of seconds that Vibe maintains idle connections
through Vibe web service with a remote application. The default is 3600 (1 hour). After the
maximum idle time elapses, Vibe closes idle connections.

Same Address Policy: Select this option if interactions with the Vibe site are initiated by the
remote application, and if the remote application must communicate with Vibe through the
Vibe web services machine by using the same security token for the entire communication.

6 Click Add to add the remote application to the list of remote applications that are available on
your Vibe site, then click Close.

Users now see the new remote application in the list of tools within the designers and within
the tool used to create accessories.

Creating an Application Group

If you create a number of remote applications for your OpenText Vibe site, you can create
application groups for remote applications so they can all be assigned the same roles in the Access
Control table. For example, you might have a group of remote applications that are allowed to
perform administrative tasks and another group of remote applications that are granted only read
access.

1 Login to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration

Console icon * .

3 Under Manage, click Application Groups.

Application Groups

Application Groups

Add a New Application Group

Select an Application Group to Modify or Delete

All Applications ()

4 Click Add a New Application Group.
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Application Groups

Application Groups

Add a New Application Group
Application Group Title

Application Group Name®@

Application Group Description

Select an Application Group to Modify or Delete

All Applications (

5 Fill in the following fields:

Application Group Title: Specify a unique title for the remote application group. Vibe site users
who need to set access controls for a remote application can select the title from the list of
available remote application groups.

Application Group Name: Specify a unique name for the remote application group. The name is
for internal use in the Vibe database. The first character must be an alphabetic character (a-z, A-
Z). For the rest of the name, you can use alphanumeric characters (a-z, A-Z, 0-9), hyphens (-),
and underscores (_).

Application Group Description: Provide a description of the types of remote applications that
the application group includes.

Click Add to add the application group to the list of application groups that are available on your
Vibe site, then select the new application group to add remote applications to it.

Administrative Applications (sdministrative_apps)

Modify the Application Group Title or Description

Modify the Application Group Membership
Applications

Find Applications

Application Groups

Find Groups

Fill in the following fields:

Applications: Start typing the title of a remote application, then select the remote application.
Repeat for each application that you want to add to the application group.

Application Groups: Start typing the title of an existing application group that you want to nest
in the new application group, then select the application group. Repeat for each application
group that you want to nest in the application group.

8 Click Apply to save the application group, then click Close.
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Managing Access Controls for Remote Applications

Because not all remote applications can be completely trusted, it is often a good idea to limit the
privileges of the remote application. This section describes how you can accomplish this.

If you are running a trusted remote application, such as an application that you are maintaining on
the same server as OpenText Vibe, then you do not need to set access controls on it.

When an application is restricted to a specific role, the application can use web services to perform
only those tasks that are allowed for that role. For example, the Participant role can create new
entries, modify entries that the user created, add comments to entries, and so on. Participants
cannot perform system administration tasks and cannot modify other users’ entries.

Because workspace and folder owners can change the access control for places they own, you
should communicate to your users about registered applications in the system and recommended
access-control settings.

To limit the remote application to privileges assigned to a specific role:
1 Login to the Vibe site as the Vibe administrator.

2 Access the top workspace in the hierarchy by clicking the workspace tree icon & , then clicking
Home Workspace (this is the default name for the top workspace).
3 Click Workspace > Access Control.

4 On the Configure Access Control page, click Add an Application.

Add an Application = Application Title App

--nn anolicatinns--

Add an Application

5 Inthe Add an Application field, use the type-to-find to specify and select the application that
you want to add.

6 In the access control table, select the check box that is located in the row of the remote
application that you just added, and the column of the role that you want to assign to the
application.

Add an Application = Application Title Application Name Workspace Crestor  Participart  Team Member

Hello Warld helloword F O

7 Click Save Changes > Close.

The application that you added is now restricted to those operations allowed for the role that you
selected. For example, if you assigned the Participant role to the remote application, then the
inheritance of workspace and folder access controls means that it is very likely that most workspaces
and folders inherit this setting. Assuming that all places inherited this setting, the most powerful role
the remote application can assume within the installation is that of a Participant.
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You can assign access-control roles to groups of applications instead of assigning roles to one
application at a time if you have enabled multiple applications for your site and have grouped them
together in an application group, as described in “Creating an Application Group” on page 187.

Implementing Remote Applications on Your Vibe Site

After you as the OpenText Vibe administrator have added remote applications to the Vibe site, users
can implement them in custom forms and views, in workspaces, and as accessories. For instructions,
see “Managing Remote Applications” in the OpenText Vibe 4.0.8 Advanced User Guide.
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Setting Up Mirrored Folders

A mirrored folder is a library folder within Vibe that is synchronized with a folder located on a system
drive outside of Vibe. When you perform basic actions (adding subfolders and files, modifying files,
deleting folders and files) by using the Vibe interface or by accessing the file on the drive, the change
is reflected in the other interface. The advantage to using mirrored files is that you can apply Vibe
tools to files on a drive, including tools such as text search, workflow, and discussion (in the form of
comments applied to the entry in the library folder).

Initial setup of mirrored folder resource drivers is done during Vibe installation, as described in
“Configuring Mirrored Folder Resource Drivers” in “Advanced Installation and Reconfiguration” in
the OpenText Vibe 4.0.8 Installation Guide.

The Vibe Installation program lets you set up as many as three mirrored folder resource drivers. If
you need more than three, you must manually edit the i nst al | er. xn file, then update your Vibe
installation.

After you set up the mirrored folder resource drivers by using the Installation program, you must
perform additional mirrored folder configuration on the Vibe site.

+ “Manually Setting Up More Than Three Mirrored Folder Resource Drivers” on page 191

+ “Creating a Mirrored Files Folder for a Mirrored Folder Resource Driver” on page 194

Manually Setting Up More Than Three Mirrored Folder
Resource Drivers

+ “Editing the installer.xml File” on page 191
+ “Updating Your Vibe Site Configuration” on page 193

Editing the installer.xml File

The Vibe Installation program lets you set up three mirrored folder resource drivers. However, there
is no limit to the total number of mirrored folder resource drivers that you can set up after
installation. A useful strategy is to set up resource drivers for root directories, then set up Mirrored
File folders for root directories and subdirectories as needed, as described in “Creating a Mirrored
Files Folder for a Mirrored Folder Resource Driver” on page 194.

When you run the Vibe Installation program, it creates the i nst al | er. xml file in the directory
where you runit. Thei nst al | er. xm file stores the information you provided during installation.
You can also edit it manually, then update your Vibe installation.

1 Make a backup copy of your existing i nstal | er. xm file.

2 Opentheinstaller.xmn filein a text editor.

3 Search form rrored.

4 Scroll down until you reach the three existing mirrored folder resource drivers.
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5 Copy the mirrored folder resource driver that is most like the one you want to create, then
paste it between the <M r r or edFol der > and </ M r r or edFol der > tags.

The Vibe Installation program displays only the first three mirrored folder resource drivers, so
you might want to place new resource drivers at the top of the list in order to double-check the
information when you run the Vibe Installation program to implement your changes.

6 Set the parameters as needed for the file system location that you want to mirror in your Vibe
site:

Tag Setting

enabl ed= true
type= fileorwebdav

i d= The unique internal name for the mirrored folder resource driver. Use
only alphanumeric characters. Do not include spaces, extended
characters, or double-byte characters.

title= The name of the mirrored folder resource driver that displays on the
Vibe site. The title can include any characters.

r oot Pat h= For the fi | e mirrored folder type, the absolute path to the directory
from the point of view of the Vibe server.

For the webdav mirrored folder type, the path to the directory after
the WebDAV server hostname, and optionally, the port number, as
specified by the host Ur | = parameter. The path should start with a
slash (/), because it is appended to the setting of the host Ur | =
parameter. For example, if the full WebDAV server location is:

http://webdavserver/archive/ docs
the r oot Pat h= setting would be:
/ ar chi ve/ docs

readonl y= trueorfal se

zonel d= For a multi-zone Vibe site, this is the ID of the zone where you want
the mirrored folder resource driver to be available. For information
about Vibe zones, see Chapter 18, “Setting Up Zones (Virtual Vibe
Sites),” on page 197. For a single-zone Vibe site, leave this parameter
empty.--

Al | owedUsers idList= A list of Vibe user IDs that can access the mirrored folder resource
driver and create mirrored folders. Use a semicolon (;) between user
IDs.

Al | owedG oups i dList= Alist of Vibe groups that can access the mirrored folder resource
driver and create mirrored folders. Use a semicolon (;) between group
IDs.

7 (Conditional) If you are setting up a webdav mirrored folder, set the following additional
parameters:
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Tag

Setting

host Ur | =

user =

passwor d=

The hostname, and optionally, the port number for the WebDAV
server. For example:

http://webdav_host nane[: port]
https://webdav_host name[: port]

Do not include the directory path to the data. Use the r oot Pat h=
parameter to specify the path to the directory on the WebDAV server.
For example, if the full WebDAV server location is:

http://webdav_host nane/ ar chi ve/ docs
the host Ur | = setting would be:
htt p: // webdav_host name

The user name that Vibe can use to connect to the WebDAV server.
The WebDAV server must support HTTP Basic authentication (http://
en.wikipedia.org/wiki/Basic_access_authentication).

The password for the user name specified by the user = parameter.

8 Repeat Step 5 and Step 6 for each mirrored folder resource driver that you want to create.

9 Savetheinstaller.xnl file, then exit the text editor.

Updating Your Vibe Site Configuration

After you edit the i nstal | er. xm file, you must run the Vibe Installation program to update the
configuration of your Vibe site. If you need assistance with any of the following steps, refer to the
appropriate platform-specific instructions in “Installing and Setting Up a Basic Vibe Site” in “Single-
server (Basic) Installation” in the OpenText Vibe 4.0.8 Installation Guide.

1
2

a U A~ W

Stop Vibe.

Start the Vibe Installation program.

The Vibe Installation program reads the updated i nst al | er. xmi file. If your edits
inadvertently changed the syntax of the file, the Installation program cannot start. If this
happens, correct the problem in thei nstal | er. xm file, or return to your backup copy and

try your edits again.

Accept the License Agreement, then click Next.

Select Reconfigure Settings, then click Next.

Select Advanced, then click Next.

Click Next until you reach the Mirrored Folder Resource Driver Configuration page.

The Vibe Installation program displays the first three mirrored folder resource drivers listed in

theinstaller.xmn file.

(Conditional) If you placed the new resource drivers at the top of the list, review the
information that you added, and make corrections if necessary.

Click Next.
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9 Click Install to implement the new mirrored folder resources.
10 Start Vibe.

Creating a Mirrored Files Folder for a Mirrored Folder
Resource Driver

After you have set up one or more mirrored folder resource drivers in the Vibe Installation program,
you need to create a Mirrored Files folder for each resource driver in order to make the data
accessible to users on your Vibe site.

1 Navigate to the workspace where you want to create a mirrored folder.

2 Create a new File folder:

2a Click the Configure icon © next to the workspace title, then click New Folder.

New Folder
Title
Folder Title
Folder
# Discussion A Discugsion folder is useful for creating a forum where users are likely to both create and reply to entries.

Blog A bilog folder is a forum where entire entries are displayed in reverse chronoclogic al order, based on when they were created. Blogs typically
provide information on a partic ular topic from an individual or small group of authors. Optionally, the blog folder can be configured so thata
larger group can make comments on the entries posted by the onginal author.

Calendar A calendar folder is a place to post group events or display other types of entries by date.

Guestbook A guestbook folder is a simple place that individuals can "sign,” indic ating that they have visited a user's Personal Workspace. Visitors may
also leave comments about the entries created in that personal workspace. Com are displayed in reverse chronolof roer. A
picture of the individual signing the guestbook is displayed with the comment. The guestbook is useful for expanding users’ social networks

Files A file folder is a place to put files. Comments or entire discussions can be posted about individual files. Additionally, the files can be
automatic ally loc ked, edited-in-place, then uniocked, creating a new version of the file. A file folder ¢ an emulate a WebDA\ server. This
allows a user to add a ete files via any WebDAW client, such as the MS Windows File Manager.

Milestones A milestone folder is used to roll up or summarize activity in one or more Task folders.

Micro-Blog A mic ro-blog folder is & special folder that gets created automatically for each user. It is intended to contain short text entries only. Each user

tan add micro-blog entries directoy from the tools area on every page. While you can create multiple micro-blog folders, only the one that is
created automatically wil be accessed as the user's real micro-bilog.

Mirrored Files & mirrored file folder is & special t
\ibe repository. Ty pically the d
about the folder contents in sync

ype of file folder where it uses a server file system directory as its file storage area instead of the normal
ctory iz a file share accessed via normal file sharing mechanisms. \ibe attempts to keep its knowledge
with whatever is in the directory. The mirrored folder feature can mirror any WebDAW or loc al file path.

Photo Album A photo album allows the user to add and view thumbnails of files in a graphical format such as JPG and .PNG

Surveys Asurvey folder can hold a series of surveys. Each survey is made up of a series of questions. The results of the survey are summarized
and can be viewed within the folder.

Tasks A task folder contains a series of task entries. The folder also displays a summary of task priority and status

Wiki Awikiis a ¢ cllaborative folder ¢ ontaining linked web pages that can be edited by anyone with appropriate access. Itis useful for creating and

making available information ¢reated by a group of authors

2b Specify a name for the folder that reflects the type of data that is available in the mirrored
location.

2c Select Mirrored Files, then click OK.

3 Configure the new Mirrored Files folder to access the resource driver:

3a Click the Configure icon 'E} next to the folder title, then click Edit Folder.

3b Scroll down to the mirrored folder options at the bottom of the page.
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Resource Driver  Shared Files 1 (Read Only) s

Resource Root Path  fmntarchiveidocuments
Resource Path Relative to the Root Path (f you're modifying old value, it is highly recommended to synchronize this folder immediately)

3c Set the mirrored folder options as needed:

Resource Driver: Select the name of the mirrored folder resource driver, as specified in the
Title field on the Mirrored Folder Resource Driver Configuration page in the Vibe
Installation program or usingthetitl e=tagintheinstal |l er. xm file.

Resource Root Path: Displays the pathname you specified in the Vibe Installation program
ortheinstaller.xmn file.

Resource Path Relative to the Root Path: (Optional) Add a subdirectory path to restrict the
scope of the files available in the Mirrored File folder.

IMPORTANT: After you configure a Mirrored Files folder with a resource driver, you cannot
edit any of the mirrored folder settings except for the subdirectory path. If you need to
change other settings, you can delete the Mirrored File folder and create a new one with
different settings.

3d Click OK to save the mirrored folder settings.

4 Display the Mirrored Files folder, click the Configure icon @ next to the folder title, then click
Manually Synchronize to create the initial metadata for the mirrored folder.

5 Set up a synchronization schedule to keep the metadata current:
5a Click the Configure icon @ next to the folder title, then click Schedule Synchronization.

Schedule Mirrored Folder Synchronization

[ Enable Scheduled Synchronization 9

@) Every Day
® Weekly (on the days selected below)

Ooooogoo
Sunhon Tue'Wed Thu Fri Sat

@ AtTime 12 % : 15 ~ GMT
O Repeat Every 0.25 » Hours

6 Select Enable Scheduled Synchronization.
7 Set schedule options as needed.

You can choose to have mirrored folder synchronization performed every day, or you can select
specific days of the week (for example, on Monday, Wednesday, and Friday). You can choose to
have synchronization performed once a day at a specified time (for example, at 2:00 a.m.), or
you can set a time interval, so that it is performed multiple times each day (for example, every
four hours). The smallest time interval you can set is .25 hours (every 15 minutes).

8 Click Apply > Close to save the synchronization schedule options for the mirrored folder.
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9 Click the new Mirrored Files folder to display the directories and files in the mirrored location.

IMPORTANT: If you set up multiple Mirrored Files folders that point to the same files, and if
Vibe users have been granted write access to those files, multiple Vibe users can gain write
access to the same mirrored file at the same time. File locking is associated with each Mirrored
File folder entry, not with the physical source files. Make sure that all Vibe users have access to
mirrored files through the same Mirrored File folder.

10 Set appropriate access controls on the Mirrored Files folder, as described in Chapter 2,
“Planning and Controlling User Access to Workspaces and Folders,” on page 21.
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Setting Up Zones (Virtual Vibe Sites)

You can set up multiple virtual Vibe sites within a single physical Vibe site by setting up Vibe zones.
Each Vibe zone is completely independent. Each zone has its own unique URL, and data files for each
zone are stored in a separate subdirectory of the Vibe file repository, so that no searching across
zones is possible.

¢ “Creating a New Vibe Zone” on page 197
+ “Configuring DNS to Support the New Zone” on page 198
+ “Accessing the New Zone” on page 199

+ “Setting Up Access Control for the New Zone” on page 199

Creating a New Vibe Zone

1 Login to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon %',

3 Under Management, click Zones.
Zones

Add a New Zone

D Name Virtual Host
kablink

The default zone name is kabl i nk. It represents your initial Vibe site, from which all other
zones can be managed.

4 Click Add a New Zone, then fill in the fields.
Zones

Add a New Zone
Name

Virtual Host

ID Name Virtual Host
1 kablink
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Name: Specify a unique name to describe the zone. The name can include alphanumeric
characters, periods, and underscores. Do not include spaces, extended characters, or double-
byte characters.

Virtual Host: Specify the hostname for the zone. You can use any hostname that does not
conflict with an existing hostname.

5 Click Add, then click Close to create the zone.

Configuring DNS to Support the New Zone

The new zone URL has the following format:
http://virtual hostnane[: port]

where vi rt ual _host nane is the hostname or fully qualified domain name of the Vibe zone that
you have set up in DNS.

All zones use the same port number as the physical Vibe site. If you have the Vibe site configured to
listen on your browser default port, you do not need to include the port number in the zone URL.
How you configure your Vibe site to listen on the browser default port varies by platform.

Linux: See “Setting Up Port Forwarding on SLES 12” in “Single-server (Basic) Installation” in the
OpenText Vibe 4.0.8 Installation Guide.

Windows:  Specify the desired port numbers when you run the Vibe Installation program, as described in
“HTTP/HTTPS Ports” in “Single-server (Basic) Installation” in the OpenText Vibe 4.0.8
Installation Guide.

1 To perform an initial test of the Vibe zone, add the zone URL to the host s file on your local
workstation where you run your browser. The location of the host s file and the format of the
line to add vary by platform:

Linux / etc/ hosts
i p_address vi be_zone_url host nane
172.16.5.18 www. nyvi besi te. com vi bel
Windows C.\ W ndows\ syst enB2\ dri ver s\ et c\ hosts
i p_address vi be_zone_url

172.16.5.18 www. nyvi besi te. com

2 Specify the zone URL in your web browser.
http://ww. nmyvi besite.com

3 Login to the new zone by using the default administrator user name (adni n) and password
(admi n).

From this, you can see that each zone has its own site administrator who has administrative
rights only within that particular zone.
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4 Immediately change the site administrator password to a secure password of your own
choosing, as described in “Accessing Your Basic Vibe Site as the Site Administrator” in “Single-
server (Basic) Installation” in the OpenText Vibe 4.0.8 Installation Guide.

5 After you can access the new zone successfully following the instructions in Step 1, have your
network administrator make comparable changes to DNS so that the zone URL is recognized
across your company or across the Internet as needed.

Accessing the New Zone

As with your original Vibe site, the Vibe administrator user name is adm n, and the password is
adm n. For the security of the new zone, you should immediately change the zone’s administrator
password.

1 In your web browser, specify one of the following URLs, depending on whether or not you are
using a secure SSL connection:

http://zone_host name
https://zone_host nane

Replace zone_host nane with the zone hostname or fully qualified domain name that you set
up in DNS.

2 Login using admi n as the login name and admi n as the password.

3 Change the default zone administrator password to a secure password:
3a Navigate to the personal workspace of the Vibe administrator.
3b Click Profile, then click Edit on the Profile page.

3c Specify a new password for the zone administrator in the New Password and Confirm New
Password fields.

3d (Optional) Provide useful information in the additional fields of the zone administrator’s
profile.

3e Click OK to return to the zone administrator’s profile.

IMPORTANT: The zone can only be administered by accessing the zone URL and by logging in
through the zone administrator password. The zone cannot be administered from the main Vibe site,
even when you are logged in as the main Vibe administrator.

Setting Up Access Control for the New Zone

After you log in to the zone as the zone administrator, you can set access controls for the zone.

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon *.

3 Under System, click Access Control.
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4 (Conditional) If you want to have more than one zone administrator:
4a Click Add a User, start typing the user’s name, then select the user from the drop-down list.
4b Select the check box in the Zone Administration column.
4c¢ Click Save Changes.
(Optional) Add roles, as described in “Managing Roles to Refine Access Control” on page 31.

6 (Optional) Set other access controls for the zone, as described in “Controlling Access” in the
OpenText Vibe 4.0.8 Advanced User Guide.
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1 9 Managing a Multiple-Language Vibe Site

¢ “Accommodating Multiple Languages” on page 201

+ “Adding a New Language” on page 202

Accommodating Multiple Languages

+ “Understanding the Vibe Site Default Language” on page 201
+ “Setting Up a Multilingual Workspace Name” on page 201
+ “Changing the Default Language on the Login Page” on page 202

Understanding the Vibe Site Default Language

There can be only one default language for the entire OpenText Vibe site. You select the default
language when you install Vibe, as described in “Planning the Default Locale and Logging Time Zone”
in the OpenText Vibe 4.0.8 Installation Guide.

When you create Vibe users, you can select a locale for each user, which determines the language of
each personal workspace. However, when users who speak various languages work together on a
Vibe site, they can often see interface text that is not in their preferred language. Examples include:

+ Standardized text such as Home Workspace, Global Workspaces, Personal Workspaces, and Team
Workspaces in the Workspace tree
+ Standardized group names, such as All Users
+ Login page
Although you cannot change standardized group names, such as All Users, you can rename the
standardized workspaces to include multiple languages. Although the Vibe login page can be

displayed in only one language, you can change the page’s default language.You must be logged in as
the Vibe administrator in order to perform these tasks.

Setting Up a Multilingual Workspace Name

1 Browse to the workspace.

2 Click the Configure icon © next to the workspace title, then click Edit Workspace.
3 Inthe Title field, add text in another language, then click OK.
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Changing the Default Language on the Login Page

The language of the Vibe login page is decided by the Guest user account. Because of this, you can
display only one language for your entire Vibe site in the login page.

To change the language of the Guest user account, and therefore change the language that is
displayed on the Vibe login page:
1 Navigate to the Guest workspace.
2 On the Profile page click Edit.
The User page is launched.

3 Inthe Locale drop-down list, select the language that you want to be displayed on your login
page.
Users who log in as Guest view the Vibe site in the language that you select.

4 Click OK.

Adding a New Language

¢ “Current Language Availability” on page 202
+ “Text to Translate” on page 203

+ “New Language Implementation” on page 203

Current Language Availability

OpenText Vibe is currently translated into 15 languages. Each language is identified by a language
code in the Vibe software. Directory names and filenames include the language codes to identify the
languages of directories and files.

+ Chinese-Simplified (zh_TW)

+ Chinese Traditional (zh_CN)

+ Danish (da)

¢ Dutch (nl)

+ English (en)

+ French (fr)

+ German (de)

¢ Hungarian (hu_HU)

+ [talian (it)

+ Japanese (ja)

+ Polish (pl)

+ Portuguese (pt_BR)

+ Russian (ru_RU)

+ Spanish (es)

+ Swedish (sv)
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Kablink Vibe is an open source project where additional languages can be contributed by interested
members of the open source community.

Text to Translate

You can translate the software interface text and pop-up text.

The files that contain the text strings in the Vibe interface
(messages_| anguage_code. properti es) and in mouse-over pop-ups (hel p-
nmessages_| anguage_code. properti es) are located in the following directory

Linux: / opt/ novel | / t eam ng/ apache-tontat/
webapps/ ssf/ WEB- | NF/ nessages

Windows: c:\Program Fil es\ Novel | \ Team ng\ apache-t ontat\
webapps\ ssf\ WEB- | NF\ nessages

1 Identify the file in the language that you want to translate from.
2 ldentify the language code for the language that you want to translate into.

Lists of standard language codes (http://en.wikipedia.org/wiki/Language_code) are available on
the Internet.

3 Create a copy of the file that you want to translate, and name it with the appropriate language
code.

4 Edit the file to translate in a text editor.
Useful information for translators is provided at the top of each file (in English).

5 Locate the following line:
Team ng. Lang=

6 Replace the existing language code with the language code for the language that you want to
translate into.

The lines in the file have the following format:
tag=string
7 In each ling, replace the text after the equal sign (=) with your translation for the string.

8 Save your translated file along with the other translated files.

9 Configure Vibe to recognize the new language, as described in “New Language
Implementation” on page 203.

New Language Implementation

1 Change to the following directory:

Linux: /opt/ novel | / t eam ng/ apache-t ontat /
webapps/ ssf/WEB- | NF/ cl asses/ confi g

Windows: c¢:\Program Fi | es\ Novel | \ Teani ng\ apache-t oncat\
webapps\ ssf\ WEB- | NF\ cl asses/ config
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2 Make a backup copy of the ssf - ext . properti es file, located in the same directory with the
ssf. properti es file.

3 Openthessf. properti es filein a text editor.

4 Locate the following line:

i 18n. 1 ocal e. support=en, da, de,es,fr,hu_HU it,ja,nl,pl,pt_BR ru_RU sv,
zh_CN, zh
TW

Copy that line to the clipboard of your text editor.
Open the ssf - ext . properti es file.
Scroll to the end of the ssf - ext . properti es file, then paste the line you copied.

Type a comma (,) at the end of the line, followed by your language code.

O 00 N O U

Save and close the ssf - ext . properti es file.
10 Close the ssf. properti es file without saving it.
11 Stop and restart Vibe.
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Site Maintenance

+ Chapter 20, “Managing Users,” on page 207

+ Chapter 21, “Managing Groups,” on page 233

+ Chapter 22, “Managing Workspaces,” on page 235

+ Chapter 23, “Managing Disk Space Usage with Data Quotas and File Restrictions,” on page 243
+ Chapter 24, “Managing Workspace and Folder Templates,” on page 263
¢ Chapter 25, “Creating and Managing Workflows,” on page 271

+ Chapter 26, “Viewing and Updating the Vibe License,” on page 273

+ Chapter 27, “Managing Email Configuration,” on page 275

+ Chapter 28, “Managing the Lucene Index,” on page 283

+ Chapter 29, “Managing Database Logs and File Archives,” on page 289
¢ Chapter 30, “Backing Up Vibe Data,” on page 291

+ Chapter 31, “Monitoring the Vibe Site,” on page 295

¢ Chapter 32, “Reconfiguring the Vibe Site,” on page 317
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O Managing Users

As time passes on your Vibe site, users come and go, resulting in the need for periodic maintenance
activities.

+ “Synchronizing Users and Groups from an LDAP Directory” on page 207

+ “Setting a Default Time and Locale for Non-LDAP and External Users” on page 222

¢ “Creating a New Local User” on page 223

+ “Listing Vibe Users” on page 223

+ “Modifying a User’s Profile Information” on page 224

+ “Renaming a Vibe User” on page 225

+ “Deleting a Vibe User” on page 226

+ “Disabling Vibe User Accounts” on page 228

+ “Limiting User Visibility” on page 228

+ “Managing Local Users and Groups by Importing Profile Files” on page 229

+ “Enabling Users to Bypass the XSS Security Filter” on page 230

Synchronizing Users and Groups from an LDAP Directory

Unless you are planning a very small Vibe site, the most efficient way to create Vibe users is to
synchronize initial user information from your network directory service (eDirectory, GroupWise, or
Active Directory directory service) after you have installed the Vibe software. Over time, you can
continue to synchronize user information from the LDAP directory to your Vibe site.

IMPORTANT: The following limitations apply when synchronizing user information to Vibe from an
LDAP directory service:

+ Vibe performs one-way synchronization from the LDAP directory to your Vibe site. If you
change user information on the Vibe site, the changes are not synchronized back to your LDAP
directory.

+ If your LDAP directory contains a multi-value attribute, Vibe recognizes only one of the values.
For example, if your LDAP directory contains multiple email addresses for a given user, only one
of the email address is synchronized to Vibe.

+ Users that are imported to Vibe via LDAP are always authenticated to Vibe via the LDAP source.
If the LDAP source is unavailable for any reason, the LDAP-imported users cannot log in to Vibe.

For information about known issues with LDAP synchronization in Vibe, see “LDAP” in the OpenText
Vibe 4.0.8 Release Notes.

Table 20-1 shows user synchronization rates based on samples from test labs at OpenText. Results
may vary depending on hardware, LDAP server, database, and network topology.

Managing Users 207


https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_readme_novell/vibe4_readme_novell.pdf#ble286e
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_readme_novell/vibe4_readme_novell.pdf#vibe4readmenovell
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_readme_novell/vibe4_readme_novell.pdf#vibe4readmenovell

Table 20-1 LDAP Synchronization Performance Rate Samples

Number of Users Synchronized Time Required to Complete Synchronization
1,000 20 seconds

2,500 44 seconds

10,000 2 minutes

20,000 5 minutes

50,000 13 minutes

To synchronize users and groups from LDAP:

1 Login to Vibe as the Vibe administrator.
1a Launch a web browser.
1b Specify one of the following URLs, depending on whether you are using a secure SSL
connection:

http://vi be_host name: 8080
htt ps://vi be_host nane: 8443

Replace vi be_host nane with the host name or fully qualified domain name of the Vibe
server that you have set up in DNS. If you configured the HTTP ports correctly during
installation, you do not need to include the port number in the Vibe URL.

Depending on how you have configured your Vibe system, you might not be required to
enter the port number in the URL. If you are using NetlQ Access Manager, the Vibe login
screen is not used.

2 Click the admin link in the upper-right corner of the page, then click the Administration Console
icon '+,

3 Under System, click LDAP.

¢ “Configuring an LDAP Connection” on page 208

+ “Configuring LDAP Synchronization” on page 215

+ “Restricting Local User Accounts from Logging In” on page 218

+ “Synchronizing Additional LDAP Attributes” on page 218

+ “Allowing Users to Log In When the LDAP Server is Down” on page 220
+ “Previewing and Running the LDAP Synchronization” on page 221

+ “Viewing Synchronization Results” on page 222

+ “Deleting an LDAP Configuration” on page 222

Configuring an LDAP Connection

You can configure one or more LDAP connections to your directory.

You should never configure multiple LDAP connections to point to the same location on the same
LDAP directory. If you need a failover solution, you should use a load balancer.
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To configure an LDAP connection:

1 On the LDAP Configuration page, click the LDAP Servers tab.
2 To create a new LDAP connection, click Add.

or

To modify an existing LDAP connection, click the URL of the connection in the Server URL

column of the provided table.

3 On the LDAP Server Configuration dialog box, specify the information on each tab, as described

in the following sections:

+ “Server Information” on page 209
+ “Users” on page 212

+ “Groups” on page 214

Server Information

1 On the LDAP Servers tab, click Add.
The LDAP Server Configuration dialog box is displayed.

LDAP Server Configuration =

Server Information Users Groups

The LDAP server URL format is Idap:/fhostport For example: Idap:#flocalhost 389
LDAP server URL:

User DN:

Password:

Directory type: |eDirectory v

Enter the LDAP atfribute that uniquely identifies a user.

Guid attribute: [GuID 7|

Select if you want users created as internal or external users

Create users as: Intemal Users ¥ |
Select the LDAP attribute whose value will be used as the Vibe account name
Vibe account name attribute: cn v |

Enter the mappings from the internal identifiers to the LDAP attribute names of the user record. Use the
following syntax: internallD=ldapAttributeMame

firstName=gn
emailAddress=mail
lastName=sn
description=description
phone=telephoneNumber
lastName=surname
firstName=givenhame

o) Carca

2 Specify the following information on the Server Information tab:
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IMPORTANT: When modifying an existing LDAP connection, do not modify the LDAP server
URL. Doing so can lead to synchronized users being disabled or deleted.

LDAP Server URL: In order to synchronize initial user information, Vibe needs to access an LDAP
server where your directory service is running. You need to provide the host name of the server,
using a URL with the following format:

| dap: // host nane
If the LDAP server requires a secure SSL connection, use the following format:
| daps:// host nanme

If the LDAP server is configured with a default port number (389 for non-secure connections or
636 for secure SSL connections), you do not need to include the port number in the URL. If the
LDAP server uses a different port number, use the following format for the LDAP URL:

| dap: // host name: port _nunber
| daps:// host nane: port _nunber

If the LDAP server requires a secure SSL connection, additional setup is required. You must
complete the steps in “Securing LDAP Synchronization” on page 338 to import the root
certificate for your LDAP directory into the Java keystore on the Vibe server before you
configure Vibe for LDAP synchronization.

User DN (proxy user for synchronizing users and groups): Vibe needs the user name and
password of a user on the LDAP server who has sufficient rights to access the user information
stored there:

Directory Service Required Rights

eDirectory + [All Attribute Rights] - Compare & Read

+ [Entry Rights] - Browse (on the container containing the users that need
to be imported into Vibe)

Active Directory Any authenticated user can be used as the proxy user as long as there are no
read restrictions in place on the Organizational Unit (OU) that contains the
users

Required rights if OU read restrictions are in place:

+ Read (on the Organizational Unit containing the users that need to be
imported into Vibe)

Ensure that This object & all descendant objects is selected in the
Security tab under the advanced options.

GroupWise GroupWise requires an Admin App user for this. See “Creating an Admin App
in GroupWise” in the GoupWise Mobility Service 2014 R2 Administration
Guide.

You need to provide the fully qualified, comma-delimited user name, along with its context in
your LDAP directory tree, in the format expected by your directory service.
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Directory Service Format for the User Name

eDirectory cn=user nane, ou=or gani zati onal _unit, o=organi zati on
Active Directory cn=user nane, ou=or gani zati onal _uni t, dc=domai n_conponent
GroupWise cn=adm n_app_user, 0=syst em nane

Password: Password for the User DN.

Directory Type: The directory type that you are connecting to. Select eDirectory, Active
Directory, or GroupWise.

GUID attribute: Depending on the directory type that you chose, this field is populated with the
name of the LDAP attribute that uniquely identifies a user or group. For eDirectory, this value is
QU D. For Active Directory, this value is obj ect GUI D. For GroupWise, this value is ent r yUUl D.
This attribute always has a unique value that does not change when you rename or move a user
in the LDAP directory. It ensures that Vibe modifies the existing user instead of creating a new
user when the user is renamed or moved in the LDAP directory.

If this attribute is not set and you rename or move a user in the LDAP directory, Vibe assumes
that the new name (or the new location of the same name) represents a new user, not a
modified user, and creates a new Vibe user.

For example, suppose you have a Vibe user named William Jones. If William changes his name
to Bill, and you make that change in the LDAP directory, Vibe creates a new user named Bill
Jones.

If you want to map users to a different attribute, select Other in the drop-down list, specify the
name of the LDAP attribute, then click OK. Before you do this, ensure that the attribute that you
use is a binary attribute. For example, the cn attribute cannot be used because it is not a binary
attribute.

Create Users As: Specify whether you want Vibe to treat the users as Internal or External. If you
choose External, then the Vibe Account Name attribute will change from cn to nai | . All
external users use their email address as their login.

Vibe account name attribute: The attribute you choose here depends on the directory type
you selected in the Directory type drop-down list. If you selected eDirectory in the Directory type
drop-down list, you see cn and Other as options for this attribute. If you selected GroupWise in
the Directory type drop-down list, you see only cn as an option for this attribute.If you selected
Active Directory or Other in the Directory type drop-down list, you see sAMAccountName, cn,
and Other as options for this attribute. If you select Other as the value for this attribute, you are
prompted to enter the name of the LDAP attribute. The value of the attribute that you enter is
used for the Vibe account name.

The Vibe account name attribute has two purposes:

+ Used as the Vibe user name when the user is first provisioned from LDAP. The value of this
attribute must be unique.

¢ During Vibe login, Vibe uses this attribute to locate the user in the LDAP directory and then
tries to authenticate as that user.

LDAP directories differ in the LDAP attribute used to identify a User object. Both eDirectory and
Active Directory might use the cn (common name) attribute. A more sure alternative for Active
Directory is to use the sAMAccountName attribute. Other LDAP directories might use the uid
(unique ID) attribute, depending on the structure and configuration of the directory tree.
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You might need to consult with your directory administrator in order to determine which
attribute is best to use. In some cases where not all users are imported successfully, you might
need to set up two LDAP sources pointing to the same LDAP server and have each source use a
different value for the LDAP Attribute Used for Vibe Name. For example, set up one LDAP source
and use cn as the Vibe account name attribute. Then set up a separate source to the same LDAP
server and use sAMAccountName as the Vibe account name attribute.

In addition to the attributes already mentioned in this section, other LDAP attributes can be
used for the Vibe account name attribute, as long as the attribute is unique for each User object.
For example, the mail LDAP attribute on User objects could be used to enable Vibe users to log
in to the Vibe site by using their email addresses.

NOTE: Because the login name becomes part of the user’s workspace URL, the at sign (@) in the
email address is replaced with an underscore (_) in the workspace URL because @ is not a valid
character in a URL.

3 Continue with “Users” on page 212.

Users

1 On the LDAP Server Configuration page, click the Users tab, then click Add.
The LDAP Search dialog box is displayed.

LOAP Search

Base DN: =

(&(!{objectClass=computer))(|{objectClass=Person){cbjectClass=orgPerson)

Filter ({objectClass=inetOrgPerson)))

Search subtree

2 Specify the following information n the LDAP search dialog box:

Base DN: Vibe can find and synchronize initial user information from User objects located in
one or more containers in the LDAP directory tree. A container under which User objects are
located is called a base DN (distinguished name). The format you use to specify a base DN
depends on your directory service.

Directory Service Format for the User Container

eDirectory ou=or gani zati onal _unit, o=organi zati on
Active Directory ou=or gani zati onal _unit, dc=donmai n_conponent
GroupWise cn=adni n_app_user, o=syst em nane
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Container names cannot exceed 128 characters. If the container name exceeds 128 characters,
users are not provisioned.

TIP: You can use the Browse icon £ next to the Base DN field to browse the LDAP directory for
the base DN that you want to use.

Filter: If you are using GroupWise, accept the default as is.

To identify potential Vibe users, Vibe by default filters on the following LDAP directory object
attributes:

¢ Person
+ orgPerson
+ inet OrgPerson

You can add attributes to the user or group filter list if necessary. You can use the following
operators in the filter:

+ | OR (the default)
+ & AND
¢ INOT

You might find it convenient to create a group that consists of all the users that you want to set
up in Vibe, regardless of where they are located in your LDAP directory. After you create the
group, you can use the following filter to search for User objects that have the specified group
membership attribute:

IMPORTANT: If you create a filter to search for a specific group to find users, users that are
located in any sub-groups to that group are not synchronized.

When synchronizing against Active Directory, you can create a filter that synchronizes users in
sub-groups by using the following rule object identifier (OID):

<attribute name>:<matching rul e O D>: =<val ue>

Be sure to include the parentheses in your filter.

Directory Service Filter to search for User objects

eDirectory (groupMenber shi p=cn=gr oup_nane, ou=or gani zati onal _unit, o=org
ani zat i on)

Active Directory (menber O =cn=gr oup_nane, ou=or gani zati onal _unit, dc=domai n_co
nponent)

GroupWise Use the default.

Search subtree: Select whether you want Vibe to search for users in containers underneath the
base DN (that is, in subtrees).

3 Click OK.

4 Continue with “Groups” on page 214.
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Groups

1 On the LDAP Server Configuration page, click the Groups tab, then click Add.

The LDAP Search dialog box is displayed.

LDAF Search

Base DN: E

(| {objectClass=group)({cbjectClass=groupOfiamess)

Filter (objectClass=groupOfUniqueNamss))

Search subtree

2 Specify the following information on the LDAP Search dialog box:

Base DN: Vibe can find and synchronize initial user information from group objects located in
one or more containers in the LDAP directory tree. A container under which User objects are
located is called a base DN (distinguished name). The format you use to specify a base DN
depends on your directory service.

Directory Service Format for the Group Container

eDirectory ou=or gani zati onal _unit, o=organi zati on
Active Directory ou=or gani zati onal _unit, dc=donai n_conponent
GroupWise cn=adm n_app_user, o=syst em nane

Container names cannot exceed 128 characters. If the container name exceeds 128 characters,
users are not provisioned.

TIP: You can use the Browse icon E next to the Base DN field to browse the LDAP directory for
the base DN that you want to use.

Filter: For GroupWise, use the default.

To import groups based on information in your LDAP directory, Vibe filters on the following
LDAP directory object attributes:

* group
¢ groupO Nanes
+ groupO Uni queNanes

You can add attributes to the group filter list if necessary. You can use the following operators in
the filter:

+ | OR (the default)
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¢+ &AND
+ INOT

IMPORTANT: Be sure to include the parentheses in your filter.

TIP: For information about how to import GroupWise distribution lists to be used in Vibe, see
the following Cool Solutions article: “Using GroupWise Distribution Lists in Novell Vibe” (https:/
/www.novell.com/communities/coolsolutions/using-groupwise-distribution-lists-novell-vibe/)

Directory Service Filter to search for Group objects

eDirectory (gr oupMenber shi p=cn=gr oup_nane, ou=or gani zati onal _unit, o=org
ani zati on)

Active Directory (menber Of =ch=gr oup_nane, ou=or gani zati onal _unit, dc=domai n_co
nponent)

GroupWise Use the default.

Search subtree: Select whether you want Vibe to search for groups in containers beneath the
base DN (that is, in subtrees).

3 Click OK, then click OK again to save the LDAP server configuration.
4 Continue with “Configuring LDAP Synchronization” on page 215.

Configuring LDAP Synchronization

When you configure LDAP synchronization, you configure user synchronization options, groups
synchronization options, and the synchronization schedule.

NOTE: Because the synchronization options apply to all LDAP configurations within the same zone,
you cannot have customized synchronization settings for each LDAP configuration. However, the
Vibe site can have multiple zones. For more information about zones, see Chapter 18, “Setting Up
Zones (Virtual Vibe Sites),” on page 197.

+ “Configuring User Synchronization Options” on page 215
+ “Configuring Group Synchronization Options” on page 217

¢ “Configuring the Synchronization Schedule” on page 218

Configuring User Synchronization Options

1 On the LDAP Configuration page, click the User Settings tab.

2 Specify the following information for enabling and configuring user synchronization from your
LDAP directory to your Vibe site:

Register LDAP user profiles automatically: Select this option to automatically add LDAP users
to the Vibe site. However, workspaces are not created until users log in to the Vibe site for the
first time.
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Synchronize user profiles: Select this option to synchronize user information whenever the
LDAP directory information changes after initial Vibe site setup. The attributes that are
synchronized are the attributes that are found in the map box on the Server Information tab on
the LDAP Server Configuration page.

Enter the mappings from the internal identifiers to the LDAP attribute names of the user record. Use the
following syntax: internallD=|ldapAttribute Name

firstName=gn

emailAddress=mail

lastMame=sn

description=description

phone=telephoneNumber

lastName=surname

firstName=givenName

By default, Vibe synchronizes the following attributes from the LDAP directory:
¢ First name
¢ Last name
¢ Phone number
¢ Email address
+ Description

For information about how to add additional attributes to be automatically synchronized, see
“Synchronizing Additional LDAP Attributes” on page 218.

For user accounts provisioned from LDAP that are no longer in LDAP: Because deleting user
accounts cannot be undone, OpenText recommends that you leave Disable account selected.

For more information about disabled users in Vibe, see “Disabling Vibe User Accounts” on
page 228.

Select Delete account only if you are certain that you want to delete users that exist on the Vibe
site but do not exist in your LDAP directory. If you do decide to delete user accounts, you can
select the option Also delete associated user workspaces and content to remove obsolete
information along with the user accounts.

IMPORTANT: A deleted user cannot be undeleted; deleting a user is permanent and is not
reversible.

If you are sure that you want to automatically delete users that are not in LDAP, this option is
designed to be used under the following conditions:

+ You have deleted users from your LDAP directory and you want the LDAP synchronization
process to also delete them from Vibe.

+ |n addition to the users synchronized from LDAP, you create some Vibe users manually, as
described in “Creating a New Local User” on page 223, and you want the LDAP
synchronization process to delete the manually created users.

+ In addition to the users synchronized from LDAP, you allow Guest users to self-register, as
described in ““Allowing Guest Access to Your Vibe Site” on page 106,” and you want the
LDAP synchronization process to delete the self-registered users.
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Use the following time zone when creating new users: Select this option to set the time zone
for user accounts that are synchronized from the LDAP directory into your Vibe site. The time
zone list is grouped first by continent or region, optionally by country or state, and lastly by city.

Common selections for United States time zones:

Time Zone Continent/City
Pacific Time America/Los Angeles
Mountain Time America/Denver
Central Time America/Chicago
Eastern Time America/New York

Use the following locale when creating new users: Select this option to set the locale for user
accounts that are synchronized from the LDAP directory into your Vibe site. The locale list is
sorted alphabetically by language.

3 Continue with “Configuring Group Synchronization Options” on page 217.

Configuring Group Synchronization Options

1 On the LDAP Configuration page, click the Group Settings tab.

2 Specify the following information for enabling and configuring user and group synchronization
from your LDAP directory to your Vibe site:

Register LDAP group profiles automatically: Select this option to automatically add LDAP
groups to the Vibe site.

Synchronize group profiles: Select this option to synchronize group information, such as the
group description, to the Vibe site whenever this information changes in LDAP.

Synchronize group membership: Select this option so that the Vibe group includes the same
users (and possibly groups) as the group in your LDAP directory. If you do not select this option,
and you make changes to group membership in the LDAP directory, the changes are not
reflected on your Vibe site.

If users have rights to files on your OES or Windows file systems through group membership,
you must select this option to synchronize group membership to Vibe. If you do not synchronize
group membership, users who have access rights to files through membership in a group might
not have the appropriate access rights in Vibe.

Delete groups that were provisioned in LDAP but are no longer in LDAP: Select this option to
delete groups that exist on the Vibe site but do not exist in your LDAP directory. Use this option
under the following conditions:

+ You have deleted groups from your LDAP directory and you want the LDAP synchronization
process to delete them from Vibe as well.

+ In addition to the groups synchronized from LDAP, you create some Vibe groups manually,
as described in “Creating Groups of Users” on page 99, and you want the LDAP
synchronization process to delete the manually created groups.

3 Continue with “Configuring the Synchronization Schedule” on page 218.
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Configuring the Synchronization Schedule

This section describes how to set a schedule for the LDAP synchronization.

When planning the schedule, take into account how often your LDAP directory user (and, optionally,
group) information changes and the server resources required to perform the synchronization for
the number of users (and, optionally, groups) that you have.

1 On the LDAP Configuration page, click the Synchronization Schedule tab.

2 Select Enable schedule to enable a schedule for the LDAP synchronization to occur.

3 Select whether to run the LDAP synchronization every day, or select specific days of the week
when you want it run (for example, on Monday, Wednesday, and Friday).

You can choose to have it run once a day at a specified time (for example, at 2:00 a.m.), or you
can set a time interval, so that it is run multiple times each day (for example, every four hours).
The smallest time interval you can set is .25 hours (every 15 minutes).

4 (Conditional) If you want to restrict local users from logging in to the Vibe site, continue with
“Restricting Local User Accounts from Logging In” on page 218.

5 Continue with “Previewing and Running the LDAP Synchronization” on page 221.

Restricting Local User Accounts from Logging In

By default, Vibe allows locally created users to log in the Vibe site. This section describes how to
configure Vibe to allow only users that are synchronized via LDAP to log in.
1 On the LDAP Configuration page, click the Local User Accounts tab.

2 Leave Allow log in for local user accounts (i.e. user accounts not in LDAP) to allow users who you
have created locally to log in to the Vibe site.

For more information about creating users, see “Creating a New Local User” on page 223.

3 Continue with “Previewing and Running the LDAP Synchronization” on page 221.

Synchronizing Additional LDAP Attributes

By default, Vibe synchronizes the following attributes from the LDAP directory:

¢ First name
¢ Last name
+ Phone number
+ Email address
+ Description
This information displays on each user’s personal user profile.

To synchronize additional LDAP attributes, complete the following sections:

+ “Identifying or Creating a Vibe Field for the LDAP Attribute” on page 219
+ “Copying the Data Name of the Vibe Field” on page 219
+ “Mapping the Vibe Field to the LDAP Attribute” on page 219
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Identifying or Creating a Vibe Field for the LDAP Attribute

Before you can synchronize Vibe user profiles with additional attributes from your LDAP directory,
you first need to ensure that there is a corresponding Vibe field for the LDAP attribute that you want

to synchronize.
To view the existing fields in the user profile:
1 Navigate to a user profile and see if there is an existing field that corresponds to the LDAP

attribute that you want to synchronize.

2 If the appropriate field already exists, continue with “Copying the Data Name of the Vibe Field”
on page 219.

If the appropriate field doesn’t already exist, you must create it, as described in “Customizing
the Default User Profile View” on page 50.

Copying the Data Name of the Vibe Field

Each field in Vibe has an internal data name, which is added when the field is created. When you
create a field by using the Form and View Designers tool, Vibe requires that you enter a data name.
This name is how Vibe identifies the field.

To map an LDAP attribute to a Vibe field, you must find the data name for the field.
The following procedure shows how to find the data name for a particular field in the user profile:

1 Log in to the Vibe site as the Vibe administrator.

2 Click the Administrator link in the upper right corner of the page, then click the Administration
Console icon '+

3 In the System section, click Form/View Designers.

4 Expand Profile View, then click User.

5 Expand Profile Form Definition, expand Form, then locate the Vibe field that you want to
synchronize with an LDAP attribute.

6 Click the name of the field, then click Modify in the dialog box on the right side of the page.

7 Copy the text in the Data Name field, then continue with “Mapping the Vibe Field to the LDAP
Attribute” on page 219.

Mapping the Vibe Field to the LDAP Attribute

After you have copied the data name of the Vibe field that you want to synchronize with an LDAP
attribute as described in “Copying the Data Name of the Vibe Field” on page 219, you can map the
Vibe field to the LDAP attribute that you want to synchronize.
1 Log in to the Vibe site as the Vibe administrator.
2 Click the Administrator link in the upper right corner of the page, then click the Administration
Consoleicon %',
The Administration page is displayed.
3 In the System section, click Configure LDAP.

The map box in the Users section lists the LDAP attributes that are currently being synchronized.
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The items in the list have the following format:

vi be_field nane=ldap_attribute nane

Add a new line to the list, specifying the Vibe field name to the left of the equal sign (=) and the
LDAP attribute name to the right of the equal sign.

The vi be_fi el d_name is the data name that you copied in “Copying the Data Name of the
Vibe Field” on page 219, and | dap_at t ri but e_nane is the name of the LDAP attribute in
your LDAP directory.

Repeat Step 4 for each LDAP attribute that you want to add to the user profile.
Select Run Immediately, then click Apply.

The status box shows the LDAP attribute information being added to Vibe users.

Allowing Users to Log In When the LDAP Server is Down

You can configure the Vibe server to allow users who are being synchronized through LDAP to still
have access to the Vibe server when the LDAP server is down.

1

Change to the following directory:
Linux: / opt/ novel | / t eam ng/ apache-t ontat /

webapps/ ssf/WEB- | NF/ cl asses/ confi g
Windows: c¢:\Program Fi | es\ Novel | \ Teani ng\ apache-t oncat\

webapps\ ssf\ WEB- | NF\ cl asses\ config

Make a backup copy of the ssf - ext . properti es file, which is located in the same directory
as the ssf. properti es file.

3 Openthe ssf. properti es file in a text editor.

10

Search for the following line:
portal . passwor d. aut 0. synchroni ze=f al se

Open the ssf - ext . properti es file in a text editor.

Copy the portal.password.auto.synchronize=false line from the ssf . properti es file to the
bottom of the ssf - ext. properti es file.

Changef al se totrue, so that the line now reads
portal . passwor d. aut 0. synchroni ze=tr ue.

Save and close the ssf - ext . properti es file.
Close the ssf. properti es file without saving it.

Stop and restart Vibe to enable users to log in to the Vibe site when the LDAP server is down.
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Previewing and Running the LDAP Synchronization

Before you run the LDAP synchronization, it is a good idea to preview the synchronization so that you
are aware what changes will occur when you run the live synchronization.
+ “Previewing LDAP Synchronization” on page 221

+ “Running the LDAP Synchronization” on page 221

Previewing LDAP Synchronization

After you have configured the LDAP connection, you can see a preview of what the synchronization
results will be. This allows you to see beforehand the users and groups that will be added or deleted,
as well as the users that will be disabled, before you run the actual synchronization.

To preview the LDAP synchronization:

1 On the LDAP Configuration page, click the LDAP Servers tab, then click Preview sync.

Users and groups that will be modified by running the LDAP sync are shown, along with
information about how they will be modified (whether they will be added, modified, deleted, or
disabled).

2 (Optional) Specify a user or group in the Filter List field to filter the list of users and groups to be
synchronized.

or

Click the drop-down arrow next to the Filter List field, then select the type of users or groups
that you want to display, then click OK. (For example, select to display added users, modified
users, modified groups, and so forth.)

3 After you review the results of the synchronization, click Close, then continue with “Running the
LDAP Synchronization” on page 221.

Running the LDAP Synchronization

After you have run the preview of the LDAP synchronization (as described in “Running the LDAP
Synchronization” on page 221), you are ready to run the live synchronization.
1 On the LDAP Configuration page, click the LDAP Servers tab, then click Sync All.

Users and groups that have been modified by running the LDAP sync are shown, along with
information about how they have been modified (whether they were added, modified, deleted,
or disabled).

2 (Optional) Specify a user or group in the Filter List field to filter the list of users and groups to be
synchronized.

or

Click the drop-down arrow next to the Filter List field, then select the type of users or groups
that you want to display. (For example, select to display added users, modified users, modified
groups, and so forth.)

3 Click Close.
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Viewing Synchronization Results

You can view the synchronization results of the most recent LDAP synchronization for the current
browser session. If you perform a synchronization, log out of Vibe, and then log in again, you cannot
view the results of the LDAP synchronization for your previous session.

To view the results for a previous synchronization:

1 On the LDAP Configuration page, click the LDAP Servers tab.

2 Click Show sync results.

Deleting an LDAP Configuration

IMPORTANT: If you delete an LDAP configuration and you have selected the option to delete user
accounts that are provisioned from LDAP that are no longer in LDAP, all users that were synchronized
to the Vibe site through that LDAP configuration are deleted from the Vibe site. (For more
information about the configuration option concerning user accounts provisioned from LDAP, see
“Configuring User Synchronization Options” on page 215.)

1 On the LDAP Configuration page, click the LDAP Servers tab.
2 Select the LDAP configuration that you want to delete, then click Delete.

Setting a Default Time and Locale for Non-LDAP and
External Users

Path to Configuration Dialog: Vibe Administration Console > Management > Default User Settings

By default, the locale setting for newly created local users is English (US) and the time zone is set to
Greenwich Mean Time (GMT).

This dialog lets you change the defaults for newly created local users.

You specify the default locale and time zone for LDAP users when you configure LDAP
synchronization.

Creating a New Local User

You can manually create users on the Vibe site, rather than synchronizing user information from an
LDAP directory. Users created in this way are local users, and are not added to your LDAP directory.
Local users are not authenticated through NetlQ Access Manager when Access Manager is fronting
the Vibe system.

You can create local users from the Administration Console:
1 Login to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, and then click the Administration

Console icon '+,

3 In the Management section, click Users.
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4 Click New.
The User page is displayed.

5 Provide the user’s information in the User page, then click OK.

Listing Vibe Users

On the Vibe site, you can view a comprehensive list of all the Vibe users.

1 Log in to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon '+

3 In the Management section, click Users.

All users in the Vibe site are displayed.
You can use this page in the following ways:

+ “Filtering Users” on page 223
+ “Navigating to a User’s Individual Workspace” on page 224

+ “Adding Local Users” on page 224

Filtering Users

You can filter the user list in the following ways: by specifying a name in the Filter List field in the
upper-right corner.
+ Specify a name in the Filter List field in the upper-right corner, then press Enter.

+ Click the drop-down arrow next to the Filter List field, then select from the following options (by
default, all options are selected):

+ Show Internal Users: Shows internal Vibe users.

+ Show External Users: Shows external Vibe users.

+ Show Disabled Users: Shows users that have been disabled.

+ Show Enabled Users: Shows users that are enabled.

+ Show Administrators: Shows users that have Administrative rights.

+ Show Users That Are Not Administrators: Shows users that do not have Administrative
rights.

Navigating to a User’s Individual Workspace

You can use the user list to navigate to a user’s individual workspace.

1 Inthe user list, in the Full Name column, click the name of the user whose workspace you want
to navigate to, then click Workspace.

If you have deleted a user workspace but have not yet purged the workspace, the user
workspace is still displayed in the user list, but you are unable to navigate to the workspace.
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If you want the user workspace to be removed from the user list, you must purge the
workspace, as described in “Making Disk Space Available by Deleting Items from the Trash” in
the OpenText Vibe 4.0.8 Advanced User Guide.

If you want to restore the workspace, see “Restoring Items from the Trash” in the OpenText Vibe
4.0.8 Advanced User Guide.

Adding Local Users

A local user is a Vibe user who is not added to your LDAP directory. You can use the Users page to
add new local users to your Vibe site.

For information about how to add local users, see “Creating a New Local User” on page 223.

Modifying a User’s Profile Information

You can modify the following information in a user’s profile directly from Vibe, unless the
information is being synchronized from an external directory via LDAP:

*

*

Password

Name

Email addresses

Time zone

Locale

Personal information, including job title, state, and postal code
Contact information, including phone numbers

Organization information, including department and manager
Job responsibilities

Profile picture

To modify a user’s profile information:

Log in to the Vibe site as the Vibe administrator.

Click your linked name in the upper right corner of the page, then click the Administration
Console icon '*.

In the Management section, click Users.

All users in the Vibe site are displayed.

Click the name of the user whose profile information you want to change.

5 If the user has logged in to the Vibe site at least one time, click Profile.

or
If the user has never logged in to the Vibe site, click Modify.

Modify the user’s profile information as desired, then click OK.
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Renaming a Vibe User

Vibe users are identified by name (first, middle, last) and by user ID. User names are used to identify
personal workspaces. User IDs are used for logging in. You can change users’ names, but not their
user IDs. How you change users’ name depends on how you created the user.

+ “Renaming a Vibe User from LDAP” on page 225

+ “Renaming a Local Vibe User” on page 225

Renaming a Vibe User from LDAP

If you are synchronizing user information from an LDAP directory, as described in “Adding Vibe Users
from Your LDAP Directory” in “Single-server (Basic) Installation” in the OpenText Vibe 4.0.8
Installation Guide, you change a user’s first, middle, or last name by updating it in the LDAP
directory. The updated information then synchronizes to the Vibe site according to the schedule you
have established for LDAP synchronization. If you change a user’s first, middle, or last name by
updating information on the Vibe site, the change is not synchronized back to the LDAP directory, so
the two sources of user information can be out of sync.

Renaming a Local Vibe User

If you manually create Vibe users on the Vibe site, rather than synchronizing user information from
an LDAP directory, you can change users’ names (first, middle, last) on the Vibe site.

When a user logs in to the Vibe site for the first time, the user’s personal workspace is created.
Before a user logs in, he or she does not have a personal workspace. Vibe enables site administrators
to manually rename both types of users.

NOTE: Vibe does not allow you to change a user ID after the user account has been created.

To rename a local Vibe user:

1 Log in to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon '+

3 In the Management section, click Users.
All users in the Vibe site are displayed.

4 Click the name of the user who you want to rename.

5 If the user has logged in to the Vibe site at least one time, click Profile.
or
If the user has never logged in to the Vibe site, click Modify.

6 Modify the First Name, Middle Name, and Last Name fields as desired.

7 Click OK.
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Deleting a Vibe User

When users no longer need access to your Vibe site, you have two options to revoke their access to
the Vibe site: disabling or deleting their Vibe user accounts.

IMPORTANT: OpenText recommends that you disable user accounts instead of deleting them. When
you delete a user account, the account can never be re-activated. If there is the slightest possibility
that the user might return to your Vibe site, disable the user account rather than deleting it.
Disabled accounts do not count as a licensed user. For information on how to disable a user, see
“Disabling Vibe User Accounts” on page 228.

When you delete a user, the following user information is deleted and cannot be recovered:

+ All profile information, including profile pictures

+ Access controls to workspaces and folders
Entries and information that the user contributed are preserved even after the user is deleted.
How you delete a user depends on how you originally created the user.

+ “Deleting a Local User” on page 226

+ “Deleting an LDAP User” on page 227

Deleting a Local User

Any user account that has been created manually (not created by the LDAP synchronization process)
can be deleted as described in this section. To delete a user account that was created by the LDAP
synchronization process, see “Deleting an LDAP User” on page 227.

IMPORTANT: If you delete user accounts that were created by the LDAP synchronization process
without following the instructions in “Deleting an LDAP User” on page 227, new users with the same
name are created the next time the users log in or the next time the LDAP synchronization occurs.

1 Login to Vibe as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon '+

3 In the Management section, click Users.

4 Select the users whose accounts you want to delete, then click Delete.
The Delete Users dialog box is displayed.

5 Select Move user workspaces to trash if you want the workspaces to be recoverable.
or

Select Delete user workspaces to permanently delete the workspaces. You then have an
additional option to Delete user object.

The first option deletes only the user’s personal workspace. The user account remains on the
system, and the user can still log in, create a new workspace, and so on.
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The second option also removes the user account from the system, so that the user no longer
exists on the system, can’t log in, and so on.

6 Click OK.

Deleting an LDAP User

User accounts can be synchronized to the Vibe site with an LDAP directory. While you can delete
Vibe user accounts, OpenText recommends that you disable them, as described in “Disabling Vibe
User Accounts” on page 228.

If you decide to delete Vibe user accounts, it is safer to manually delete them rather than deleting
them through the LDAP synchronization process.
+ “Manually Deleting User Accounts That Are Being Synchronized through LDAP” on page 227
+ “Configuring LDAP to Automatically Delete User Accounts” on page 227

Manually Deleting User Accounts That Are Being Synchronized through
LDAP

Following is the preferred method for deleting user accounts from the Vibe site that are being
synchronized from an LDAP directory:

1 In your LDAP directory, modify the User objects that you want to delete from the Vibe site so
that the User objects no longer match the LDAP synchronization criteria that you previously set.

For information about setting LDAP synchronization criteria, see “Synchronizing Users and
Groups from an LDAP Directory” on page 207.

2 InVibe, manually delete the user accounts, as described in “Deleting a Local User” on page 226.

Because user accounts that are deleted cannot be recovered, you should make sure you know
exactly which users you are deleting, and the only way to be sure is by manually deleting them.

Configuring LDAP to Automatically Delete User Accounts

IMPORTANT: While it is possible to configure LDAP synchronization to automatically delete Vibe
users and workspaces, this should be avoided because it might result in unwanted deletion of users.
For example, if the LDAP context is entered incorrectly and none of the users match the incorrect
LDAP context, all of the users would be permanently deleted.

For more information about how to configure the LDAP synchronization to automatically delete Vibe
users and workspaces, see “Configuring LDAP Synchronization” on page 215.
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Disabling Vibe User Accounts

OpenText recommends that you disable user accounts instead of deleting them. When you delete a
user account, the account can never be re-activated. If there is the slightest possibility that the user
might return to your Vibe site, disable the user account rather than delete it. Disabled accounts do

not count as a licensed user.

This section describes how to disable local user accounts as well as accounts that are being
synchronized with an LDAP directory.

To disable user accounts:
1 Login to Vibe as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon %',

3 In the Management section, click Users.

4 Select the users whose accounts you want to disable, then click More > Disable User Account.

The user accounts are disabled
To re-enable user accounts:

1 Login to Vibe as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon '*.

3 In the Management section, click Users.

4 Select the users whose accounts you want to re-enable, then click More > Enable User Account.

The user accounts are enabled

Limiting User Visibility
Path to Configuration Page: Vibe Administration Console > Management > Limit User Visibility

By default, each Vibe user can see all other Vibe users on the site.

Vibe lets you restrict the users that appear in Vibe dialogs and so on, to only those within groups to
which a user belongs.
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For additional information and instructions on limiting user visibility, see “Restricting Groups of
Users from Seeing One Another” on page 105.

¢ “Creating User Visibility Limitations” on page 229

Creating User Visibility Limitations

For administrative efficiency and as a best practice, user-visibility limitations are usually applied to
one or more groups.

Most organization choose to limit visibility at the group level and then manage exceptions by
creating overrides for individual users. However, limitations can be applied to individual users if
needed.

1 Identify the groups whose users require and/or will benefit from having user-visibility
limitations set.

2 lIdentify group users who will need to be able to collaborate and share on a system-wide basis
and will therefore need overrides.

3 Login as an administrator, open the Vibe Administration Console > Management > Limit User
Visibility.

4 Use the Add Limitation button to add user-visibility limitations to the groups (or users)
identified.

5 Use the Add Override as needed.

6 If you need to remove a limitation, select the line to be removed and use the Remove Visibility
Settings button to remove the setting from the list.

Managing Local Users and Groups by Importing Profile
Files

You can manage local users and groups by importing profile files that contain user or group
information in XML format. This is a good way to simultaneously perform multiple actions when you
are not using LDAP.

You can perform the following actions:

+ Create or modify users
+ Delete users

+ Create or modify groups
To manage local users and groups by importing profile files:

1 Login to Vibe as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon '+

3 In the Management section, click Users.

4 Click the Import Profiles tab.
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5 Click Choose File, then navigate to and select the file that contains user or group profile
information in XML format.

Ensure that the format of your file matches the format that is shown in the provided sample
file. To view the provided sample file, click View a Sample File in the Import Files tab.

6 Click OK.

Enabling Users to Bypass the XSS Security Filter

Cross-site scripting (XSS) is a client-side computer attack that is aimed at web applications. Because
XSS attacks can pose a major security threat, Vibe contains a built-in security filter that protects
against XSS vulnerabilities. This security filter is enabled by default.

The XSS security filter protects the Vibe site from XSS in two key areas:

+ Text and HTML fields in entries and folders
+ Uploaded HTML files
Specific users might need to add some of the content described in “Understanding What Content Is

Not Permitted” on page 365. If you trust these users, you can enable them to bypass the XSS security
filter by adding JavaScript and other restricted content.

IMPORTANT: We do not recommend that you turn off the XSS security filter for the entire site. For
more information about keeping your Vibe site secure from XSS, see “Securing the Vibe Site against
XSS” on page 365.

Enabling a group to bypass the XSS filter is more efficient than enabling individual users because it
requires you to modify the configuration file only once, when you initially authorize the group. After
the initial setup, you can easily modify group membership.

+ “Enabling Groups to Bypass the XSS Security Filter” on page 230

+ “Enabling Individual Users to Bypass the XSS Security Filter” on page 231

Enabling Groups to Bypass the XSS Security Filter

The most efficient way to enable users to bypass the XSS security filter is to set up a group in Vibe,
add users to this group who you trust, then authorize this group to bypass the XSS security filter.
Only group members have the authority to bypass the XSS security filter.
1 Create a group in Vibe and add only users who you trust to this group.
Members of this group will be allowed to bypass the XSS security filter.

For information on how to create a group and add users to the group, see “Creating Groups of
Users” on page 99.

2 On the Vibe server, change to the following directory:

Linux: /opt/ novel | / t eam ng/ apache-t ontat/
webapps/ ssf/WEB- | NF/ cl asses/ config

Windows: c¢:\Program Fi |l es\ Novel | \ Teani ng\ apache-t ontat\
webapps\ ssf\ WEB- | NF\ cl asses\config
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3 Openthe zone-ext. cfg. xm file in a text editor.
4 Add the following information to the xmi file, inside the <zoneConf i gur at i on> tags:

<zone nane="kabl i nk">
<xssConfi gurati on>
<t rust edG oups>
<group nanme="trusted"/>
</trustedG oups>
</ xssConfi gurati on>
</ zone>

The gr oup nane value should contain the group ID for the group you want to be able to upload
HTML files to the Vibe site.

If your Vibe system began as Teaming version 1, the zone nane valueis| i f er ay. cominstead
of kabl i nk

5 Stop and restart Vibe.

Enabling Individual Users to Bypass the XSS Security Filter

1 Change to the following directory:

Linux: / opt/ novel | / t eam ng/ apache-t ontat /
webapps/ ssf/WEB- | NF/ cl asses/ confi g

Windows: c¢:\ Program Fi | es\ Novel | \ Teani ng\ apache-tontat\
webapps\ ssf\ WEB- | NF\ cl asses\ config

2 Openthe zone-ext. cfg. xm file in a text editor.
3 Add the following information to the xnl file, inside the <zoneConf i gur at i on> tags:

<zone name="kabl i nk">

<xssConfi gurati on>
<trust edUser s>
<user nane="jchavez"/>
</trustedUsers>

</ xssConf i gurati on>

</ zone>

The user nane value should contain the user ID for the user you want to be able to upload
HTML files to the Vibe site.

If your Vibe system began as Teaming version 1, the zone nane valueis|i f er ay. cominstead
of kabl i nk

To enable multiple users to add HTML content to the Vibe site, create a group and enable the
group to add content, as described in “Enabling Groups to Bypass the XSS Security Filter” on
page 230. Or, you can enable multiple users on an individual basis by using multiple <user
nane> elements. For example:

<user nane="jchavez"/>
<user nanme="ahal | "/>
<user nane="cjones"/>

4 Stop and restart Vibe.
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Managing Groups

Group creating and maintenance is an useful way to manage users throughout your Vibe site. For

more information about why it is important to create groups, see “Creating Groups of Users” on
page 99.

+ “Creating Groups” on page 233
+ “Modifying Groups” on page 233
+ “Deleting Groups” on page 234

Creating Groups

For information on how to create groups, see “Creating Groups of Users” on page 99.

Modifying Groups

1 Log in to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon *.

3 Under Management, click Groups.

4 Click the name of the group that you want to modify.

-

Edit Group - marketing (7
Title: marketing|
Description:

* Group membership is static
P P Edit group membership

Group membership is dynamic

5 Modify the title, description, and group membership, then click OK.

For more information about editing static and dynamic group membership, see “Creating
Groups of Users” on page 99.
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Deleting Groups

1 Log in to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon *.

3 Under Management, click Groups.

4 Select the group that you want to delete, then click Delete.

234 Managing Groups



2 Managing Workspaces

As an administrator for Vibe, you can perform management functions on all Vibe workspaces. For
information on how to perform general workspace management functions, such as creating a
workspace, deleting a workspace, moving a workspace, and so forth, see “General Workspace
Management” in the OpenText Vibe 4.0.8 User Guide.

You can perform additional workspace management tasks as the Vibe administrator:

+ “Exporting/Importing Workspaces, Folders, and Entries” on page 235
+ “Managing Workspace Disk Space Usage” on page 241

+ “Modifying the Title, Description, and Branding of the Personal Workspaces Workspace” on
page 241

Exporting/Importing Workspaces, Folders, and Entries

You can transfer data from one Vibe site to another by exporting it from the source Vibe site and
importing it into the destination Vibe site. When you export data, it remains in the source Vibe site
and a copy of the exported data is imported into the destination Vibe site.

By default, only the Vibe administrator can export and import workspaces, folders, and entries. For
information on how to make this functionality available to all workspace and folder owners, see
“Customizing the Simple URL Prefix” on page 96.

¢ “Understanding the Export and Import Process” on page 236

+ “Exporting Workspaces” on page 238

+ “Importing Workspaces” on page 239

+ “Exporting Folders” on page 239

+ “Importing Folders” on page 240

+ “Exporting Folder Entries” on page 240

+ “Importing Folder Entries” on page 240
If you want to simply move or copy data within a single Vibe site, see “Copying a Workspace” and

“Moving a Workspace”, “Copying a Folder” and “Moving a Folder”, or “Copying a Folder Entry” and
“Moving a Folder Entry” in the OpenText Vibe 4.0.8 User Guide.
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Understanding the Export and Import Process

The export process creates a . zi p file named export. zi p that you can save to any convenient
location on disk. The . zi p file contains all the workspaces, folders, folder entries, and attachments
that you elected to export.

When you export and import a workspace, folder, or folder entry, not all types of data are preserved.

+ “Data That Is Preserved” on page 236
+ “Data That Is Not Preserved” on page 237

Data That Is Preserved

+ Hierarchical structure of the workspace

If you are selecting specific folders within the workspace to export, the hierarchical structure to
the selected folders must be preserved. For example, if you select to export a sub-folder but not
the parent folder, the parent folder is also included in the export as a blank folder in order to
keep the structure.

+ All folders in the workspace (unless they are specifically excluded)
+ All content in exported folders
+ Access control information

User and group IDs are also preserved and are matched to the same users and groups if they
exist on the Vibe system where the workspace, folder, or entry is imported.

Access control settings are not preserved if the workspace, folder, or entry is inheriting its
access control settings from the parent folder or workspace in the original Vibe system. When
you import a workspace, folder, or entry that is inheriting its access control settings, the
workspace, folder, or entry assumes the access control settings of the higher-level workspace or
folder where it is being imported. For more information on access control, see Chapter 2,
“Planning and Controlling User Access to Workspaces and Folders,” on page 21.

+ Landing pages for workspaces or folders

For more information on landing pages, see “Creating and Managing Landing Pages” in the
OpenText Vibe 4.0.8 Advanced User Guide.

+ Entry definitions associated with any folder content

Entry definitions are custom entry forms that have been created in your folder or workspace.
Entry definitions that are being used in any exported content are preserved, even if the
definition is saved at a higher level in the workspace hierarchy. For more information on entry
definitions, see “Designing Custom Folder Entry Forms” in the OpenText Vibe 4.0.8 Advanced
User Guide.

+ Workflows associated with any workspace content

Workflows that are being used in any exported content are preserved, even if the workflow is
saved at a higher level in the workspace hierarchy.

NOTE: If your workflow contains an On Entry condition that starts a parallel workflow thread, as
described in “Adding On-Entry or On-Exit Events” in the OpenText Vibe 4.0.8 Advanced User
Guide, the parallel workflow is automatically restarted when the workflow is imported.
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For more information on workflows, see “Creating and Managing Workflows” in the OpenText
Vibe 4.0.8 Advanced User Guide.

+ Custom forms associated with any workspace content

Custom forms that are being used in any exported content are preserved, even if the custom
form is saved at a higher level in the workspace hierarchy.For more information on custom
forms, see “Designing Custom Folder Entry Forms” in the OpenText Vibe 4.0.8 Advanced User
Guide.

+ Wiki links
For more information on wiki links, see “Linking to a Folder or Folder Entry” in the OpenText
Vibe 4.0.8 User Guide.

+ Content in Mirrored Files folders

When you export a Mirrored Files folder, the files from the mirrored folder are written in the
export file. However, when the folder is imported, the resulting folder becomes a Vibe library
folder where all the files are added as regular file entries that are no longer mirrored. There is
no way to export a mirrored folder and import it back into Vibe as a mirrored folder.

Data That Is Not Preserved

The following types of data are not included in the export and import processes:
+ Profile information for user workspaces

When a user workspace is exported and imported, the profile information for the user is not
preserved. To move user workspaces from one Vibe site to another, add users to the target Vibe
server in one of the ways described in “Adding New Users to Your Vibe Site” on page 99. You can
then export the folders within the workspace from the source Vibe site, then re-import the
folders into the target Vibe site to the user workspace for each appropriate user.

+ Accessories

For more information on accessories, see “Managing Accessories” in the OpenText Vibe 4.0.8
User Guide.

+ Custom JSP files

Custom JSP files must be exported as part of an extension. (For more information on extensions,
see Chapter 15, “Adding Software Extensions to Your Vibe Site,” on page 181.) However, if you
have a workspace that leverages custom JSP files, the workspace still retains the settings that
point to the custom JSP files. Therefore, if you export a workspace or folder that is referencing
custom JSP files, and the Vibe site where you import the workspace has the same custom JSP
files, the imported workspace or folder points to the correct custom JSP files.

+ Permalinks

Entries that are exported receive new permalinks when they are imported. However, if an entry
description contains a permalink to another entry that was also imported, then the permalink is
preserved.

+ Activity data, such as who visited the place, edit history, and workflow history

For more information about activity data, see “Generating Activity Reports for a Workspace”,
“Generating an Activity Report on a Folder”, and “Generating Reports about a Folder Entry” in
the OpenText Vibe 4.0.8 User Guide.

+ Entry ratings
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For more information on entry ratings, see “Rating a Folder Entry” in the OpenText Vibe 4.0.8
User Guide.

+ Entry definitions that are not associated with folder content

Entry definitions are custom entry forms that have been created in your folder or workspace.
For more information on entry definitions, see “Designing Custom Folder Entry Forms” in the
OpenText Vibe 4.0.8 Advanced User Guide.

+ Workflows that are not associated with workspace content

For more information on workflows, see “Creating and Managing Workflows” in the OpenText
Vibe 4.0.8 Advanced User Guide.

+ Email notification settings
+ Default folder columns
+ Global filters

Exporting Workspaces

1 Login to the Vibe site as the Vibe administrator.

2 Navigate to the workspace that you want to export.

3 Click the Configure icon @ next to the workspace title, then click Import/Export Workspace.
The Export/Import page is displayed.

Export / Import
® Export This Folder ar Workspace Import into This Folder or Workspace

Select the ltems to be Exported:
Selecting an item wil export that tem and all of its child folders and workspaces unless this is tumed off below.
Making no selections will result in exporting everything.

Only export child folders or warkspaces that are specifically checked.

- By Marketing

[0« _] Close ]

4 Select Export This Folder or Workspace.
5 To export all contents of the folder or workspace, click OK.
or

To export only individual workspaces and folders, select Only export child folders or workspaces
that are specifically checked, then expand the workspace tree and select the workspaces and
folders that you want to export. Then click OK.
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Importing Workspaces

1 Login to the Vibe site as the Vibe administrator.
2 Navigate to the workspace where you want the imported workspace to reside.

3 Click the Configure icon @ next to the workspace title, then click Import/Export Workspace.

The Export/Import page is displayed.

4 Select Import into This Folder or Workspace.

Export / Import
Expart This Folder or Workspace *' Impaort into This Folder or Workspace

Select the Import File

Choose File | Mo file chosen

5 Browse to and select the workspace that you want to import, then click OK.

Exporting Folders

1 Login to the Vibe site as the Vibe administrator.

2 Navigate to the folder that you want to export.

3 Click the Configure icon € next to the folder title, then click Import/Export Folder.
The Export/Import page is displayed.

Export / Import
® Export This Folder or Waorkspace Impaortinto This Folder or Workspace

Select the ltems to be Exported:

Selecting an item will export that tem and sll of its child folders and workspaces unless this is tumed off below.

Making no selections will result in exporting everything.

Cnly export child folders or workspaces that are specifically checked.

..... 4" |Blog

4 Select Export This Folder or Workspace.
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5 To export all contents of the folder or workspace, click OK.
or

To export only individual workspaces and folders, select Only export child folders or workspaces
that are specifically checked, then expand the workspace tree and select the workspaces and
folders that you want to export. Then click OK.

Importing Folders

1 Login to the Vibe site as the Vibe administrator.

2 Navigate to the folder or workspace where you want the imported folder to reside.

3 Click the Configure icon € next to the folder or workspace title, then click Import/Export Folder
if you are importing into a folder.

The Export/Import page is displayed.

4 Select Import into This Folder or Workspace.

Export / Import
Export This Folder or Workspace ® Impart into This Folder or Workspace

Select the Import File
Choose File | Mo file chosen

[_ox_] Close ]

5 Browse to and select the folder that you want to import, then click OK.

Exporting Folder Entries

1 Log in to the Vibe site as the Vibe administrator.
2 Navigate to and select the folder entry that you want to export.
3 In the entry footer, click Export this entry.

You can now download the entry to your computer’s file system.

Importing Folder Entries

1 Login to the Vibe site as the Vibe administrator.

2 Navigate to the folder where you want the imported folder entry to reside.

3 Click the Configure icon © next to the folder title, then click Import/Export Folder.
The Export/Import page is displayed.

4 Select Import into This Folder or Workspace.
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Export / Import
Export This Folder or Workspace ® Impart into This Folder or Workspace

Select the Import File
Choose File | Mo file chosen

5 Browse to and select the folder entry that you want to import, then click OK.

Managing Workspace Disk Space Usage

Disk space usage is managed on both a folder and workspace basis as well as an individual user or

group basis.

You can enforce one or both of these types of data quotas. See “Managing the File Upload Size Limit”
on page 260.

Modifying the Title, Description, and Branding of the
Personal Workspaces Workspace

By default, the workspace that contains all of the personal workspaces is named Personal
Workspaces. (This is an alternate way of viewing users in your Vibe system.) The brand for this
workspace is inherited from the parent workspace, and there is no workspace description. However,
Vibe lets you modify the name, description, and brand of the workspace.

+ “Modifying the Title and Description” on page 241
+ “Modifying the Brand” on page 242

Modifying the Title and Description

1 Navigate to the Personal Workspaces workspace by clicking the Workspace Tree icon E in the
Action toolbar, expanding Home Workspace, then clicking Personal Workspaces.

2 Click the Configure icon © next to the workspace title, then click Edit Workspace.

Use this page to change the title and description of the workspace.
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Modifying the Brand

1 Navigate to the Personal Workspaces workspace by clicking the Workspace Tree icon B inthe
Action toolbar, expanding Home Workspace, then clicking Personal Workspaces.
2 Click the Configure icon E} next to the workspace title, then click Brand Workspace.

Use the Workspace/Folder branding dialog box to modify the workspace brand. For more
information about how to brand a workspace, see “Branding a Folder or Workspace” in the
OpenText Vibe 4.0.8 Advanced User Guide.
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Managing Disk Space Usage with Data
Quotas and File Restrictions

As time passes, your Vibe site occupies more and more disk space as users post folder entries, attach
files, create new versions of files, and so on. As the Vibe administrator, you can impose limits on the
amount of data that is uploaded into the Vibe site.

Only files and attachments count toward the data quota. Workspaces, folders, and entries that do
not contain files and attachments do not count toward the data quota.

You can limit the amount of files and attachments for individual users and groups as well as
individual workspaces and folders.

¢ “Understanding the Types of Data Quotas” on page 243

+ “Understanding Data Quota Behavior and Exclusions” on page 244

+ “Managing Workspace and Folder Data Quotas” on page 245

+ “Managing User Data Quotas” on page 248

+ “General Data Quota Management” on page 259

+ “Managing the File Upload Size Limit” on page 260

+ “Setting a Maximum Number of Versions for Each File” on page 262

+ “Automatically Deleting Old File Versions” on page 262

Understanding the Types of Data Quotas

You as the Vibe administrator can enable two kinds of data quotas:

+ User data quotas

+ Workspace and folder data quotas
You can enable one of these quotas, or both of them.

+ “Understanding User Data Quotas” on page 243
+ “Understanding Workspace and Folder Data Quotas” on page 244

Understanding User Data Quotas

User data quotas limit the amount of data individual users can add to the Vibe site. Any files and
attachments that a user adds to the Vibe site counts toward his or her data quota, regardless of the
folders or workspaces where the user adds them.
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Understanding Workspace and Folder Data Quotas

Workspace and folder quotas limit the amount of data that can be stored in individual workspaces
and folders.

Sub-workspaces and sub-folders that have a data quota are subject to their own data quota as well
as any data quotas that exist on parent folders and workspaces. For example, consider a workspace
that has a data quota of 50 MB. The workspace contains two sub-workspaces: Workspace A and
Workspace B. Users cannot upload data that is in excess of 50 MB into either of these sub-
workspaces. Furthermore, users cannot upload data into both of these sub-workspaces that is in
excess of 50 MB (for example, users cannot upload data that is in excess of 30 MB into both sub-
workspace, because the amount of combined data for both sub-workspaces is greater than 50 MB).

Understanding Data Quota Behavior and Exclusions

¢ “Understanding Default Data Quota Behavior” on page 244

+ “Understanding Data Quota Exclusions” on page 245

Understanding Default Data Quota Behavior

The following sections describe the default behavior for how user data quotas work after they have
been enabled. (For information on how to enable data quotas for your Vibe site, see “Enabling
Workspace and Folder Data Quotas” on page 245 and “Managing Workspace and Folder Data
Quotas” on page 245.)

+ “Exceeding the Data Quota” on page 244
+ “Exceeding the High-Water Mark” on page 245

Exceeding the Data Quota

By default, Vibe users are strictly held to the data quota that you set. If a user who is approaching his
or her data quota tries to upload a file to the Vibe site and that file exceeds the user’s data quota,
Vibe rejects the upload attempt and the entry is lost. This is also true with data quotas that are set
on workspaces and folders.

For user data quotas (not for workspace and folder data quotas), you can allow users to post a final
entry to the Vibe site even if the entry exceeds the user data quota. This approach is less strict and
does not guarantee that users won’t exceed the data quota; however, it is more forgiving because it
allows users to post one final upload to the Vibe site and does not erase the entry and attached file
that they are trying to upload.

For information on how to configure your Vibe data quotas to be less strict by allowing users one
final upload to the Vibe site, see “Configuring Data Quotas to Be Less Strict” on page 259.
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Exceeding the High-Water Mark

When users exceed the data quota high-water mark, they are notified that they are approaching the
data quota. Vibe informs them how many kilobytes of disk space are still available.

For more information on selecting an appropriate high-water mark, see “Selecting an Appropriate
High-Water Mark” on page 250.

Understanding Data Quota Exclusions

Files stored in mirrored folders do not count against data quotas because they are not uploaded into
the Vibe site.

Managing Workspace and Folder Data Quotas

+ “Enabling Workspace and Folder Data Quotas” on page 245
+ “Setting Quotas on Workspaces and Folders” on page 246

+ “Validating Workspace and Folder Quotas” on page 247

Enabling Workspace and Folder Data Quotas

Before you can set data quotas on workspaces and folders, you must first enable them. You can
enable data quotas so that only you as the Vibe administrator can manage workspace and folder
quotas, or you can enable data quotas so that all users can manage the data quotas for their own
workspaces and folders.

1 Login to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration

Console icon %',
3 Under Management, click Personal Storage.
4 Click Initialize Workspace and Folder Quota Counts.

This sets up the workspace and folder data quota for your Vibe site. This operation can take a
significant amount of time (10 to 20 minutes).
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Personal Storage

Enable Workspace and Folder Quotas

Allow Workspace and Folder Owners To Set Quotas

Enable User Data Quotas @)

Default User Data Quota Size: 100 MB
Default High-Water Mark: a0 %
Add a Group
Add a User

5 Select Enable Workspace and Folder Quotas.

6 (Optional) If you want to allow users to manage the data quotas for their own workspaces and
folders, select Allow Workspace and Folder Owners To Set Quotas.

7 Click Apply > Close.

8 Set data quotas on workspaces and folders as described in “Setting Quotas on Workspaces and
Folders” on page 246.

Setting Quotas on Workspaces and Folders

Before you can set data quotas on workspaces and folders, you need to enable them, as described in
“Enabling Workspace and Folder Data Quotas” on page 245.

You can set quotas on individual workspaces and folders, or you can set quotas on all workspaces
and folders of a certain type. For example, you can configure all Photo Album folders in your Vibe
site to have a data quota of 10 MB.

+ “Setting Quotas on Individual Workspaces and Folders” on page 246
+ “Setting Quotas on All Workspaces and Folders of a Certain Type” on page 247
Setting Quotas on Individual Workspaces and Folders

1 Navigate to the workspace and folder where you want to set the quota.

2 Click the Configure icon E" next to the workspace or folder title, then Configure Views, URLs
and Controls.
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3 Click the Quotas tab.
4 In the Set a Quota field, specify the new data quota, then click OK.

Setting Quotas on All Workspaces and Folders of a Certain Type

When you set data quotas on all workspaces or folders of a certain type, the quota applies only to
workspaces or folders that are created after you set the quota. Workspaces and folders that were
created before the quota was set do not automatically have a data quota assigned to them.

To set a data quota on all workspaces and folders of a certain type, you need to modify the template
for the workspace or folder where you want to set the data quota. For information on how to modify
the template for workspaces and folders, see “Modifying Workspace and Folder Templates” on
page 263.

Validating Workspace and Folder Quotas

Quota counts for workspaces and folders can become marginally inaccurate over time if multiple
users are frequently adding and deleting files in a workspace or folder where a data quota has been
set.

You can repair any data quota inaccuracies by validating the data quota:

1 Login to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon %',

3 Under Management, click Personal Storage.
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Personal Storage

|#| Enable Workspace and Folder Quotas

| Allow Workspace and Folder Owners To Set Quotas

! Enable User Data Quotas @)

Default User Data Quota Size: 100 MB
Default High-Water Mark: a0 %

Add a Group

[ Appiy I Ciose ]

4 Click Validate Workspace and Folder Quota Counts.
5 Click Apply > Close.

Managing User Data Quotas

Each user’s data quota establishes how much disk space the user’s attached files and file versions
can occupy in the Vibe site. Workspaces, folders, and entries that do not contain files or attachments
do not count toward a user’s data quota.

By default, users are not limited in the disk space that their attached files and file versions occupy in
the Vibe site. As the Vibe administrator, you can decide when limiting users’ disk space usage
becomes appropriate.

+ “Planning User Data Quotas” on page 249

+ “Setting User Data Quotas” on page 250

+ “Modifying User Data Quotas” on page 253

+ “Removing User Data Quotas” on page 256

+ “Managing Your Personal Data Quota” on page 258

+ “Monitoring User Data Quotas” on page 259
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Planning User Data Quotas

+ “Understanding User Data Quota Priority” on page 249

+ “Selecting the Default User Data Quota for All Users” on page 249
+ “Selecting an Appropriate High-Water Mark” on page 250

+ “Determining Data Quotas for Specific Users” on page 250

+ “Determining Data Quotas for Specific Groups” on page 250

Understanding User Data Quota Priority

Because users can have multiple data quotas assigned to them, either individually, through group
membership, or through the site-wide default, Vibe prioritizes the existing data quotas and uses only
one for each individual Vibe user. If users have multiple data quotas that pertain to them, the
priority level is as follows:

1. User Quota: A quota that is set for an individual user overrides the site-wide default quota and
any other quotas that are associated with any groups where the user is a member.

2. Group Quota: A quota that is set for an individual group overrides the site-wide default quota.
This pertains to all users who are members of that group.

When a user is a member of multiple groups that have data quotas associated with them, the
user is given the highest data quota. For example, if a Vibe user is a member of Group A, Group
B, and Group C, and the data quotas for each of these groups is 10, 20, and 30, the Vibe user’s
data quota is 30.

3. Site-Wide Default: The site-wide default quota is used for all Vibe users who have not been
assigned individual quotas, and who are not associated with any groups where a quota has
been set.

Selecting the Default User Data Quota for All Users

When you enable the data quota feature, the initial default data quota is 100 MB. This means that
each Vibe user can upload 100 MB of files and attachments to the Vibe site. There is one default
data quota for each Vibe zone.

When you select the default data quota for your Vibe site, consider the size of your Vibe site, the
number of Vibe users, the amount of available disk space, and so on. You can override the default
data quota on a per-user and per-group basis, as described in “Managing Workspace and Folder Data
Quotas” on page 245.

As described in “Exceeding the Data Quota” on page 244, when a user adds enough files and
attachments to exceed the data quota, the user can no longer attach files or create versions until
existing files have been deleted and purged to free up storage space.

For information about purging deleted files to make storage space available, see “Permanently
Deleting Files from the Trash” on page 260.

For information about the user experience when nearing or exceeding a data quota, see “Adding
Files and Attachments to the Vibe Site When You Are Over Your Quota” in the OpenText Vibe 4.0.8
Advanced User Guide.
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For information about which data quota is used when users have multiple data quotas that pertain
to them, see “Understanding User Data Quota Priority” on page 249.

Selecting an Appropriate High-Water Mark

The high-water mark is the percentage of the data quota when users are notified that they are
approaching their data quotas. The default high-water mark is 90% of a user’s data quota.

This high-water mark also applies to data quotas that are set on workspaces and folders.

Determining Data Quotas for Specific Users

If there is a user in your Vibe site who needs either a higher or lower data quota than the site-wide
default, you can assign that user an individual user data quota.

When you set data quotas for specific users, remember that individual user data quotas override the
default user data quota, as well as quotas that are assigned to any groups where the user is a
member, as described in “Understanding User Data Quota Priority” on page 249.

Determining Data Quotas for Specific Groups

When you set data quotas for specific groups, remember that group data quotas override the
default site-wide data quota, but do not override individual user quotas, as described in
“Understanding User Data Quota Priority” on page 249.

Setting User Data Quotas

You can set data quotas for the entire Vibe site, for individual groups, and for individual users.

+ “Setting a Default Data Quota” on page 250

+ “Setting Data Quotas for Individual Groups” on page 251

+ “Setting Data Quotas for Individual Users” on page 252

+ “Setting Data Quotas on Outgoing Email Messages” on page 253

Setting a Default Data Quota

When you set a default data quota, the quota applies to all Vibe users who have not been assigned
individual quotas, and who are not associated with any groups where a quota has been set.

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon *.

3 Under Management, click Personal Storage.
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Personal Storage

| Enable Workspace and Folder Quotas

| Allow Workspace and Folder Owners To Set Quotas

Validate Workspace and Folder Quota Counts

L) Enable User Data Quotas )

Default User Data Ciuota Size: 100 MB
Default High-Water Mark: a0 %
Add a Group

[ Apply I Ciose ]

4 Select Enable User Data Quotas.

5 Set the Default Data Quota Size and Default High-Water Mark options as determined in
“Planning User Data Quotas” on page 249.

6 Click Apply > Close to save the user data quota settings.

Setting Data Quotas for Individual Groups

1 Login to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration

Console icon *.

3 Under Management, click Data Quotas and File Upload Limits.
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Personal Storage

! Enable Workspace and Folder Quotas
) Allow Workspace and Folder Owners To Set Quotas

) Enable User Data Quotas (@)

Default User Data Quota Size: 100 MB
Default High-Water Mark: 90 %

Add a Group

4 Select Enable User Data Quotas.
5 Click Add a Group.

Add a Group

‘Add a Group

Group: (]

Find Groups

© Quota: B

|

{ @@» €

6 In the Group field, start typing the name of the group for which you want to set a quota, then
click the group name when it appears in the drop-down list.

Repeat this process to add additional groups for which you want to assign the same data quota.
7 In the Quota field, specify the disk space limit for the group.
8 Click OK, then click Apply > Close to save the user data quota settings.

Setting Data Quotas for Individual Users

1 Login to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon %',

3 Under Management, click Data Quotas and File Upload Limits.
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Personal Storage

Enable Workspace and Folder Quotas

Allow Workspace and Folder Owners To Set Quotas

Enable User Data Quotas (@

Default User Data Quota Size: 100 MB
Default High-Water Mark: 90 %

Add a Group

4 Select Enable User Data Quotas.
5 Click Add a User.

[ | Pecple

MB

D €& |

6 Inthe User field, start typing the name of the user for which you want to set a quota, then click
the user’s name when it appears in the drop-down list.

Repeat this process to add additional users for which you want to assign the same data quota.
7 In the Quota field, specify the disk space limit for the user.
8 Click OK, then click Apply > Close to save the user data quota settings.

Setting Data Quotas on Outgoing Email Messages

You can set a maximum file size on individual email messages that are sent from the Vibe system. For
more information, see “Enabling/Disabling Outbound Emailing of Folder Digests” on page 167.

Modifying User Data Quotas

Vibe lets you modify data quotas that you have previously set. You can modify data quotas for your
entire Vibe site, or modify data quotas for individual groups and users.

+ “Modifying User Data Quotas for the Entire Vibe Site” on page 254
+ “Modifying User Data Quotas for Individual Groups and Users” on page 255
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Modifying User Data Quotas for the Entire Vibe Site

Vibe lets you easily modify the site-wide default user data quota.

1 Login to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration

Console icon * .
3 Under Management, click Personal Storage.

Personal Storage

I#| Enable Workspace and Folder Quotas

1# Allow Warkspace and Folder Cwners To Set Quotas

¥| Enable User Data Quotas )

Default User Data Quota Size: 100 MB
Default High-Water Mark: a0 %
Add a Group

Group Quotas
Delete Group Name Group Title Quota

o marketing  marketing 200

Delete

User Quotas

Delete  Full Name Userld Quota Data Quota Used
O Janet Desoto jdesoto 175 0

O Julio Chavez jchavez 150 0.01
Delete

[ Apply | Ciose ]

4 In the Default User Data Quota Size field, delete the existing quota and specify the new quota.

You can also modify the default high-water mark in the Default High-Water Mark field. For more
information about the high-water mark, see “Selecting an Appropriate High-Water Mark” on

page 250.
5 Click Apply > Close to save the user data quota settings.
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Modifying User Data Quotas for Individual Groups and Users

Vibe lets you easily modify individual group and user data quota settings that you have previously
set.

1 Login to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration

Console icon .

3 Under Management, click Personal Storage.

Personal Storage

I#| Enable Workspace and Folder Quotas

1# Allow Warkspace and Folder Cwners To Set Quotas

¥| Enable User Data Quotas )

Default User Data Quota Size: 100 MB
Default High-Water Mark: a0 %
Add a Group

Group Quotas
Delete Group Name Group Title Quota

o marketing  marketing 200

Delete

User Quotas

Delete  Full Name Userld Quota Data Quota Used
O Janet Desoto jdesoto 175 0

O Julio Chavez jchavez 150 0.01
Delete

[ Apply | Ciose ]

4 In the Group Quotas table or User Quotas table, click the group name or user name that
represents the group or user whose quota you want to modify.
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User Quotas

Delete  Full Mame Userld Quota DataQuota Used
Janet Desoto jdesoto 175 ]
Julio Chavez jchavez 150 0.01

User: Julio Chavez (jchavez)

Cuota: 150 MB
bply J§ |
| ok ] cancel |

5 Inthe Quota field, delete the existing quota and specify a new quota.

6 Click OK, then click Apply > Close to save the user data quota settings.

Removing User Data Quotas

Vibe lets you disable data quotas that you have previously set. You can disable data quotas for your
entire Vibe site, or remove data quotas from individual groups and users.
+ “Disabling User Data Quotas for the Entire Vibe Site” on page 256

+ “Removing User Data Quotas from Individual Groups and Users” on page 257

Disabling User Data Quotas for the Entire Vibe Site

If you decide that you no longer need to impose limits on the amount of data that users are
permitted to upload into the Vibe site, you can disable the data quota feature. Disabling the data
quota feature enables all Vibe users to upload as much data to the Vibe site as they want.
1 Login to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon * .
3 Under Management, click Personal Storage.
The Data Quotas and File Upload Limits page is displayed.
4 Deselect Enable User Data Quotas, then click Apply.
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Personal Storage

#| Enable Workspace and Folder Quotas

¥ Allow Workspace and Folder Owners To Set Quotas

Validate Workspace and Folder Quota Counts

Enable User Data Quotas @)

Default User Data Quota Size: 100 MB
Default High-Water Mark: 90 %
Add a Group

Group Quotas
Delete Group Name Group Title Quocta

marketing  marketing 200

User Quotas
Delete  Full Name User Id

JanetDesoto jdesoto 175 0

CQucta Data Quota Used

Julio Chavez jchavez 150 0.01

Data quotas are not enabled.

L Apply ] Close
Data quotas are no longer enabled for your Vibe site.

Removing User Data Quotas from Individual Groups and Users

You can remove data quotas that you have previously set for individual groups and users. Users are
held to the site-wide data quota default setting if they do not have an individual quota defined for

them and they are not members of any groups where a group quota has been assigned.

1 Login to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration

Console icon * .
3 Under Management, click Personal Storage.
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Personal Storage

¥ Enable Workspace and Folder Quotas

¥ Allow Waorkspace and Folder Owners To Set Quotas

| Enable User Data Quotas (@)

Default User Data Quota Size: 100 MB
Default High-Water Mark: 90 (%
Add a Group

Group Quotas
Delete  Group Name Group Title Quota

marketing  marketing 200

User Quotas
Delete ' Full Name Userld Quota Data Quota Used

Janet Desoto  jdesoto 175 0

Julio Chavez jchavez 150 0.01

[ Appiy J Close

4 In the Group Quotas table or User Quotas table, select the check box next to the group or user
whose quota you want to remove, then click Delete.

5 Click Apply > Close to save the user data quota settings.

Managing Your Personal Data Quota

NOTE: As a Vibe administrator, you are also held to a data quota. If you want to assign yourself a
larger quota than the site-wide default, you can add an individual quota for yourself, as described in

“Setting Data Quotas for Individual Users” on page 252.

All Vibe users need to manage their personal data quotas. When you have a limited allocation of disk
space, you need to be aware of the amount of disk space that you have available, know how to make
more disk space available as you approach your quota, and know what counts against your quota

and what doesn’t.

For information on how to accomplish these and other important tasks as you manage your data
quota, see “Managing Your Data Quota” in the OpenText Vibe 4.0.8 Advanced User Guide.
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Monitoring User Data Quotas

You can monitor which users in the Vibe site have exceeded or are close to exceeding their data
guotas by generating the following reports:

+ “Data Quota Exceeded Report” on page 307
+ “Data Quota Highwater Exceeded Report” on page 308

General Data Quota Management

This section describes tasks that are common to both types of data quotas: workspace and folder
data quotas and user data quotas.

¢ “Configuring Data Quotas to Be Less Strict” on page 259

+ “Permanently Deleting Files from the Trash” on page 260

Configuring Data Quotas to Be Less Strict

This section applies only to user data quotas. You cannot configure workspace and folder quotas to
be less strict, as described in this section.

As a Vibe administrator, you can decide how strictly you want to enforce user data quota adherence.
You can maintain the default behavior, or you can be less strict by allowing users to post a final entry
that exceeds the data quota.

For more information about the default behavior for a data quota, see “Understanding Default Data
Quota Behavior” on page 244.

To configure Vibe to allow users to post a final entry that exceeds the data quota:

1 Change to the following directory:

Linux: /opt/ novel | / t eam ng/ apache-t ontat /
webapps/ ssf/WEB- | NF/ cl asses/ confi g
Windows: c:\Program Files\Novell\Teaming\apache-tomcat\ webapps\ssf\WEB-
INF\classes\config

2 Make a backup copy of the ssf - ext . properti es file.
3 Openthessf-ext. properti es filein a text editor.
4 Add the following line to the ssf - ext . properti es file:

data. quota. strict. conformance=fal se

5 Save and close the ssf - ext . properti es file.
6 Stop and restart Vibe.
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Permanently Deleting Files from the Trash

When users delete files or file versions, the disk space occupied by the deleted files and versions
counts against the data quotas until users permanently delete the files and versions from the Trash,
as described in “Making Disk Space Available by Deleting Items from the Trash” in the OpenText Vibe
4.0.8 Advanced User Guide.

As a Vibe administrator, you can permanently delete files and versions anywhere on the Vibe site in
order to recover disk space.

IMPORTANT: After items have been permanently deleted, they cannot be recovered except through
a tedious manual process from the archive store with the help of OpenText Technical Support. For
more information, see “Manually Restoring Individual Entries” on page 294.

To permanently delete files and file versions from the Trash:

1 Log in to the Vibe site as the Vibe administrator.

2 Click the Workspace tree icon &, then click Home Workspace.

All global workspaces, team workspaces, and personal workspaces are located under the Home
Workspace.

3 Click Trash at the bottom of the Left Navigation pane to display a list of all deleted files and
versions.

By default, the list is ordered alphabetically by title.

4 (Optional) Click a column heading to sort the list by when items were deleted, who deleted the
items, or where the items were deleted on the Vibe site.

5 Select items to permanently delete, then click Delete.

Managing the File Upload Size Limit

The file upload size limit conserves disk space on your Vibe site because it prevents users from
uploading large files to the Vibe site. The default size limit for uploading files into your Vibe site is 2
GB.

Browsers also impose limits on the size of files that can be uploaded. This limit differs depending on
which browser you are using to run Vibe.

If you are using Vibe Desktop to upload and download files between user workstations and the Vibe
site, see “Configuring the Maximum File Size Limit for Vibe Desktop” on page 152 for more
information about controlling maximum file size limits.

+ “Modifying the File Upload Size Limit for the Vibe Site” on page 261

+ “Setting a File Upload Size Limit for Individual Users and Groups” on page 261

+ “Setting a File Upload Size Limit for Individual Workspaces and Folders” on page 262
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Modifying the File Upload Size Limit for the Vibe Site

You as the Vibe administrator can increase or decrease this size limit for the Vibe site. Workspace
and folder owners can set a file upload size limit for their own workspaces and folders, but the limit
in individual workspaces and folders cannot exceed what you set for the Vibe site.
1 Click your linked name in the upper right corner of the page, then click the Administration
Console icon %',
2 Under Management, click File Upload Limits.
3 In the File Upload Size Limits section, specify the new file upload size limit.

4 Click Apply > Close.

Setting a File Upload Size Limit for Individual Users and Groups

You can assign a file upload size limit to individual users and groups that is different from the site-
wide file upload size limit. For example, if the file upload size limit for your Vibe site is 2 GB, but your
Marketing team often uploads large files, you can give the Mar ket i ng group a file upload size of 3
GB.

+ “Setting a Limit for a Group” on page 261

+ “Setting a Limit for a User” on page 261

Setting a Limit for a Group

1 Click your linked name in the upper right corner of the page, then click the Administration
Console icon *.

2 Under Management, click File Upload Limits.

3 In the File Upload Size Limits section, click Add a Group.

4 Specify the following information:

Group: Begin typing the group name for which you want to set a file upload size limit, then click
the name when it appears in the list.

File Size Limit: Specify the new file size limit for the group.
5 Click OK.

Setting a Limit for a User

1 Click your linked name in the upper right corner of the page, then click the Administration
Console icon %',

2 Under Management, click File Upload Limits.

3 In the File Upload Size Limits section, click Add a User.

4 Specify the following information:

User: Begin typing the user name for which you want to set a file upload size limit, then click
the name when it appears in the list.
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File Size Limit: Specify the new file size limit for the user.
5 Click OK.

Setting a File Upload Size Limit for Individual Workspaces and
Folders

Workspace and folder owners can set a file upload size limit on individual workspaces and folders. If
a site-wide limit has been set by the Vibe administrator, the limit on the workspace or folder must be
less than the site-wide limit. For more information, see “Limiting the File Upload Size for Folders and
Workspaces” in “Managing Folders” in the OpenText Vibe 4.0.8 Advanced User Guide.

Setting a Maximum Number of Versions for Each File

Because a significant amount of data can be consumed by old versions of files, you can configure the
Vibe site to allow only a certain number of file versions for each file version set within the folder or
workspace. (A file version set includes the major file version and all minor file versions. For more
information about major and minor file versions, see “Incrementing the Major Version Number of a
File” in “Working with Files in a Folder Entry” in the OpenText Vibe 4.0.8 Advanced User Guide.)

To configure the Vibe site in this way, navigate to the top-level workspace (which by default is called
Home Workspaces), then follow the instruction in “Automatically Deleting Minor File Versions That
Exceed the Allowed Maximum” in the OpenText Vibe 4.0.8 Advanced User Guide.

Automatically Deleting Old File Versions

Because a significant amount of data can be consumed by old versions of files, you can configure all
minor versions of each file to be automatically deleted after a specified number of days on the Vibe
site. When you configure your Vibe site in this way, all minor versions of each document are deleted
after the specified number of days (major versions are never deleted).

Workspace and Folder owners can remove this setting for their workspaces and folders, or specify a
different number of days, as described in “Automatically Deleting Minor File Versions after a
Specified Number of Days” in the OpenText Vibe 4.0.8 Advanced User Guide.
1 Click your linked name in the upper right corner of the page, then click the Administration
Console icon %',
2 Under System, click File Version Aging.

3 Specify the number of days to wait before each lower-level version is automatically deleted,
then click Apply > Close.
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Managing Workspace and Folder
Templates

Workspace and Folder templates are a powerful and efficient way to manage your Vibe site. They
enable you to customize the default features, default layout, and default access control settings of
the workspaces and folders throughout your Vibe site.

For example, the Team Workspaces template is used when any team workspace is created. By
default, the access control settings for the Team Workspaces template specify that only team
members are able to view the team workspace. However, if you want to run a more relaxed Vibe site
and allow all Vibe users to view any team workspace, you can simply modify the access control
settings on the Team Workspaces template.

Changes that you make to templates affect only those workspaces and folders that are created after
the template was modified.

For more information about templates, see “Understanding Templates” on page 62.

+ “Creating Workspace and Folder Templates” on page 263

+ “Modifying Workspace and Folder Templates” on page 263

+ “Exporting Templates” on page 267

+ “Importing Templates” on page 269

+ “Reverting All Templates to the Factory Default” on page 269

Creating Workspace and Folder Templates

For information on how to create new workspace and folder templates, see “Creating Workspace
and Folder Templates” on page 65.

Modifying Workspace and Folder Templates

Vibe lets you modify default templates as well as custom templates that you have already created.

For information on how to create custom templates, see “Creating Workspace and Folder
Templates” on page 65.

1 Click your linked name in the upper right corner of the page, then click the Administration
Console icon * .

2 Under Management, click Workspace and Folder Templates.
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Workspace and Folder Templates
New « Reset Import Export

Standard Templates

» Discussion - A Discussion folder is useful for creating a forum where users are likely to both create and reply to entries.

= Blog - A blog folder is a forum where entire entries are displayed in reverse chronological order, based on when they were created.
Blogs typically provide information on a particular topic from an individual or small group of authars. Optionally, the blog folder can be
configured so that a larger group can make comments on the entries posted by the original author.

= Calendar - A calendar folder is a place to post group events or display other types of entries by date.

= Guestbook - A guestbook folder is a simple place that individuals can "sign,” indicating that they have visited a user's Persanal
Waorkspace. Visitors may also leave comments about the entries created in that personal workspace. Comments are displayed in
reverse chronological order. A picture of the individual signing the guestbook is displayed with the comment. The guestbook is useful
for expanding users' social networks.

= Files - Afile folder is a place to putfiles. Comments or entire discussions can be posted about individual files. Additionally, the files can
be automatically locked, edited-in-place, then unlocked, creating a new version of the file. A file folder can emulate a WebDAY server.
This allows a user to add and delete files via any WebDAV client, such as the MS Windows File Manager.
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3 Click the workspace or folder template that you want to modify.

From this page you can do any of the following:

+ “Deleting the Template” on page 264

+ “Exporting the Template” on page 264

+ “Renaming the Template” on page 265

+ “Adding an Existing Workspace Template” on page 265

+ “Adding an Existing Folder Template” on page 265

+ “Removing a Folder Template or Workspace Template from the Template” on page 266
+ “Adding Access Controls to the Template” on page 266

+ “Adding a Data Quota to the Template” on page 266

+ “Changing the Default View for the Template” on page 266

+ “Changing the Title, Description, Brand, and Icon for the Template” on page 267
+ “Modifying the Accessory Panel for the Template” on page 267

Deleting the Template

Deleting a template deletes the template and all sub-templates.

1 Click Manage This Template.
2 Click Delete This Template > OK.

Exporting the Template

1 Click Manage This Template.
2 Click Export This Template > OK.

For information on how to export multiple templates simultaneously, see “Exporting Multiple
Templates” on page 268.

Managing Workspace and Folder Templates



Renaming the Template

You can change the information that is displayed on the Add New Workspace page (or Add New
Folder page), when users select which type of workspace they want to add.

1
2
3

4

Click Manage This Template.

Click Modify This Template.

Specify the following information:

Name: This is the internal database name.

Template Title: This name appears in the Add New Workspace page (or Add New Folder page)
when users select which type of workspace they want to add.

Description: This description appears in the Add New Workspace page (or Add New Folder
page) when users select which type of workspace they want to add.

Click Modify.

Adding an Existing Workspace Template

You can add a workspace template to the template that you are currently modifying. The workspace
template that you add becomes a sub-workspace to the main workspace. All template sub-
workspaces and sub-folders that you add are preserved when the template is used in your Vibe site.

1
2
3

Click Manage This Template.
Click Add Workspace Template.

In the Currently Defined Templates section, select the workspace template that you want to
add.

Click Add.

A cloned copy of the workspace template is added as a sub-folder to the main workspace.

Adding an Existing Folder Template

You can add a folder template to the template that you are currently modifying. The folder template
that you add becomes a sub-folder to the main workspace or folder. All template sub-workspaces
and sub-folders that you add are preserved when the template is used in your Vibe site.

You can add a folder template to the template that you are currently modifying.

1 Click Manage This Template.

2 Click Add Folder Template.

3 In the Currently Defined Templates section, select the folder template that you want to add.
4 Click Add.

A cloned copy of the folder template is added as a sub-folder to the main folder or workspace.
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Removing a Folder Template or Workspace Template from the
Template

You can also remove folder or workspace templates that you previously added to the template that
you are modifying (as described in “Adding an Existing Workspace Template” on page 265 and
“Adding an Existing Folder Template” on page 265.) Or you can remove folder or workspace
templates that exist by default in the template that you are modifying. For example, you can remove
the Files folder template from the User Workspace template.

1 Expand the workspace tree on the Workspace and Folder Templates page.

2 Select the workspace or folder template that you want to remove.

3 Click Manage This Template.

4 Click Delete This Template > OK.

Adding Access Controls to the Template

1 Click Manage This Target.
2 Click Access Control.
The Configure Access Control page is displayed.

For information on how to use this page, see Chapter 2, “Planning and Controlling User Access
to Workspaces and Folders,” on page 21.

3 After you have made your access control modifications, click Close.

An example of adding access controls to a template is described in “Restricting Access to Personal
Workspaces throughout the Vibe Site” on page 26.

Adding a Data Quota to the Template

1 Click Manage This Target.

2 Click Configure Views, URLs, and Controls.

3 Click the Quotas tab.

4 Specify the quota in the Set a Quota field, then click OK.

For information on data quotas for workspaces and folders, see “Managing Workspace and
Folder Data Quotas” on page 245.

Changing the Default View for the Template

1 Click Manage This Target > Configure Views, URLs and Controls.
A page with various configuration options is displayed.
2 In the Default View section, select the default view that you want the template to have.

3 Click Apply > Close.
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Changing the Title, Description, Brand, and Icon for the Template

You can change the attributes of the template that are displayed in the workspace after the
workspace is created.

1 Click Manage This Target.
2 Click Modify.

3 Change the title, description, brand, and icon as desired, then click OK.

Modifying the Accessory Panel for the Template

Vibe lets you modify the Accessory Panel in a template.

If the Accessory Panel already contains accessories, you can modify them; or, you can create new
accessories. For information on how to modify and create accessories, see “Managing Accessories”
in the OpenText Vibe 4.0.8 User Guide.

Exporting Templates

You might want to export templates for the following reasons:
+ To import the template into another system.

For information on how to import a template, see “Importing Templates” on page 269.
+ To back up the template.

This can be useful if you want to edit a template, so you can restore the original if your edits
don’t go according to plan.

Vibe lets you export individual templates, or export multiple templates simultaneously.

+ “Exporting a Single Template” on page 267
+ “Exporting Multiple Templates” on page 268

Exporting a Single Template

1 Click your linked name in the upper right corner of the page, then click the Administration
Console icon * .

Under Management, click Workspace and Folder Templates.

Click the workspace or folder template that you want to export.

Click Manage This Template.

Click Export This Template.

Click OK.
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Exporting Multiple Templates

1 Click your linked name in the upper right corner of the page, then click the Administration
Console icon * .

2 Under Management, click Workspace and Folder Templates.
Workspace and Folder Templates

Standard Templates

Discussion - A Discussion folder is useful for creating a forum where users are likely to both create and reply to entries.

Blog - A blog folder is a forum where entire entries are displayed in reverse chronological order, based on when they were created.
Blogs typically provide information on a particular topic from an individual or small group of authors. Optionally, the blog folder can be
configured so that a larger group can make comments on the entries posted by the original author.

Calendar - A calendar folder is a place to post group events or display other types of entries by date.

Guestbook - A guestbook folder is a simple place that individuals can “sign,” indicating that they have visited a user's Personal
‘Workspace. Visitors may also leave comments about the entries created in that personal workspace. Comments are displayed in
reverse chronological order. A picture of the individual signing the guestbook is displayed with the comment. The guestbook is useful
for expanding users’ social networks.

Files - Afile folder is @ place to putfiles. Comments or entire discussions can be posted aboutindividual files. Additionally, the files can
be automatically locked, edited-in-place, then unlocked, creating a new version of the file. A file folder can emulate a WebDAV server.
This allows a user to add and delete files via any WebDAV client, such as the MS Windows File Manager.

3 Click Export.

Workspace and Folder Templates

Select the Templates to be Exported:

Select Al Clear All
E||:| Templates

= [[] piscussion

5] [] Biog

= [] Calendar

o b [] Guestbook

| A D Milestones

| 0 . D Micro-Blog

| A D Mirrored Files
| A D Photo Album

| 0 I D Surveys
| D Wiki

| D Running Workspace

|55 . D Discussions Workspace

|55 I D Project Management Workspace
| A D Team Workspace

| I D Workspace

| 0 I D Landing Page

(] D Guest (guest)

|55 I D User workspace

|0 [ [[] External User workspace

Select All Clear All

4 In the Select the Templates to be Exported section, select the template or templates that you
want to export, then click OK.
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Importing Templates

You can import a template after you have exported it. For information on how to export a template,
see “Exporting Templates” on page 267.

1 Click your linked name in the upper right corner of the page, then click the Administration
Console icon %',

2 Under Management, click Workspace and Folder Templates.

Workspace and Folder Templates
New v |[ Reset | Import || Export

Standard Templates

= Discussion - A Discussion folder is useful for creating a forum where users are likely to both create and reply to entries.

= Blog - Ablog folder is a forum where entire entries are displayed in reverse chronological order, based on when they were created.
Blogs typically provide information on a particular topic from an individual or small group of authors. Optionally, the blog folder can be
configured so that a larger group can make comments on the entries posted by the original author.

= Calendar - A calendar folder is a place to post group events or display other types of entries by date.

= Guestbook - A guestbook folder is a simple place that individuals can "sign,” indicating that they have visited a user's Personal
Workspace. Visitors may also leave comments about the entries created in that personal workspace. Comments are displayed in
reverse chronological order. A picture of the individual signing the guestbook is displayed with the comment. The guestbook is useful
for expanding users’ social networks.

= Files - Afile folder is a place to put files. Comments or entire discussions can be posted aboutindividual files. Additionally, the files can
be automatically locked, edited-in-place, then unlocked, creating a new version of the file. A file folder can emulate a WebDAV server.
This allows a user to add and delete files via any WebDAV client, such as the M3 Windows File Manager.

3 Click Import.
The Import Templates page is displayed.
4 Browse for and select the templates that you want to import, then click OK.

The imported templates are displayed in the Manage Workspace and Folder Templates page.

Reverting All Templates to the Factory Default

When you revert all templates to the factory default, you lose any modifications that you have made
to existing templates, as well as any custom templates that you might have created.

1 Click your linked name in the upper right corner of the page, then click the Administration
Console icon * .

2 Under Management, click Workspace and Folder Templates.

Workspace and Folder Templates
MNew ~ |[ Reset | Import || Export

Standard Templates

= Discussion - A Discussion folder is useful for creating a forum where users are likely to both create and reply to entries.

= Blog - A blog folder is a forum where entire entries are displayed in reverse chronological order, based on when they were created.
Blogs typically provide information on a particular topic from an individual or small group of authors. Optionally, the blog folder can be
configured so that a larger group can make comments on the entries posted by the original author.

= Calendar - A calendar folder is a place to post group events or display other types of entries by date.

= Guestbook - A guestbook folder is a simple place that individuals can "sign,” indicating that they have visited a user's Personal
‘Workspace. Visitors may also leave comments about the entries created in that personal workspace. Comments are displayed in
reverse chronological order. A picture of the individual signing the guestbook is displayed with the comment. The guestbook is useful
for expanding users' social networks.

= Files - Afile folder is a place fo put files. Comments or entire discussions can be posted aboutindividual files. Additionally, the files can
be automatically locked, edited-in-place, then unlocked, creating a new version of the file. A file folder can emulate a WebDAV server.
This allows a user to add and delete files via any WebDAV client, such as the M3 Windows File Manager.

3 Click Reset, then click OK.

Managing Workspace and Folder Templates 269



270  Managing Workspace and Folder Templates



Creating and Managing Workflows

Workflows can improve efficiency in your organization by automating common business processes.

As an administrator for Vibe, you have the ability to create workflows and make them available to all
Vibe users. You can also import existing workflows and then tailor them to your specific
organization.

Examples of workflows include approving documents, ordering supplies, hiring new employees,
requesting paid time off, and getting expense reimbursements.

¢ “Creating Global Workflows” on page 271

+ “Downloading Existing Custom Forms and Workflows” on page 272

Creating Global Workflows

You can create workflows that are accessible to all Vibe users.

1 Click your linked name in the upper right corner of the page, then click the Administration

Console icon '+

2 Under System, click Form/View Designers.
Form and View Designers

Public Form and View definitions
New Copy Reset Imiport Export

(- @ Form/\iew Designers
[l @ Entry Definitions

...| External User Workspace View

EE
-
2

E OB

\ibe Resource Library

3 Follow the steps for creating and managing a workflow, as described in “Creating and Managing
Workflows” in the OpenText Vibe 4.0.8 Advanced User Guide.

Remember that when you create workflows at the Administration level, the workflows that you
create can be leveraged by all users in your Vibe site.
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Downloading Existing Custom Forms and Workflows

The Vibe Resource Library provides a collection of existing Vibe folder entry forms and workflows
that have been designed to solve specific business problems. You can easily download the custom
forms and workflows, then import them into your Vibe environment. You can further customize
these forms and workflows to suit your individual business needs.

1 Visit the Vibe Resource Library (http://www.novell.com/products/vibe/resource-library/).

2 Select the custom form or workflow that you want to use in your Vibe environment.

3 In the Attachment section, click the zi p file to download it.

4 Import the file into your Vibe environment and deploy it for use.

For information on how to do this, follow the Vibe Resource Library Deployment Instructions
(http://www.novell.com/products/vibe/resource-library/demos/
form_workflow_deployment.html).
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6 Viewing and Updating the Vibe License

+ “Viewing the Vibe License” on page 273

+ “Updating the Vibe License” on page 273

Viewing the Vibe License

1 Click the admin link in the upper-right corner of the page, then click the Administration Console
icon * .

2 Under Management, click License.
The Vibe license is displayed.

3 (Conditional) If you have updated your Vibe license and the contents of the new license are not
being displayed, click Reload Vibe License.

Updating the Vibe License

You update the Vibe license as described in “Updating Your Vibe License” in the OpenText Vibe 4.0.8
Installation Guide.
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7 Managing Email Configuration

After you enable email integration for the Vibe site as described in Chapter 10, “Configuring Email
Integration,” on page 167, you can further modify the way emails are managed on the Vibe site.

¢ “Configuring Outbound Email with TLS over SMTP” on page 275

¢ “Customizing Email Templates” on page 276

+ “Configuring the Field that Vibe Uses When Sending Emails” on page 277

+ “Configuring the Number of Users Who Can Be Included in the Same Email Notification” on
page 278

+ “Configuring Vibe to Send Email Messages and Notifications from a Custom Address” on
page 279

+ “Enabling Users to Configure a Folder or External Email Address to Receive Sent Emails” on
page 281

+ “Displaying the User’s Profile Picture in Email Notifications” on page 281

Configuring Outbound Email with TLS over SMTP

Depending on how your email application is configured, it may require that Vibe outbound email be
configured with TLS over SMTP for secure email. OpenText GroupWise, for example, can be
configured to require this. If you are using GroupWise or another email application that requires this
type of configuration, you can configure Vibe with TLS over SMTP by using STARTTLS.

NOTE: In the Vibe installation program, on the Outbound Email Configuration page, ensure that you
have selected SMTP in the Protocol drop-down list. For more information about outbound email
configuration in the Vibe installation program, see “Planning for Outbound Email” in the OpenText
Vibe 4.0.8 Installation Guide. See also TID 7024403.

To configure outbound email with TLS over SMTP:

1 Import the root certificate from the email server into the Vibe Java keystore file (cacert s).

The import process is the same as that described for securing LDAP synchronization in “Securing
LDAP Synchronization” on page 338.

The default location for the Java keystore file is:

Linux: /opt/novell/team ng/jre/lib/security

Windows: c¢:\Program Fil es\ Novel |\ Team ng\jre\lib\security

2 Stop and restart Vibe.

Managing Email Configuration 275


https://support.microfocus.com/kb/doc.php?id=7024403
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_inst/vibe4_inst.pdf#bj9dx2s
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_inst/vibe4_inst.pdf#bookinfo
https://www.novell.com/documentation/vibe4/pdfdoc/vibe4_inst/vibe4_inst.pdf#bookinfo

276

Customizing Email Templates

+ “About Vibe’s Email Templates” on page 276
+ “Tips and Documentation” on page 276

+ “Modifying the Template Files” on page 277
+ “AVideo Walkthrough” on page 277

About Vibe’s Email Templates

Vibe generates email notifications using Apache Velocity version 1.5 templates.

You can customize the following templates, beginning with the Vibe 4.0.1 release:

Template Name

Purpose

footervm

Text or images applied at the end of each email

headervm

Text or images applied at the beginning of each email

passwordChangedNotification.vm

Notification that user’s password changed

publicLinkNotification.vm

Notification of a publicly available link to a file

selfRegistrationRequired.vm

Shared item notification to user who must register
with Vibe in order to view it

sharedEntrylnvite.vm

Shared file invitation to an existing Vibe user

sharedEntryNotification.vm

Shared file notification of change to existing Vibe
user

sharedFolderlnvite.vm

Shared folder invitation to existing Vibe user

sharedFolderNotification.vm

Shared folder notification of change to existing Vibe
user

style.vm

CSS style sheet for email notifications

teaming.vm

Macros that get applied to all emails

Tips and Documentation

The following are tips about the template files in Vibe.

+ Each template contains a brief explanation about what you can customize.

+ Vibe system-generated emails contain both text and HTML MIME parts. You can customize

these independently.

+ You can customize by language to localize the emails your Vibe system generates.

+ You can revert back to the default template by selecting a customize template in the list and

then clicking the Delete button.
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+ Make sure you use the Velocity documentation (https://velocity.apache.org/engine/releases/
velocity-1.5/user-guide.html).

For example, one user assumed that the hash marks (#) indicated comments, when in fact they
are part of many scripting languages, including Velocity.

Complete information and instructions for the Apache Velocity version 1.5 template language are
available on the Apache Velocity Project website (https://velocity.apache.org/engine/releases/
velocity-1.5/).

Modifying the Template Files

The default email templates that reside on the Vibe 4.0.8 system cannot be changed or deleted, but
you can create and deploy customized copies of them by doing the following:

1. Download a template to your local disk by clicking it in the Email Templates dialog

2. Openitin a text editor

3. Save it on your local disk.

4. Upload the customized file by dragging and dropping it into the Email Templates dialog.
The Type then changes to Customized.

A Video Walkthrough

To see a demonstration of the email template customization process for the Filr product, view the
following video:

11111111

Ml http://www.youtube.com/watch?v=AA4A-nG3dlY

The same principles apply to Vibe.

Configuring the Field that Vibe Uses When Sending Emails

By default, emails that are sent from Vibe are sent with the recipients in the BCC field. You can
configure Vibe to use the To field rather than the BCC field for all sent messages.

Configuring Vibe in this way makes it so message recipients can see other message recipients in the
email notification. For information about how to configure Vibe to send individual messages to each
user rather than including multiple users on the same message, see “Configuring the Number of
Users Who Can Be Included in the Same Email Notification” on page 278.

1 Change to the following directory:

Linux: / opt/ novel | / t eam ng/ apache-t ontat/

webapps/ ssf/WEB- | NF/ cl asses/ config
Windows: c¢:\Program Fi |l es\ Novel | \ Teani ng\ apache-t ontat\

webapps\ ssf\ WEB- | NF\ cl asses\ confi g

2 Openthessf. properti es filein a text editor.

3 Search for the following line:
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mai | . noti f yAsBCC=t r ue

Make a backup copy of the ssf - ext . properti es file, which is located in the same directory
as the ssf. properti es file.

Open the ssf - ext . properti es file in a text editor.

Copy the mail.notifyAsBCC=true line from the ssf . pr operti es file to the bottom of the ssf -
ext. properti es file.

7 Changetruetofal se, sothatthe line now reads mai | . noti f yAsBCC=f al se.

Save and close the ssf - ext . properti es file.

9 Close the ssf. properti es file without saving it.

10

Stop and restart Vibe to configure Vibe to use the To field rather than the BCC field when
sending messages.

Configuring the Number of Users Who Can Be Included in
the Same Email Notification

By default, Vibe imposes a limit of 500 message recipients for each email notification that Vibe
sends. You might want to change this limit to 1 if you have configured Vibe as described in
“Configuring the Field that Vibe Uses When Sending Emails” on page 277.

1

Change to the following directory:
Linux: / opt/ novel | / t eam ng/ apache-t ontat /

webapps/ ssf/WEB- | NF/ cl asses/ config
Windows: c¢:\Program Fi |l es\ Novel | \ Teani ng\ apache-t ontat\

webapps\ ssf\ WEB- | NF\ cl asses\config

Make a backup copy of the ssf - ext . properti es file, which is located in the same directory
asthe ssf. properti es file.

3 Openthessf. properti es filein a text editor.

Search for the following line:
mai | . rept.limt=500

Open the ssf - ext . properti es file in a text editor.

Copy themail .rcpt.|imt=500 line from the ssf. properti es file to the bottom of the
ssf-ext. properti es file.

7 Change 500 to 1, so that the line now readsmai | . rcpt. i mt=1.

10

Save and close the ssf - ext . properti es file.
Close the ssf . properti es file without saving it.

Stop and restart Vibe to configure Vibe to include only one user in each email notification that
is sent.
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Configuring Vibe to Send Email Messages and
Notifications from a Custom Address

For security reasons, your corporation’s email system might be set up to automatically delete
messages from internal users that are not sent from the corporate email system. If your corporate
email system is configured in this way, email messages and notifications sent from Vibe are
automatically deleted.

You can configure Vibe to send email messages directly from the Vibe server, rather than from
internal users. These are messages that are sent when a user performs an action that creates a
message. For example, when a user shares a workspace with another Vibe user, a message is sent to
the receiving user’s email mailbox. By default, this message is sent from the internal user. However,
you can configure Vibe to send such messages from the Vibe server itself. Configuring Vibe in this
way enables email messages to be sent from Vibe, while maintaining the same level of security for
your corporation.

By default, Vibe is configured to send messages from individual users in the following scenarios:

+ When sending a workflow notification, as described in “Adding On-Entry or On-Exit Events” in
the OpenText Vibe 4.0.8 Advanced User Guide.

+ When creating an entry, as described in “Creating a Folder Entry” in the OpenText Vibe 4.0.8
User Guide.

You can configure Vibe to send email messages from an external address for an individual zone or for
the entire Vibe site:

¢ “Configuring a Zone-Specific Email Address for Sent Messages” on page 279

¢ “Configuring a Site-Wide Email Address for Sent Messages” on page 280

Configuring a Zone-Specific Email Address for Sent Messages

1 Change to the following directory:

Linux: / opt/ novel | / t eam ng/ apache-t ontat/
webapps/ ssf/ WEB- | NF/ cl asses/ confi g

Windows: c¢:\Program Fil es\ Novel | \ Team ng\ apache-t ontat\
webapps\ ssf\ WEB- | NF\ cl asses\ confi g

2 Make a backup copy of the ssf - ext . properti es file, which is located in the same directory
as the ssf. properti es file.

3 Openthessf.properti es file in a text editor.

4 Search for the following line:
ssf. out goi ng. from addr ess. <zone name>=zoned@onpany. com

5 Openthe ssf-ext. properti es file in a text editor.

6 Copythe ssf. outgoi ng. from address. <zone nanme>=zoned@onpany. comline from
the ssf. ext. properti es file to the bottom of the ssf. properti es file.
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Replace <zone namne> with the name of the Vibe zone that you want email messages to be
addressed from and edit the email address to reflect your company’s email.

For example, if the name of your Vibe zone is kabl i nk, and the name of your company is
gr eener gy, the line would read:

ssf. out goi ng. from addr ess. kabl i nk=zone@r eener gy. com

Save and close the ssf. properti es file.

9 Close the ssf . ext. properti es file without saving it.

Stop and restart Vibe.

Configuring a Site-Wide Email Address for Sent Messages

1 Change to the following directory:

Linux: / opt/ novel | / t eam ng/ apache-t ontat /
webapps/ ssf/WEB- | NF/ cl asses/ confi g

Windows: c¢:\ Program Fi | es\ Novel | \ Teani ng\ apache-tontat\
webapps\ ssf\ WEB- | NF\ cl asses\ config

Make a backup copy of the ssf - ext . properti es file, which is located in the same directory
as the ssf. properti es file.

3 Openthe ssf. properti es file in a text editor.

Search for the following line:
ssf. out goi ng. from addr ess=gl obal @onpany. com

Open the ssf - ext . properti es file in a text editor.

Copy the ssf . out goi ng. f rom addr ess=gl obal @onpany. comline from the
ssf. properti es file to the bottom of the ssf - ext . properti es file.

Edit the email address to reflect your company’s email.

For example, if the name of your company is gr eener gy, the line would read:

ssf. out goi ng. f rom addr ess=gl obal @r eener gy. com

7 Save and close the ssf - ext . properti es file.

Close the ssf . properti es file without saving it.

9 Stop and restart Vibe.
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Enabling Users to Configure a Folder or External Email
Address to Receive Sent Emails

Like a personal email Outbox for the Vibe site, users can configure a folder or external email address
to receive all email messages that they send from the Vibe site. This can help users better track their
activity.

To enable users to set up a folder or external email address in this way, Vibe administrators must
ensure that the following prerequisites are met:

+ Enable the Vibe site to allow incoming email.
For information on how to enable Vibe to allow incoming email, see “Disabling/Enabling
Inbound Email Postings” on page 168.

+ Reset definitions on the Vibe site if the Vibe site was upgraded from a version of Vibe prior to
3.1. If you are installing Vibe 3.1 or later as a new installation, you do not need to reset the
definitions.

For information on how to reset the definitions, see “Resetting Your Definitions” in “Upgrade”
in the OpenText Vibe 4.0.8 Installation Guide.

NOTE: If you have made customizations to definitions throughout the Vibe site and you do not
want your customizations to be overwritten, you can manually add a field to the User Profile
form, rather than resetting the definitions for the Vibe site. To do this, add the BCC Email
Address element to the Contact Information section of the Profile Form Definition for the User
Profile. For more information on how to modify the User Profile definition, see “Customizing
the Default User Profile View” on page 50.

For more information on how users can configure folders to receive sent emails, see “Setting Up a
Folder or External Email Address to Receive All Sent Email Messages” in the OpenText Vibe 4.0.8
Advanced User Guide.

Displaying the User’s Profile Picture in Email Notifications

By default, a user’s profile picture (avatar) is no longer included in email notifications sent from
Vibe. This is because OpenText GroupWise does not always display the profile picture correctly.

To configure Vibe to always include the profile picture in email notifications:

1 Change to the following directory:
Linux: /opt/ novel | / t eam ng/ apache-t ontat /
webapps/ ssf/WEB- | NF/ cl asses/ config

Windows: c¢:\Program Fi | es\ Novel | \ Teani ng\ apache-tontat\
webapps\ ssf\ WEB- | NF\ cl asses\ config

2 Make a backup copy of the ssf - ext . properti es file, which is located in the same directory
asthe ssf. properti es file.

3 Openthessf. properti es filein a text editor.

4 Search for the following line:
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emai | . showAvat ar | nHeader =f al se

5 Openthe ssf-ext. properti es file in a text editor.

6 Copythe email . showAvat ar | nHeader =f al se line from the ssf. properti es file to the
bottom of the ssf - ext. properti es file.

7 Replace f al se witht r ue so that the line now reads
enai | . showAvat ar | nHeader =t r ue

8 Save and close the ssf - ext. properti es file.
9 Close the ssf. properti es file without saving it.
10 Stop and restart Vibe.
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Managing the Lucene Index

For background information about the Lucene index, see “Understanding Indexing” in “Advanced
Installation and Reconfiguration” in the OpenText Vibe 4.0.8 Installation Guide.

+ “Starting and Stopping the Lucene Index Server” on page 283
+ “Changing Your Lucene Configuration” on page 283

+ “Optimizing the Lucene Index” on page 284

+ “Rebuilding the Lucene Index” on page 285

+ “Performing Maintenance on a High Availability Lucene Index” on page 287

Starting and Stopping the Lucene Index Server

¢ “On Linux” on page 283
+ “On Windows” on page 283

On Linux

Use the following commands to manually start and stop the Lucene Index Server:

[etc/init.d/indexserver start
letc/init.d/indexserver stop

On Windows

Use the following command at a DOS command prompt to manually start the Lucene Index Server:

c:\Program Fi | es\ Novel | \ Teani ng\ | uceneserver\i ndexserver\ bi n\
i ndexserver -
startup. bat

To stop the Lucene Index Server, close the command prompt window where you started the Lucene
Index Server.

Changing Your Lucene Configuration

The default Lucene Index Server configuration is appropriate for a medium-sized Vibe site. If you
have a larger Vibe site, you can change its Lucene Index Server configuration by rerunning the Vibe
Installation program, selecting Reconfigure Settings, then selecting Advanced. For instructions, see
“Changing Your Lucene Index Server Configuration” in “Advanced Installation and Reconfiguration”
in the OpenText Vibe 4.0.8 Installation Guide.
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Optimizing the Lucene Index

If you notice that search performance in Vibe is becoming slower over time, you might want to
optimize your Lucene index.

For a medium to large Vibe system, it is recommended that you run the optimization once a week.
You should run the optimization during off hours or on weekends when the Vibe system is not being
heavily used.

Optimizing the Lucene index does not repair a damaged or out-of-date index. To repair a damaged or
out-of-date index, you must rebuild the index, as described in “Rebuilding the Lucene Index” on
page 285.

+ “Optimizing a Single Search Index” on page 284

+ “Optimizing the Search Index with Multiple Index Servers” on page 285

Optimizing a Single Search Index

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon *.

3 Under Management, click Search Index.

Search Index @

Manage Search Index Optimize Search Index

Re-Index Everything

Select the Places to Be ReIndexed:
Selecting a folder or workspace automatic ally indexes all folders and workspaces within it.
BB Home Workspace
----- 5P Users and Groups
I\;l Global Workspaces
----- By Met Folders
'fg,i Personal Workspace
5;1 Team Workspat es

4 Click the Optimize Search Index tab.
5 Select Run Immediately if you want to run the optimization right now.

6 Select Run at Scheduled Time, then specify the days and times that you want the optimization to
occur.

7 Click OK.
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Optimizing the Search Index with Multiple Index Servers

1 Login to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon '*.

In the Search Index section, click Index.

Click the Optimize Search Index tab.

Select Run Immediately if you want to run the optimization right now.

a U A~ W

Select Run at Scheduled Time, then specify the days and times that you want the optimization to
occur.

~

Select each node that you want to optimize.
8 Click OK.

Rebuilding the Lucene Index

The Lucene index provides access to all data in your Vibe site. If it becomes damaged or out-of-date
for some reason, you can rebuild it. Users might first notice a problem with the Lucene index if they
cannot find information that they know should be available on the Vibe site. If you are running
multiple Lucene Index Servers, follow the instructions in “Performing Maintenance on a High
Availability Lucene Index” on page 287.

The steps to reset the search index differ depending on whether you have multiple Lucene Index
servers.

+ “Rebuilding a Single Search Index” on page 285
+ “Rebuilding the Search Index with Multiple Index Servers” on page 286

Rebuilding a Single Search Index

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon '+

3 In the Management section, click Search Index.
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Search Index @

Manage Search Index

Re-Index Everything

Select the Places to Be Re-Indexed:
Selecting a folder or workspace automatic ally indexes all felders and workspaces within it.

BB Home Workspace
----- P Users and Groups
l-t, Global Workspaces
l-t, Met Folders
';g,! Personal Workspace
I}g Team Workspac es

4 To reindex the entire Vibe site, select Re-Index Everything.
Depending on the size of your Vibe site, this can be a very time-consuming process.
or
Select one or more parts of your Vibe site to reindex.

5 Click OK to start the indexing.

Users can still access the Vibe site during the indexing process, but search results might not be
accurate until the index has been completely rebuilt.

A message notifies you when indexing is complete.

Rebuilding the Search Index with Multiple Index Servers

1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon '+
3 In the Search Index section, click Index.
4 To reindex the entire Vibe site, select Re-Index Everything.
Depending on the size of your Vibe site, this can be a very time-consuming process.
or
Select one or more parts of your Vibe site to reindex.
5 Select each node that you want to re-index.
6 Click OK to start the indexing.

Users can still access the Vibe site during the indexing process, but search results might not be
accurate until the index has been completely rebuilt.

A message notifies you when indexing is complete.
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Performing Maintenance on a High Availability Lucene
Index

If you have a high availability Lucene configuration, you can take one Lucene node out of service for
maintenance while other Lucene nodes continue to operate. Then you can synchronize the out-of-
date Lucene node with the current indexing data.
1 Log in to the Vibe site as the Vibe administrator.
2 Take the Lucene node that needs maintenance out of service:
2a Click your linked name in the upper right corner of the page, then click the Administration

Console icon * .

2b Under Search Index, click Nodes.

Lucene on Linux {LuceneLinux}

Host 137.65.67.221
RMI port 1199

User Mode Access
® Read and Write
O wirite Only
O Mo Access

Enable Deferred Update Log

Mo Deferred Update Log Record Exists

Lucene on Windows {LuceneWindows)

Host 137 B5.67.222
RMI port 1199

User Mode Access
® Read and Write
O wirite only
O Mo Access

Enable Deferred Update Log

No Deferred Update Log Record Exists

2c In the list, locate the node that needs maintenance.

2d Make sure that Enable Deferred Update Log is selected.

2e Inthe User Mode Access box, change Read and Write to Write Only.
2f Click Apply, then click Close.

The new setting is put into effect immediately, so that the Lucene node is no longer
accessible to Vibe users.

3 Perform the needed maintenance on the Lucene server, then start the Lucene Index Server
again.

4 Return the out-of-date Lucene node to full service:

4a Click your linked name in the upper right corner of the page, then click the Administration
Console icon '+

4b Under Search Index, click Nodes.
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Liscane on Linps jLuceneLin

[ Enatie Defermed Update Log

Daterred Update Log Records Exist
O Ted Update Log Records 10 the Index
ered Update Log Records

Lucans on Windows iLucsnaWindows)
Host 17216.518
L]

[ Enabie Deferred Update Log

Ho Deferred Update Log Record Exists

The out-of-date Lucene node is flagged with Deferred Update Log Records Exist.

The User Mode Access option shows Read and Write because this is the last selected
setting. If you are checking the Tomcat cat al i na. out file, as described in “Observing
Lucene Node Activity” in “Multi-Server Configurations and Clustering” in the OpenText
Vibe 4.0.8 Installation Guide, Vibe is not actually accessing the out-of-date Lucene node
because it is out of sync with the Vibe site.

4c Select Apply Deferred Update Log Records to the Index, then click Apply.
The Deferred Update Log options disappear if the update is successful.
4d Click Close.

The Lucene node that was out of service has now been updated with current indexing data.
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2 9 Managing Database Logs and File Archives

Vibe allows you to manage the frequency in which database logs are deleted, as well as whether
deleted files are archived.

+ “Managing Database Logs” on page 289

+ “Managing File Archiving” on page 290

Managing Database Logs

You can determine the frequency with which database logs (audit trail entries and change log
entries) are deleted from the Vibe system.
1 Log in to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Consoleicon %',
3 Click Database Logs and File Archiving.
4 In the Manage Database Logs section, the following options are available:

Automatically Delete Audit Trail Entries Older Than xx Days: Enabled by default, this sets the
maximum number of days that audit trail log entries are retained. The default is 0, meaning that
entries are retained indefinitely.

IMPORTANT: Vibe uses audit trail entries to build activity and login reports. Removing older
entries limits the possible time span for these reports. (For more information about these
reports, see “Generating Reports” on page 299.)

Also, the Vibe desktop application relies on audit trail data when doing full synchronizations.

Enable the Change Log: Enabled by default, this log tracks the edit history of folders, files, and
entries, including the following actions:

+ Adding, modifying, deleting, and moving of entries, folders, and workspaces.
+ Changes to access control settings for entries, folders, and workspaces.
+ Changes to workflows, including starting, stopping, changing states, and timeouts.

Automatically Delete Change Log Entries Older Than xx Days:

CAUTION: Generally speaking, OpenText doesn’t recommend changing this setting because
doing so causes entire Workflow histories to be removed.

You can specify the maximum number of days to keep change log entries before they are
deleted. The default is 0, meaning that entry retention is unlimited.

Removing older log entries will limit how far back changes to an item can be traced.
5 Click OK.
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Managing File Archiving

1 Log in to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon %',

3 Click Database Logs and File Archiving.

4 In the Manage File Archiving section, the following options are available:

Enable Archiving of Deleted Files: Select this option to move files to the Vibe archive when
they are deleted.

Files in Mirrored Files folders cannot be archived.
5 Click OK.
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3 O Backing Up Vibe Data

Reliable backups are critical to the stability of your Vibe site.

+ “Locating Vibe Data to Back Up” on page 291
+ “Scheduling and Performing Backups” on page 293
+ “Restoring Vibe Data from Backup” on page 293

+ “Manually Restoring Individual Entries” on page 294

Locating Vibe Data to Back Up

In order to keep adequate backups of your Vibe data, you must back up the following types of data.

+ “Vibe File Repository” on page 291
+ “Vibe Database” on page 292
+ “Lucene Index” on page 292

+ “Certificates” on page 292

Vibe File Repository

Platform Default Location

Linux: [ var/ opt/novel | /team ng

Windows:  c¢:\ Novel I\ Teani ng\fil erepository

For more information, see “Distributing Different Data Types to Different Locations” in “Advanced
Installation and Reconfiguration” in the OpenText Vibe 4.0.8 Installation Guide.
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Vibe Database

Database Server Default Linux Location  Default Windows Location

MysQL /var/libl/nysql c:\ Program Fi | es\ MySQL\
MySQ. Server version\Data
Microsoft SQL  N/A c:\Program Fil es\M crosoft SQ Server\
MSSQL\ Dat a
Oracle N/A N/A
PostgreSQL /var/lib/pgsql c:\ Program Fi | es\ Post gr eSQL\

Post greSQL Ser ver
ver si on\ Dat a

For more information, see “Creating the Vibe Database on a Separate Server” and “Running Multiple
Database Servers” in “Multi-Server Configurations and Clustering” in the OpenText Vibe 4.0.8
Installation Guide.

Lucene Index

Platform Default Location

Linux: [ var/opt/novel | /t eam ng/| ucene/ zone_nane

Windows:  ¢:\ Novel I\ Team ng\ | ucene\ kabl i nk

For more information, see “Installing the Lucene Index Server on a Separate Server” and “Running
Multiple Lucene Index Servers” in “Multi-Server Configurations and Clustering” in the OpenText Vibe
4.0.8 Installation Guide.

Certificates

If you have changed your password in the ser ver . xm when creating a new keystore file (as
described in “Do Not Change the Password for the Keystore File” on page 342), be aware that these
changes are not preserved when you upgrade Vibe. You should make these changes again after
upgrading Vibe rather than backing up the server . xm file.

+ “Linux Locations” on page 293

+ “Windows Locations” on page 293
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Linux Locations

Certificate Default Location

Type
Tomcat: [ opt/ novel | / t eanm ng/ apache-tontat/conf/. keystore
Java: fusr/libljvmjava-version/jre/lib/security/cacerts

Windows Locations

Certificate Default Location

Type
Tomcat: c:\Program Fi | es\ Novel | \ Team ng\ apache-t ontat\ conf\. keystore
Java: c:\Program Fil es\Java\jreversion\lib\security\cacerts

Scheduling and Performing Backups

You do not need to bring your Vibe site down in order to perform backups. You might want to back
up the Vibe file repository and the Vibe database every night, perhaps doing a full backup once a
week and incremental backups on other days. You can back up the Lucene index whenever it is
convenient. You can always reindex the Vibe site in order to re-create the Lucene index, but being
able to restore one from backup can save time in case of an outage.

Restoring Vibe Data from Backup

If you need to restore your Vibe site from a backup, restoring the same backup version for both the
file repository and the database creates a Vibe site that is consistent within itself but might be
missing information that was added after the backups were created. If you lose the file repository
but not the database, you can restore the backed-up file repository and keep the more current
database, but some entries then have files that are missing from the file repository. If you lose the
database but not the file repository, you can run a report to identify entries created since the last
database backup, as described in “Content Modification Report” on page 305. You can then notify
the affected Vibe users that they need to re-create the entries that are not available in the backup.
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Manually Restoring Individual Entries

All Vibe users can restore individual entries and attached files if the entry has been deleted but not
yet purged. For information on how to do this, see “Restoring Items from the Trash” in the OpenText
Vibe 4.0.8 Advanced User Guide.

If an entry has been deleted and also purged from the Vibe site, it can usually be recovered from the
archive store with the help of OpenText Technical Support, but this is not an easy process. If an entry
can be restored, it is not identical to the original entry in that the original entry ID is lost, the original
creation and modification dates are lost, and some entry metadata is lost. Contact OpenText Support
(http://www.novell.com/support) for assistance.
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3 1 Monitoring the Vibe Site

You can monitor activity on your Vibe site by using Vibe reports and log files. You can also use JMX to
monitor Vibe and to perform certain management functions.

+ “Using JMX to Monitor the Vibe Site” on page 295

+ “Generating Reports” on page 299

¢ “Using Log Files” on page 313

+ “Checking the Vibe Site Software Version” on page 315

Using JMX to Monitor the Vibe Site

Java Management Extensions (JMX) is a Java technology for managing and monitoring applications,
system objects, devices, and services. It is a lightweight, non-intrusive mechanism for gathering and
monitoring useful runtime statistics. You can use JMX in addition to other tools that are included in
the Vibe product to monitor your Vibe site.

+ “Installing and Configuring JMX for Vibe” on page 295
+ “Requiring Authentication When Accessing Vibe through JMX” on page 296
+ “Using JConsole to Monitor the Vibe Site” on page 297

Installing and Configuring JMX for Vibe

1 Install Vibe as described in the OpenText Vibe 4.0.8 Installation Guide.

2 Navigate to the following directory on the Vibe server:

Linux: / opt/ novel | / t eam ng/ apache-t ontat/ conf

Windows: c¢:\Program Fi | es\ Novel I\ Teanm ng\ apache-t ontat\ conf

3 Openthevi be. managenent . properti es file in a text editor.

4 Uncomment the following line:
#com sun. managenent . j nxr enot e. port =8642

If this port is already in use on your server, change the port number to a port that is not in use.

5 (Recommended) To require authentication when accessing Vibe remotely through JMX, change
the value of the following property tot r ue:

com sun. nanagenent . j mxr enot e. aut henti cati on=f al se

IMPORTANT: If you require authentication when accessing Vibe remotely through JMX, you
must specify a password and restrict access to the password file in order for JMX to run, as
described in “Requiring Authentication When Accessing Vibe through JMX” on page 296.
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6 By default, SSL is not enabled when accessing Vibe through JMX. If the JMX user is accessing
Vibe from within the firewall (which is recommended), there is no reason to require an SSL
connection. If SSL is required by your organization, you can enable it.

To require an SSL connection when accessing Vibe remotely through JMX, change the value of

the following property tot r ue:
com sun. nanagemnent . j nxrenot e. ssl =f al se

If you require an SSL connection when accessing Vibe through JMX, you must also set up a
certificate and configure SSL as instructed in the online IMX documentation (http://
download.oracle.com/javase/6/docs/technotes/guides/management/agent.html).

7 Save your changes, then close the text editor.

8 Stop and restart the Vibe server.

Requiring Authentication When Accessing Vibe through JMX

For security reasons, you must configure JMX to require authentication when accessing Vibe. In a
clustered environment where a firewall is protecting your entire system but where there is no

firewall running between individual nodes (which is the recommended configuration), it is extremely
important that authentication is required when accessing Vibe through JMX in order to prevent an

unauthorized entity from gaining access to the Vibe system.

After you have required authentication for the JMX user as discussed in “Installing and Configuring

JMX for Vibe” on page 295, you need to finish setting up the authentication:

+ “Specifying a Password for One or Both JMX User Types” on page 296

+ “Restricting Access to the Password File” on page 297

Specifying a Password for One or Both JMX User Types

The properties discussed in this section represent JMX user types that can have access to Vibe
through JMX. These are not Vibe users, but rather are JMX users. These users are not reflected
anywhere in your Vibe system.

1 Navigate to the following directory on the Vibe server:

Linux: / opt/ novel | / t eam ng/ apache-t ontat / conf

Windows: c¢:\Program Fil es\ Novel | \ Teanm ng\ apache-t ontat\ conf

2 Openthej nxr enot e. passwor d file in a text editor.

3 Uncomment one or both of the user types, depending on whether you want the JMX user to
have Read Only access or Read/Write access through JMX. If you plan to use only one user type

(for example, Read/Write), leave the other one commented out.
Read Only access: Allows the JMX user to monitor or view Vibe data through JMX.

To configure the JMX user to have Read Only access, uncomment the following user type:

# noni tor Vi beRol e XYZ
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Read/Write access: Allows the JMX user to perform state-changing actions such as initiating
garbage collection of the JVM, changing an attribute of an MBean, or executing an operation on
an MBean, as well as monitoring and viewing Vibe data through JMX.

To configure the JMX user to have Read/Write access, uncomment the following user type:
# control Vi beRol e A&B

4 Replace the XYZ and/or A&B values to a secure password. For example, if you want to change
the password for Read/Write access to Novel |, the line would look like the following:

cont rol Vi beRol e Novel |

Passwords are case-sensitive.

5 Save the j mxr enot e. passwor d file and close the text editor.

Restricting Access to the Password File

The j mxr enot e. passwor d file displays the user names of the JMX users who can access the Vibe
site through JMX, together with the passwords for these users, in plain text. For this reason it is
important that you restrict access to this file to only the file owner, which is the operating system
account where the Vibe server is running.

+ “Restricting Access to the Password File on Linux” on page 297

+ “Restricting Access to the Password File on Windows” on page 297

Restricting Access to the Password File on Linux

If your Vibe server is running on a Linux operating system, the file permissions are changed
automatically when Vibe is installed. (The Vibe program runs this command: chnod 600
vi be. j mxr enot e. passwor d.)

Restricting Access to the Password File on Windows

If your Vibe server is running on a Windows operating system, you must change the permissions
manually after Vibe is installed. For instructions on how to set file permissions on Windows, see
How to Secure a Password File on Microsoft Windows Systems (http://download.oracle.com/javase/
6/docs/technotes/guides/management/security-windows.html).

Using JConsole to Monitor the Vibe Site

JConsole is a Java monitoring tool that comes with JDK. You can use JConsole to monitor your Vibe
site through JMX.

+ “Starting JConsole” on page 298
+ “Using JConsole to Monitor Vibe” on page 298

+ “Using Zenoss Core to Supplement JConsole Monitoring” on page 298
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Starting JConsole

Because JConsole requires a considerable amount of system resources in order to run, you should
not run JConsole from the same machine where Vibe is running. The section describes how to
connect JConsole to Vibe from a remote machine.

The machine that you run JConsole from must have a JDK installed.

1 Navigate to the location where your JDK is installed, then in the bi n directory launch the
following file appropriate for your operating system:

Linux: j consol e

Windows: j consol e. exe

The New Connection dialog box is displayed.

2 Select Remote Process, then specify the hostname and port number of the server where Vibe is
running.

3 In the Username and Password fields, specify the user name and password that you created in
“Specifying a Password for One or Both JMX User Types” on page 296.

4 Click Connect.

The Java Monitoring & Management Console is displayed.

Using JConsole to Monitor Vibe

JConsole contains several tabs that help you monitor various aspects of your server. Information
specific to Vibe is found in the MBeans tab in the Vibe folder. For specific information about the
other tabs in JConsole, see Using JConsole (http://download.oracle.com/javase/6/docs/technotes/
guides/management/jconsole.html).

Using Zenoss Core to Supplement JConsole Monitoring

Zenoss Core is not a replacement for JConsole, but it can provide additional monitoring functionality.
Zenoss provides the following capabilities:

+ Define alerts on an MBean attribute based on the attribute’s acceptable value range, without
relying on the JMX notification mechanism.

+ Display performance graphs to view how data points change over time (JConsole displays only
the current snapshot).

For more information about Zenoss, see Zenoss Core - Enterprise IT Monitoring (http://
sourceforge.net/projects/zenoss/).
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Generating Reports

Most Vibe reports are created in CSV format, so that you can import them into a spreadsheet and
easily manipulate the data to suit your needs. The default CSV filename isreport. csv. If you
create multiple reports without manually renaming them, the default filename is incremented
(report-n.csv).

The maximum report length is 10,000 rows, at which point the report is truncated.

The default location to save the report varies by platform:

Linux: /[tnp

Windows:  Your current Windows default directory

*

*

*

*

“Login Report” on page 299

“User Activity Report” on page 301

“User Access Report” on page 302

“Content Modification Report” on page 305

“Data Quota Exceeded Report” on page 307

“Data Quota Highwater Exceeded Report” on page 308
“Disk Usage Report” on page 308

“Email Report” on page 309

“License Report” on page 310

“XSS Report” on page 312

Login Report

The Login report lists the Vibe users who have logged in to the Vibe site during a specified period of
time. In addition, it can include a dated list of every login by each user.

1 Log in to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration

Console icon %,

3 Under System, click Reports.

4 In the Run a Report drop-down list, select Login Report.
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Reports

Run a Report: | Login Report v

Reports may be truncated if too large.

Report on User Login Information (CSV format)

Report on Login Activity Between

Feb 20. 2015 and | Mar 20, 2015

People

® Summarize Login Entries
Sortreport by: | --none-—- r

List All Legin Entries
Sort report by: | Login Date ¥

Create Report

5 Specify the date range for the Login report.
6 Leave the People field blank to list all user logins.
or

In the People field, begin typing the first name of a Vibe user, then in the drop-down list of
names that match what you have typed, select a user whose logins you want to be reported.
Repeat this process to include multiple users in the report.

7 Select the type of Login report that you want to generate.

Summarize Login Entries: Lists how many times the selected users have logged into the Vibe
site. In the Sort Report By drop-down list, select User, Last Login, or Number of Logins to organize
the data.

List All Login Entries: Lists each individual user login and includes the following data about the
action:

* First name
+ Last name
+ User name
+ Date
+ Time

In the Sort report by drop-down list, select Login Date or User to organize the data most
helpfully.

8 Click Create Report to generate the Login report.

9 Select a text editor to view the report in, then click OK.
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For a short report, you might obtain the information you need by viewing the CSV file.

10 (Optional) Save the CSV file with a meaningful name in a convenient location, then retrieve it
into a spreadsheet program for further examination.

User Activity Report

The User Activity report lists how many times specified users have viewed, added, modified, or
deleted content on the Vibe site during a specified period of time. In addition, it can include the date
and time of each action, along with the location of the action.

1 Login to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration

Console icon %',
3 Under System, click Reports.
4 In the Run a Report drop-down list, select User Activity Report.

Reports

Run a Report: | User Activity Report v

Reports may be truncated if too large.

Report of User Activity (CSV format)

Report on User Activity Between

Feb 20, 2015 and | Mar 20, 2015

People

* Activity Summary
Report Workspace or Folder Activity (view, add, modify, delete)

Create Report

5 Specify the date range for the User Activity report.
6 Leave the Select User field blank to list all user activity.
or
In the Select User field, start typing the first name of a Vibe user.

In the drop-down list of names that match what you have typed, select a user whose activity
you want to be reported. Repeat this process to include additional users.

7 Select the type of User Activity report that you want to generate.
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Activity Summary: Lists how many times the selected users have performed the following
actions in the Vibe site:

+ View

* Add

+ Edit

+ Delete (purge)

+ Pre-Delete (delete but not purge)

+ Restore (restore a deleted item that has not been purged)

Report Workspace or Folder Activity: Lists each individual user action and includes the
following data about the action:

+ User
* Activity
+ Date
¢ Time
+ Folder
¢ Entry title
+ Entry type
8 Click Create Report to generate the User Activity report.
9 Select a text editor to view the report in, then click OK.
For a short report, you might obtain the information you need by viewing the CSV file.

10 (Optional) Save the CSV file with a meaningful name in a convenient location, then retrieve it
into a spreadsheet program for further examination.

User Access Report

The User Access report lists the locations on the Vibe site where a specified user has access rights. In
addition, you can view, and if necessary, change or remove the access rights for any location. This
report is especially useful on Vibe sites where Guest user access has been granted, as described in
“Setting Up Guest Access for the Vibe Site” on page 107.
1 Login to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon '+

3 Under System, click Reports.

4 In the Run a Report drop-down list, select User Access Report.
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Reports

Run a Report: | UserAccess Report v

Reports may be truncated if too large.

Report on the Objects a User has Access To

Select a user to view their accessible objects in the system.

User:

5 In the User field, begin typing the first name of a Vibe user.
6 In the drop-down list of names that match what you have typed, select the user whose site
access you want to be reported.
Reports

Run a Report: | User Access Report v

Reports may be truncated if too large.

Report on the Objects a User has Access To
Select a user to view their accessible cbjects in the system.

User: | Guest (guest)

Select an object’s name to change the access control rights on that object.

Mame Type
[Home Workspace/Personal Workspaces/Guest (guest) Workspace
/Home Workspace/Personal Workspaces/Janet Desoto (jdesoto)/Blog Folder
[Home Workspace/Personal Workspaces/Janet Desoto (jdesoto)Calendar Folder
[Home Workspace/Personal Workspaces/Janet Desoto (jdesoto)/Guestbook Folder
/Home Workspace/Personal Workspaces/Janet Desoto (jdesoto)Fhoto Album Folder
[Home Waorkspace/Personal Workspaces/Janet Desoto (jdesoto)Tasks Folder

MHame Warkenare/Parennal Workenareellanst Naantn fidesntnl Wnrkenara

In this example, the Guest user has access to the Guest workspace and also to Janet DeSoto’s
personal workspace. This could be appropriate if Janet DeSoto’s job is to maintain a publicly

available workspace, but would not be appropriate if the Guest access has been granted in
error.

7 (Conditional) If you want to change the current access:

7a Click the name of a location to display the Configure Access Control page for that location.
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GConfigure Access Control

Configure Access Control @

Workspace: Janet Desoto (jdesoto)
‘Workspace Owner: Janet Desoto(jdesoto) [adi]

Home Workspace 4 [al-Personal Wi

orkspaces i/

Janet Desoto (jdesoto)

This folder does not inherit its access control settings from its parent.

Inherit role membership from the parent folder or workspa
yes ® no

Sharing
This workspace has not been shared

ce?

v designates the access control setting of the parent workspace

Add User Names from Clipboard

Add a Role »
Allow Sharing  Allow Sharing o L Allow Workspace
g Allow Sharing . . . Team
With Internal With External ool SR it The Publye  Sharing File  Visitor  Parficipant R and Folder
Users Users Links Administrator
Owner of Workspace or @ & & & @ @ & & v @
Folder
Team Members It rd rd
Allow Sharing  Allow Sharing Allow Workspace
Add a Group - Group Title  Group Name  With Internal With External ﬂ'mﬁﬂ?ﬁ::mﬁ: ue"‘h"‘}‘hz":;‘:l?c Sharing File  Visitor  Participant MLEm“L"y and Folder
Users Users Links Administrator
All
Internal allusers’ v
Users’
Allow Sharing  Allow Sharing o L Allow Workspace
. g Allow Sharing . . . Team
AddaUserw User Title User Id With Internal With External of Sharing Rights  With The Public Sharing File Visitor  Participant o and Folder
Users Users Links Administrator
Guest guest i
. - Allow Sharing  Allow Sharing gy ool b Allow = Workspace
S a ow Sharing eam
Add an Group v e e With Internal With External of Sharing Rights  With The Public Sharing File Visitor  Participant . o and Folder
Users Users Links Administrator
—no application groups—
. Allow Sharing Allow Sharing oo e Allow Workspace
ieati g Allow Sharing § . . Team
Add an - Title Name With Internal With External of Sharing Rights  With The Public Sharing File Visitor  Participant and Folder
Users Users Links Administrator

—no applications—

In this example, the Guest user has been granted Visitor access to Janet DeSoto’s personal

workspace.

7b Select or deselect access rights as needed.

7c¢ Click Save Changes, then click Close to return to the User Access Report page

7d Rerun the report to view the results of your changes.

For example, if you removed the Guest access rights from Janet DeSoto’s personal

workspace, her workspace is no longer listed in the User Access report for the Guest user.

Reports

Run a Report: | User Access Report

Reports may be truncated if too large.

Report on the Objects a User has Access To

Select a user to view their accessible objects in the system.

User. | Guest (guest)

Select an object's name to change the access control rights on that object.

Name
fHome Workspace/Personal Workspaces/Guest
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8 (Conditional) If you want to save the user access information, select it and copy it into a text
editor.

9 Click Close when you are finished checking user access rights.

Content Modification Report

The Content Modification report lists changes to workspaces, folders, and folder entries, as well as
users, groups, access rights, and workflows. By generating a Content Modification report, you can
determine who has performed any of the following actions:

+ Added, modified, moved, or deleted a workspace
+ Added, modified, moved, or deleted a folder
+ Added, modified, renamed, or deleted a file or one of its versions
+ Added, modified, moved, or deleted an entry
For purposes of this report, users and groups are handled as if they are folder entries.
+ Started or modified a workflow

+ Modified or deleted access rights
The Content Modification report can also help you recover data that has been accidentally deleted.

1 Log in to the Vibe site as the Vibe administrator.

2 Determine the exact name of the workspace, folder, file entry, and so on where you want to
check for content modifications.

3 Click your linked name in the upper right corner of the page, then click the Administration
Console icon %',
4 Under System, click Reports.

5 Inthe Run a Report drop-down list, select Content Modification Log.

Reports

Run a Report: | Content Njcé;lifi_caﬁon 'Il_c_>g_| v

Reports may be truncated if too large.

Select a folder or workspace, then select an entry within that folder or workspace.

Folder or Workspace: Binder Id:
Entry: Entity Id:
Entity Type:

folderEntry ¥
Filter by operation:
=Show All Changes> ¥

Create Report
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6 Fill in the fields to specify where to check for content modifications and the type of

modifications to check for:

Folder or Workspace: Start typing the name of a folder or workspace. In the drop-down list of
names that match what you have typed, select the folder or workspace where you want to
check for content modifications. The internal ID of the folder or workspace is displayed for
reference.

Entry: (Optional) To restrict the content modification check to a specific entry in a folder, start
typing text in the title of the entry. In the drop-down list of entry titles that match what you
have typed, select the entry where you want to check for content modifications. The internal ID
of the entry is displayed for reference.

Entity Type: (Optional) To further restrict the content modification check, select one of the
following:

+ Workspace (not the contents of the workspace, but the workspace itself)
+ Folder (not the contents of the folder, but the folder itself)
+ Folder entry (the contents of the folder entry)

+ Profiles (the contents of the Personal Workspaces folder where there is a personal
workspace for each user)

+ User (the contents of a user’s personal profile, such as the user’s name, email address, and
locale)

+ Group (the contents of the group)

Filter by Operation: Further restrict the content modification check by selecting a specific
action performed on the selected workspace, folder, or entry (add, modify, rename, delete, and
so on).

Click Create Report to generate the Content Modification report.

The results are displayed as an XML file.

<folder databaseId="53" logVersion="1" operation="addBinder"™ modifiedBy="jchavez"™
modifiedCn="Fri Feb 18 16:14:16 GMT 2011">
<_entryhclrall</ entryRcl>
<_folderAcl»2 own team</_ folderAcl>
<_teamhcl>xx</_teamfcl>
<historyStamp author="g" when="18% Feb 2011 16:14:16 GMI" name="created"/>
<historyStamp author="g" when="18 Feb 2011 16:14:16 GMIT" name="modified"/>
<property name="parentBinder">58</property>
<property name="entryDef">402883c6115753d8011157619e35000b</property>
<attribute name="iconName" type="string">/icons/folder blue_blog.gif</attribute>
<attribute name="title" type="string">Blog</attribute>
<property name="library">false</property>
<property name="inheritFunctionMembership">true</property>
<property name="inheritDefinitionz">false</property>
<property name="inheritTeamMembers">true</property>
<property name="unigqueTitle">false</property>
<property name="teamMembers"/>
</folder>

m

8 (Conditional) If the results are too extensive, restrict the scope of the content modification

check until you locate the modification that you are seeking.

9 Click Close when you are finished checking for content modifications.
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A specialized use of the Content Modification report is to restore accidentally deleted data. For
example, you can use the following steps to recover an accidentally deleted folder entry:

1 Run the Content Modification report to list all entry deletions in the folder where the entry was
accidentally deleted.
2 Record the entry ID of the deleted entry.

3 Run the Content Modification report on the entry ID, selecting folderEntry in the Entity Type
field.

4 Use the modification history of the entry to reconstruct the accidentally deleted entry.

Data Quota Exceeded Report

The Data Quota Exceeded report lists individual users who have exceeded the data quota. The report
provides a spreadsheet with the following information for each user:

+ Data Quota Used (MB): Displays the amount of disk space the user is currently using.

+ Data Quota: Displays the user’s individual quota if one has been set.

For information on how to set a quota for individual users, see “Managing Workspace and
Folder Data Quotas” on page 245.

+ Max Group Quota (MB): Displays the largest data quota for any group that the user is a
member of. Users are assigned the highest of all data quotas for any group for which they are a
member.

+ Default Data Quota (MB): Displays the site-wide default quota.

For information on how to set a default data quota, see “Managing Workspace and Folder Data
Quotas” on page 245.

To generate the Data Quota Exceeded report:

1 Login to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon *'.

3 Under System, click Reports.

4 In the Run a Report drop-down list, select Data Quota Exceeded Report.

5 Click Create Report to generate the report.

The report is launched in a spreadsheet.
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Data Quota Highwater Exceeded Report

The Data Quota Highwater Exceeded report lists individual users who have exceeded the data quota
high-water mark. The report provides the following information for each user:

+ Data Quota Used (MB): Displays the amount of disk space the user is currently using.

+ Data Quota: Displays the user’s individual quota if one has been set.

For information on how to set a quota for individual users, see “Managing Workspace and
Folder Data Quotas” on page 245.

+ Max Group Quota (MB): Displays the largest data quota for any group that the user is a
member of. Users are assigned the highest of all data quotas for any group for which they are a
member.

+ Default Data Quota (MB): Displays the site-wide default quota.

For information on how to set a default data quota, see “Managing Workspace and Folder Data
Quotas” on page 245.

To generate the Data Quota Highwater Exceeded report:

1 Login to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon %',

3 Under System, click Reports.

4 In the Run a Report drop-down list, select Data Quota Highwater Exceeded Report.

Report of users exceeding the highwater percentage of their data quota (CSV format).

5 Click Create Report to generate the report.

The report is launched in a spreadsheet.

Disk Usage Report

The Disk Usage report lists the amount of disk space for workspaces on the Vibe site by user, by
workspace, or by both. In addition, you can restrict the reporting to only those workspaces that
exceed a specified number of megabytes.

1 Log in to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration

Console icon %',
3 Under System, click Reports.
4 In the Run a Report drop-down list, select Disk Usage Report.
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Report of User and Workspace Disk Usage (C 5V format)

@ Total Usage by User
© Total Usage by Workspace
) Total Usage by User and Workspace
Include only users or workspaces with usage greater than:

0 MB

5 Select the type of Disk Usage report that you want to generate.

Total Usage by User: Lists all Vibe users whose disk space usage is above the amount specified
in the Usage Greater Than field.

Total Usage by Workspace: Lists all workspaces where disk space usage is above the amount
specified in the Usage Greater Than field. Disk space usage for each folder in each workspace is
listed separately. The data is organized by workspace and folder ID.

Total Usage by User and Workspace: Combines the user and workspace data into a single
report.

Include only users or workspaces with usage greater than: Specify the number of megabytes
above which you want to list disk space usage. This eliminates smaller disk space usages from
the report.

6 Click Create Report to generate the Disk Usage report.
7 Select a text editor to view the report in, then click OK.
For a short report, you might obtain the information you need by viewing the CSV file.

8 (Optional) Save the CSV file with a meaningful name in a convenient location, then retrieve it
into a spreadsheet program for further examination.

9 Click Close when you are finished checking disk space usage.

Email Report

The Email Report lists mail messages that have been sent from and into the Vibe site. It also lists
email errors that have been encountered.
1 Login to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon '*.
3 Under System, click Reports.

4 In the Run a Report drop-down list, select Email Report.
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Reports

Run a Report: | Email Report v

Reports may be truncated if too large.

Report on Email Activity Between

Feb 20, 2015 and | Mar 21, 2015

® Sent emails Received emails Error emails

Create Report

5 Specify the date range for the Email report.

6 Select whether you want a report on email that was sent from Vibe, email that was sent into
Vibe, or email errors that occurred.

7 Click Create Report.
The report contains the following information:
Send Date: Date when the email was sent.
From Address: Address that the email was sent from.
This is the email address that the user has defined in his or her user profile.
To Address: Address that the email was sent to.

This is the email address if the message was sent from Vibe, or it is the folder or workspace if
the message was sent into Vibe.

Type: For messages that are sent from Vibe, this is the action that caused the message to be
sent. For example, wor kf | owNot i fi cat i on indicates that the email message was sent as a
result of a workflow notification. For messages that are sent into Vibe, this is enai | Post i ng,
which indicates that the email message was converted to a Vibe entry via the internal Email
Posting Agent.

Status: Status of the message, such as Sent or Received.
Subject Line: Subject line of the message.
Attached Files: Filename of any attachments that were included in the email message.

Errors: Any errors that are associated with the email message.

License Report

The License report lists information about your Vibe license, as well as information about the
number of users in your Vibe site and how many of those users have accessed the site.
1 Login to the Vibe site as the Vibe administrator.
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon '*.
3 Under System, click Reports.

4 In the Run a Report drop-down list, select License Report.
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Reports

Run a Report: | License Report v

Reports may be truncated if too large.

Report on License Activity Between

Feb 20, 2015 and | Mar 20, 2015

Create Report

5 Specify the date range for the License report, then click Create Report.

The License report lists the following information:

+ Vibe version

+ User access information

*

*

*

*

*

Current Number of Local Users: Number of local users accessing the system at the
precise moment when you view the license report

Current Number of External Users: Number of external users accessing the system at
the precise moment when you view the license report

Current Number of LDAP Synchronized Users: Number of LDAP-synchronized users
accessing the system at the precise moment when you view the license report

Current Active User Count: Number of users who have accessed the Vibe system in
the past 365 days.

Guest Access Enabled: Displays whether Guest access is currently enabled on the
Vibe site.

License information

*

*

*

License key type
Date the license key was issued

Date range when the license key is valid

Allowed number of registered users during the date range

Allowed number of external users during the date range

List of dates in the date range with the following user license information:

*

*

*

Local and External Users: The user account was created within Vibe, and is not being
synchronized from an LDAP directory.

Users Synchronized from LDAP: The user account was created from an LDAP source.
(Only synchronized accounts that are not marked as Deleted or Disabled are counted.)

Users Who Used Vibe During the Previous 365 Days: Users who have logged in at
least once in the past 365 days.
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User logins are counted only after your Vibe system is upgraded to Vibe 3 or later. The
number of users who have logged in is always 0 for dates prior to the upgrade to Vibe
3 or later.

To see how many people accessed the Vibe site prior to the upgrade to Vibe 3 or later,
or just for more detailed information in this area, run the Login report. For more
information about the Login report, see “Login Report” on page 299.

The Vibe software does not limit the number of Vibe users that you can create, but sites where
Vibe licenses have been purchased and the Vibe software installed are periodically audited
against their purchased number of licenses.

6 Click Close when you are finished reviewing the License report.

For information on how to install a new Vibe license, see “Updating Your Vibe License” in “Single-
server (Basic) Installation” in the OpenText Vibe 4.0.8 Installation Guide.

XSS Report

Cross-site scripting (XSS) is a client-side computer attack that is aimed at web applications. Because
XSS attacks can pose a major security threat, Vibe contains a built-in security filter that protects
against XSS vulnerabilities. For more general information about XSS, see “Securing the Vibe Site
against XSS” on page 365.

The XSS report in Vibe lets you remove potentially harmful XSS threats from your Vibe site.

1 Login to the Vibe site as the Vibe administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon '*.

3 Under System, click Reports.

4 In the Run a Report drop-down list, select XSS Report.

Run a Report: | XSS Report v

Reports may be truncated if too large.

This report scans the binders and entries in each selected binder looking for potential
without any noticeable effect. The scan takes about 1 minute for every 1000 entries.

Selectthe binders to be checked:

= W Home Workspace
n‘, Global Workspaces
m Personal Workspac es
5-_; Team Workspaces

5 Select the workspace or folder where you want to run the report. Any sub-workspaces or sub-
folders of the workspace or folder that you select are included in the report.

6 Click Create Report.
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IMPORTANT: Because XSS attacks often are designed to wait for users with extra privileges
(such as the administrator) to view the page where the attack was set, it is important that you
don’t navigate to the page after you run the report.

For information about how to run the XSS report and safely remove XSS threats, see “TID
7007381: Running the XSS Report in Vibe” in the OpenText Support Knowledgebase (http://
www.novell.com/support).

Using Log Files

+ “Vibe Log File” on page 313
+ “Tomcat Log File” on page 313

Vibe Log File
The Vibe log file (ssf . | 0g) is available from the Vibe site.

1 Login as the Vibe site administrator.

2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon '+

3 Under System, click Reports, click System Error Logs.

4 In the Run a Report drop-down list, select System Error Logs.

5 Click Download Log.

You are prompted to open or save a file named | ogfi | es. zi p, which contains the current
appserver. | og file. This file contains any stack traces or warning messages because of
unexpected events encountered by the Vibe program.

6 Save the appserver. | og file to a convenient location on the Vibe server.

This file is helpful when you need assistance resolving a problem with your Vibe site.
If you are unable to start Vibe and therefore cannot retrieve the log file as described above, the Vibe
log file is also available in the following directory of your Vibe installation:
Linux: / opt/ novel | / t eam ng/ apache-t ontat / webapps/ ssf/WEB- | NF/ | ogs

Windows: c:\Program Fil es\ Novel | \ Team ng\ apache-t ontat \ webapps\ ssf\ VEB- | NF\ | ogs

Tomcat Log File

In addition to the Vibe error log file (ssf . | 0g), the Tomcat error log file (cat al i na. out on Linux
and st dout _*. | og on Windows when Vibe runs as a service) is also useful. The Tomcat log file
contains more information than the Vibe log file, because it includes problems encountered by
Tomcat outside of the Vibe application itself. The location of the Tomcat log file varies by platform:

Linux: [ opt/ novel | / t eanm ng/ apache-tontat/| ogs

Windows:  c¢:\Program Fi | es\ Novel | \ Team ng\ apache-tontat\| ogs
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NOTE: When Vibe and Tomcat run as a Windows application, rather than as a Windows service, the
information displayed in the command prompt window where you started Vibe is your only source
of information. The data displayed in the command prompt window is not logged by Tomcat on
Windows.

The Tomcat log file provides the following useful information:

+ At the top, the Tomcat log file lists Tomcat startup messages.

+ The System Properties section lists information about the supporting software packages that
Tomcat relies on (for example, Java) and information about their current location and
configuration.

+ The System Environment section lists the currently set environment variables (for example,
HOSTNAME, PATH, and JAVA HOME).

+ Exception and error data includes sufficient information for you to determine what user was
trying to perform what action in what location on the Vibe site, to help you isolate and
reproduce the problem.

NOTE: The Vibe product name prior to version 3 is Novell Teaming. If your Vibe site was
originally installed as a Teaming 2.0 or Vibe site, the root of your site is referred to as

or g. kabl i nk in the Tomcat error log. If you updated from a Teaming 1.0 site or a Teaming 2.0
beta site, the root of your site is referred toascom | i f er ay.

This file is helpful when you need assistance resolving a problem with your Vibe site.

Adjusting the Log Level for the Tomcat Log File

The log levels for various Tomcat functions are set in the | og4j 2. properti es file. Each type of
information that is logged can have a log level of INFO, WARN, ERROR, FATAL, or DEBUG, depending
on the type and quantify of information that you want logged. Some lines in the
| 0g4j 2. properti es file are commented out with a pound sign (#), so that no information of that
type is gathered. You can change the log level for each type of information and comment or
uncomment lines to adjust the information gathered in the Tomcat log file to meet your
troubleshooting needs.

1 Openthel og4j 2. properti es file in a text editor.

The location of the | 0g4j 2. properti es file varies by platform.

Linux: /opt/ novel | /team ng/ | uceneserver/indexserver/lib

Windows: C:\ Program Fi | es\ Novel | \ Team ng\ apache-t ontat\ conf

Change log level settings as needed for the type of information you want to gather.
Comment or uncomment lines, depending on the type of information you want to gather.

Save the | 0g4j 2. properti es file, then exit the text editor.

v A W N

Stop Vibe, then start Vibe to put the new logging level into effect.
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Checking the Vibe Site Software Version

To display the version number and software date of the Vibe software:

1 Login to the Vibe site as the Vibe administrator
2 Click your linked name in the upper right corner of the page, then click the Administration
Console icon %',

The Vibe software version and date are displayed.
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Reconfiguring the Vibe Site

Many aspects of your Vibe site can be changed when you are logged in to the Vibe site as the Vibe
administrator. Some aspects of reconfiguring the Vibe site require you to rerun the Vibe installation
program, as described in “Setting Configuration Options after Installation” in “Advanced Installation
and Reconfiguration” in the OpenText Vibe 4.0.8 Installation Guide.

+ “Basic Installation” on page 317

+ “Advanced Installation” on page 318

Basic Installation

The configuration settings that can be changed using a Basic installation are:

Default Locale for Vibe
Network Information
Host
HTTP Port and Secure HTTP Port
Listen Port and Secure Listen Port
Shutdown Port and AJP Port
WebDAV Authentication Method
Database Selection
Database Type
JDBC URL
Credentials
Java Heap Size
Outbound Email Configuration
Protocol
Host, Port, and Time Zone
User name, Password, and Authentication
Allow Sending Email to All Users
Inbound Email Configuration
Internal SMTP Email Server
SMTP Bind Address
SMTP Port
Announce TLS

For information about these basic configuration options, see “Planning a Basic (Single-server) Vibe
Installation” in “Single-server (Basic) Installation” in the OpenText Vibe 4.0.8 Installation Guide.
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Advanced Installation

An Advanced installation includes the options available in a Basic installation, as well as the following
additional options:

Web Services

Enable WSS Authentication

Enable Basic Authentication

Enable Token-Based Authentication

Enable Anonymous Access
Lucene Configuration
RSS Configuration

Max Elapsed Days

Max Inactive Days
Presence Configuration
Reverse Proxy Configuration

Access Gateway Address

Logout URL

WebDAV Access Gateway Address
Integration with IIS for Windows Authentication
Mirrored Folder Resource Driver Configuration
Vibe Cluster Configuration

For information about these advanced configuration options, see “Planning an Advanced Vibe
Installation” in “Advanced Installation and Reconfiguration” in the OpenText Vibe 4.0.8 Installation
Guide.
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Interoperability

Vibe can be used in conjunction with various other software products. By incorporating these
products into your Vibe system, you can add functionality, increase security, and maximize the value
of Vibe.

*

*

Chapter 33, “NetlQ Access Manager,” on page 321

Chapter 34, “Internet Information Services (lIS),” on page 323
Chapter 35, “OpenText GroupWise,” on page 325

Chapter 36, “GroupWise Messenger,” on page 327

Chapter 37, “Skype,” on page 329

Chapter 38, “Twitter and Other Remote Applications,” on page 331
Chapter 39, “YouTube,” on page 333
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NetlQ Access Manager

Using Vibe in conjunction with NetlQ Access Manager adds enterprise-level security to your Vibe
system.

Only a version of Access Manager that supports Transport Layer Security (TLS) can be used when
using Access Manager with Vibe. For information about which versions of Access Manager support
TLS and how to enable it, see Enabling Transport Layer Security 1.1 and 1.2 for Access Manager
(https://www.netig.com/documentation/netiqaccessmanager4/enable_tls_nam40/data/
enable_tls_nam40.html#).

IMPORTANT: When NetlQ Access Manager (or another single sign-on tool) is used in conjunction
with your Vibe system, external users and the Guest user cannot access your Vibe site.

For more information about external users in Vibe, see “Understanding External Users” on page 129.

Before you can access your Vibe site through NetlQ Access Manger, you must first configure specific
protected resources in Access Manager to be public, as described in Chapter 8, “Allowing Access to
the Vibe Site through NetlQ Access Manager,” on page 141.

Furthermore, you can configure NetlQ Access Manager to work with Vibe in the following ways:
+ Configure NetlQ Access Manager to provide single sign-on access to the Vibe site.

For more information, see “Configuring Single Sign-On with Novell Access Manager” in the
OpenText Vibe 4.0.8 Installation Guide.

+ Configure NetlQ Access Manager to allow access to iOS and Android mobile applications for
Vibe.

For more information, see “Configuring Mobile Device Access with NetlQ Access Manager” on
page 116.

When you set up NetlQ Access Manager to work with Vibe, ensure that you specify the correct
HTTP/HTTPS port numbers during the Vibe installation, as described in “HTTP/HTTPS Ports When
You Use Novell Access Manager with Vibe” in the OpenText Vibe 4.0.8 Installation Guide.
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Internet Information Services (lIS)

You can integrate Vibe with Internet Information Services (lIS) to achieve Integrated Windows
Authentication functionality. For more information about IIS and Integrated Windows
Authentication with Vibe, see “Configuring Single Sign-On with Internet Information Services for
Windows” in the OpenText Vibe 4.0.8 Installation Guide.
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OpenText GroupWise

When you use Vibe with GroupWise, some configuration steps are required to integrate the
applications, as described in “Configuring GroupWise for Use with Micro Focus Vibe” in the
GroupWise 18 Interoperability Guide:

+ “Configuring GroupWise for Use with Micro Focus Vibe”

+ “’Enabling GroupWise/Vibe Integration for GroupWise Client Users

+ “”Accessing Your Vibe Site from the GroupWise Client
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GroupWise Messenger

Vibe lets you integrate with GroupWise Messenger 2.2 and later. This integration displays users’
Messenger presence information within Vibe. For information about how to configure Vibe to work
with Messenger, see “Integrating Messenger with Vibe” on page 173.
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Skype

Vibe lets you integrate with Skype, so Vibe users can easily set up instant Skype meetings with other
Vibe users, as described in “Using Skype from within Vibe” in the OpenText Vibe 4.0.8 User Guide.

Before users can use Skype from within Vibe, Vibe administrators must enable this functionality. For
instructions on how to set up Vibe to work with Skype, see “Integrating Skype with Vibe” on
page 174.
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Twitter and Other Remote Applications

Vibe lets you incorporate third-party products such as Twitter into Vibe, through the use of remote
applications.

For information on how to incorporate existing remote applications into your Vibe site, see
Chapter 16, “Using Remote Applications on Your Vibe Site,” on page 185.
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YouTube

Vibe lets you display YouTube videos directly from the Vibe site. This functionality is enabled by
default and does not need to be activated by a Vibe administrator.

For more information about how to display YouTube videos on the Vibe site, see “Displaying
YouTube Videos in a Folder Entry” in the OpenText Vibe 4.0.8 User Guide.
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I V Site Security

¢ Chapter 40, “Security Administration,” on page 337
+ Chapter 41, “Security Policies,” on page 361
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O Security Administration

SSL (Secure Socket Layer) and TLS (Transport Layer Security) can be used to secure the connections
between your OpenText Vibe site and other network services.

+ “Dealing with Security Scan Results” on page 337

¢ “Securing LDAP Synchronization” on page 338

+ “Securing Email Transfer” on page 340

¢ “Securing HTTP Browser Connections” on page 340

+ “Securing against Brute-Force Attacks with CAPTCHA” on page 349

+ “Securing User Passwords” on page 351

+ “Securing Web Service Connections” on page 352

+ “Securing Tomcat” on page 352

+ “Requiring That External Users Accept Terms and Conditions” on page 353

+ “Vibe Sanitizes HTML to Prevent Security Risks” on page 353

Dealing with Security Scan Results

Running regular security scans on your network is critical to security administration. As exemplified
in Chapter 41, “Security Policies,” on page 361, security is a top priority for the Vibe development
team.

Occasionally, reputable security scanning software reports risks that the Vibe team considers to be
less significant than reported. The following are specific examples:

+ PHP as a Security Vulnerability: Although in many cases the presence of PHP scripts is a
legitimate concern, in the case of Vibe, there is no PHP access without first authenticating
through port 9443. Since access through port 9443 is secure by definition, Vibe’s PHP
implementation is secure.

+ Diffie-Hellman 1024 Keys: If you run a Nessus or equivalent security scan, you might receive a
report of “Medium Risk” associated with Diffie-Hellman 1024-bit keys.

The Vibe team is aware of this and is considering increasing the key size in a future release. At
this time, however, the team does not feel that this is a significant threat to Vibe installations;
breaking 1024-bit keys requires computing resources that only a nation-state would have at its
disposal.

If you are concerned or feel that your organization might be vulnerable to nation-state attacks,
you can specify a stronger key through the Java security policy.
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Securing LDAP Synchronization

If your LDAP directory service requires a secure LDAP connection (LDAPS), you must configure Vibe
with a root certificate. The root certificate identifies the root certificate authority (CA) for your Vibe
site, which lets you generate a self-signed root certificate based on your eDirectory tree.

+ “Understanding How Vibe Uses the Root Certificate for Your eDirectory Tree” on page 338
+ “Generating a Root Certificate in ConsoleOne” on page 338

+ “Importing the Root Certificate into the Java Keystore” on page 339

Understanding How Vibe Uses the Root Certificate for Your
eDirectory Tree

You can generate a self-signed root certificate for your eDirectory tree by using either ConsoleOne or
iManager, then import the root certificate into the Java keystore file (cacert s) on the Vibe server
to make it accessible to Vibe. The default location for the Java keystore file is:

Linux: [opt/novel |l /teami ng/jre/libl/security

Windows: c¢:\Program Fil es\ Novel |\ Teami ng\jre\lib\security

NOTE: For iManager instructions, see “TID 3176104: How to Enable SSL for Teaming LDAP
Synchronization and Authentication” in the Novell Support Knowledgebase (http://
www.novell.com/support). If you are using Active Directory rather than eDirectory, consult your
Active Directory documentation for a procedure comparable to the one provided in “Generating a
Root Certificate in ConsoleOne” on page 338.

Generating a Root Certificate in ConsoleOne

1 On Linux or Windows, start ConsoleOne and authenticate to your eDirectory tree.

2 Expand the Security container, right-click the Tree_ Name CA object, then click Properties.
3 Click Certificates > Self Signed Certificate.
4

Click validate to update the certificate status, then click OK to close the Certificate Validation
dialog box.

5 Click Export to export your eDirectory root certificate into a file that can be imported into the
Java keystore file.

6 Click Next to accept the default of No for exporting a private key file along with the root
certificate.

7 Select the output format for the root certificate file.
Either DER or Base64 format can be imported into the Java keystore file.

8 In the Filename field, specify the location where you want to create the root certificate file and
the filename to use, such as Sel f Si gnedRoot Cert . der.

IMPORTANT: You need to be able to access this file from the Vibe server. Specify an accessible
location or copy it to the Vibe server after you create it.
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9 Click Next to display a summary of the options you have selected, then click Finish to generate
the root certificate file.

10 Click Cancel to close the Self Signed Certificate properties page of the Tree_ Name CA object.
11 Exit ConsoleOne.

12 (Conditional) If necessary, copy the root certificate file to a convenient location on the Vibe
server.

Importing the Root Certificate into the Java Keystore

1 On the Vibe server, make sure that you have access to the root certificate file.

2 Make sure that you can access the keyt ool tool:

SLES: [ opt/ novel | / t eam ng/j re/ bi n/ keyt ool

Windows: c¢:\ Program Fi | es\ Novel I\ Teani ng\j re\ bi n\ keyt ool . exe

For convenient use, you might need to add its location to the PATH environment variable.

3 Use the following command to import the root certificate into the Java keystore:

keytool -inportcert -alias alias_nanme -file path_to_root_cert file -
cacerts

where alias_name is an arbitrary name that you assign to the certificate being imported into
the Java keystore (cacert s) and root_certificate_file is the name of the certificate file.

For example:

keytool -inportcert -alias gw . Idap _srvr -file /certs/SSignedCert.der -
cacerts

4 When prompted, enter changei t as the password for the Java keystore.
5 Enteryes to accept the certificate import.

6 Use the following command to verify that the root certificate has been imported into the Java

keystore:

keytool -list -alias alias_nane -cacerts
For example:

keytool -list -alias gw.|dap_srvr -cacerts

7 Enter the root certificate password to list the root certificate information.

8 Restart Vibe so that Tomcat rereads the updated Java keystore file.

You are now ready to configure your Vibe site for secure LDAP synchronization, as described in
“Adding Vibe Users from Your LDAP Directory” in “Single-server (Basic) Installation” in the OpenText
Vibe 4.0.8 Installation Guide.
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Securing Email Transfer

When you install OpenText Vibe, you can choose whether or not the Vibe internal mail host uses TLS
(Transport Layer Security) when it communicates with other SMTP mail hosts. For more information,
see “Inbound Email Security” in “Single-server (Basic) Installation” in the OpenText Vibe 4.0.8
Installation Guide.

If your Vibe site needs to send email messages to an email system that requires secure SMTP, such as
GroupWise 2018, the Vibe site must have the same type of root certificate that is required for secure
LDAP (LDAPS). If you have not already set up secure LDAP for your Vibe site, follow the instructions
in “Securing LDAP Synchronization” on page 338 to set up secure SMTP for communications with
your email system.

Securing HTTP Browser Connections

Using secure HTTP (HTTPS) improves the security of your OpenText Vibe site. During installation, you
can choose to configure your Vibe site for HTTP or HTTPS. After installation, you can force secure
HTTP connections.

+ “Preparing for Secure HTTP Connections” on page 340

+ “Implementing Secure HTTP Connections” on page 345

+ “Forcing Secure HTTP Connections” on page 345

+ “Defaulting to Secure HTTP URLs” on page 347

Preparing for Secure HTTP Connections

If you want users to access the Vibe site with a secure HTTP connection, you must configure Vibe
with a root certificate and a server certificate. The root certificate identifies the root certificate
authority (CA) for your Vibe site. The server certificate is customized for the specific server where
Vibe is installed.

+ “Understanding How Vibe Handles Certificates” on page 340

+ “Creating a New Keystore File” on page 341

+ “Generating a Certificate Signing Request” on page 342

+ “Submitting the Certificate Signing Request to a Certificate Authority (CA)” on page 343

+ “Using the Certificate Signing Request to Generate a Self-Signed Certificate” on page 343

+ “Importing the Certificate Files into the Vibe Keystore” on page 344

+ “Replacing the Original Vibe Keystore File with Your Permanent Keystore File” on page 344

Understanding How Vibe Handles Certificates
Vibe uses a keystore to store certificates. The default keystore file that is installed along with Vibe is:

Linux: /opt/ novel | / t eam ng/ apache-tontat/conf/. keystore

Windows: c:\Program Fi |l es\ OpenText\ Teani ng\
apache-tontat\conf\. keystore
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The original certificate in the default keystore is sufficient for you to set up secure HTTP connections

during initial installation, but it is self-signed and has an expiration date, so you cannot use it
permanently. Soon after installation, you must obtain a permanent certificate. You can use a

commercially signed certificate or a self-signed certificate. There are advantages and disadvantages

to each approach.

+ Commercially Signed Certificate: The advantage to using a certificate signed by a commercial

certificate authority (CA) is that browsers automatically accept these certificates. The

disadvantage is that an additional step is required, with some wait time while you obtain the

commercially signed certificate.

+ Self-Signed Certificate: The advantage to using a self-signed certificate is that it is quick and

easy for you to do as the Vibe administrator. The disadvantage is that users receive a warning in
the browser about the self-signed certificate the first time they access the Vibe site using secure

HTTP. Users must manually accept the self-signed certificate, then the warning never occurs
again.

After you obtain your permanent certificate, you can store it in the default Vibe keystore, orin a
location of your own choosing. Vibe reads the location of its keystore from the following file:
Linux: [ opt/ novel | / t eam ng/ apache-tontat/conf/server. xm

Windows: c¢:\Program Fi |l es\ Novel | \ Teani ng\
apache-tontat\ conf\server. xn

If you do not want to use the default keystore location, you must update the server. xni file to
match the location you choose for your keystore.

Creating a New Keystore File

Rather than updating the Vibe . keyst or e file that is provided during installation, it is easier to
create a new . keyst or e file, then import your signed certificate into it.

1 Create a new directory where you want to create the new . keyst or e file, suchasacerts
directory in a convenient location.

2 Change to the new cert s directory.

3 Make sure that you can access the keyt ool tool:

Linux: /opt/ novel | / team ng/jre/ bin/keyt ool

Windows: c¢:\ Program Fi | es\ Novel | \ Team ng\j r e\ bi n\ keyt ool . exe

For convenient use, you might need to add its location to the PATH environment variable.

4 Use the following command to create a new . keyst or e file:

keyt ool -genkey -alias tontat -keyal g RSA -keystore .keystore

5 When prompted, specify and confirm changei t as the password for the new . keyst or e file.

6 When you are prompted for your first and last name, specify the fully qualified DNS name of the

Vibe server, such as vi be. your conpanyname. com
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You are then prompted for additional information about your organization:
+ Organizational unit

+ Organization

*

City or locality

*

State or province

*

Two-letter country code

7 (Conditional) If you are planning to obtain a your certificate from a commercial certificate
authority (CA), respond to the additional information prompts with accurate information
appropriate to your organization.

or

(Conditional) If you are planning to generate a self-signed certificate, press Enter to skip through
the prompts.

8 When you are prompted whether the information you provided is correct, enter yes.

9 Press Enter to use the same password that you specified in Step 5 as the key password for
Tomcat.

10 List the files in the cert s directory to see that a new . keyst or e file has been created.

Do Not Change the Password for the Keystore File
The password for the . keyst or e file is hard coded and should not be changed.

The password adds no additional protection because the keystore is secured by being located in a
root-owned directory, not by the password.Port 9443 Vibe and Filr Cert management are hard coded
to expect the password as it is created on the system.

Changing the password breaks 9443 certificate management.

Generating a Certificate Signing Request

1 Use the following command to create a certificate signing request (CSR):

keytool -certreq -alias tonctat -keyal g RSA
-file certreqg.csr -keystore .keystore

2 Enter the keystore password (changei t ) to create the CSR.

3 List the filesin the cert s directory to see thata new certreq. csr file has been created along
with the existing. keyst or e file.

4 Usethecertreq. csr file to obtain a signed certificate.:

4a To use a commercial certificate authority (CA), continue with “Submitting the Certificate
Signing Request to a Certificate Authority (CA)” on page 343.

or

4b To use a self-signed certificate, skip to “Using the Certificate Signing Request to Generate a
Self-Signed Certificate” on page 343.
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Submitting the Certificate Signing Request to a Certificate Authority (CA)

You can find a commercial certificate authority (CA) on the Internet by searching for “certificate
authority.” The process of obtaining a signed certificate varies from company to company. Each
company provides instructions to assist you.

The certificate authority sends you a set of certificate files that you import into the Vibe keystore.
Import these files into the same keystore that you used to create the original certificate request. You
must import all of the files that you receive.

The following procedure is a guideline for importing the certificate into the Vibe keystore.
Instructions might vary depending on the certificate authority.

1 Change to the cert s directory where you created the root certificate file and the server
certificate file.

2 Use the following command to import the root certificate file:

keytool -inport -alias root -trustcacerts -keyalg RSA -keystore
. keystore
-file CertificateAuthorityCert. der

3 Enter the keystore password (changei t ) to add the root certificate to the Vibe keystore.

4 Use the following command to import the SSL certificate file that you received from the
certificate authority:

keytool -inport -alias tontat -keyal g RSA -keystore .keystore
-file certificate_name.cer

5 Enter the keystore password (changei t ) to add the server certificate to the Vibe keystore.

Using the Certificate Signing Request to Generate a Self-Signed Certificate

If you do not want to wait to receive your signed certificate from a commercial certificate authority
(CA), you can generate your own self-signed certificate using iManager. You must generate both a
self-signed eDirectory root certificate file and a server certificate file.

For help, refer to “Understanding the Certificate Server” in the NetlQ eDirectory Administration
Guide.

NOTE: If you are using Active Directory rather than eDirectory, consult your Active Directory
documentation for comparable procedures.
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Importing the Certificate Files into the Vibe Keystore

After you have obtained or generated a signed certificate, you must import the certificate files into
the Vibe keystore. This section describes how to import the files associated with a self-signed
certificate. For information about how to import the files for a certificate that you receive from a
certificate authority, see “Submitting the Certificate Signing Request to a Certificate Authority (CA)”
on page 343.

1

Change to the cert s directory where you created the root certificate file and the server
certificate file.

Use the following command to import the root certificate file:

keytool -inport -alias root -keyalg RSA -keystore .keystore
-file Sel fSignedRoot Cert. der

3 Enter the keystore password (changei t ) to add the root certificate to the Vibe keystore.

Use the following command to import the server certificate file:

keytool -inport -alias tonctat -keyal g RSA -keystore .keystore
-file Sel fSignedServerCert.der

Enter the keystore password (changei t ) to add the server certificate to the Vibe keystore.
The new . keyst or e file is now ready to be added to your Vibe system.

Use the following command to verify that the server certificates have been imported into the
Vibe keystore:

keytool -list -keystore .keystore

Enter the keystore password (changei t ), then verify that the certificates have been imported.

You should see the text Your keystore contains 2 entries, followed by information
about each certificate that you imported.

Continue with “Replacing the Original Vibe Keystore File with Your Permanent Keystore File” on
page 344.

Replacing the Original Vibe Keystore File with Your Permanent Keystore
File

1

Change to the following directory on the Vibe server:

Linux: /opt/ novel | / t eam ng/ apache-t ontat/ conf

Windows: c¢:\Program Fi | es\ Novel | \ Team ng\
apache-tontat\ conf

Rename the existing . keyst or e file to keyst or ebackup.

3 Copy your new . keyst or e from the cert s directory to the conf directory.

Adjust the ownership and permissions of the new . keyst or e file to match those of the
backed-up keystore file.

Restart Vibe so that Vibe rereads the updated keystore file.
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Implementing Secure HTTP Connections

When you run the Vibe installation program, you can choose between non-secure and secure HTTP
connections, as described in “HTTP/HTTPS Ports” in “Single-server (Basic) Installation” in the
OpenText Vibe 4.0.8 Installation Guide.

Forcing Secure HTTP Connections

With additional configuration, you can force users from a non-secure HTTP connection to a secure
HTTPS connection.

+ “Using NetlQ Access Manager to Force Secure HTTP Connections” on page 345

+ “Configuring Tomcat to Redirect to Secure HTTP Connections” on page 345

+ “Adding the Apache Web Server to Force Secure HTTP Connections” on page 347

Using NetlQ Access Manager to Force Secure HTTP Connections

With Vibe, you can use NetlQ Access Manager to force secure HTTP connections. For more
information, see “Configuring Single Sign-On with Novell Access Manager” in “Advanced Installation
and Reconfiguration” in the OpenText Vibe 4.0.8 Installation Guide.

Configuring Tomcat to Redirect to Secure HTTP Connections

To reconfigure Tomcat, you must update two configuration files (both named web. xnl ) under two
different directories (ssf and ROOT). The ssf directory name refers to SiteScape Forum, a legacy
product name. The ssf directory contains the main Vibe web application that you use when you
interact with your browser. The ROOT directory name refers to SiteScape File System. The ROOT
directory contains the Vibe WebDAV application that you use to access files on a remote WebDAV
server from the Vibe site.

1 Login to the Vibe server with sufficient rights to edit the web. xmi files (r oot on Linux,
Admi ni st rat or on Windows).
2 Modify the web. xnl file under the ssf directory:

2a Change to the directory where the web. xmi file is located.

Linux: / opt/ novel | / t eami ng/ apache-tontat/
webapps/ ssf/ WEB- | NF

Windows: c:\Program Fi | es\ Novel | \ Teani ng\ apache-t ontat\
webapps\ ssf\ WEB- | NF

2b Make a backup copy of the web. xni file, then open the web. xmi file in a text editor.

2c Add the following security constraint at the bottom of the file, immediately above the </
web- app> tag.
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<security-constraint>
<web-resource-col | ecti on>
<web-resour ce-nane>Entire Applicati on</web-resource-nane>
<url-pattern>/*</url-pattern>
</ web-resource-col | ecti on>
<user - dat a- constrai nt >
<transport - guar ant ee>CONFI DENTI AL</ t r ansport - guar ant ee>
</ user - dat a- constrai nt >
</ security-constraint>

2d (Conditional) If users access the Vibe site with Internet Explorer, find the following single
line in the security constraint you just added:

<url-pattern>/*</url-pattern>
2e Replace it with the following set of lines:

<l-- Patterns fromweb.xm .tmpl. -->
<url-pattern>/al/*</url-pattern>
<url-pattern>/ws/*</url-pattern>
<url-pattern>/rss/*</url-pattern>
<url-pattern>/atom *</url -pattern>
<l-- Patterns fromsubdirectories of webapps/ssf. -->
<url-pattern>/applets/*</url-pattern>
<url-pattern>/css/*</url-pattern>
<url-pattern>/hel p/*</url -pattern>
<url - pattern>/ hel p_doc/*</url -pattern>
<url-pattern>/i/*</url-pattern>
<url-pattern>/images/*</url-pattern>
<url-pattern>/js/*</url-pattern>

For Internet Explorer, this list of URL patterns forces secure HTTP connections for
everything except the / s/ * pattern (document files with extensions such as . odt and
.doc)andthe/i cal / * pattern (calendar . i cs files).

2f Save the modified web. xnl file, then exit the text editor.
3 Modify the web. xnl file under the ROOT directory:
3a Change to the directory where the web. xmi file is located.
Linux: / opt/novel | / t eam ng/ apache-t ontat/
webapps/ ROOT/ WEB- | NF
Windows: c:\Program Fi | es\ Novel | \ Tean ng\ apache-t ontat\

webapps\ ROOT\ VEB- | NF

3b Make a backup copy of the web. xni file, then open the web. xmi file in a text editor.

3c Add the following security constraint at the bottom of the file, immediately above the </
web- app> tag.
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<security-constraint>
<web-resource-col | ecti on>
<web-resour ce-nane>Entire Applicati on</web-resource-nane>
<url-pattern>/*</url-pattern>
</ web-resource-col | ecti on>
<user - dat a- constrai nt >
<transport - guar ant ee>CONFI DENTI AL</ t r ansport - guar ant ee>
</ user - dat a- constrai nt >
</ security-constraint>

3d Save the modified web. xm file, then exit the text editor.

Adding the Apache Web Server to Force Secure HTTP Connections

You can set up the Apache web server to front your Vibe site and use a meta refresh (http://
en.wikipedia.org/wiki/Meta_refresh) to redirect users to a secure URL.

1 Install the Apache web server on one server.
2 Configure Apache to listen on port 80.

3 Create ani ndex. ht m file similar to the following example:

<htm >

<head>
<neta http-equiv="refresh" content="0;url=https://vibe_url" />
<title>Redirected to Secure Vibe</title>

</ head>

<body>
This page is used to redirect to the Secure Vibe server. |f your
browser does not automatically redirect you in a few seconds, click
<a href="https://vibe_url">here</a> to go to the secure page.

</ body>

</htm >

4 Replace vibe_url with the URL to your Vibe site.

5 Place the i ndex. ht nl file in the document root directory of the Apache web server.

Linux: [ srv/ww/ ht docs

Windows: c:\Program Fil es\ Apache Software Foundati on\ Apache2. 2\ ht docs
6 Restart the Apache web server.

Defaulting to Secure HTTP URLs

+ “Defaulting to Secure HTTP URLs in Vibe Links” on page 348
+ “Defaulting to Secure HTTP URLs in Email Notifications” on page 349
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Defaulting to Secure HTTP URLs in Vibe Links

Vibe includes URLs to locations on the Vibe site in various links throughout the Vibe system. By
default, the URLs are formed with HTTP rather than HTTPS. You can reconfigure Vibe to default to
HTTPS for Vibe site URLs.

1 Log in to the Vibe server with sufficient rights to edit the ssf - ext . properti es file (r oot on
Linux, Admi ni st rat or on Windows).

2 Change to the following directory:

Linux: /opt/ novel | / t eam ng/ apache-t ontat /
webapps/ ssf/WEB- | NF/ cl asses/ config

Windows: c¢:\Program Fi |l es\ Novel | \ Teani ng\ apache-t ontat\
webapps\ ssf\ WEB- | NF\ cl asses/ config

3 Openthessf. properti es filein a text editor.
4 Locate and copy the following lines:
adapt er. web. prot ocol =context-http
servl et. web. prot ocol =context-http
rss.web. protocol =context-http
i cal . web. protocol =context-http

ssfs. web. prot ocol =context-http
si mpl eurl . web. prot ocol =context-http

5 Make a backup copy of the ssf - ext . properti es file, located in the same directory with the
ssf. properti es file.

6 Openthessf-ext. properti es filein a text editor.

7 Paste the lines that you copied in Step 4 to the bottom of the file.

8 Change httptohttps.

adapt er. web. pr ot ocol =cont ext - htt ps
servl et. web. protocol =cont ext-https
rss. web. prot ocol =cont ext - ht t ps

i cal . web. prot ocol =cont ext - htt ps
ssfs. web. prot ocol =cont ext - https

si mpl eurl . web. prot ocol =cont ext - htt ps

9 Close the ssf. properti es file without saving.
10 Save the ssf - ext. properti es file, then exit the text editor

11 Restart Vibe to put the change into effect.
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Defaulting to Secure HTTP URLs in Email Notifications

When an email notification is sent from Vibe, Vibe includes a URL to the location on the Vibe site
where the notification was sent. By default, the URLs in email notifications are formed with ht t p
rather than ht t ps. You can reconfigure Vibe to default to ht t ps for Vibe site URLs.

1 Log in to the Vibe server with sufficient rights to edit the ssf - ext . properti es file (r oot on
Linux, Admi ni st rat or on Windows).

2 Change to the following directory:
Linux: /opt/ novel | / t eam ng/ apache-t ontat /
webapps/ ssf/WEB- | NF/ cl asses/ config
Windows: c¢:\Program Fi |l es\ Novel | \ Teani ng\ apache-t ontat\

webapps\ ssf\ WEB- | NF\ cl asses/ config

3 Openthessf. properti es filein a text editor.

4 Locate and copy the following line:
ssf.secure.links.in. emil=fal se

5 Close the ssf. properti es file without saving.

6 Make a backup copy of the ssf - ext . properti es file, located in the same directory with the
ssf. properti es file.

7 Openthessf-ext. propertiesfilein atext editor.
8 Paste the line that you copied in Step 4 to the bottom of the file:

ssf.secure.links.in.emil=fal se
9 Changef al se totrue sothat the line now looks like this:
ssf.secure.links.in.enmail=true

10 Save the ssf-ext. properti es file, then exit the text editor

11 Restart Vibe to put the change into effect.

All system-generated email notifications now default to secure HTTP URLs. However, all user-
generated emails from the Vibe system follow the current user’s context. For example, if a user is
logged in as HTTP and chooses to share an entry with another user, the link in the email notification
uses HTTP.

Securing against Brute-Force Attacks with CAPTCHA

CAPTCHA (http://en.wikipedia.org/wiki/CAPTCHA) provides additional security against brute-force
attacks on the Vibe web application.

Brute-force attack monitoring is enabled on the Vibe system by default.

By default, Vibe considers a brute-force attack to be taking place if any user has 5 failed login
attempts to the Vibe system within a 30-minute timeframe. During the time that Vibe believes that a
brute-force attack is occurring, Vibe requires all users to specify the CAPTCHA response when
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logging in to the Vibe web application. Vibe considers the system to be safe from the brute-force
attack as soon as there have been fewer than 5 failed login attempts within the past 30 minutes. At
that time, specifying a CAPTCHA response is no longer required.

To change the default configuration settings for CAPTCHA for the Vibe web application:
1 Log in to the Vibe server with sufficient rights to edit the ssf - ext . properti es file (r oot on
Linux, Adni ni st rat or on Windows).

2 Change to the following directory:

Linux: / opt/ novel | / t eam ng/ apache-t ontat /
webapps/ ssf/WEB- | NF/ cl asses/ config

Windows: c¢:\Program Fi |l es\ Novel | \ Teani ng\ apache-t ontat\
webapps\ ssf\ WEB- | NF\ cl asses/ confi g

3 Openthessf. properti es filein a text editor.

4 Locate and copy the following lines:

#f ai | ed. user. aut hentication. history = true

#f ai | ed. user. aut henti cation. history. max.user.size =5
#brute.force. attack.in.last.numseconds = 30
#brute.force.attack.numfailed.logins =5

5 Close the ssf. properti es file without saving.

6 Make a backup copy of the ssf - ext . properti es file, located in the same directory with the
ssf. properti es file.

7 Openthessf-ext. properties filein a text editor.

8 Paste and uncomment the lines that you copied in Step 4 to the bottom of the file:

fail ed.user.authentication.history = true

fail ed. user.aut hentication. history. nmax. user.size = 5
brute.force.attack.in.last.numseconds = 30
brute.force.attack.numfailed.logins =5

9 Change the values to match your desired functionality. The function of each setting is as follows:

failed.user.authentication.history: When this option is set to t r ue it enables tracking of failed
login attempts on a per-user basis. The subsequent settings allow you to further customize the
functionality.

failed.user.authentication.history.max.user.size: The number of failed login attempts per user
of which Vibe keeps a history.

brute.force.attack.in.last.num.seconds: The number of seconds for which Vibe will look for the
number of failed login attempts. The default value for this setting is 30 seconds.

brute.force.attack.in.last.num.failed.logins: The number of failed login attempts allowed per
user (within the specified number of seconds) before Vibe requires all users to specify the
CAPTCHA response. The default of failed login attempts allowed per user is 5.
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For example, suppose brut e. f orce. attack. i n. | ast. num seconds is set to 300 (5
minutes) and brut e. force. attack. num f ai | ed. | ogi ns is set to 4. If user A
unsuccessfully attempts to log in to the Vibe web application 4 times within a 5-minute period,
the next time any user in the Vibe system attempts to log in he or she will be required to enter
a CAPTCHA response.

10 Save the ssf - ext. properti es file, then exit the text editor
11 Restart Vibe to put the change into effect.

Securing User Passwords

You can require that user passwords to the Vibe site meet certain criteria by enabling password
complexity checking. Only locally created users and external users are affected by this setting; users
whose accounts are synchronized to Vibe via LDAP are not affected.

Users’ existing passwords are not forced to comply with the password policy; only when a user
changes his or her password is the password policy put into effect.

When you enable password complexity checking in Vibe, Vibe requires that passwords:

+ Are at least 8 characters in length

+ Do not contain the user’s first name, last name, or user ID (these restrictions are not case-
sensitive)

+ Contain at least 3 of the following:
+ Alower-case character
+ An upper-case character
+ A number
One of the following symbols: ~ @# $ %~ &* () - +{ } [ ]| \V?/ , . <>

*

To enable password policy checking on the Vibe site:

1 Log in to the Vibe site as the Vibe administrator.

2 Click the admin link in the upper-right corner of the page, then click the Administration Console
icon %,

3 Under System, click Password Policy.

4 Select Enable Password Complexity Checking for Local and External Users, then click OK.
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Securing Web Service Connections

Web Services in Vibe allow third-party applications to integrate with your Vibe system. To increase
the security of your Vibe site, you can configure Vibe to allow only secure applications to integrate
with Vibe. This section does not attempt to describe how to write a third-party application that
supports HTTPS. Instead, this section describes how to configure your Vibe system to prevent non-
secure third-party applications from connecting with Vibe.

To prevent non-secure third-party applications from connecting with your Vibe system:

1 Login to the Vibe server with sufficient rights to edit the web. xmi files (r oot on Linux,
Adm ni st rat or on Windows).

2 Modify the web. xnl file under the ssr directory:
2a Change to the directory where the web. xmi file is located.

Linux: [ opt/novel | / t eanmi ng/ apache-tontat/
webapps/ ssr/ WEB- | NF

Windows: c:\Program Fi |l es\ Novel | \ Teani ng\ apache-t ontat\
webapps\ ssr\ VWEB- | NF

2b Make a backup copy of the web. xni file, then open the web. xri file in a text editor.

2c¢ Add the following security constraint at the bottom of the file, immediately above the </
web- app> tag.

<security-constraint>
<web-resource-col | ecti on>
<web-resour ce- nane>Entire Applicati on</web-resource-nane>
<url-pattern>/*</url-pattern>
</ web-resource-col | ecti on>
<user - dat a- const r ai nt >
<transport - guar ant ee>CONFI DENTI AL</ t r ansport - guar ant ee>
</ user - dat a- constrai nt >
</ security-constraint>

2d Save the modified web. xmi file, then exit the text editor.

Securing Tomcat

In order to support a wide variety of browsers, Vibe (Tomcat) allows the full range of SSL and TLS key
cipher methods. Over time, some of the cipher methods have proven vulnerable to attack. To
harden Tomcat and eliminate the server acceptance of vulnerable ciphers, you can specify which
ciphers the server should not accept:

NOTE: Because cipher lists are constantly changing, we can’t provide an up-to-date list of vulnerable
ciphers. Consult with your risk management department or security manager for your organization’s
list.

1 Change to the following directory:
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Linux: / opt/ novel | / t eam ng/ apache-t ontat /
conf

Windows: c¢:\ Program Fi | es\ Novel | \ Teani ng\ apache-tontat\
conf

2 Opentheserver. xnl filein a text editor.
3 Locate the ssl Prot ocol attribute.

4 Disable the weak ciphers supplied by your risk management department or security manager by
adding a list to the ser ver . xnl file, after the ssl Pr ot ocol attribute:

ci pher s="exanpl e_ci pher__1, exanpl e_ci pher_2, etc."

5 Save and close the server. xm file.

Requiring That External Users Accept Terms and
Conditions

You can require that any external (guest) users who access the Vibe site accept terms and conditions
before being granted access.

Path: Vibe Administration Console > System > Share Settings > External Users Licensing Terms tab

1. Enter your access terms in the Terms and Conditions for External Users window.
2. Enable Display Terms and Condition.

External users are now required to accept the terms and conditions before being granted
access.

Vibe Sanitizes HTML to Prevent Security Risks

Vibe 4.0.2 and later uses the OWASP HTML Sanitizer to allow or remove HTML elements, attributes,
and CSS Style properties that OpenText regards as “safe” or “unsafe,” as explained in the following
sections:

+ “HTML Elements” on page 353

+ “HTML Element Attributes” on page 354

+ “Conditional HTML Element Attributes” on page 355
+ “CSS Style Properties” on page 356

HTML Elements

The following HTML Elements are considered “safe.”
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a dfn h4 ol table

abbr dir h5 p tbody
area div h6 pre td

b dl hr q textarea
big dt i s tfoot
blockquote em img samp th

br figcaption input small thead
caption figure ins span tr
center font kbd strike tt

cite hl li strong u
code h2 map sub ul

dd h3 o sup var
del

You can configure your Vibe site to regard additional HTML elements as “safe” by doing the
following:

1. Using a text editor, add the following parameter with the elements you are adding, to the ssf -
ext. properti es file.

ht m . saf e. el enent s=El enent 1, El enent 2, El enent 3

2. After adding or modifying the file, you must restart Apache Tomcat for your configuration
changes to take effect.

IMPORTANT: Additions to the default OWASP HTML Sanitizer settings are not supported and are
regarded as unsafe by OpenText Support.

If you want OpenText to consider supporting your additions in a future Vibe release, you must
submit them for consideration to OpenText via Customer Care.

HTML Element Attributes

The following HTML Element Attributes are considered safe by default
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abbr compact rowspan

acronym coords rules
align dir scope
alt face size
axis frame sortable
bgcolor haling sorted
border headers style
cellpadding height summary
cellspacing href (on ar ea elements) target
char hspace title
charoff id type
class lang usemap
color longdesc valign
colspan name vspace
nowrap width

rel

You can configure your Vibe site to regard additional HTML attributes as “safe” by doing the
following:

1. Using a text editor, add the following parameter with the attributes you are adding, to the ssf -

ext. properti es file.

ht .safe.attributes=Attributel, Attribute2, Attri bute3

2. After adding or modifying the file, you must restart Apache Tomcat for your configuration
changes to take effect.

IMPORTANT: Additions to the default OWASP HTML Sanitizer settings are not supported and are
regarded as unsafe by OpenText Support.

If you want OpenText to consider supporting your additions in a future Vibe release, you must
submit them for consideration to OpenText via Customer Care.

Conditional HTML Element Attributes

Vibe limits the following HTML elements as indicated.
href

+ Allowed on <a/ > tags

+ Allowed URL protocolsare http, httpsandnailto

src

*

Allowed on <img/> tags

*

Allowed URL protocols are htt p, ht t ps, mai | t 0 and dat a

*

For embedded images, allowed mime-types are:

+ data: i mage/j peg;
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+ dat a: i mage/ png;
¢ data:imge/qgif;

CSS Style Properties

The following is a list of CSS style properties in “style” attributes are considered “safe.”
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-moz-border-radius

-moz-border-radius-bottomleft
-moz-border-radius-bottomright

-moz-border-radius-topleft
-moz-border-radius-topright
-moz-box-shadow
-moz-outline
-moz-outline-color
-moz-outline-style
-moz-outline-width
-o-text-overflow

-webkit-border-bottom-left-radius
-webkit-border-bottom-right-

radius
-webkit-border-radius

-webkit-border-radius-bottom-left
-webkit-border-radius-bottom-

right

-webkit-border-radius-top-left
-webkit-border-radius-top-right
-webkit-border-top-left-radius
-webkit-border-top-right-radius

-webkit-box-shadow
azimuth

background
background-attachment
background-color
background-image
background-position
background-repeat
border

border-bottom
border-bottom-color
border-bottom-left-radius
border-bottom-right-radius
border-bottom-style
border-bottom-width
border-collapse
border-color

border-left
border-left-color
border-left-style
border-left-width
border-radius
border-right
border-right-color
border-right-style
border-right-width

border-spacing
border-style
border-top
border-top-color
border-top-left-radius
border-top-right-radius
border-top-style
border-top-width
border-width
box-shadow
caption-side
color

cue

cue-after
cue-before
direction

display

elevation
empty-cells

float

font

font-family
font-size
font-stretch
font-style
font-variant
font-weight
height

image()
letter-spacing
line-height
linear-gradient()
list-style
list-style-image
list-style-position
list-style-type
margin
margin-bottom
margin-left
margin-right
margin-top
max-height
max-width
min-height
min-width

outline
outline-color
outline-style
outline-width
padding
padding-bottom
padding-left
padding-right
padding-top
pause
pause-after
pause-before
pitch
pitch-range
quotes
radial-gradient()
rect()
repeating-linear-gradient()
repeating-radial-gradient()
rgh()

rgba()

richness

speak
speak-header
speak-numeral
speak-punctuation
speech-rate
stress
table-layout
text-align"
text-decoration
text-indent
text-overflow
text-shadow
text-transform
text-wrap
unicode-bidi
vertical-align
voice-family
volume
white-space
width
word-spacing
word-wrap
z-index
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You can configure your Vibe site to regard additional CSS Style Properties as “safe” by doing the
following:

1. Using a text editor, add the following parameter with the properties you are adding, to the ssf -
ext. properti es file.

css. saf e. properti es=Propertyl, Property2, Property3

2. After adding or modifying the file, you must restart Apache Tomcat for your configuration
changes to take effect.

IMPORTANT: Additions to the default OWASP HTML Sanitizer settings are not supported and are
regarded as unsafe by OpenText Support.

If you want OpenText to consider supporting your additions in a future Vibe release, you must
submit them for consideration to OpenText via Customer Care.
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1 Security Policies

+ “Securing the Vibe Data” on page 361
+ “Securing the Vibe Software” on page 362
+ “Securing the Vibe Site” on page 363

Securing the Vibe Data

+ “Limiting Physical Access to Vibe Servers” on page 361
+ “Protecting the Vibe File Repository” on page 361
+ “Protecting the Vibe Database” on page 361

Limiting Physical Access to Vibe Servers

Servers where OpenText Vibe data resides should be kept physically secure, so unauthorized persons
cannot gain access to the server consoles.

Protecting the Vibe File Repository

The OpenText Vibe file repository contains unencrypted data. See “Distributing Different Data Types
to Different Locations” in “Advanced Installation and Reconfiguration” in the OpenText Vibe 4.0.8
Installation Guide for details about how Vibe uses the local file system for data storage. These
directories contain uploaded information in various formats (both native file formats and potentially
a number of rendered formats (such as cached HTML versions of files, thumbnails, and RSS feeds) as
well as archived data. These files are managed exclusively by the Vibe application software.

For data security, encrypted file systems should be used on servers where Vibe data resides. Only
Vibe administrators should have direct access to Vibe data.

Protecting the Vibe Database

During installation, you select the encryption method that you want to use for the Vibe database, as
described in “Database Encryption Algorithm” in “Single-server (Basic) Installation” in the OpenText
Vibe 4.0.8 Installation Guide. Three levels of encryption strength are available. The encryption
algorithm cannot be changed after you have started using the Vibe database, so be sure to select the
level of encryption appropriate for your Vibe site during initial installation.

Depending on your local security guidelines, you might want to encrypt the database connections
between the Vibe software and the Vibe database. SSL-encrypted data between the Vibe
application and the database server imposes a performance penalty because of the increased
overhead of encrypting and decrypting the retrieved data.
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Support for this is highly dependent on the database client drivers and JDBC connector support, and
on how you are configuring your database client and server certificates. You should check with your
database vendor on how to set up SSL connections on both the client and server sides of the
connection. You might need to modify the JDBC URL during installation, as described in “Database
Location” in “Single-server (Basic) Installation” in the OpenText Vibe 4.0.8 Installation Guide. For
example, for MySQL, you might add useSSL=t r ue& equi r eSSL=t r ue to the opt i ons part of the
JDBC URL.

Securing the Vibe Software

+ “Protecting the Vibe Configuration Files” on page 362
+ “Protecting the Vibe Properties File” on page 362
+ “Protecting Log Files” on page 362

+ “Protecting the Vibe Process on Linux” on page 363

Protecting the Vibe Configuration Files

The OpenText Vibe configuration file (i nst al | er. xm ) for the Vibe software should be protected
from tampering. It contains user name and password information for Vibe features that interact with
other programs.

The initial i nst al | er. xm is created in the same directory where the Vibe Installation program is
run. Backup copies are stored in:

Linux: [ opt/ novel | / t eam ng/team ng-config

Windows:  c¢:\Program Fi | es\ Novel | \ Team ng\t eam ng-config

Protecting the Vibe Properties File

The Vibe properties file (ssf . properti es) should be protected from tampering. Like the Vibe
configuration file, it contains user name and password information, as well as many other details
about your Vibe site configuration. The Vibe properties file (ssf . properti es) is located in the
following directory:

Linux: [ opt/novel | / t eam ng/ apache-tontat/
webapps/ ssf/WEB- | NF/ cl asses/ confi g

Windows: c¢:\Program Fil es\ Novel | \ Team ng\ apache-t ontat\
webapps\ ssf\ WEB- | NF\ cl asses/ config

Protecting Log Files

The log files for Vibe and Tomcat should be protected against access by unauthorized persons. Log
files contain very detailed information about your Vibe system and Vibe users.

The Vibe log file is available in the following directory of your Vibe installation:
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The Tomcat log file is available in the following directory of your Vibe installation:

Linux: [ opt/ novel | / t eam ng/ apache-tontat/| ogs

Windows: c:\Program Fil es\ Novel I\ Team ng\ apache-t ontat\| ogs

Protecting the Vibe Process on Linux

On Linux, Vibe is installed to run as a user other than the Linux r oot user. See “Identifying Vibe’s
Linux User and Group” in “Single-server (Basic) Installation” in the OpenText Vibe 4.0.8 Installation
Guide.

Securing the Vibe Site

+ “Configuring a Proxy Server” on page 363

+ “Setting the Vibe Administrator Password” on page 363
+ “Setting Up SSL Connections” on page 364

+ “Shortening the Vibe Session Timeout” on page 364

+ “Using Role-Based Access Control” on page 364

+ “Monitoring Inbound Email” on page 364

+ “Preventing Web Services Access” on page 364

¢ “Controlling RSS Feeds” on page 364

+ “Securing Mirrored Folders” on page 365

+ “Securing the Vibe Site against XSS” on page 365

Configuring a Proxy Server

Your OpenText Vibe system should be located behind your firewall. If Vibe users want to access the
Vibe site from outside your firewall, you should set up a proxy server outside your firewall to provide
access. You can use NetlQ Access Manager to protect your Vibe site, as described in “Configuring
Single Sign-On with Novell Access Manager” in “Advanced Installation and Reconfiguration” in the
OpenText Vibe 4.0.8 Installation Guide.

Setting the Vibe Administrator Password

The Vibe site is initially installed to allow administrator access by using the user name adm n and
the password adni n. The Vibe administrator password should be changed immediately after
installation, as described in “Accessing Your Basic Vibe Site as the Site Administrator” in “Single-
server (Basic) Installation” in the OpenText Vibe 4.0.8 Installation Guide.
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Setting Up SSL Connections

All communication with the Vibe site should be configured to use SSL connections, as described in:

+ “Securing Email Transfer” on page 340
+ “Securing LDAP Synchronization” on page 338

¢ “Securing HTTP Browser Connections” on page 340

Shortening the Vibe Session Timeout

By default, if a user’s Vibe session is idle for four hours (240 minutes), Vibe logs the idle user out. For
increased security for your Vibe site, you can make the session timeout shorter, as described in
“Changing the Vibe Session Timeout” in “Advanced Installation and Reconfiguration” in the
OpenText Vibe 4.0.8 Installation Guide.

Using Role-Based Access Control

Vibe controls all access to folders and entries by using role-based access controls. Vibe is intended to
be used primarily for the sharing of information, so many default access rights tend toward allowing
at least universal read access. For information on setting access controls for your Vibe site, see:

+ Chapter 2, “Planning and Controlling User Access to Workspaces and Folders,” on page 21 in this
guide

+ “Controlling Access” in the OpenText Vibe 4.0.8 Advanced User Guide

Monitoring Inbound Email

You can configure Vibe to receive email and post the messages as entries in a folder, as described in
“Planning to Enable Inbound Email” in “Single-server (Basic) Installation” in the OpenText Vibe 4.0.8
Installation Guide. Because email is inherently non-secure, there is no way to be sure that the
senders are who they claim to be. Entries posted by email include the email address of the sender to
alert Vibe users about the origin of the postings.

Preventing Web Services Access

The default Vibe installation allows authenticated access via web services, as described in
“Configuring Web Services” in “Advanced Installation and Reconfiguration” in the OpenText Vibe
4.0.8 Installation Guide. If you are not using web services, you can disable them.

Controlling RSS Feeds

Because RSS readers are outside of the authentication Vibe system, the URL provided by Vibe for an
RSS feed embeds some authentication information about the user. This means that the RSS URL
must be protected and not shared between users. For this reason, RSS is not recommended for use
on highly sensitive data. If necessary, you can disable RSS feeds for your Vibe site, as described in
“Managing RSS Feeds” in “Advanced Installation and Reconfiguration” in the OpenText Vibe 4.0.8
Installation Guide.
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Securing Mirrored Folders

Mirrored folders make files that are stored on a file system available to users on the Vibe site. Two
levels of security are provided for mirrored folder access:

+ When you create mirrored folder resource drivers, as described in “Configuring Mirrored Folder
Resource Drivers” in “Advanced Installation and Reconfiguration” in the OpenText Vibe 4.0.8
Installation Guide, you can choose read-only access or read/write access. In addition, you can
identify specific Vibe users and groups that are allowed access to the mirrored folder resource
drivers.

+ When you set up the mirrored folders on the Vibe site, as described in Chapter 17, “Setting Up
Mirrored Folders,” on page 191 in this guide, you can set access controls on the Mirrored File
folder.

Securing the Vibe Site against XSS

Cross-site scripting (XSS) is a client-side computer attack that is aimed at web applications. Because
XSS attacks can pose a major security threat, OpenText Vibe contains a built-in security filter that
protects against XSS vulnerabilities. This security filter is enabled by default.

The following sections describe the types of content that the security filter blocks from the Vibe site,
where exactly it blocks it from entering, and how you can disable the security filter or enable specific
users to bypass the security filter.

+ “Understanding What Content Is Not Permitted” on page 365

+ “Understanding Where the Content Is Not Permitted” on page 365
+ “Listing All XSS Threats in Your System” on page 366

+ “Disabling the XSS Security Filter” on page 366

Understanding What Content Is Not Permitted

By default, the XSS security filter in Vibe is very strict, and does not allow users to add certain types
of content. For example, the following content is not permitted:

+ HTML that contains JavaScript
+ Forms

+ Frames

+ Objects

+ Applets

Understanding Where the Content Is Not Permitted

The type of content discussed in “Understanding What Content Is Not Permitted” on page 365 is
filtered by Vibe in the following areas:

+ Text and HTML fields in entries and folders
+ Uploaded HTML files
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Listing All XSS Threats in Your System

Vibe lets you run an XSS report that lists XSS threats that are contained in your Vibe system. For
more information, see “XSS Report” on page 312.

Disabling the XSS Security Filter

IMPORTANT: Because of the serious nature of XSS attacks, we strongly recommend that you do not
disable the XSS security filter for the entire site. If there are certain users who need to upload
information to the Vibe site, you can grant those users access to bypass the XSS security filter, as
described in “Enabling Users to Bypass the XSS Security Filter” on page 230.

It is possible to disable the XSS security filter for the entire site for each of these areas by copying the
appropriate lines from the ssf . properti es file, pasting them into the ssf - ext . properties
file, then changing the values of the lines to f al se. The lines in the ssf . properti es file that are
responsible for enabling and disabling the XSS security filter are:

+ xss. check. enabl e
¢ xss.content.filter.file.extensions
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+ Appendix A, “Managing Product Improvement,” on page 369
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Managing Product Improvement

Path to Configuration Dialog: Vibe Administration Console > Management > Product Improvement

The first time you log in to Vibe, after changing the admin user’s password, a dialog displays that
explains that the purpose of the Vibe data collection system is to help improve the Vibe product.

IMPORTANT: OpenText collects nothing that identifies your organization, your data, or your users.

Accessing the Product Improvement Dialog

You can see what is collected, and you can modify, disable, or re-enable the data collection system
by using the Product Improvement dialog.
1 Open the Vibe Administration Console as the Admin user.

2 Click Product Improvement.

The data collection process runs for the first time when a Vibe server has been running for 24 hours.
Thereafter, it runs weekly.

After the initial run, a View the information collected link displays in the dialog that lets you
download the . | son file created by the collection process.

To see the information collected, open the downloaded file in an application such as WordPad.

About the Data That Is Collected for Product Improvement

As already mentioned, OpenText collects nothing that identifies your organization, your data, or your
users.

The items in the . j son file are mostly self-explanatory, but the following points might be helpful to
understanding file content.

The data is divided in three sections:
+ Installation Identifier: This is a unique string generated for each appliance. Its sole purpose is to
let OpenText track usage and statistics for a specific appliance over time.
+ Tier 1: This section includes the product, version and build, license type, and number of users.

+ Tier 2: This section includes additional information about the installation, most of which is self-
explanatory.

¢ The user information doesn’t include the LDAP user count because that is already available
under the Tierl.

+ The user count numbers do not include system user accounts, such as admi n,
_filesyncagent, and so on.
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+ The group count numbers do not include system groups, such as al | users,
al | extusers, andsoon.

+ wor kspaceCount does notinclude system workspaces, such as the / Hormre workspace and
so on.

+ The mobile device type is derived from the value of the description field associated with
the device information captured in the system. Any descriptions that don’t match one of
the pre-defined keywords are included as ot her .

How OpenText Receives Product Improvement Data

After the weekly data collection process concludes, the system creates a . j son data file and sends it
toftp://productfeedback. Novel | . cont st at s/ Vi be.

If the FTP transfer is unsuccessful, the system attempts to send it again during the next weekly cycle.
No send attempts are made outside of the weekly cycles.

Data files are sent through a regular non-secure FTP connection. File contents are not encrypted
because no sensitive or identifying information is included.
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